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ΠΡΟΛΟΓΟΣ 

Στο παρόν σύγγραμα παρουσιάζονται  τα Συστήματα Γεωγραφικών Πληροφοριών (ΣΓΠ) και  
Διαστημικές Τεχνικές, όπως έχουν εφαρμοσθεί σε ένα ευρύ φάσμα Γεωλογικών, Γεωφυσικών 
και Γεω-περιβαλλοντικών Μελετών.  Αποτελεί βελτιωμένη έκδοση του συγγράματος   
«Εφαρμογές Συστημάτων Γεωγραφικών Πληροφοριών και Τηλεανίχνευσης σε Γεωλογικές και 
Γεω-περιβαλλοντικές Μελέτες» (Σπ. Βασιλοπούλου, 2012, ΕΚΠΑ, σ. 267). 
Αναλύεται η διαχείριση διαφορετικού είδους δεδομένων (επίγειων και δορυφορικών) καθώς 
και η δημιουργία-οργάνωση ψηφιακών βάσεων δεδομένων σε ΣΓΠ, με σκοπό την σύνθεση 
χαρτών και την δημιουργία συστημάτων λήψεως αποφάσεων. Απαραίτητη προϋπόθεση στην 
διαχείριση των δεδομένων αποτελεί η γνώση βασικών αρχών της χαρτογραφίας, των 
χαρτογραφικών απεικονίσεων και της γεωδαισίας, όπου και παραθέτονται.  
 
Αρχικά, το σύγγραμμα σχεδιάσθηκε ως βοήθημα σε  μαθήματα και εργαστήρια  του 
Προπτυχιακού και Μεταπτυχιακού Προγράμματος Σπουδών του Τομέα Γεωφυσικής-
Γεωθερμίας, του Τμήματος Γεωλογίας και Γεωπεριβάλλοντος του ΕΚΠΑ που άρχισε το 
Ακαδημαϊκό Έτος 2003-2004: 
• «Γεωλογικές και Περιβαλλοντικές Εφαρμογές Ψηφιακής Χαρτογραφίας και Συστημάτων 

Γεωγραφικών Πληροφοριών» (Προπτυχιακό) 
• «Γεωλογικές και Περιβαλλοντικές Εφαρμογές Δορυφορικών Συστημάτων Πλοήγησης (GPS) 

και Παρακολούθησης της Γης» το οποίο μετονομάσθηκε σε «Διαστημικές Τεχνικές και 
Συστήματα Γεωγραφικών Πληροφοριών στις Γεωεπιστήμες» (Προπτυχιακό) 

•  «Εφαρμογή ΣΓΠ στις Γεωεπιστήμες» το οποίο μετονομάσθηκε σε «Διαστημικές Εφαρμογές 
και Συστήματα Γεωγραφικών Πληροφοριών στην Γεωφυσική και την Σεισμολογία» 
(Μεταπτυχιακό) 

 
Τμήμα του συγγράμματος αποτέλεσε βοήθημα στα μαθήματα και εργαστήρια «Πρόβλεψη-
Διαχείριση Φυσικών Καταστροφών με τη χρήση ΓΣΠ» και «Εφαρμογή Διαστημικής Τεχνολογίας 
στην Πρόληψη και Διαχείριση Φυσικών Καταστροφών»,  του Διϊδρυματικού Προγράμματος 
Μεταπτυχιακών Σπουδών «Πρόληψη και Διαχείριση Φυσικών Καταστροφών», από την έναρξη 
του Προγράμματος το 2004 έως και το 2009. 
  
Από το 2004 έως σήμερα, η ύλη ενημερώνεται και εμπλουτίζεται διαρκώς, με στόχο να 
αποτελέσει βοήθημα σε γεωεπιστήμονες ή επιστήμονες και ερευνητές άλλων κλάδων, οι οποίοι 
επιθυμούν να ασχοληθούν με τα συγκεκριμένα αντικείμενα, καθόσον περιλαμβάνει ένα ευρύ 
πεδίο βασικών αρχών (ερμηνευόμενες κυρίως κατά την φυσική τους έννοια), τεχνικών 
επεξεργασίας ψηφιακών δεδομένων, εφαρμογών και ασκήσεων, σε μικρό σχετικά αριθμό 
σελίδων. 
 
Στο Κεφάλαιο 1 δίδονται βασικές έννοιες σχετικές με την Επιφάνεια της Γης, το Γεωειδές, το 
Ελλειψοειδές, τις Συντεταγμένες Σημείου. 
 
Στο Κεφάλαιο 2 περιγράφονται βασικές έννοιες σχετικές με την Χαρτογραφία που αποτελούν 
απαραίτητες γνώσεις για την περαιτέρω επεξεργασία-διαχείριση ψηφιακών δεδομένων. 
 
Στο Κεφάλαιο 3 και στο Κεφάλαιο 4 δίδονται αντίστοιχα Συστήματα Συντεταγμένων και 
Μέθοδοι Μέτρησης. 
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Οι βασικές αρχές των Χαρτογραφικών Απεικονίσεων και των Γεωδαιτικών Συστημάτων 
Αναφοράς αναλύονται στα Κεφάλαιο 5 και 6 αντιστοίχως. 
 
Στο Κεφάλαιο 7 περιγράφονται τα Συστήματα Γεωγραφικών Πληροφοριών (ΣΓΠ), οι βασικές 
αρχές αυτών, η διαφορά με άλλα σχεδιαστικά η χαρτογραφικά πακέττα, η σχέση τους με την 
Ψηφιακή Χαρτογραφία  η χρήση τους ως προς τις Γεωεπιστήμες και την διαχείριση των 
δεδομένων. 
 
Τα Ψηφιακά Μοντέλα Αναγλύφου (ΨΜΑ) και τα παράγωγα χωρικά μοντέλα αυτών, τα οποία 
αποτελούν βασικό συστατικό σε έναν μεγάλο αριθμό εφαρμογών ως προς την γεωλογική, 
γεωφυσική και γεω-περιβαλλοντική έρευνα, αναλύονται στο Κεφάλαιο 8. Στο ίδιο κεφάλαιο 
δίδονται οι μέθοδοι που χρησιμοποιούνται για την παραγωγή των ΨΜΑ και οι εφαρμογές τους 
στις γεω-επιστήμες. 
 
Στο Κεφάλαιο 9 δίδεται η σχέση των Δεδομένων Τηλεανίχνευσης και ειδικότερα των 
Δορυφορικών Εικόνων με τα ΣΓΠ καθώς και η χρήση τους ως προς τις Γεωεπιστήμες. 
 
Στο Κεφάλαιο 10 δίδονται βασικές αρχές σχετικά με την Δορυφορική Τηλεανίχνευση. 
 
Στο Κεφάλαιο 11 παρουσιάζεται μια σειρά από Δορυφόρους που αποτελούν χρήσιμο εργαλείο  
στις Γεωεπιστήμες. 
 
Οι δορυφορικές εικόνες και η χρήση τους ως προς τις γεωεπιστήμες αναλύονται στο Κεφάλαιο 
12, ενώ στο Κεφάλαιο 13 παρουσιάζονται τα στάδια  επεξεργασίας ψηφιακών δορυφορικών 
εικόνων.  
 
Στο Κεφάλαιο 14 παραθέτονται τμήματα Γεωλογικών και Γεω-περιβαλλοντικών Εφαρμογών 
σχετικών με Ανάπτυξη ΣΓΠ σε συνδυασμό με Τηλεανίχνευση. Επιχειρείται κατά αυτόν τον τρόπο 
η κατανόηση της φιλοσοφίας των τεχνολογιών  αυτών, ενώ ταυτόχρονα δίδεται η κατεύθυνση-
καθοδήγηση για την διαχείριση των πολυθεματικών δεδομένων αναλόγως με το ζητούμενο. Σε 
αυτό βοηθούν οι Εργαστηριακές Ασκήσεις  που παραθέτονται στο ΠΑΡΑΡΤΗΜΑ και 
σχετίζονται με επεξεργασία επίγειων και δορυφορικών δεδομένων σε περιβάλλον ΑrcGIS και 
ENVI. 
 
Θεωρώ υποχρέωσή μου να ζητήσω συγνώμη για τυχόν λάθη, παραλλείψεις ή παραβλέψεις που 
πιθανόν έχουν γίνει στο παρόν σύγγραμμα, με την υπόσχεση να διορθωθούν σε επόμενη 
έκδοση. 
 
Στο  σημείο αυτό, θα επιθυμούσα να ευχαριστήσω για την πολύτιμη και πολύπλευρη 
συνεργασία τους επί σειρά ετών, τον Καθηγητή κ. Ευάγγελο Λάγιο (ΕΚΠΑ), τον Καθηγητή κ. 
Lorenz Hurni (ETH Zurich), τον Πρόεδρο της Εταιρείας MDS Marathon Data Systems κ. Άδωνι 
Κοντό, την Υπεύθυνη της Inforest O.C. κ. Μαρουλιώ Χανιώτη, τον Καθηγητή κ. Volker Dietrich 
(ETH Zurich), τον Καθηγητή κ. Λύσσανδρο Τσούλο (ΕΜΠ), τον συνάδελφο Δρ. Βασίλη Σακκά 
(ΕΚΠΑ) και τον Dr. Brian Damiata (UCLA). Η οικογένειά μου και ειδικότερα η μητέρα μου Τζένη 
και ο σύζυγός μου Παναγιώτης υπήρξαν πάντοτε αληθινό στήριγμα σε όλα όσα επέλεξα και 
τους οφείλω ένα μεγάλο ευχαριστώ.  
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PREFACE 

 
The Geographic Information Systems (GIS) and the application of the newly developed Space 
Techniques in Geological, Geophysical and Geo-environmental issues are presented in this 
textbook. The management of different kind of data (ground and satellite) and their 
organization in a database form to help create a decision making system is analytically outlined. 
The fundamental principles of digital Cartography, Geodesy and Map Projection Systems that 
are very important for data management are also presented. 
 
Under the framework of the undergraduate and postgraduate studies program of the School of 
Geology & Geoenvironment in the Faculty of Science of the University of Athens, lecture notes 
were written for students attending the following courses carried out by personnel of the 
Department of Geophysics & Geothermics: 
 
♦ “Geological and Environmental Applications in Digital Cartography and GIS”  
♦  “Geological and Environmental Applications applying GPS and Earth Observation 
Techniques”  
♦ “Space Application Techniques and GIS in Geophysics and Seismology”. 
 
A part of the above notes were also available to students in the following courses during 2005-
2009: 
 
• “Application of Space Technology in the Forecasting and Management of Natural 
Disasters”, within the framework of Post-graduate Studies Program of the School of Geology & 
Geoenvironment (NKUA) in collaboration with the Department of Geomatics and Surveying, 
Technological Educational Institution of Serres (Greece). 
• “Forecasting and Management of Natural Disasters using GIS” within the framework of 
Post-graduate Studies Program of the School of Geology & Geoenvironment (NKUA) in 
collaboration with the Department of Geomatics and Surveying, Technological Educational 
Institution of Serres (Greece). 
 
The above notes were updated in the form of the present textbook. It constitutes a useful tool 
for geoscientists who would like to work on geological and geo-environmental applications using 
GIS and Remote Sensing Techniques. 
 
The fundamental principles relating to the Earth’s Surface, Geoid, Ellipsoid and Map Coordinate 
Systems are described in Chapter 1. 
 
The main principles of Cartography (Analytical, Mathematical, Digital) are given in Chapter 2. 
 
The Coordinate Systems and the Methods of Measurements are described in the Chapter 3 & 4, 
respectively. 
 
The Map Projections and the Geodetic Reference Systems are given in the Chapter 5 & 6, 
respectively. 
Chapter 7 is relating to GIS and their fundamental principles applied to digital Cartography and 
Geosciences. 
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The Digital Elevation Models (DEM) together with the Spatial Models associated with basic 
features in various Geological and Geo-environmental studies are presented in Chapter 8. 
 
The relation between GIS and Remote Sensing Data (especially Satellite Imaging), and their use 
in Geosciences are given in Chapter 9.  
 
Chapter 10 presents the fundamental principles of Satellite Remote Sensing. 
 
Chapter 11 outlines a series of Earth Observation Satellites Systems. 
 
The characteristics of Satellite Images are given in Chapter 12, while the steps of the Image 
Processing are analytically presented in Chapter 13. 
 
Finally in Chapter 14, some examples of Geological, Geophysical and Geo-environmental Studies 
related to the GIS Development and Remote Sensing are presented aiming to the better 
understanding of these technologies. The Exercises in ArcGIS and ENVI which are included in the 
ANNEX can also be of some help. 
 
I would like to apologize for probable errors promising to correct them in the next edition. 
 
At this point, I would like to acknowledge for their valuable and multilateral collaboration, Prof. 
Evangelos Lagios (NKUA, Athens), Prof. Lorenz Hurni (ETH Zurich), Mr. Adonis Kontos (President 
of Marathon Data Systems co.), Mrs. Maroulio Chanioti (Head of Inforest O.C), Prof. Volker 
Dietrich (ETH Zurich), Prof. Lyssandros Tsoulos (NTUA, Athens), Dr. Vassilis Sakkas (NKUA, 
Athens), Dr. Brian Damiata (UCLA). Finally, I am grateful to my family, especially to my mother 
Jenny and my husband Panagiotis, for they are my real helpmates in all my attempts. 
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1. ΓΕΝΙΚΕΣ ΕΝΝΟΙΕΣ 

1.1. Η Επιφάνεια της Γης 
 
Η μελέτη της Γης έχει απασχολήσει τους ερευνητές από την αρχαιότητα. Πολλοί κλάδοι 
της Επιστήμης έχουν ως βάση της έρευνάς τους την Γήινη Επιφάνεια, η οποία 
χαρακτηρίζεται ως ακανόνιστη και συνεχώς μεταβαλλόμενη. Η μοντελοποίηση της 
επιφάνειας της Γης κρίνεται απαραίτητη για την πλοήγηση και χαρτογράφηση.  
 
Η πραγματική επιφάνεια της ξηράς και θάλασσας (Φυσική Γήινη Επιφάνεια) σε 
συγκεκριμένη χρονική στιγμή, αποτελεί την Τοπογραφική Επιφάνεια της Γης (Εικ. 1.1, 
1.3). 
Ο καθορισμός μιας νοητής επιφάνειας–του γεωειδούς που πλησιάζει περισσότερο την 
γήινη, κρίθηκε αναγκαίος ώστε να διεξάγονται οι διαφόρου είδους μελέτες. 

Γεωειδές:  Ορίζεται ως η νοητή επιφάνεια που πλησιάζει περισσότερο την επιφάνεια 
της γης (Εικ. 1.2, 1.3). Ορίζεται από την Μέση Στάθμη της Θάλασσας (ΜΣΘ) και της 
νοητής προέκτασής της κάτω από τις ηπείρους. Η διεύθυνση του διανύσματος της 
βαρύτητας με φορά  προς το εσωτερικό της γης είναι πάντοτε κάθετη στην επιφάνεια του 
γεωειδούς. Το Γεωειδές δεν δύναται να εκφρασθεί με απλές μαθηματικές σχέσεις. 
 
Ακριβέστερα, το Γεωειδές είναι εκείνη η επιφάνεια, στην οποία το γήινο πεδίο βαρύτητας 
έχει σταθερή και προκαθορισμένη τιμή (όση στην ”μέση στάθμη θάλασσας"). Το νέο 
γεωειδές που δημιουργήθηκε από τα δεδομένα της βαρύτητας που συλλέγησαν από 
από τον δορυφόρο GOCE (Gravity Field και Steady-State Ocean Circulation Explorer) 
της ESA, κατά τον Μάρτιο 2009 έως τον Νοέμβριο 2013, προσφέρει την καλύτερη 
άποψη της παγκόσμιας βαρύτητας (Εικ. 1.2). Το γεωειδές είναι η επιφάνεια ενός 
ιδανικού παγκόσμιου ωκεανού, χωρίς παλίρροιες και ρεύματα, διαμορφωμένο μόνο από 
την βαρύτητα. Το σχήμα αυτό είναι μία κρίσιμη αναφορά για την μέτρηση της ωκεάνιας 
κυκλοφορίας, της αλλαγής στην στάθμη της θάλασσας και την δυναμική του πάγου. 
 
Η μοντελοποίηση της επιφάνειας της γης με μαθηματικό τρόπο,  οδήγησε τελικά στο 
ελλειψοειδές εκ περιστροφής. 
 
Ελλειψοειδές εκ Περιστροφής (ΕΕΠ): Ορίζεται ως η μαθηματική λεία επιφάνεια που 
προσεγγίζει το Γεωειδές (Εικ. 1.3,  1.4). Παριστάνει την μαθηματική μορφή της Γης, στην 
οποία αναφέρονται οι θέσεις των τριγωνομετρικών σημείων είτε στο σύστημα των 
ορθογωνίων ελλειψοειδών συντεταγμένων του, είτε στο σύστημα των ορθογωνίων 
καρτεσιανών συντεταγμένων του. Η επιπλάτυνση του ελλειψοειδούς στους πόλους είναι 
σχετικά μικρή ώστε το ελλειψοειδές τείνει σε σφαίρα και αντίστοιχα ονομάζεται  
σφαιροειδές. 
 
Η Γη γενικότερα θεωρείται  ως σφαιροειδές.  Συχνά λαμβάνεται ως σφαίρα (ανάλογα 
με την κλίμακα μελέτης και την ακρίβεια που απαιτείται) και επιτυγχάνονται ευκολότερα 
οι μαθηματικοί υπολογισμοί. Όταν πρόκειται για περιορισμένες εκτάσεις, η επιφάνεια 
αναφοράς θεωρείται και ως οριζόντιο επίπεδο.Οι αποστάσεις και τα εμβαδά μετρώνται 
ευκολότερα σε επίπεδη επιφάνεια, με βάση το Καρτεσιανό Σύστημα Συντεταγμένων, 
όπου χρησιμοποιεί γραμμικές μονάδες όπως το μέτρο κ.ά., παρά στο σφαιροειδές, ή 
στην σφαίρα, οπότε συνδυάζεται το τρισορθογώνιο σύστημα συντεταγμένων (Ο, Χ, Y, Ζ) 
με το σφαιροειδές. 
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Εικ. 1.1. Σκιασμένο 
Ανάγλυφο Ηφαιστειακού 
Πεδίου «Κως – Γυαλί – 
Νίσυρος – Τήλος» σε 
κλίμακα 1/100000, στο 
Ελληνικό Γεωδαιτικό 
Σύστημα Αναφοράς-
ΕΓΣΑ΄87 (Lagios et al. 
2001). Αναπαρίσταται το 
γήινο ανάγλυφο καθώς 
και το ανάγλυφο του 
πυθμένα της θάλασσας 
της συγκεκριμένης 
περιοχής μελέτης, σε 
συγκεκριμένη χρονική 
στιγμή. 
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Εικ. 1.2 
 
Το 2011 GOCE Γεωειδές. 
Οι χρωματικές διαβαθμίσεις (μπλε προς 
κόκκινο) δίνουν αντιστοίχως  την 
διαβάθμιση των υψομέτρων (από -100m 
έως 100m), από ένα ιδεατό γεωειδές. 
Έως τον Νοέμβριο του 2013 πέντε 
μοντέλα βαρύτητας και αντίστοιχα 
γεωειδή παρήχθησαν από τα δεδομένα 
του δορυφόρου GOCE, όπου κάθε 
νεώτερη έκδοση ήταν περισσότερο 
ακριβής από την προηγούμενη 
(http://www.esa.int/spaceinimages/Imag
es/2014/07/2011_GOCE_geoid). 
 

 

  

 
 
Εικ. 1.3.  
Η Επιφάνεια Γης 
(Τοπογραφική Επιφάνεια 
ή Φυσική Γήινη 
Επιφάνεια), σε 
συγκεκριμένη χρονική 
στιγμή, σε σχέση με την 
Επιφάνεια Γεωειδούς και 
Ελλειψοειδούς. 
 

 

 
Εικ. 1.4.  
Το Ελλειψοειδές εκ 
Περιστροφής και οι 
Παράμετροι 
Ελλειψοειδούς: Μεγάλος 
ημι-άξονας - a, Μικρός 
ημι-άξονας - b, 
Επιλάτυνση – f και 
Εκκεντρότητα – e, στο 
Παγκόσμιο Γεωδαιτικό 
Σύστημα Αναφοράς - 
WGS’84. 
 



 8 

Το ελλειψοειδές χαρακτηρίζεται ως: 
• γήϊνο ή γεωκεντρικό ελλειψοειδές (ΓΕΕΠ) 
• γεωδαιτικό ελλειψοειδές (γΕΕΠ) 

 
Το γήϊνο ή γεωκεντρικό ελλειψοειδές (ΓΕΕΠ) χρησιμοποιείται  ως μαθηματική 
προσέγγιση ολόκληρης της επιφάνειας του γεωειδούς (εικ. 1.5). Το κέντρο του ταυτίζεται 
με το κέντρο μάζας της γης. Ο άξονας ΟΖ συμπίπτει με τον άξονα περιστροφής της Γης, 
ενώ το επίπεδο (ΟΧ, ΟΖ) συμπίπτει με το μεσημβρινό επίπεδο του Greenwich. 
Χρησιμοποιείται για διακρατικές ή διαηπειρωτικές εργασίες. 

 
Το γεωδαιτικό ελλειψοειδές (γΕΕΠ) χρησιμοποιείται ως μαθηματική προσέγγιση 
συγκεκριμένου τμήματος κάθε φορά της επιφάνειας της φυσικής Γης, δηλαδή τοπικά. Το 
κέντρο του δεν ταυτίζεται με το κέντρο μάζας της Γης, αλλά απέχει από αυτό. Το 
μηδενικό μεσημβρινό επίπεδο αυτού θα είναι παράλληλο με το μεσημβρινό επίπεδο του 
Greenwich του ΓΕΕΠ.  

 
Γενικά το γΕΕΠ θεωρείται ότι έχει υποστεί μια παράλληλη μετατόπιση κατά Χ, Υ, Ζ ως 
προς το ΓΕΕΠ ενώ η στροφή του ως προς αυτό θεωρείται αμελητέα. Χρησιμοποιείται για 
εργασίες που αφορούν μεμονωμένα κράτη ή και για μια ολόκληρη ήπειρο, όπου δύναται 
να προσαρμόζεται σε κάποιο σημείο του Γεωειδούς στην περιοχή. 
 

 
 
 
 
1.2. Συντεταγμένες και Υψόμετρο Σημείου 
 
1.2.1. Γεωγραφικές Συντεταγμένες Σημείου 
 
Η προβολή επάνω στην σφαίρα, κάθε σημείου ευρισκομένου στην  επιφάνεια της Γης, 
προσδιορίζεται με τρεις παραμέτρους (συντεταγμένες): Tο υψόμετρο «h» (height) και τις 
γεωγραφικές συντεταγμένες του, που ορίζονται από τις γωνίες του γεωγραφικού 
πλάτους (latidude)  «φ» και γεωγραφικού μήκους (longitude) «λ», μετρούμενες σε μοίρες 
ή ακτίνια, σε σφαιρικό σύστημα συντεταγμένων (Εικ. 1.6). 

Εικ. 1.5. Το Γεωκεντρικό 
Ελλειψοειδές με το 
πλέγμα Μεσημβρινών και 
Παραλλήλων και το 
Καρτεσιανό Σύστημα 
Συντεταγμένων (Χ,Υ,Ζ), 
προσαρμοσμένο στο 
κέντρο του Ελλειψοειδούς 
(κέντρο Γης).  
Σημείο-πόλος (Pole) Ρ  
ευρισκόμενο στην 
επιφάνεια του 
Ελλειψοειδούς, 
προσδιορίζεται είτε με τις 
Γεωδαιτικές 
Συντεταγμένες του (φ, λ, 
Η)   είτε με τις 
Καρτεσιανές 
Συντεταγμένες (x,y,z). 
(Ordance Survey 2002). 
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Γεωγραφικό πλάτος (Latitude - φ) ενός σημείου ευρισκομένου στη σφαίρα, ορίζεται 
ως η γωνία που σχηματίζει η κάθετος από το σημείο με το επίπεδο του Ισημερινού, στην 
κατεύθυνση Βορρά – Νότου. Μετράται επί του μεσημβινού του σημείου, με αρχή τον 
Ισημερινό (ο οποίος χαρακτηρίζεται από γεωγραφικό πλάτος 0°) και από 0° έως 90° 
προς τον Βόρειο Πόλο ή από 0° έως - 90° ως προς τον Νότιο Πόλο. Μονάδες μέτρησης 
είναι οι μοίρες (°) και υποδιαιρέσεις αυτών (πρώτα λεπτά (΄) και δεύτερα λεπτά (΄΄). 
 
Το γεωγραφικό πλάτος χαρακτηρίζεται Βόρειο (Β) ή Νότιο (Ν) ανάλογα με το ημισφαίριο 
όπου ευρίσκεται το σημείο.Σημεία του ίδιου ημισφαιρίου έχουν ομώνυμα πλάτη σε 
αντίθεση με σημεία διαφορετικού ημισφαιρίου που έχουν ετερώνυμα πλάτη (λαμβάνεται 
σοβαρά υπ΄ όψιν στους υπολογισμούς). 
 
Γεωγραφικό Μήκος (Longitude - λ) ενός σημείου, ευρισκομένου στην επιφάνεια της 
σφαίρας, ορίζεται ως η γωνία που σχηματίζεται από το επίπεδο του μεσημβρινού που 
διέρχεται από το εν λόγω σημείο, με το επίπεδο του Πρώτου Μεσημβρινού (00

 

),  στην 
διεύθυνση Ανατολής – Δύσης. Ως Πρώτος Μεσημβρινός ορίσθηκε το 1884 στο Διεθνές 
Συνέδριο Μεσημβρινών στην Ουάσιγκτον, ο Μεσημβρινός του Βασιλικού 
Αστεροσκοπείου στο Γκρήνουιτς πλησίον του Λονδίνου. Το γεωγραφικό μήκος μετράται 
επάνω στον Ισημερινό και κυμαίνεται από 0° έως 360°. Μονάδες μέτρησης είναι οι 
μοίρες και υποδιαιρέσεις αυτών.  

Στην Γεωγραφία μετράται από 0° έως 180° Ανατολικά (Α) ή 0° έως - 180° Δυτικά (Δ) και 
χαρακτηρίζεται Ανατολικό (Α) ή Δυτικό (Δ) ανάλογα με το ημισφαίριο, στο οποίο 
ευρίσκεται το σημείο. Σημεία του ίδιου ημισφαιρίου έχουν ομώνυμα μήκη, σε αντίθεση με 
τόπους διαφορετικού ημισφαιρίου όπου έχουν ετερώνυμα μήκη (λαμβάνεται σοβαρά υπ΄ 
όψιν στους υπολογισμούς). 
 
 
Όλα τα σημεία της Γης με το ίδιο γεωγραφικό πλάτος ορίζουν έναν παράλληλο. Όλα τα 
σημεία της Γης με το ίδιο γεωγραφικό μήκος ορίζουν έναν μεσημβρινό. Το νοητό δίκτυο 
παράλληλων και μεσημβρινών στην Γη ονομάζεται πλέγμα, όπως επίσης και η προβολή 
τους σε ένα επίπεδο (Εικ. 1.6). 
 
1.2.2. Γεωδαιτικές Συντεταγμένες Σημείου 
 
Οι συντεταγμένες ενός σημείου ευρισκομένου στην επιφάνεια του ελλειψοειδούς 
καλούνται γεωδαιτικές και έχουν ως ακολούθως:  
 
Γεωδαιτικό Πλάτος (Geodetic Latitude) ορίζεται η γωνία μεταξύ της καθέτου στην 
επιφάνεια του ελλειψοειδούς και του επιπέδου του Ισημερινού του ελλειψοειδούς.  
 
Γεωδαιτικό Μήκος (Geodetic Longitude) ορίζεται η γωνία που σχηματίζει στον 
Ισημερινό, το επίπεδο του μεσημβρινού, που διέρχεται από το σημείο  και του επιπέδου 
του Πρώτου Μεσημβρινού. 
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1.2.3. Είδη Υψομέτρου Σημείου 
 
Υψόμετρο: Υψόμετρο ενός σημείου, ευρισκομένου στην φυσική γήινη επιφάνεια, 
ορίζεται η απόστασή του από το ελλειψοειδές ή το γεωειδές αναφοράς. Το ελλειψοειδές 
ή γεωμετρικό υψόμετρο (H) και το γεωειδές  ή ορθομετρικό υψόμετρο (h) ενός σημείου A 
σε σχέση με μοντέλο γεωειούς-ελλειψοειδούς διαχωρισμού (N) δίδεται από την σχέση  
H = h + N (Εικ. 1.7).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Εικ. 1.6. Οι Μεσημβρινοί και Παράλληλοι Κύκλοι ορίζουν το Γεωγραφικό Πλάτος (Latitude) και το 
Γεωγραφικό Μήκος (Longitude) ενός σημείου Ρ στη σφαίρα (προβολή-πόλος σημείου 
ευρισκομένου στην επιφάνεια της Γης) - (ESRI, 2004).  
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Ρ 
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Εικ. 1.7. (α) Ελλειψοειδές  ή Γεωμετρικό Υψόμετρο (H) και Γεωειδές  ή Ορθομετρικό Υψόμετρο 
(h)   ενός σημείου A σε σχέση με το μοντέλο Γεωειδούς-Ελλειψοειδούς Διαχωρισμού N. 
(β)  Σχέση μεταξύ Γεωειδούς, Τοπικού Γεωειδούς Μοντέλου, Μέσης Στάθμης Θάλασσας και 
Ελλειψοειδούς. Διακρίνονται τα αντίστοιχα υψόμετρα. 
 
 
 

(α) 

(β) 
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Σημειώνεται, ότι η κατακόρυφος από τον τόπο-σημείο (Τ) ευρισκομένου στην επιφάνεια 
της Γης (γεωειδές υψόμετρο-h) και η κάθετος  από τον τόπο στο ελλειψοειδές αναφοράς 
(ελλειψοειδές υψόμετρο-Η) αποκλίνουν μεταξύ τους (εικ. 1.8). Η απόκλιση της 
κατακορύφου είναι διάνυσμα και υπολογίζεται ως η διανυσματική διαφορά της 
κατακορύφου και της καθέτου στο ελλειψοειδές αναφοράς, που διέρχονται από τον 
συγκεκριμένο τόπο. Συνήθως η απόκλιση αναλύεται σε δύο κάθετες συνιστώσες (η μία 
κατά μήκος του γεωδαιτικού μεσημβρινού και η δεύτερη κατά την διεύθυνση Ανατολή-
Δύση). 
 
Το ελλειψοειδές υψόμετρο Η προσδιορίζεται σε οποιοδήποτε σημείο έχουν γίνει 
μετρήσεις με το σύστημα GPS. Οι διαφορές των ορθομετρικών υψομέτρων Δh 
υπολογίζονται με υψομετρία. Για τον προσδιορισμό του h απαιτείται καλή γνώση 
της αποχής Ν, με ακρίβεια αντίστοιχη των γεωδαιτικών εργασιών. 
 
Τα γεωδυναμικά μοντέλα, που χρησιμοποιούνται σήμερα, δεν δύναται να δώσουν 
αξιόπιστες προσεγγίσεις των τιμών του Ν σε τμήματα της Γης που παρουσιάζουν έντονο 
και ανομοιόμορφο τοπογραφικό ανάγλυφο, όπως συμβαίνει στην Ελλάδα. Στις 
περιπτώσεις αυτές δύνανται να χρησιμοποιηθούν εκτιμήσεις για την μεταβολή ΔΝ του 
υψομέτρου του γεωειδούς, που προκύπτουν από αξιοποίηση μετρήσεων της απόκλισης 
της κατακορύφου σε δύο σημεία. 
 
Για μικρές αποστάσεις και με την προϋπόθεση ότι μεταξύ των δύο σημείων η μεταβολή 
της απόκλισης της κατακορύφου είναι ομαλή, η μεταβολή ΔΝ προσδιορίζεται με 
γραμμική παρεμβολή. Η απόκλιση της κατακορύφου υπολογίζεται εάν προσδιορισθούν 
οι αστρονομικές συντεταγμένες των σημείων με μεθόδους Γεωδαιτικής Αστρονομίας. 
 

 
 

Εικ. 1.8. Διακρίνεται η απόκλιση της κατακορύφου από τον τόπο-σημείο (Τ) ευρισκομένου στην 
επιφάνεια της Γης (γεωειδές υψόμετρο-h) και της καθέτου  από τον τόπο στο ελλειψοειδές 
αναφοράς (ελλειψοειδές υψόμετρο-Η).  
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2. ΧΑΡΤΟΓΡΑΦΙΑ – ΧΑΡΤΗΣ 
 
2.1. Γενικά 
 
Οι Γεωεπιστήμες ειδικότερα, αλλά και άλλοι κλάδοι της Επιστήμης και της Τεχνολογίας, 
ως μέσον παρουσίασης-έκφρασης-αποτύπωσης των πληροφοριών-δεδομένων-
αποτελεσμάτων, των διαφόρων μελετών, έχουν τον χάρτη (εικ. 2.1).  
 
O xάρτης, στις γεωεπιστήμες, αποτελεί την γραφική αναπαράσταση συγκεκριμένης 
γεωγραφικής περιοχής, σε δεδομένη χρονική στιγμή. Τα γεωγραφικά στοιχεία συνιστούν 
την γεωγραφική περιοχή.  
 
Γεωγραφικό στοιχείο είναι το χωρικό στοιχείο, που αντιλαμβάνεται ο άνθρωπος και δεν 
υποδιαιρείται σε άλλα επιμέρους στοιχεία. Τα γεωγραφικά στοιχεία συντιθέμενα 
αποτελούν σύνθετα στοιχεία, ανάλογα με τις απαιτήσεις της εκάστοτε εφαρμογής.  
 
Το υποσύνολο των γεωγραφικών στοιχείων, τα οποία πρόκειται να αποδοθούν 
χαρτογραφικά, ονομάζονται χαρτογραφικά στοιχεία.  
 
Εκτός από τα γεωγραφικά στοιχεία, αντικείμενο ψηφιακής καταγραφής αποτελούν και 
χωρικά φαινόμενα όπως η θερμοκρασία, η υγρασία, ο πληθυσμός κ.ά. σε δεδομένο 
τόπο και χρόνο.  
 
Ο χάρτης επιτελεί δύο σημαντικές λειτουργίες: 
 

• Μέσον αποθήκευσης πληροφοριών. 
• Εργαλείο για την κατανόηση των χωρικών φαινομένων, τις σχέσεις μεταξύ τους 

και την πολυπλοκότητα του περιβάλλοντος. 
 

Ο χάρτης είναι το βασικότερο μοντέλο περιγραφής του χώρου και χαρακτηρίζεται 
αναλογικό χωρικό μοντέλο. Ως τέτοιου είδους μοντέλο χαρακτηρίζεται από 
περιορισμούς, όπως στατικότητα και διδιάστατη απόδοση, που περιορίζουν την 
αντίληψη του χώρου. 
 
H Επιστήμη και Τέχνη της Χαρτογραφίας ασχολείται με την κατασκευή και μελέτη 
χαρτών.  Αναλυτικά το αντικείμενο της είναι: 
 

• Συλλογή και επιλογή δεδομένων για χαρτογράφηση 
• Διαχείριση και γενίκευση δεδομένων, σχεδιασμός και κατασκευή χάρτη 
• Ανάγνωση ή θέαση χάρτη 
• Ανταπόκριση ή ερμηνεία πληροφορίας 

 
2.2. Βασικά Χαρακτηριστικά Χάρτη 
 
α) Ο Χάρτης είναι εργαλείο χωρικής ανάλυσης. Οι χάρτες περιέχουν δύο ειδών 
πληροφορίες: τις γεωγραφικές θέσεις και τα χαρακτηριστικά (Εικ. 2.1). 
 
Γεωγραφικές θέσεις:

 

 Σημεία στον χώρο των δύο διαστάσεων με συντεταγμένες χ,y 
(χωρικά δεδομένα). 
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Χαρακτηριστικά:

Από τα δύο βασικά στοιχεία του χάρτη προκύπτουν χωρικές σχέσεις:  

 Ποιοτική ή ποσοτική πληροφορία για συγκεκριμένη γεωγραφική θέση 
(περιγραφικά δεδομένα). 

• Ανάμεσα στις γεωγραφικές θέσεις 
• Ανάμεσα σε χαρακτηριστικά ίδιας θέσης 
• Προσδιορισμού της μεταβολής της τιμής ενός χαρακτηριστικού στις διάφορες 

θέσεις 
• Περιγραφής συσχετισμού κατανομών στις διάφορες θέσεις 

 
Κάθε είδους τοπολογική και μετρητική ιδιότητα των σχέσεων δύναται να αναγνωρισθεί 
και προκύψει. 
 
β) Κλίμακα: Ο λόγος ανάμεσα στις διαστάσεις του χάρτη και της πραγματικότητας. 
Εκφράζει την σμίκρυνση. 
 
γ)  Χαρτογραφική Απεικόνιση: H μετάφραση γεωμετρικών ή φυσικών μεγεθών της 
γήινης επιφάνειας σε επίπεδη επιφάνεια (χάρτη). 
 
δ) Γενίκευση:  Η απλοποιημένη αναπαράσταση των λεπτομερειών που κρίνονται 
κατάλληλες ως προς την κλίμακα και τον σκοπό του χάρτη. Περιλαμβάνει την 
επεξεργασία κατάταξης των δεδομένων απλοποίησής τους, αφαίρεση των περιττών 
πληροφοριών για τον σκοπό του χάρτη (Εικ. 2.2).   
 
ε)  Συμβολισμός: Οι χάρτες χρησιμοποιούν σύμβολα προκειμένου να αποδώσουν 
στοιχεία της πραγματικότητας. Τα νοήματα των συμβόλων συνιστούν τον συμβολισμό. 
Τα σύμβολα που χρησιμοποιούνται για την απεικόνιση δεδομένων αποτελούνται από 
διάφορα είδη γραφικών στοιχείων (γραμμές, κουκίδες, χρώματα, μοτίβα κ.ά.). Τα 
σύμβολα και η περιγραφή-νόημα αυτών δίδονται στο υπόμνημα του χάρτη (Εικ. 2.1).  
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Εικόνα 2.1. Ορθο-αναγώμενη δορυφορική εικόνα ΙΚΟΝΟΣ-2 Νισύρου με τοπογραφική πληροφορία εξαγόμενη από την εικόνα.  (Διάκριση- 

ψηφιοποίηση δομών , επεξεργασία δεδομένων και σύνθεση χάρτη στο ArcGIS, Vassilopoulou et al., 2002).
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Εικόνα 2.2. Κατά την αλλαγή κλίμακας χάρτη, είναι απαραίτητη η διαδικασία της γενίκευσης. Οι 
δομές (τα στοιχεία του χάρτη) απλοποιούνται σε μικρές κλίμακες χωρίς να χάνεται η απαραίτητη 
πληροφορία (www.cartography.ch). 
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2.3. Κατηγορίες Xάρτη 
   
Οι χάρτες ταξινομούνται με βάση την κλίμακα σε τρεις κατηγορίες: 
 

• Μεγάλης κλίμακας (1:25.000 και άνω) 
• Μεσαίας κλίμακας (1:25.000 - 1:250.000) 
• Μικρής κλίμακας (μικρότερη από 1:250.000) 

 
Οι χάρτες ταξινομούνται με βάση την λειτουργία, στις κατηγορίες: 

• Γενικής αναφοράς (τοπογραφικός) 
• Θεματικοί ή ειδικού σκοπού (τεκτονικός) 
• Διαγράμματα (οικοδομικά τετράγωνα) 

 
Οι χάρτες ταξινομούνται με βάση το περιεχόμενο τους ως: 

• Τοπογραφικοί 
• Γεωλογικοί 
• Γεωφυσικών δεδομένων 
• Σεισμολογικοί 
• Γεωτεχνικοί 
• Γεωμορφολογικοί 
• Νεοτεκτονικοί 
• Τεκτονικοί 
• Γεωχημικοί 
• Κτηματολογικοί 
• Πολεοδομικοί 
• Χρήσεων Γης κ.ά. 

 
2.4. Μαθηματική Χαρτογραφία  
 
Η μελέτη της απεικόνισης της επιφάνειας της γης σε επίπεδο (το επίπεδο του χάρτη), 
αποτελεί αντικείμενο της Μαθημαικής Χαρτογραφίας. 
 
Τα τελευταία έτη η Αναλυτική Χαρτογραφία έχει συμπεριλάβει την Μαθηματική. 
 
2.5. Αναλυτική Χαρτογραφία 
  
Η Αναλυτική Χαρτογραφία περιέχει τις μαθηματικές έννοιες και μεθόδους που 
υποστηρίζουν την χαρτογραφία και εξετάζει τις εφαρμογές τους στην παραγωγή χαρτών 
και στην λύση γεωγραφικών προβλημάτων. Αποτελεί συνδυασμό των μαθηματικών 
μεθόδων που χρησιμοποιούσε παλαιότερα η Μαθηματική Χαρτογραφία και των 
αναλυτικών μεθόδων στην μελέτη των χωρικών αντικειμένων έρευνας. 
 
Θέματα μελέτης και έρευνας της Αναλυτικής Χαρτογραφίας είναι: οι χαρτογραφικές 
απεικονίσεις, οι παρεμβολές, η γενίκευση, η δημιουργία ΨΜΑ, η αυτόματη τοποθέτηση 
ονοματολογίας στους χάρτες, η επεξεργασία χωρικών δεδομένων. 
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2.6. Ψηφιακή Χαρτογραφία 
 
Η διείσδυση των υπολογιστών στην Χαρτογραφία δημιούργησε ένα γνωστικό αντικείμενο 
και τομέα έρευνας καλούμενο «Ψηφιακή Χαρτογραφία» ή «Αυτοματοποιημένη 
Χαρτογραφία» ή «Χαρτογραφία με την βοήθεια των ηλεκτρονικών υπολογιστών».  
 
Το θεωρητικό υπόβαθρο της «νέας» Χαρτογραφίας δεν έχει διαφοροποιηθεί. Η 
επίδραση της τεχνολογίας αφορά στην διαδικασία της χαρτογραφικής σύνθεσης και στην 
τεχνική διαδικασία της παραγωγής. Ο ανθρώπινος παράγοντας διαδραματίζει 
καταλυτικό ρόλο στην διαδικασία συνθέσεως χαρτών μέσω διαφόρων λογισμικών. 
Σημειώνεται, ότι στην ψηφιακή χαρτογραφία επεξεργάζονται ψηφιακά δεδομένα. 
Αναλογικοί χάρτες και κάθε είδους μη ψηφιακή πληροφορία μετατρέπεται σε ψηφιακή. 
 
Επιπτώσεις: 
 

• Επιτάχυνση του συνόλου των φάσεων που υπεισέρχονται στην χαρτογραφική 
διαδικασία. 

• Ακρίβεια στην καταγραφή και απόδοση των χαρτογραφικών στοιχείων 
• Ευρύτητα επιλογής χαρτογραφικού προϊόντος 
• Κόστος νέας τεχνολογίας (software, hardware) 
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3. ΣΥΝΤΕΤΑΓΜΕΝΕΣ ΚΑΙ ΣΥΣΤΗΜΑΤΑ ΣΥΝΤΕΤΑΓΜΕΝΩΝ 
 
Η μέτρηση αποστάσεων και γωνιών βασίζεται σε εφαρμογές των σχέσεων των 
τριγώνων, όπως προκύπτουν από την ευκλείδεια γεωμετρία. Ο René Descartes (1596-
1650) παρουσίασε συστήματα συντεταγμένων βάσει ορθογωνίων συντεταγμένων. Τα 2- 
και 3-διαστάσεων συστήματα συντεταγμένων χρησιμοποιούνται στην Αναλυτική 
Γεωμετρία και αναφέρονται ως Καρτεσιανά Συστήματα. Συστήματα βασισμένα σε γωνίες 
που σχετίζονται με τους βασικούς άξονες αναφέρονται ως Πολικά Συστήματα.  
Αναλυτικά, ακολουθούν εικόνες (Εικ. 3.1 – 3.7), που περιγράφουν τον προσδιορισμό 
σημείων με Καρτεσιανές και Πολικές Συντεταγμένες. 
 
 

 

 
 
Εικόνα 3.1. Προσδιορισμός 
σημείου Α, σε επίπεδο, βάσει των 
Καρτεσιανών  (Χ,Y) 
Συντεταγμένων του. 

 

 

 

 
 
 
Εικόνα 3.2. Προσδιορισμός  
ευθυγράμμου τμήματος ΑΒ σε 
επίπεδο, βάσει των Καρτεσιανών  
Συντεταγμένων των σημείων αρχής 
(Α) και πέρατος (Β) αυτού. 
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Εικόνα 3.3. Προσδιορισμός ευθυγράμμου τμήματος ΑΒ σε επίπεδο, βάσει των Καρτεσιανών  
Συντεταγμένων αρχής και πέρατος αυτού και του Πυθαγορείου Θεωρήματος:      

(ΑΒ)2 = (ΑΚ)2 + (ΒΚ)2  = SQRT ((XB-XA)2 + (YB-YA)2) = SQRT ((16 +12)2  + (15 – 8)2

 

 ) = SQRT 
(784 + 49) = SQRT (833) = 28.86 

 

Εικόνα 3.4. Προσδιορισμός σημείου Α σε επίπεδο, βάσει των Πολικών Συντεταγμένων:  
ακτίνα (r)  και  γωνία ( θ) 
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Εικόνα 3.5. Μετατροπή Πολικών Συντεταγμένων  (r, θ) σημείου Α,  σε  Καρτεσιανές (χ,y), στο επίπεδο. 
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Εικόνα 3.6. Τριών διαστάσεων Καρτεσιανές Συντεταγμένες και προσδιορισμός σημείων και 
γραμμών (στον χώρο). 

 
 

 
 
Εικόνα 3.7. Προσδιορισμός σημείου A, στον χώρο, σε τρισορθογώνιο σύστημα αξόνων (Χ,Y,Z). 
Mετατροπή πολικών συντεταγμένων (φ,θ,r) σε καρτεσιανές (χ, y, z). 
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4. ΜΕΘΟΔΟΙ ΜΕΤΡΗΣΗΣ 
 
4.1. Γενικά 
 
Η εξέλιξη της επιστήμης και τεχνολογίας επιφέρει συνεχώς μεταβολές και στον τρόπο με 
τον οποίο επιτυγχάνονται οι τοπογραφικές μετρήσεις. Οι μετρήσεις έγκεινται στον 
προσδιορισμό της απόστασης μεταξύ δύο σημείων και της διεύθυνσης (γωνιακή 
απόκλιση από μια γραμμή βάσης). Αρχικά οι μέθοδοι ήταν χειρωνακτκές και εν συνεχεία 
μαγνητικές, μηχανικές, οπτικές και ηλεκτρονικές. Σχετικά με τον προσδιορισμό σημείων 
αναφοράς και θέσης παρατήρησης στην φυσική επιφάνεια της γης έχουν 
χρησιμοποιηθεί αρκετές μέθοδοι: 
 
Διαδικασία Tριγωνισμού 
Η διαδικασία του τριγωνισμού στηρίζεται στην μέτρηση των γωνιών μεταξύ του σημείου 
παρατήρησης και σημείων αναφοράς. Ως σημεία αναφοράς λαμβάνονταν γνωστά 
σημεία επάνω στην επιφάνεια της Γης (δένδρα, βράχοι, κορυφές βουνών κ.λ.π.) ή 
ουράνια σώματα (Ήλιος, Σελήνη και άλλα άστρα). 
 
Διαδικασία Τριπλευρισμού 
Κατά την διαδικασία του τριπλευρισμού, μετρώνται οι αποστάσεις του σημείου 
παρατήρησης από σημεία αναφοράς χρησιμοποιώντας τα ραδιοκύματα (Συστήματα 
Ραδιοεντοπισμού). Η αρχή λειτουργίας των συστημάτων αυτών βασίζεται στην μέτρηση 
του χρόνου που χρειάζεται το κύμα να διαδοθεί από την πηγή του (πομπός) στον δέκτη. 
Ανάλογα με το που ευρίσκονται οι πομποί, τα συστήματα Ραδιοεντοπισμού διακρίνονται 
σε:  
 
Επίγεια Συστήματα όπου οι πομποί είναι εγκατεστημένοι στην επιφάνεια της Γης. Κατά 
την διάρκεια του Β΄ Παγκοσμίου Πολέμου, διάφορα επίγεια συστήματα  αναπτύχθηκαν, 
το πιο γνωστό από τα οποία είναι το LORAN (Long Range Aid to Navigation). Το 
σύστημα αυτό, ανεπτυγμένο από τις Η.Π.Α., χρησιμοποιείται έως και σήμερα (LORAN – 
C) στη ναυσιπλοΐα και στην επίγεια πλοήγηση παράλληλα με το αντίστοιχο Ευρωπαϊκό 
σύστημα  DECCA. 
 
Δορυφορικά Συστήματα όπου οι πομποί είναι τοποθετημένοι σε δορυφόρους σε τροχιά 
γύρω από την Γη.  
 
Το πρώτο δορυφορικό σύστημα ραδιοεντοπισμού, το οποίο αναπτύχθηκε από το 
Ναυτικό των Η.Π.Α. στα μέσα της δεκαετίας του ΄60, είναι το NAVSAT (NAVigation 
SATellite System)  ή  TRANSIT. Έχει τα ακόλουθα χαρακτηριστικά :  
   Σύστημα  έξι  δορυφόρων  
   Παγκόσμια κάλυψη κάθε  90 λεπτά  
   Ακρίβεια  Συστήματος: 200 m  
   Λειτουργία  Συστήματος έως το 1996 

 
Η μικρή ακρίβεια προσδιορισμού της θέσης παρατήρησης καθώς και η έλλειψη 24ωρης 
διάθεσης του συστήματος, οδήγησαν τις Η.Π.Α. στην ανάπτυξη ενός νέου δορυφορικού 
συστήματος, του NAVSTAR GPS (NAVigation Satellite Timing And Ranging Global 
Positioning System), το οποίο είναι ένα Παγκόσμιο Δορυφορικό Σύστημα 
Προσδιορισμού Θέσης (συντεταγμένες), Χρόνου και Ταχύτητας, οπουδήποτε στην 
επιφάνεια της Γης (ξηρά, θάλασσα, αέρα) και στο εγγύς διάστημα, σε οποιαδήποτε 
χρονική στιγμή, ανεξαρτήτως καιρικών συνθηκών. Σχεδιάσθηκε, χρηματοδοτήθηκε, 



 24 

αναπτύχθηκε και λειτουργεί από το Υπουργείο Εθνικής Άμυνας των  Η.Π.Α. Τα τελευταία 
έτη η Αμερικανική Αεροπορία έχει αναλάβει την ευθύνη για την πλήρη υποστήριξη και 
λειτουργία του συστήματος. Bασίζεται σε ένα "πλέγμα" εικοσιτεσσάρων έως τριανταδύο 
δορυφόρων της Γης (εικ. (εικ. 4.1), στους οποίους υπάρχουν ειδικές συσκευές, οι οποίες 
ονομάζονται "δέκτες GPS". Οι δέκτες αυτοί παρέχουν ακριβείς πληροφορίες για την 
θέση ενός σημείου, το υψόμετρό του, την ταχύτητα και την κατεύθυνση της κίνησης του. 
Επίσης, σε συνδυασμό με ειδικό λογισμικό χαρτογράφησης απεικονίζουν γραφικά τις 
πληροφορίες. Το σύστημα σχεδιάσθηκε στην δεκαετία του 1970 και έγινε πλήρως 
επιχειρησιακό στα μέσα της δεκαετίας του 1990. 
 
Αρκετά Δορυφορικά Συστήματα, παγκόσμια ή τοπικά (Ευρωπαϊκά, Ρωσικά, Κινέζικα, 
Ιαπωνικά, Αμερικάνικα κ.ά) έχουν αναπτυχθεί και λειτουργούν. Από το 2001 είναι σε 
πλήρη λειτουργία το ρωσικό δορυφορικό σύστημα ραδιοεντοπισμού, το οποίο καλείται 
GLONASS (Global Orbiting and Navigation System). Διαθέτει εικοσιτέσσερις 
δορυφόρους, οι οποίοι είναι κατανεμημένοι σε τρία τροχιακά επίπεδα (οκτώ δορυφόροι 
ανά επίπεδο). Ο κάθε δορυφόρος εκπέμπει σε ίδια συχνότητα με τον αντιδιαμετρικό του. 
Κατά αυτόν τον τρόπο, επιτυγχάνεται μεγαλύτερη ακρίβεια στον προσδιρισμό θέσης σε 
σχέση με το σύστημα GPS. 
 
Το 2005 ετέθη σε τοχιά ο πρώτος δορυφόρος του Ευρωπαϊκού Συστήματος GALILEO 
(προς τιμήν του Ιταλού αστρονόμου και αστροφυσικού Galileo Galileii). Το σύστημα 
αναπτύσσεται από την Ευρωπαϊκή Διαστημική Υπηρεσία (European Space Agency), για 
πολιτικούς σκοπούς και θα αποτελείται από τριάντα δορυφόρους. Υπολογίζεται ότι έξη 
έως οκτώ δορυφόροι θα είναι ορατοί ανά περιοχή. Το σύστημα συνεργάζεται με το GPS 
και το GLONASS και έχει σχεδιασθεί ως ένα πολιτικό παγκόσμιο σύστημα 
προσδιορισμού θέσης, χρόνου και ταχύτητας, με πλήθος εφαρμογών. 
 
Τα συστήματα GPS, GLONASS, GALILEO ανήκουν στην κατηγορία των παγκοσμίων 
δορυφορικών συστημάτων GNSS (Global Navigation Satellite Systems). 
 
4.2. Δορυφορικός Προσδιορισμός Θέσης 
 
4.2.1. Παγκόσμιο Σύστημα Προσδιορισμού Θέσης (GPS) 
 
Το Παγκόσμιο Σύστημα Προσδιορισμού Θέσης GPS ενώ αρχικά σχεδιάσθηκε για 
στρατιωτικές εφαρμογές, αργότερα το 1983 διατέθηκε για  πολιτική χρήση  και η 
πρόσβαση στα δεδομένα GPS είναι δωρεάν.  
 
Το Παγκόσμιο Σύστημα Προσδιορισμού θέσης GPS περιλαμβάνει 32 δορυφόρους, 
ευρισκομένων σε απόσταση περίπου 20.000 km επάνω από την επιφάνεια της Γης,  οι 
οποίοι κινούνται σε "διάταξη" σε μέση γήινη τροχιά  γύρω από τον πλανήτη και 
μεταδίδουν σήματα στην Γη, που λαμβάνουν όλοι οι δέκτες GPS.  
 
Η ακρίβεια των λαμβανομένων δεδομένων εξαρτάται από τον αριθμό των δορυφόρων 
GPS από τους οποίους  λαμβάνουν σήμα οι επίγειοι δέκτες GPS στην συγκεκριμένη  
χρονική περίοδο. Όταν ένας δορυφόρος δεν μεταδίδει ή μεταδίδει εσφαλμένα σήματα, τα 
σήματα αυτά ακυρώνονται από τις ενδείξεις κάποιου άλλου δορυφόρου της ομάδας. 
 
Το Σύστημα GPS συνίσταται από τρία τμήματα:  

• Το δορυφορικό τμήμα το οποίο αποτελείται από τριάντα δύο δορυφόρους που 
κινούνται γύρω από την Γη (εικ. 4.1). 

http://el.wikipedia.org/wiki/%CE%A4%CE%B5%CF%87%CE%BD%CE%B7%CF%84%CF%8C%CF%82_%CE%B4%CE%BF%CF%81%CF%85%CF%86%CF%8C%CF%81%CE%BF%CF%82�
http://el.wikipedia.org/wiki/%CE%93%CE%B7�
http://el.wikipedia.org/wiki/%CE%9B%CE%BF%CE%B3%CE%B9%CF%83%CE%BC%CE%B9%CE%BA%CF%8C�
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• Το επίγειο τμήμα ελέγχου που αποτελείται από δεκαέξι μόνιμους σταθμούς 
παρακολούθησης με γνωστές συντεταγμένες ως προς WGS’84, κατενεμημένων 
σε όλη την Γη, τέσσερις σταθμούς τηλεπικοινωνιών ευρισκόμενους σε θέσεις 
μόνιμων στσθμών και ένα επανδρωμένο κέντρο ελέγχου στο Colorado Springs, 
με στόχο τον έλεγχο των δορυφόρων, των δορυφορικών τροχιών και άλλων 
παραμέτρων καθώς και την επεξεργασία δεδομένων.  

• Το τμήμα χρηστών που απαρτίζεται από τους χιλιάδες χρήστες δεκτών GPS ανά 
την Γη. 
 

Η βασική αρχή του GPS είναι ο καθορισμός της θέσης με την μέτρηση της απόστασης. 
Ο υπολογισμός της απόστασης του σημείου παρατήρησης από έναν δορυφόρο 
στηρίζεται στην μέτρηση του χρόνου διαδρομής «tδιαδρ

 

», δηλαδή του χρόνου που 
απαιτείται για να φτάσει το ραδιοσήμα από τον δορυφόρο στον δέκτη (εικ. 4.2) και ο 
οποίος υπολογίζεται με αρκετά μεγάλη ακρίβεια. Επειδή οι δορυφόροι δεν είναι σταθεροί 
αλλά κινούνται, προαπαιτείται ο ακριβής υπολογισμός θέσης του δορυφόρου κάθε 
χρονική στιγμή. 

΄Εχοντας υπολογίσει τον χρόνο διαδρομής του σήματος «tδιαδρ» και δεδομένου ότι τα 
ραδιοσήματα διαδίδονται με την ταχύτητα του φωτός «c», η απόσταση «p» δορυφόρου – 
δέκτη προσδιορίζεται βάσει της γνωστής σχέσης:    p = c * tδιαδρ
 

  

Βασική απαίτηση είναι η μέτρηση απόστασης (συγκεκριμένου σημείου στην επιφάνεια 
της γης) ταυτοχρόνως από τουλάχιστον τέσσερις δορυφόρους. Ουσιαστικά, οι άγνωστοι 
που θα υπολογισθούν είναι 3 (συντεταγμένες Χ, Υ, Ζ) συν μια άγνωστη παράμετρος, η 
διόρθωση του χρόνου του ωρολογίου του δέκτη ως προς την ενιαία κλίμακα χρόνου του 
GPS. Επομένως, οι άγνωστοι είναι 4, απαιτούνται 4 μετρήσεις για την επίλυση 
συστήματος τεσσάρων εξισώσεων με τέσσερις αγνώστους. 
 
Η ποιότητα της επίλυσης εξαρτάται από την ακρίβεια των αποστάσεων και την 
γεωμετρία της διατομής των κυκλικών ή σφαιρικών επιφανειών, όπου έχουν ως κέντρο 
τον κάθε δορυφόρο και ακτίνα την αντίστοιχη μετρηθείσα απόσταση δορυφόρου-δέκτη. 
 
Η ακρίβεια προσδιορισμού της τελικής θέσης του σημείου παρατήρησης εξαρτάται 
άμεσα από την ακρίβεια μέτρησης των αποστάσεων από τους δορυφόρους. Η μέτρηση 
των αποστάσεων υπόκειται σε ένα πλήθος σφαλμάτων σχετιζομένων με τον δορυφόρο, 
την ατμόσφαιρα κ.ά. Με την άρση της επιλεκτικής διαθεσιμότητας, τον Μάιο του 2000, η 
ακρίβεια των μετρήσεων εξαρτάται κατά κύριο λόγο από την ακρίβεια των ωρολογίων 
δεκτών και δορυφόρων. Η χρήση ατομικών ωρολογίων στους δορυφόρους έχει μειώσει 
σημαντικά το σφάλμα  αυτών στις μετρήσεις. 
 
Ως αποτέλεσμα, λαμβάνονται οι Καρτεσιανές Συντεταγμένες (Χ, Υ, Ζ) ή οι 
Γεωδαιτικές Συντεταγμένες (φ, λ, H) – (γεωδαιτικό πλάτος, γεωδαιτικό μήκος, 
γεωμετρικό υψόμετρο) του συγκεκριμένου σημείου που ζητείται να προσδιορισθεί. Οι 
συντεταγμένες έχουν υπολογισθεί ως προς το WGS’84 (σύστημα υπολογισμού 
συντεταγμένων των δορυφόρων). Εν συνεχεία, δύνανται να μετασχηματισθούν σε άλλα 
γεωδαιτικά συστήματα (π.χ. ΕΓΣΑ’87), οπότε είναι δυνατόν να προκύψουν 
χαρτογραφικές συντεταγμένες (χ, y) και ορθομετρικά υψόμετρα (υψόμετρο «h» ως προς 
το Γεωειδές), αναλόγως με τις ανάγκες της μελέτης και τα δεδομένα με τα οποία θα 
συσχετισθούν και θα διαχειρισθούν σε μια κοινή βάση δεδομένων, συνήθως σε ένα 
Σύστημα Γεωγραφικών Πληροφοριών. 
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Η ακρίβεια προσδιορισμού της θέσης παρατήρησης εξαρτάται και από την γεωμετρική 
διάταξη των  χρησιμοποιούμενων δορυφόρων. Η εξάρτηση της ακρίβειας από την 
γεωμετρία εκφράζεται με ένα βαθμωτό μέγεθος, το οποίο καλείται DOP (Dilution of 
Precision) και διακρίνεται στα ακόλουθα:  

Το GDOP (Geometric DOP) αφορά στην ακρίβεια προσδιορισμού της θέσης στις 3 
διαστάσεις και του σφάλματος του χρόνου, ουσιαστικά αφορά την «καλή γεωμετρία 
των δορυφόρων».  
Το TDOP  (Time DOP) αφορά στην ακρίβεια προσδιορισμού του σφάλματος του 
χρόνου.  
Το PDOP  (Position  DOP) αφορά την ακρίβεια προσδιορισμού της θέσης στις 3 
διαστάσεις, ουσιαστικά αφορά την ακρίβεια θέσης βάσει του αριθμού των δορυφόρων 
και το GDOP. 
Το HDOP  (Horizontal  DOP) αφορά στην ακρίβεια προσδιορισμού της θέσης σε ένα 
επίπεδο (2 διαστάσεις), ουσιαστικά αφορά στην διόρθωση κατά την οριζόντια 
διάσταση. 
Το VDOP  (Vertical DOP) αφορά στην ακρίβεια προσδιορισμού του υψομέτρου. 

 
Τα πλεονεκτήματα του συστήματος μέτρησης GPS έχουν ως ακολούθως: 
 Παγκόσμια κάλυψη  
 Δυνατότητα χρήσης του συστήματος καθ’ όλη την διάρκεια της ημέρας και της 

νύχτας όλον τον χρόνο 
 Ανεξάρτητο από τις καιρικές συνθήκες (βροχή, χιόνι, ομίχλη) 
 Προσδιορισμός θέσης σε πραγματικό χρόνο 
 Εύκολος και γρήγορος προσδιορισμός θέσης παρατήρησης 
 Δεν απαιτείται ορατότητα μεταξύ των δεκτών 
 Έκφραση συντεταγμένων θέσης παρατήρησης σε κοινό σύστημα αναφοράς 

(WGS’84 κ.ά.). 
 Μεγάλο εύρος εφαρμογών (τοπογραφία, γεωδαισία, αεροπλοΐα κ.ά.) 

 
To μειονέκτημα του συστήματος μέτρησης GPS είναι το υψηλό κόστος.  
 
4.2.2.  Διαφορικές Μετρήσεις GPS (Differential GPS) 
 
Η εύρεση θέσης με διαφορικές μετρήσεις GPS (Differential GPS ή DGPS) προϋποθέτει 
δύο δέκτες GPS: 

• έναν δέκτη εγκατεστημένο σε σταθερή θέση Α (δέκτης αναφοράς), οι 
συντεταγμένες της οποίας είναι γνωστές. 

• έναν δέκτη εγκατεστημένο κάθε φορά στην θέση παρατήρησης  Β. 
 
Βασική προϋπόθεση είναι η ταυτόχρονη παρατήρηση των ίδιων δορυφόρων και από 
τους δύο δέκτες. Αποτέλεσμα της χρήσης δεύτερου δέκτη–δέκτη αναφοράς είναι η 
βελτίωση της ακρίβειας προσδιορισμού. Με αυτόν τον τρόπο: 

• Εξαλείφονται τα σφάλματα των ωρολογίων δέκτη και δορυφόρου. 
• Ελαχιστοποιούνται τα σφάλματα τα οποία οφείλονται στις τροποσφαιρικές και 

ιονοσφαιρικές επιδράσεις. 
 
Η μέθοδος προσδιορισμού της θέσης παρατήρησης, χρησιμοποιώντας δύο δέκτες, 
καλείται Εύρεση Θέσης με Διαφορικές GPS  μετρήσεις (DGPS). 
 
Η ακρίβεια της μεθόδου είναι 0.5cm – 5m (όταν χρησιμοποιείται ο κώδικας) και 5 – 
10mm (όταν χρησιμοποιείται η φάση). 
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Εικόνα 4.1. Το Δορυφορικό 
Σύστημα GPS αποτελείται από 
32 δορυφόρους GPS  σε μέσο 
ύψος 20.200 χιλιομέτρων 
επάνω από την επιφάνεια της 
θάλασσας (με μέση ακτίνα Γης 
6360 Km). Κινούνται σε 
κυκλικές τροχιές (έξη επιπέδων) 
και εκτελούν δύο περιστροφές 
γύρω από την Γη κάθε 24ωρο. 
Για ακριβείς μετρήσεις 
απαιτείται ένας επαρκής 
αριθμός δορυφόρων 
(τουλάχιστον 4)  επάνω από 
κάθε σημείο παρατήρησης στην 
επιφάνεια της Γης. 
(http://www.kowoma.de/index.ht
m (2009)) 

 

 
Εικόνα 4.2. Δέκτης GPS 
μετρήσεων στον Εμπορειό 
Νισύρου, κατά την διάρκεια 
Γεωδαιτικών Μετρήσεων στην 
Νίσυρο από τον Τομέα 
Γεωφυσικής-Γεωθερμίας του 
Τμ. Γεωλογίας & 
 Γεωπεριβάλλοντος, ΕΚΠΑ. 
 

 
 
4.2.3. Χαρακτηριστικά GPS Σήματος 
 
To βασικό σήμα του GPS αποτελείται από την κύρια βασική συχνότητα f0

 

 (10.23 MHz), 
η οποία πολλαπλασιάζεται με τις ποσότητες 154 και 120 και δίνει τις δύο βασικές 
φέρουσες συχνότητες L1 και L2, αντιστοίχως. Οι δύο βασικές φέρουσες  συχνότητες 
και τα μήκη κύματος (λ) των δύο κυμάτων είναι:  

           L1 = f0 × 154 = 1575.42 MHz                λ1
                                         και  

 ≈ 19.03cm  

           L2 = f0 × 120 = 1227.6 MHz                λ2
 

 ≈ 24.42 cm 

Τα κύματα αυτά διαδίδονται με την ταχύτητα του φωτός (c ≈ 3*108  m/sec) και 
διαπερνούν την ατμόσφαιρα, αλλά όχι τα στερεά αντικείμενα. 

http://www.kowoma.de/index.htm�
http://www.kowoma.de/index.htm�
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Όπως έχει αναφερθεί, ο προσδιορισμός θέσης σε πραγματικό χρόνο επιτυγχάνεται 
μέσω του υπολογισμού της απόστασης δορυφόρου – δέκτη. Λόγω του ότι τα σήματα 
εκπέμπονται μόνον κατά την κατεύθυνση δορυφόρου → δέκτη, δηλ. οι μετρήσεις είναι 
μίας κατεύθυνσης,  χρησιμοποιούνται: 

• Οι εκπεμπόμενοι μετρητικοί κώδικες-σήματα που αποτελούν τους κώδικες 
ψευδοτυχαίου θορύβου PRN(Pseudo Radndom Noise):  

 
     C/A  (στην L1)    και     P(Υ)  (στις L1 και L2)  
 
• Ένα δορυφορικό μήνυμα (ρυθμός 50 bits / sec), βάσει του οποίου υπολογίζεται η 

ακριβής θέση και ώρα του δορυφόρου. Το μήνυμα περιέχει πληροφορίες 
σχετικά με:   
• Την προβλεπόμενη τροχιά κάθε δορυφόρου του 
συστήματος (almanac) 
• Την ακριβή τροχιά που εκτελεί ο δορυφόρος (ephemeris) 
• Την ώρα του δορυφόρου 
• Τις διορθώσεις του ωρολογίου του δορυφόρου 
• Τις ιονοσφαιρικές επιδράσεις  
• Την κατάσταση του δορυφόρου 
 
Τα ανωτέρω δεδομένα αποτελούν το μήνυμα δεδομένων (Data, Data code). 

 
Όπως φαίνεται, η συχνότητα L1 διαμορφώνεται από τον C/A, τον  P(Υ)  και από το 
μήνυμα δεδομένων, οπότε προκύπτει το σήμα (L1, C/A, D) και το σήμα (L1, P(Υ), D).  Η 
L2 διαμορφώνεται μόνον από τον  P(Υ)  και το μήνυμα δεδομένων, οπότε προκύπτει το 
σήμα (L2, P(Υ), D).   Το πρώτο σήμα είναι πολιτικό σήμα (για πολιτικούς σκοπούς), ενώ 
τα άλλα δύο στρατιωτιικά (για στρατιωτικούς σκοπούς). 
 
Το 2005, ετέθη σε τροχιά ο πρώτος δορυφόρος GPS IIR(M) που περιελάμβανε έναν 
L2C πομπό, οπότε προκύπτει το πολιτικό σήμα  L2C (L2 Civilian). Από το 2010, όπου 
ετέθη σε τροχιά ο πρώτος δορυφόρος GPS IIF με  έναν πλήρη πομπό L5, 
χρησιμοποιείται και τo πολιτικό σήμα  
 

L5. 

4.2.4. Εφαρμογές GPS 
 
Τα GPS έχουν ευρύ πεδίο εφαρμογών, όπως: 
 
Αεροπλοοϊα 
 Μεγαλύτερη ασφάλεια τόσο κατά την πτήση όσο και κατά την προσγείωση των 

αεροσκαφών  
 Βελτίωση εναέριας κυκλοφορίας 
 Ακολουθείται η βέλτιστη διαδρομή προς τον προορισμό (άνευ αποκλίσεων) βάσει 

δεδομένων, τα οποία λαμβάνονται από τον δέκτη GPS, με αποτέλεσμα την 
μείωση του χρόνου της πτήσης αλλά και των καυσίμων που απαιτούνται 

 Εύκολος και σύντομος εντοπισμός αεροσκάφους που ευρίσκεται σε κίνδυνο 
 

Ναυσιπλοοϊα 
 Ασφαλέστερα υπερατλαντικά ταξίδια 
 Δυνατότητα προσδιορισμού της ακριβούς θέσης του πλοίου που ευρίσκεται σε 

κίνδυνο με σκοπό την άμεση επέμβαση 



 29 

Πλοήγηση στην ξηρά 
  Ασφαλέστερες και ταχύτερες μετακινήσεις 
  Δυνατότητα παρακολούθησης των μέσων μεταφοράς και εμπορίου 
  Άμεση επέμβαση αστυνομίας,  πυροσβεστικής καί άλλων δυνάμεων, σε  

περιπτώσεις εκτάκτου ανάγκης 
 Προσδιορισμός θέσης πεζοπόρων, ορειβατών, αθλητών κ.ά. 

 
Τεχνικά Έργα 
  Κατασκευές οδών, φραγμάτων, γεφυρών 
  Εξορύξεις   
  Λιμενικά έργα 

 
Τηλεανίχνευση – Διαστημικές Εφαρμογές 
 Τροχιές δορυφόρων και πλοήγηση αυτών 
 Παρακολούθηση περιβάλλοντος 
 Ακριβής εντοπισμός θέσης και άμεση επέμβαση σε περιπτώσεις  φυσικών και 

άλλων καταστροφών 
 Παρακολούθηση και Διαχείριση φυσικών καταστροφών (σεισμοί, ηφαίστεια, 

κατολισθήσεις, πλημύρες, πυρκαγιές  κ.ά.)  
 

Γεωεπιστήμες  
 Γεωφυσική 
 Γεωλογία 
 Τεκτονική 
 Γεωδυναμική 
 Γεωμορφολογία     
 Ωκεανογραφία 
 Ψηφιακή Χαρτογραφία 
 Τοπογραφία 
 Παρακολούθηση Εδαφικής Παραμόρφωσης (οφειλόμενη σε τεκτονικά-

γεωδυναμικά αίτια, σε εδαφική καθίζηση ή ανύψωση λόγω φυσικών ή 
ανθρωπογενών αιτίων κ.ά. )   -  Παραγωγή Χαρτών Εδαφικής Παραμόρφωσης 
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5. ΧΑΡΤΟΓΡΑΦΙΚΕΣ ΑΠΕΙΚΟΝΙΣΕΙΣ 
 
5.1. Γενικά 
 
Η μεταφορά ή μετάφραση γεωμετρικών ή φυσικών μεγεθών της Γήινης επιφάνειας σε 
επίπεδη επιφάνεια (χάρτη) προϋποθέτει τον μετασχηματισμό των τριών-διαστάσεων 
χώρου στον δύο-διαστάσεων χάρτη. 
 
Ο μετασχηματισμός ή χαρτoγραφική προβολή ή χαρτογραφική απεικόνιση, 
επιτυγχάνεται μέσω μαθηματικών προσεγγίσεων και σχέσεων επίπεδης τριγωνομετρίας, 
ώστε το ελλειψοειδές ή σφαιροειδές ή η σφαίρα απεικονίζονται στο επίπεδο ή σε άλλες 
επιφάνειες (κώνο ή κύλινδρο) δυνητικά αναπτυσσόμενες σε επίπεδο. Το ελλειψοειδές ή 
το σφαιροειδές και η σφαίρα δεν είναι επιφάνειες δυνητικά αναπτυσσόμενες σε επίπεδο, 
με αποτέλεσμα η επιχειρούμενη απεικόνιση να περιλαμβάνει παραμορφώσεις. 

 
Σχηματικά η απεικόνιση αποδίδεται ως (λ, φ)  ⇔   (χ, y) 

 
Οι Χαρτογραφικές Απεικονίσεις ταξινομούνται σε κατηγορίες, ανάλογα με:  
 
α. την επιφάνεια βάσει της οποίας επιτυγχάνεται η απεικόνιση (προβολική επιφάνεια ή 
επιφάνεια απεικόνισης), σε κυλινδρικές, κωνικές και αζιμουθιακές ή επίπεδες (Εικ. 5.1).  

• Οι Κυλινδρικές απεικονίσεις προκύπτουν από την προβολή του δικτύου των 
παραλλήλων και μεσημβρινών στην εσωτερική επιφάνεια ενός κυλίνδρου.  

• Οι Κωνικές, από την προβολή του δικτύου των παραλλήλων και μεσημβρινών 
στην εσωτερική επιφάνεια ενός κώνου.  

• Οι Αζιμουθιακές, από την προβολή του δικτύου των παραλλήλων και 
μεσημβρινών σε επίπεδο, εφαπτόμενο σε ένα σημείο της γήινης σφαίρας. 

 
β. την θέση του άξονα της σφαίρας σε σχέση με τον άξονα της προβολικής επιφάνειας, 
σε ορθές, εγκάρσιες και πλάγιες. 

• Στις Ορθές Απεικονίσεις, οι άξονες είναι παράλληλοι μεταξύ τους 
• Στις  Εγκάρσιες Απεικονίσεις,  οι άξονες είναι κάθετοι μεταξύ τους 
• Στις Πλάγιες Απεικονίσεις, οι άξονες τέμνονται υπό γωνία διαφορετική της ορθής 

 

 
 

Εικόνα 5.1. Ταξινόμηση των απεικονίσεων ανάλογα με την προβολική επιφάνεια σε 
κυλινδρικές, κωνικές και επίπεδες ή αζιμουθιακές. 
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Οι επίπεδες απεικονίσεις, ανάλογα με το κέντρο της προβολής ή την θέση της φωτεινής 
πηγής, ταξινομούνται ως ακολούθως: 
 

• Γνωμονικές ή Κεντρικές, όπου κέντρο της προβολής θεωρείται το κέντρο της 
σφαίρας (Εικ. 5.2). 

• Στερεογραφικές, όπου κέντρο της προβολής θεωρείται το αντιδιαμετρικό σημείο 
του σημείου επαφής του επιπέδου προβολής (Εικ. 5.3). 

• Ορθογραφικές, όπου κέντρο της προβολής θεωρείται το άπειρο (Εικ. 5.4). 
 

 
 

Εικόνα 5.2.   Στις γνωμονικές απεικονίσεις κέντρο της προβολής θεωρείται το κέντρο της 
σφαίρας. Οι μέγιστοι κύκλοι απεικονίζονται ως ευθείες γραμμές.  
(http://erg.usgs.gov/isb/pubs/MapProjections/graphics) 

 
 
 

 
 

Εικόνα 5.3. Στις στερεογραφικές απεικονίσεις κέντρο προβολής θεωρείται το αντιδιαμετρικό 
σημείο του σημείου επαφής του επιπέδου προβολής  
  (http://erg.usgs.gov/isb/pubs/MapProjections/graphics) 

 

http://erg.usgs.gov/isb/pubs/MapProjections/graphics/mercator.gif�
http://erg.usgs.gov/isb/pubs/MapProjections/graphics�
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Εικ. 5.4. Στις ορθογραφικές απεικονίσεις κέντρο προβολής θεωρείται το άπειρο 
(http://erg.usgs.gov/isb/pubs/MapProjections/graphics) 

 
 
5.2. Απεικονίσεις και Παραμόρφωση 
 
Ανάλογα με τα χαρακτηριστικά του σφαιροειδούς  που διατηρούν αναλλοίωτα οι 
απεικονίσεις, αυτές  ταξινομούνται ως: 
 
Ισομετρικές: διατηρούνται οι διαστάσεις, και συγκεκριµένα οι αποστάσεις από κάποια 
σηµεία (π.χ. HATT) 
 
Σύµµορφες: διατηρείται η µορφή (δηλ. οι γωνίες) των σχηµάτων (π.χ. UTM) 
 
Ισοεπιφανειακές: Διατηρείται το εµβαδόν των σχηµάτων  (π.χ. Albers) 
 
5.3. Δίκτυα Οριζοντίου και Κατακορύφου Ελέγχου 
 
Τα Δίκτυα Οριζοντίου και Κατακορύφου Ελέγχου κάθε Χώρας αποτελούνται από 
σταθερά σημεία (γεωδαιτικά σημεία ελέγχου), κατανεμημένα στην επιφάνεια της Χώρας, 
με ακριβείς γεωδαιτικές συντεταγμένες. Τα γεωδαιτικά σημεία ελέγχου επηρεάζουν την 
ακρίβεια της Χώρας  (Εικ. 5.5). 
 
Τα Δίκτυα Οριζοντίου Ελέγχου περιλαμβάνουν γεωδαιτικά σημεία ελέγχου με ακριβές 
προσδιορισμένο  (με GPS) το γεωδαιτικό μήκος και πλάτος (φ,λ).  
 
Στα Δίκτυα Κατακορύφου Ελέγχου, το υψόμετρο είναι επίσης προσδιορισμένο με μεγάλη 
ακρίβεια (με GPS).  Η μέτρηση των υψομέτρων γίνεται ως προς την μέση στάθμη της 
θάλασσας (επιφάνεια γεωειδούς), οπότε προκύπτουν τα χωροσταθμικά δίκτυα ελέγχου.  
 
Σήμερα τα σημεία ελέγχου καθορίζονται από μετρήσεις GPS σε σχέση με την επιφάνεια 
του ελλειψοειδούς WGS’84. Τα σημεία συνορθώνονται (διορθώνονται ώστε να έχουν 
εσωτερική συνέχεια) ως προς την μέση στάθμη της θάλασσας. Η συνόρθωση απαιτεί 
την εφαρμογή του τύπου H = h+N. 

http://erg.usgs.gov/isb/pubs/MapProjections/graphics�
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Τα Δίκτυα έχουν δημιουργηθεί με διαφορετικές τάξεις ακρίβειας ανάλογα με την κλίμακα 
μελέτης. 
 

 
 
Εικ. 5.5. Δίκτυο Σταθμών Αναφοράς για το Ελληνικό Σύστημα Εντοπισμού HEPOS (HEllenic 
POsitioning System), το οποίο επιτρέπει τον προσδιορισμό θέσης με υψηλή ακρίβεια, 
αξιοποιώντας το υφιστάμενο παγκόσμιο δορυφορικό σύστημα εντοπισμού GPS (Global 
Positioning System). 
 
 
5.4. Χαρτογραφικές Απεικονίσεις στον Ελληνικό Χώρο 
 
Προκειμένου να γίνουν κατανοητές οι απεικονίσεις που χρησιμοποιούνται στον Ελληνικό 
Χώρο, προηγείται η περιγραφή της Μερκατορικής Απεικόνισης και της Εγκάρσιας 
Μερκατορικής Απεικόνισης. 
 
5.4.1. Μερκατορική Απεικόνιση (Προβολή) – Mercator Projection 
 
Η Μερκατορική Απεικόνιση είναι ορθή, κυλινδρική και σύμμορφη απεικόνιση (εικ. 5.6).  
 
Οι Μεσημβρινοί είναι  παράλληλοι μεταξύ τους και ισαπέχουν.  
 
Οι γραμμές του γεωγραφικού πλάτους (παράλληλοι) είναι παράλληλοι μεταξύ τους αλλά 
προς τους πόλους η μεταξύ τους απόσταση αυξάνεται.  
 
Οι πόλοι δεν προβάλλονται.  
 
Διατηρείται αναλλοίωτη η µορφή των τοπικών σχηµάτων. 
 
Αρχικά δημιουργήθηκε για την ναυσιπλοϊα. 
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Εικόνα 5.6. Δίδεται σχηματικά η Μερκατορική Απεικόνιση  
(http://erg.usgs.gov/isb/pubs/MapProjections/graphics/mercator.gif). 

 
 
5.4.2. Εγκάρσια Μερκατορική Απεικόνιση - Transverse Mercator Projection 
 
Παρόμοια με την Μερκατορική. Προκύπτει από την ορθή εφαρμόζοντας στροφή του 
γεωγραφικού συστήματος αναφοράς (φ,λ) κατά μια ορθή γωνία (Εικ. 5.7).  
 
Ο κεντρικός Μεσημβρινός τοποθετείται στο κέντρο της περιοχής ενδιαφέροντος. Αυτό 
ελαχιστοποιεί τις παραμορφώσεις στην περιοχή.  
 
Η απεικόνιση είναι πολύ καλή για τις Βορά – Νότο περιοχές.  
 
Το State Plane Coordinate System χρησιμοποιεί την απεικόνιση για όλες τις Βορράς – 
Νότος ζώνες.  
 
Τα UTM και  Gauss–Krüger συστήματα συντεταγμένων βασίζονται στην Εγκάρσια 
Μερκατορική Απεικόνιση. 

 
 
 

Στον Ελληνικό Χώρο χρησιμοποιούνται οι ακόλουθες απεικονίσεις: 
 
5.4.3. Παγκόσμια Εγκάρσια Μερκατορική Απεικόνιση - Universal Transverse 
Mercator (UTM) 
 
Η Eγκάρσια Μερκατορική Aπεικόνιση (κυλινδρική) είναι σύµµορφη απεικόνιση, δηλαδή, 
διατηρεί αναλλοίωτη την µορφή στοιχειωδών σχηµάτων από το ελλειψοειδές στο 
επίπεδο.  
 
Η επιφάνεια της γης χωρίζεται σε 60 ζώνες πλάτους 6° η κάθε µία (Εικ. 5.8). Κάθε ζώνη 
έχει τον δικό της κεντρικό μεσημβρινό. 
 

http://erg.usgs.gov/isb/pubs/MapProjections/graphics/mercator.gif�


 35 

Η Ελλάδα απεικονίζεται σε δύο ζώνες µε κεντρικούς µεσηµβρινούς αντίστοιχα λ0=21° 
(ζώνη 34) και λ0

 

=27° (ζώνη 35) από τον µεσηµβρινό του Greenwich. Ο συντελεστής 
κλίµακας της απεικόνισης είναι 0.9996 και στις τετµηµένες (Ε-eastings) προστίθεται η 
σταθερά 500000m.  

Οι παραµορφώσεις αυξάνονται ανάλογα µε το τετράγωνο της απόστασης από τον 
κεντρικό µεσηµβρινό και είναι της τάξης των 500ppm (δηλαδή 1:2000).  
 
Το σύστηµα UTM έχει παγκόσµια χρήση και στην Ελλάδα το διαχειρίζεται αποκλειστικά 
η ΓΥΣ. 

 

 
 
Εικόνα 5.7. Η εγκάρσια Μερκατορική Προβολή μαθηματικά είναι ίδια με την Μερκατορική αλλά 
είναι προσανατολισμένη σε διαφορετικό άξονα.  
(http://erg.usgs.gov/isb/pubs/MapProjections/graphics) 
 

 
 
Εικόνα 5.8. Οι 60 ζώνες που έχει χωρισθεί η Γη κατά την Εγκάρσια Μερκατορική Προβολή. 
(http://www.dmap.co.uk/utmworld.htm). 

http://erg.usgs.gov/isb/pubs/MapProjections/graphics/mercator.gif�
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5.4.4. Απεικόνιση HΑΤΤ 
 
Η αρχή των χαρτογραφικών επιστημών στην Ελλάδα οριοθετείται το 1889, με την ίδρυση 
της ΓΥΣ.  Το τριγωνομετρικό δίκτυο βασίσθηκε στις συντεταγμένες του παλαιού 
Αστεροσκοπείου Αθηνών. Ως προβολή επιλέχθηκε η μεταφορά στο ελλειψοειδές από 
έναν Χαρτογράφο του Γαλλικού Ναυτικού (Hatt) μιας παλαιότερης επίπεδης προβολής 
(Ορθή επίπεδη ισαπέχουσα προβολή Postel).   Ελλειψοειδές αναφοράς επιλέχθηκε το 
«Bessel 1841».  
 
Η προβολή HΑΤΤ είναι πλάγια, επίπεδη και ισαπέχουσα. Διατηρούνται αναλλοίωτα τα 
µήκη στοιχειωδών γραµµών από το ελλειψοειδές στο επίπεδο κατά ορισµένες µόνο 
διευθύνσεις. Έχει κλίμακα μηκών ms = 1.  
 
Η Χώρα χωρίζεται σε 130 περίπου σφαιροειδή τραπέζια διαστάσεων 30'x30', κάθε ένα 
από τα οποία αποτελεί και διαφορετικό τοπικό σύστηµα.  
 
Η αφετηρία του συστήµατος ΗΑΤΤ είναι το Αστεροσκοπείο Αθηνών από τον µεσηµβρινό 
του οποίου µετράται το γεωγραφικό µήκος. Τα κέντρα των σφαιροειδών τραπεζίων 
ονοµάζονται κέντρα φύλλου, των οποίων οι γεωγραφικές συντεταγµένες ευρίσκονται σε 
ακέραιες µοίρες και 15' ή 45'.  
 
Στην προβολή HΑΤΤ, έχει εκπονηθεί από την Γ.Υ.Σ. μεγάλο μέρος (περιοχές κεντρικής 
και Βόρειας Ελλάδας) από την Χαρτογραφική εργασία στις κλίμακες 1:50.000 και 
1:5.000.  Επίσης, εκπονήθηκαν πλήθος διαγραμμάτων σε μεγάλες κλίμακες,  από άλλες 
υπηρεσίες ή μελετητές. Ιδιαίτερα, τα στοιχεία της Εθνικής Στατιστικής Υπηρεσίας έχουν 
ως υπόβαθρο τους χάρτες της Γ.Υ.Σ.  Εγκεκριμένα πολεοδομικά σχέδια και εγκεκριμένες 
γραμμές αιγιαλών και παραλίας δεκαετιών έχουν χαραχθεί σε υπόβαθρα εξαρτημένα 
από την ΗΑΤΤ. 
 
Η Τοπογραφική Υπηρεσία του Υπουργείου Γεωργίας, χρησιμοποίησε από τις πρώτες 
δεκαετίες του 20ου αιώνα μέχρι την εισαγωγή του ΕΓΣΑ μια παραλλαγή του τρόπου 
διανομής των Φ.Χ., με χρήση του ιδίου Datum και προβολής.  Τα σχέδια αποτυπώσεων, 
κτηματογραφήσεων και διανομών έγιναν σε κλίμακες 1:10.000 και μεγαλύτερες ώστε για 
λόγους ευκολίας χρησιμοποίησε Φ.Χ. 6‘Χ6‘, τα οποία δίδουν έως τετραψήφιες 
συντεταγμένες, αλλά και πολλαπλάσια κέντρα Φ.Χ. 
 
Σήµερα, το σύστημα  HΑΤΤ είναι σε φθίνουσα χρήση λόγω των µειονεκτηµάτων του, 
µεταξύ των οποίων η ασυµβατότητά του µε τις σύγχρονες τεχνολογίες. Στις εφαρµογές 
αντικαθίσταται πλέον από το σύστηµα ΕΓΣΑ'87. 
 
5.4.5. Γεωγραφικό Σύστημα Συντεταγμένων - Geographic Coordinate System 
 
Η Γη προσομοιώνεται  ως σφαίρα ή σφαιροειδές. Η σφαίρα χωρίζεται σε ίσα τμήματα 
καλούμενα ως μοίρες (εικ. 5.9). Κάποιες χώρες χρησιμοποιούν grads.  
 
5.4.6. Γεωκεντρικό Σύστημα Συντεταγμένων - Geocentric Coordinate System 
 
Η γη προσομοιώνεται  ως σφαίρα ή σφαιροειδές ή ελλειψοειδές σε ένα δεξιόστροφο 
X,Y,Z σύστημα. Το Κέντρο Αξόνων ταυτίζεται με το Κέντρο της σφαίρας ή σφαιροειδούς 
ή ελλειψοειδούς. 
 



 37 

 
 
Εικόνα 5.9. Διακρίνεται ο διαχωρισμός της Γης σε μοίρες. 
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-tropics-
non.png. 
 
 
5.5. Χαρτογραφικές Απεικονίσεις και Γεωεπιστήμες 
 
Στις Γεωεπιστήμες, η κατασκευή χαρτών προϋποθέτει:  
 

• την γνώση των Χαρτογραφικών Απεικονίσεων 
• την δυνατότητα επιλογής και πραγματοποίησής τους 
• την δυνατότητα αλλαγής από μια συγκεκριμένη απεικόνιση σε άλλη, με σκοπό 

την προσαρμογή δεδομένων σε μια κοινή απεικόνιση και τελικά ένα κοινό 
Γεωδαιτικό Σύστημα Αναφοράς-ΓΣΑ. 

 
Αποτέλεσμα: 
 

• Aπεικόνιση σε έναν χάρτη, διαφόρου είδους δεδομένων (γεωλογικών, τεκτονικών 
γεωφυσικών, σεισμολογικών, τοπογραφικών, γεωμορφολογικών, γεωχημικών, 
γεωτεχνικών, χρήσεων γης κ.λ.π.) προερχομένων από διαφορετικές πηγές (δεδομένα 
πεδίου, δορυφορικές εικόνες, ascii αρχεία κ.λ.π.) και διαφορετικές απεικονίσεις. 

 
• Οργάνωση δεδομένων σε μια κοινή βάση δεδομένων, συνδυασμός και διαχείριση 

γενικότερα, εφόσον έχει καθορισθεί πλήρως ο γεωγραφικός χώρος στον οποίο ανήκουν. 
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6. ΓΕΩΔΑΙΤΙΚΟ ΣΥΣΤΗΜΑ ΑΝΑΦΟΡΑΣ 
 
6.1. Γενικά 
 
Ένα Γεωδαιτικό Σύστημα Αναφοράς (ΓΣΑ) στην κλασσική γεωδαισία  (ΒΕΗΣ, 1987): 
 

• Ορίζεται με την επιλογή ενός (γεωδαιτικού) Datum, που δίνει αρχικές 
συντεταγμένες σε ένα σημείο και τις διαστάσεις ενός ελλειψοειδούς αναφοράς. Ο 
προσανατολισμός επιτυγχάνεται με αστρονομικές μεθόδους.  
• Υλοποιείται με τις μετρήσεις ενός γεωδαιτικού δικτύου, την συνόρθωσή του και 
τον υπολογισμό των συντεταγμένων (φ, λ) των κορυφών του στο νέο Datum.  
• Εφαρμόζεται με την απεικόνιση (ή προβολή) του ελλειψοειδούς σε ένα επίπεδο 
που δίνει τις επίπεδες συντεταγμένες (Χ,Υ) του δικτύου.  
• Χρησιμοποιείται με την εξάρτηση (και εντοπισμό) των γεωδαιτικών, 
τοπογραφικών και χαρτογραφικών εργασιών στο δίκτυο και την χρήση των 
συντεταγμένων των κορυφών του. 

 
Το Datum (ή τοπικό ελλειψοειδές αναφοράς) ορίζεται από οκτώ παραμέτρους: τον 
προσδιορισμό της αρχής του τρισορθογώνιου Καρτεσιανού  Συστήματος Αξόνων (τρεις 
παραμέτρους), τον προσανατολισμό των αξόνων  (τρεις παραμέτρους), το μέγεθος του 
ελλειψοειδούς (μία παράμετρος) και το σχήμα του ελλειψοειδούς (μία παράμετρος).   Η 
εικ. 1.5 αναπαριστά το Datum. 
 
Το Datum, το γεωδαιτικό δίκτυο, το προβολικό σύστημα, η υψομετρική αφετηρία και το 
χωροσταθμικό δίκτυο, συνιστούν το Γεωδαιτικό Σύστημα Αναφοράς (ΓΣΑ). 
 
Το Σύστημα Αναφοράς είναι ένα σύνολο από: 

• Συμβάσεις (π.χ. ο άξονας περιστροφής της γης) 
• Πρότυπα (π.χ. το ελλειψοειδές αναφοράς) 
• Μοντέλα (π.χ. γεωδυναμικά / τεκτονικά μοντέλα) 
• Σταθερές (π.χ. η ταχύτητα του φωτός) 

που όλα μαζί χρησιμοποιούνται για τον καθορισμό της θέσης ενός σημείου στον χώρο. 
 
Προκειμένου το σύστημα αναφοράς να είναι προσβάσιμο και προς χρήσιν από τους 
χρήστες, απαιτείται η γνώση των συντεταγμένων σε ένα σύνολο σημείων. Οι 
συντεταγμένες επίσης, πρέπει να αναφέρονται σε μια χρονική στιγμή (εποχή) και 
παράλληλα να δίδονται και τα στοιχεία της κίνησης (ταχύτητες) του κάθε σημείου, λόγω 
γεωδυναμικών / τεκτονικών διεργασιών. Η λύση για ένα σύνολο σταθμών σε μια 
γεωγραφική περιοχή αποτελεί ένα Πλαίσιο Αναφοράς. Ουισιαστικά, ένα Πλαίσιο 
Αναφοράς (Reference Frame) συναρτάται με μια χρονική στιγμή (εποχή) στην οποία 
αναφέρονται οι συντεταγμένες. 
 
Ανάλογα με την μελέτη, κλίμακα, περιοχή κ.λ.π. χρησιμοποιούνται συγκεκριμένα 
ελλειψοειδή και αντίστοιχα ΓΣΑ. 
 
Παγκόσμια Γεωδαιτικά Συστήματα Αναφοράς όπως το WGS’84 ορίζονται 
χρησιμοποιώντας  γεωκεντρικά ελλειψοειδή, ενώ τα τοπικά ορίζονται χρησιμοποιώντας 
τοπικά ελλειψοειδή (Εικ. 6.1).  
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Αν είναι γνωστή η θέση (παράμετροι) ενός σημείου της γήινης επιφάνειας, ή οι 
παράμετροι μιας περιοχής σε ένα ΓΣΑ, είναι εύκολη η μεταφορά τους σε ένα άλλο (Εικ. 
6.2).  
 
Η γνώση συντεταγμένων δεν ορίζει την ”απόλυτη" θέση ενός σημείου, αλλά την θέση του 
σε συσχετισμό με την αφετηρία μετρήσεων, δηλαδή την θέση του σε συγκεκριμένο Γ.Σ.Α 
(Εικ. 6.3).  Eίναι δυνατόν, σημεία να έχουν ταυτόσημες συντεταγμένες, χωρίς τα σημεία 
να καταλαμβάνουν την ίδια θέση στον χώρο. Επίσης, να υπάρχουν πολλαπλά ζεύγη 
διαφορετικών κατά την τιμή μεταξύ τους συντεταγμένων, αναφερόμενα στο ίδιο σημείο. 
 
 

 
 
Εικ. 6.1. Τοπικά και Γεωκεντρικά Συστήματα Συντεταγμένων και DATUM σε σχέση με την 
Επιφάνεια  Γης (ESRI, 2005). 
 
 
 
 
 
 
 
 
 
 
 
 

Τοπικό Σύστημα Συντεταγμένων 

Επιφάνεια Γης 
Γεωκεντρικό Datum WGS’84  
Τοπικό Datum NAD27 

 Γεωκεντρικό Σύστημα 
Συντεταγμένων  

Επιφάνεια Γης 
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Εικ. 6.2.  
Η ακτογραμμή της 
Νήσου Ζακύνθου στο 
Ελληνικό Γεωδαιτικό 
Σύστημα Αναφοράς – 
ΕΓΣΑ΄87 (παχειά μπλέ 
γραμμή) και στο 
Παγκόσμιο Γεωδαιτικό 
Σύστημα Αναφοράς - 
WGS΄84 (λεπτή μωβ 
γραμμή). 
     

 

 
 
Εικ. 6.3.  
Σημείο με συγκεκριμένες 
γεωγραφικές 
συντεταγμένες (λ,φ) 
προβαλλόμενο σε τρία 
διαφορετικά συστήματα 
απεικόνισης. Ο χάρτης 
είναι διαστάσεως 200 χ 
200 m (Ordance Survey 
2002). 
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6.2. Μετατροπή άλλων ΓΣΑ σε ΕΣΑ’87 
 
Για την αλλαγή ενός ΓΣΑ-1 σε άλλο ΓΣΑ-2 λαμβάνονται υπ΄ όψιν ιεραρχικά: 
 

• Η αλλαγή του Datum 
• Η αλλαγή του Δικτύου (επηρεάζει τα (φ,λ)) 
• Η αλλαγή της Απεικόνισης (επηρεάζει τα (χ,y)) 

 
ή οποιοσδήποτε συνδυασμός αυτών. Ο Μετασχηματισμός συντεταγμένων από ένα ΓΣΑ 
σε άλλο επιτυγχάνεται με διάφορους τρόπους και αναφέρονται σε συγγράμματα 
Γεωδαισίας. 
 
Η γενική σχέση που συνδέει το Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς 1987 -   
ΕΓΣΑ΄87 (ΓΣΑ-2) με τα υπάρχοντα (ΓΣΑ-1) ως προς τις πραγματικές συντεταγμένες  X,Y 
δίδεται: 

X2 = X1 + Qx + Rx + Px + Ux 
Υ2 = Υ1 + Qy + Ry + Py + Uy  
 
Όπου Q, R και P η μεταβολή λόγω αλλαγής του Datum, του δικτύου και της 
απεικόνισης αντίστοιχα και U ένας υπολειπόμενος όρος που θεωρείται θόρυβος 
(σφάλμα), προερχόμενος από τα σφάλματα των μετρήσεων με την αλλαγή του 
δικτύου, αλλά που ίσως περιέχει και κάποιο σήμα (συστηματικό μέρος). 

 
Οι περισσότερες απεικονίσεις εκφράζονται με αναπτύγματα σε σειρά. Είναι δυνατόν 
μέσω πολυωνυμικών σχέσεων να γίνει η μετατροπή μιας απεικόνισης σε άλλη. (Αν οι 
δύο απεικονίσεις είναι σύμμορφες οι σχέσεις απλουστεύονται μέσω μιγαδικών 
συναρτήσεων).  
 
Η πολυωνυμικές σχέσεις που δίνουν τις συντεταγμένες (χ, y) HATT του παλαιού 
Ελληνικού Datum (BESSEL) σε συντεταγμένες (Χ, Y) στο ΕΓΣΑ΄87 είναι: 

X = x +a0 +a1x + a2y + a3x2 +a4y2 +a5xy 
Y = y +b0 +b1x + b2y + b3x2 +b4y2 +b5xy 
 
ao...a5, bo...b5: οι πολυωνυµικοί συντελεστές µετατροπής, υπολογιζόμενοι γενικά 
ανά φύλλο χάρτη κλίµακας 1:100.000 ή σε ειδικές περιπτώσεις ανά φύλλο χάρτη 
κλίµακας 1:50.000  ή και για τµήµατα αυτών. (Η ΓΥΣ έχει εκδόσει έντυπο µε τους 
παραπάνω συντελεστές μετατροπής). 

 
Η µαθηµατική σχέση, που συνδέει δύο Γ.Σ.Α προσδιορίζεται µε ιδιαίτερα  απλό  τρόπο,  
χρησιµοποιώντας  προσεγγιστικές  σχέσεις.  Οι  παράµετροι των  σχέσεων  αυτών  
απορροφούν  όλες  τις  διαφορές  των  συστηµάτων.  Από  τα υπόλοιπα των 
συντεταγµένων σηµείων, µετά τον µετασχηµατισµό, προσδιορίζεται η εκτίµηση της 
ακριβείας της σχέσης.  
 
Για τον Ελληνικό χώρο (ΒΕΗΣ, 1994), προκειμένου να μετατραπούν γεωδαιτικές 
συντεταγμένες προηγουμένων ΓΣΑ στο ΕΓΣΑ’87,  χρησιµοποιούνται σχέσεις της 
µορφής: 
 
φ2 = φ1 + α0 + α1* (φ1º-38º) + α2 * (λ1º-24º) και   
λ2 = λ1 + β0 + β1* (φ1º-38º) + β2* (λ1º-24º), µε τιµές γωνιών σε δευτερόλεπτα  τόξου.  
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Οι ανωτέρω  σχέσεις δύνανται να χρησιµοποιηθούν και σε αντίστροφη φορά, µε αλλαγή 
των προσήµων των παραµέτρων, διότι οι διαφορές µεταξύ αρχικών και τελικών 
γεωδαιτικών συντεταγµένων είναι πολύ µικρές. 
 
Παράµετροι προσεγγιστικών σχέσεων απευθείας µετασχηµατισµού γεωδαιτικών 
συντεταγµένων έχουν ως ακολούθως: 
 
από Γ.Σ.Α  σε Γ.Σ.Α. α0   α1           α2     β0                     β1 β2 
Παλαιό 
(Bessel)     

ΕΓΣΑ  -5.86''     -0.33''     -0.05''      0.28''      0.09''      -0.45''  
 

ED’50      ΕΓΣΑ     -13.17''  0.09'' 0.07'‘      -8.15''     -0.11''     -0.03''  
 

WGS’84   ΕΓΣΑ     -9.34''      0.02''       0.05''      -6.10''     -0.08''     -0.11''  
 

 
Η  ακρίβεια  που  πετυχαίνουν  είναι 2-4m µεταξύ  των  Παλαιού  Ελληνικού Γ.Σ.Α. και 
ΕΓΣΑ, 2-3m µεταξύ των ED’50 και ΕΓΣΑ και 1m µεταξύ των WGS’84 και ΕΓΣΑ. 
 
Η  εφαρµογή  της µεθόδου (ΒΕΗΣ, 1994 - χρήση µόνο των παραµέτρων µετάθεσης 
γεωκέντρου dX, dY, dZ) µεταξύ του Παλαιού Ελληνικού Γ.Σ.Α. και ΕΓΣΑ έχει ακρίβεια 
στην τάξη των 5-6 µέτρων.  Δύναται να χρησιμοποιηθεί εφ’ όσον δεν απαιτείται μεγάλη 
ακρίβεια ή ως ένα προσεγγιστικό στάδιο πριν τον τελικό μετασχηματισμό. 
 

Παράµετροι µετάθεσης γεωκέντρου - 3 παράµετροι 
   από Γ.Σ.Α                σε Γ.Σ.Α. 
   WGS’84                   ΕΓΣΑ’87           Παλαιό (Bessel)            ED’50               ITRF’89  
   dX=                          199.72m            -456.39m                        83.8m              0.03m 
   dY=                           -74.03m            -372.62m                        96.3m              0.79m 
   dZ=                           -246.02m          -496.82 m                       115.7m             0.03m 
 
   Παλαιό (Bessel)      ΕΓΣΑ’87            
   dX=                           656.11m              
   dY=                           298.59m             
   dZ=                           50.80m              
 
 
6.3. Ελλειψοειδή στην Ελλάδα 
 
Στην Ελλάδα χρησιμοποιούνται τα κάτωθι Ελλειψοειδή: 
 
Ελλειψοειδές Μέγιστος Ημι-άξων   1/Πλάτυνση 

GRS’ 80 6378137   298.257 

WGS’ 84 6378137   298.257 

BESSEL1841 6377397.2 299.153 

INTERNATIONAL 1924 6378388 297   

HAYFORD 6378388 297   



 43 

6.4. Γεωδαιτικά Συστήματα Αναφοράς στην Ελλάδα 
 
Στην Ελλάδα χρησιμοποιούνται τα ακόλουθα Γεωδαιτικά Συστήματα Αναφοράς:  
 
ΕΓΣΑ’87 / Ελληνικό Γεωδαιτικό Σύστηµα Αναφοράς 1987: 
 
Τον Δεκέµβριο του 1987 µετά από εισήγηση του Καθηγητή Γ. Βέη  (ΒΕΗΣ 1986), προς 
την «Γεωδαιτική και Γεωφυσική Επιτροπή του Κράτους» (Γ.Γ.Ε.Π.) εγκρίθηκε προς 
χρήση το Ελληνικό Γεωδαιτικό Σύστηµα Αναφοράς 1987, το οποίο αποτελεί  το 
επίσηµο Γεωδαιτικό Σύστηµα Αναφοράς της Ελλάδας  και υλοποιείται από τις γνωστές 
συντεταγµένες στα τριγωνοµετρικά σηµεία του Κρατικού Τριγωνοµετρικού Δικτύου. Έχει 
τα ακόλουθα χαρακτηριστικά: 
 

Ελλειψοειδές: GRS’80 / Geodetic Reference System 1980. Το επίσηµο γήινο 
µοντέλο ελλειψοειδούς-εκ-περιστροφής (ΕΕΠ) που έχει υιοθετηθεί από την Διεθνή 
Ένωση Γεωδαισίας. Χρησιµοποιείται για την µετατροπή Καρτεσιανών 
συντεταγµένων (Χ, Υ, Ζ) σε καµπυλόγραµµες γεωδαιτικές συντεταγµένες, και 
αντίστροφα. Οι βασικές γεωµετρικές παράµετροι ορισµού του GRS80 είναι: 

Μήκος µεγάλου ηµιάξονα α = 6378137.00 m 
Επιπλάτυνση f = 1/298.257222101 

 
Αφετηρία: Γεώκεντρο μετατεθημένο, προσανατολισμένο παράλληλα  με το ITRF’89 
(International  Terestrial Reference Frame -1989) με εκκεντρότητα ΔΧ= -199.695, 
ΔΥ= 74.815, ΔΖ= 246.045 και με τις συμβατικές συντεταγμένες στο Κεντρικό βάθρο 
του Διονύσου:  
             φ = 380

             λ = 23
 04’ 33’’81070 

0

             Ν = 7 m  
 55’ 51’’00950 

 
Προβολή: TM87 / Transverse Mercator Projection 1987 / Εγκάρσια Μερκατορική 
Προβολή ενιαίας ζώνης για την Ελλάδα (εκτός Καστελόριζου) - Σύμμορφη 
απεικόνιση. 
 
Η TM87 εφαρµόζεται για την µετατροπή καµπυλόγραµµων γεωδαιτικών 
συντεταγµένων (φ, λ) ως προς το ΕΓΣΑ87 σε προβολικές συντεταγµένες (Ε, Ν), και 
αντίστροφα. Οι βασικές παράµετροι για την εφαρµογή της χαρτογραφικής προβολής 
ΤΜ87 είναι: 
λο 
m

= 24° (κεντρικός µεσηµβρινός) 
ο

φ
 = 0.9996 (µέτρο γραµµικής παραµόρφωσης στον κεντρ. µεσηµβρινό) 

ο
False Easting Εο = 500000 m (προσθετική σταθερά στις τετµηµένες) 

 = 0 (γεωγραφικό πλάτος αναφοράς) 

False Northing Νο = 0 m (προσθετική σταθερά στις τεταγµένες) 
 
Επιτυγχάνονται: 
Πολύ καλή προσαρμογή στο ηπειρωτικό γεωειδές 
Εύκολη σύνδεση με τα παγκόσμια δορυφορικά συστήματα 
Αμελητέα σφάλματα σε κλίμακα και προσανατολισμό 
Υψηλής ποιότητας μετρήσεις και υπολογισμοί 
Ικανοποιητική τοπική, αλλά και στο σύνολο της χώρας, ακρίβεια. 
Εύκολες αναγωγές στις μετρήσεις πεδίου. 
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HTRS07 (HEPOS) / Hellenic Terrestrial Reference System (2007): 
 
Το Γεωδαιτικό Σύστηµα Αναφοράς του HEPOS υλοποιείται από τις επίσηµες 3Δ 
Καρτεσιανές συντεταγµένες των 98 µόνιµων σταθµών GPS που λειτουργούν υπό την 
επίβλεψη της ΚΤΗΜΑΤΟΛΟΓΙΟ Α.Ε σε όλη την Ελλάδα. Σημειώνεται ότι οι επίσημες 
συντεταγμένες των ανωτέρω σταθμών αναφέρονται στην χρονική στιγμή t = 2007.5. 
Το HTRS07 βασίζεται στο επίσηµο Ευρωπαϊκό Γεωκεντρικό Σύστηµα Αναφοράς και 
χρησιµοποιεί τα ακόλουθα πρότυπα: 

Ελλειψοειδές Αναφοράς GRS 80 
Ευρωπαϊκό Σύστηµα Αναφοράς Συντεταγµένων ETRS 89 
Ευρωπαϊκό Πλαίσιο Αναφοράς Συντεταγµένων ETRF 05 
Χαρτογραφικό Προβολικό Σύστηµα ΤΜ 07 

 
Τα χαρακτηριστικά των προαναφερθέντων προτύπων που χρησιμοποιεί το HTRS07 
έχουν ως ακολούθως: 
 

ETRS89 / European Terrestrial Reference System (1989): 
Το Ευρωπαϊκό γεωκεντρικό σύστηµα αναφοράς έχει ορισθεί και υιοθετηθεί από την 
επιτροπή EUREF της Διεθνούς Ένωσης Γεωδαισίας. 

 
ETRF05  / European Terrestrial Reference Frame (2005): 
Το Ευρωπαϊκό γεωκεντρικό πλαίσιο αναφοράς συντεταγµένων αποτελεί την πιο 
πρόσφατη και επίσηµη υλοποίηση του ETRS89 σε πανευρωπαϊκή κλίµακα. Ορίζεται 
µε βάση τις 3Δ Καρτεσιανές συντεταγµένες (σε δεδοµένη χρονική εποχή αναφοράς) 
και τις ταχύτητες µεταβολής τους για ένα σύνολο µόνιµων σταθµών που βρίσκονται 
στην Ευρωπαϊκή πλάκα (EUREF stations), συµπεριλαµβανοµένων και τριών 
µόνιµων σταθµών στην Ελλάδα: AUT1, NOA1, TUC2. 
 
Ελλειψοειδές Αναφοράς GRS 80 
 

     (Τα χαρακτηριστικά του έχουν αναφερθεί ανωτέρω) 
 
TM07 / Transverse Mercator Projection (2007): 
Εγκάρσια µερκατορική Προβολή ενιαίας ζώνης για την Ελλάδα (εκτός Καστελόριζου) 
που εφαρµόζεται για την µετατροπή των 2Δ καµπυλόγραµµων γεωδαιτικών 
συντεταγµένων (φ, λ) ως προς το HTRS07 σε 2Δ προβολικές συντεταγµένες (Ε, Ν), 
και αντίστροφα. Οι βασικές παράµετροι για την εφαρµογή της χαρτογραφικής 
προβολής ΤΜ07 είναι: 
λο
κ

 = 24° (κεντρικός µεσηµβρινός) 
ο

φ
 = 0.9996 (µέτρο γραµµικής παραµόρφωσης στον κεντρ. µεσηµβρινό) 

ο
False Easting Ε

 = 0 (γεωγραφικό πλάτος αναφοράς) 
ο

False Northing Νο = -2000000 m (προσθετική σταθερά στις τεταγµένες) 
 = 500000 m (προσθετική σταθερά στις τετµηµένες) 

 
Ο Ευθύς Μετασχηματισμός ΗTRS07 → ΕΓΣΑ87 βασίζεται στα ακόλουθα (Κωτσάκης κ.ά 
(2008) : 
 

 
Δεδομένα Θέσης 

(Χ, Υ, Ζ): 3Δ γεωκεντρικές Καρτεσιανές συντεταγμένες ως προς το ΗTRS07. 
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Δεδομένα Μοντέλου Μετασχηματισμού 

α) Επίσημες τιμές για τις επτά παραμέτρους του 3Δ μετασχηματισμού ομοιότητας που 
συνδέει το HTRS07 με το Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς ΕΓΣΑ87. 
Οι τιμές των παραμέτρων αυτών αντιστοιχούν σε τρεις συνιστώσες μετάθεσης (tx, ty, tz), 
τρεις γωνίες στροφής (εx, εy, εz

 

) και ένα συντελεστή κλίμακας δs, που χρησιμοποιούνται 
μέσω της σχέσης: 

 
 
για τον υπολογισμό των 3Δ Καρτεσιανών συντεταγμένων (Χ', Υ', Ζ') ως προς το 
ΕΓΣΑ87, από τις αντίστοιχες γνωστές 3Δ γεωκεντρικές Καρτεσιανές συντεταγμένες (Χ, 
Υ, Ζ) ως προς το HTRS07. 
 
Οι επίσημες αριθμητικές τιμές των παραμέτρων του παραπάνω μετασχηματισμού 
ομοιότητας είναι: 
 

tx = 203.437 m     εx
t

 = -0.170 arcsec       δs = -0.294 ppm 
y = -73.461 m      εy

t
 = -0.060 arcsec 

z = -243.594 m    εz
 

 = -0.151 arcsec 

β) Κάνναβοι ‘διορθώσεων’ (correction/shift grids) που περιέχουν τιμές δΕ ij και δΝ ij

 

, σε 
cm, οριζόμενες πάνω σε επίπεδο 2Δ ορθογωνικό πλέγμα το οποίο καλύπτει ολόκληρη 
την Ελλάδα, εκτός Καστελόριζου (για το Καστελόριζο, δίδονται ξεχωριστά). 

Η διακριτική ανάλυση του ορθογωνικού πλέγματος είναι 2 km επί 2 km, ενώ το 
γεωγραφικό/προβολικό του υπόβαθρο ορίζεται ως εξής: 

Datum: HTRS07 
Προβολή: ΤΜ07 
Εmin
N

: 41600.00 m 
min

Grid resolution: 2 km 
: 1845619.00 m 

Grid size: 408 γραμμές × 422 στήλες (172166 node values for δΕij) 
408 γραμμές × 422 στήλες (172166 node values for δNij) 

 

 
Τελικά αποτελέσματα 

Προβολικές συντεταγμένες ή/και 2Δ καμπυλόγραμμες γεωδαιτικές συντεταγμένες 
ως προς το ΕΓΣΑ87. 
 

 
Διαδικασία – Αλγόριθμος του Ευθέως  Μετασχηματισμού 

Βήμα 1: (Χ, Υ, Ζ) → (Χ', Υ', Ζ') 
 
Μετασχηματισμός των γνωστών 3Δ Καρτεσιανών συντεταγμένων (Χ, Υ, Ζ) ως προς το 
HTRS07 σε 3 Δ Καρτεσιανές συντεταγμένες (Χ', Υ', Ζ') ως προς το ΕΓΣΑ87, μέσω της 

(1) 
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εξίσωσης (1). 
 
Βήμα 2: (Χ', Υ', Ζ') → (φ', λ', h'), όπου h = γεωμετρικό υψόμετρο 
 
Μετατροπή των 3Δ Καρτεσιανών συντεταγμένων (Χ', Υ', Ζ') ως προς το ΕΓΣΑ87 σε 3Δ 
καμπυλόγραμμες γεωδαιτικές συντεταγμένες (φ', λ', h') ως προς το ίδιο σύστημα. 
 
 
Βήμα 3: (φ', λ') → (Ε', Ν') 
 
Μετατροπή των 2Δ καμπυλόγραμμων γεωδαιτικών συντεταγμένων (φ', λ') ως προς το 
ΕΓΣΑ87 σε προβολικές συντεταγμένες (Ε', Ν') ως προς το ίδιο σύστημα, 
χρησιμοποιώντας τις μαθηματικές εξισώσεις και τις αντίστοιχες παραμέτρους της 
προβολής ΤΜ87. 
 
Βήμα 4 
 
Υπολογισμός των διορθωτικών τιμών δΕ και δΝ που αντιστοιχούν στο συγκεκριμένο 
σημείο όπου εφαρμόζεται ο μετασχηματισμός. Ο υπολογισμός αυτός γίνεται μέσω 2Δ 
σημειακής παρεμβολής από τους αντίστοιχους καννάβους διορθώσεων, με την χρήση 
κατάλληλου μαθηματικού αλγορίθμου (προτείνεται η χρήση της 2Δ διγραμμικής 
παρεμβολής από τους 4 κοντινότερους κόμβους του καννάβου στο εκάστοτε σημείο 
υπολογισμού).  
 
Βήμα 5 
 
Υπολογισμός των τελικών τιμών για τις προβολικές συντεταγμένες ως προς το ΕΓΣΑ87, 
σύμφωνα με τις σχέσεις 
 

Ε'τελικό = Ε' + δΕ 
Ν'τελικό = Ν' + δΝ 

 
Βήμα 6 (προαιρετικό): (Ε'τελικό, Ν'τελικό) → (φ'τελικό, λ'τελικό) 
 
Μετατροπή των τελικών προβολικών συντεταγμένων ως προς το ΕΓΣΑ87 σε 2Δ 
καμπυλόγραμμες γεωδαιτικές συντεταγμένες ως προς το ίδιο σύστημα, 
χρησιμοποιώντας τις μαθηματικές εξισώσεις και τις αντίστοιχες παραμέτρους της 
προβολής ΤΜ87. 
 
Επίσης είναι δυνατή και η υλοποίηση αντίστροφου μετασχηματισμού (ΕΓΣΑ΄87 → 
HTRS07), όπου τα βήματα και οι εξισώσεις δίδονται από Κωτσάκη κ.ά (2008). 
 
 
Σημειώνεται, ότι για το Καστελόριζο η Εγκάρσια µερκατορική Προβολή χρησιμοποιείται 
με τις παραμέτρους: 
 

λο
κ

 = 30° (κεντρικός µεσηµβρινός) 
ο

φ
 = 1 (µέτρο γραµµικής παραµόρφωσης στον κεντρ. µεσηµβρινό) 

ο
False Easting Ε

 = 0 (γεωγραφικό πλάτος αναφοράς) 
ο

False Northing Νο = -2000000 m (προσθετική σταθερά στις τεταγµένες) 
 = 500000 m (προσθετική σταθερά στις τετµηµένες) 
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Παγκόσμιο Γεωδαιτικό Σύστημα Αναφοράς WGS’84: 
 

Ελλειψοειδές: WGS’84 
Αφετηρία: Γεώκεντρο 
Προβολή: Γεωγραφική (φ, λ) ή Εγκάρσια Μερκατορική (UTM) 

Εάν συμπεριληφθεί και το υψόμετρο, αντίστοιχα των ανωτέρω 
Τρισδιάστατα Συστήματα. 

 
Δεν έχει καλή προσαρμογή στο Γεωειδές του Ελληνικού Χώρου 

 
Το WGS’84 είναι ένα συμβατικό επίγειο γεωκεντρικό σύστημα και είναι αυτό που 
χρησιμοποιείται από το GPS. Από την αρχή της δημιουργίας του έχει υποστεί διάφορες 
βελτιώσεις . Από το 1988 επιδιώκεται να ταυτίζεται με το ITRS (International Terrestrial 
Reference System / Διεθνές Επίγειο Σύστημα Αναφοράς). To ITRS υλοποιείται από το 
ITRF (International Terrestrial Reference Frame), το οποίο αποτελείται από τις 
Καρτεσιανές συντεταγμένες (Χ,Υ,Ζ) και τις ταχύτητες μετακίνησης ενός συνόλου 
επιλεγμένων σταθμών ως προς κάποια εποχή αναφοράς. Οι σταθμοί, οι οποίοι είναι 
άνω των 500 σε όλη την Γη, αποτελούν ένα παγκόσμιο δίκτυο μονίμων σταθμών 
παρακολούθησης με μετρήσεις GPS, DORIS  κ.ά. Οι σταθερές συντεταγμένες ορίζουν 
έμμεσα την αρχή και τον προσανατολισμό των αξόνων του ITRS. Το ITRF αποτελεί 
αντικείμενο συνεχούς παρακολούθησης και προσδιορισμού, εφόσον δεν είναι σταθερό 
ως προς τον χρόνο (η Γη συνεχώς παραμορφώνεται). Οι μεταβολές του συστήματος 
ITRF για ένα ορισμένο χρονικό διάστημα (π.χ. ένα έτος) δύναται να περιγραφούν 
ικανοποιητικά, οι ταχύτητες θεωρούνται σταθερές και συνεπώς το ίδιο και το σύστημα. 
 
Ευρωπαϊκό Datum 1950 (ED’50): 
 

Ελλειψοειδές: HAYFORD  
Αφετηρία: Πύργος Helmet του  POTSDAM Γερμανίας 
Προβολή: Εγκάρσια Μερκατορική (UTM) – Σύμμορφη απεικόνιση 
Η γη υποδιαιρείται σε 60 ζώνες, γεωγραφικού µήκους 6ο

Η Ελλάδα καταλαµβάνει τις ζώνες 34 και 35, με κέντρα (μεσημβρινοί) προβολών 
λ=21

. Η πρώτη ζώνη ξεκινά από 
τον µεσηµβρινό του Greenwich.  

ο και λ=27ο

 
 αντίστοιχα 

Μέτρια προσαρμογή στο γεωειδές 
Δύσκολη σύνδεση με παγκόσμια συστήματα 
Ξεπερασμένο ελλειψοειδές 
Σημαντικά σφάλματα σε κλίμακα και προσανατολισμό 
Μετρίας ποιότητας μετρήσεις 
Ανεκτή ποιότητα υπολογισμών 
Ικανοποιητική τοπική ακρίβεια και οριακά ανεκτή για το σύνολο της χώρας 
Σύμμορφη απεικόνιση με λογικές παραμορφώσεις 
Εύκολες αναγωγές στις μετρήσεις πεδίου 

 
Ελληνικό Datum: 
 

Ελλειψοειδές: BESSEL 
Αφετηρία: Αστεροσκοπείο Αθηνών (λο=23ο

Προβολή: HATT – Πλάγια Επίπεδη ή Αζιμουθιακή Ισαπέχουσα 
42΄58''.815) 
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Καλή προσαρμογή στο γεωειδές 
Δύσκολη σύνδεση με παγκόσμια συστήματα 
Ξεπερασμένο ελλειψοειδές 
Μεγάλα σφάλματα στην κλίμακα και προσανατολισμό 
Μετρίας ποιότητας μετρήσεις και υπολογισμοί 
Σχεδόν ικανοποιητική τοπική ακρίβεια αλλά απαράδεκτη στο σύνολο της χώρας 
Πολλά κέντρα προβολών – Η Χώρα υποδιαιρείται σε 130 ανεξάρτητα σφαιροειδή 
τραπέζια 30’ * 30’ κατά πλάτος και κατά μήκος. 
Μη σύμμορφη απεικόνιση – ελάχιστες παραμορφώσεις, δεν χρειάζονται αναγωγές. 
 
Στην εικ. 6.4 δίδεται τμήμα τοπογραφικού χάρτη της ΓΥΣ και οι συντεταγμένες σε 
διαφορετικά Γεωδαιτικά Συστήματα Αναφοράς. 
 
 

 
 
Εικόνα 6.4. Τμήμα Τοπογραφικού Χάρτη Νήσου Ιθάκης (1/50000, ΓΥΣ), στον οποίο 
αποτυπώνονται συντεταγμένες σε διαφορετικές Χαρτογραφικές Απεικονίσεις και Γεωδαιτικά 
Συστήματα Αναφοράς. 
 
 
 
 
 
 
 

← 
Γεωγραφικές 
συντεταγμένες  

← 
 UΤΜ Προβολή, 
ΕΓΣΑ’87 

← 
HATT Προβολή, 
Παλαιό 
Ελληνικό 
Γεωδαιτικό 
Σύστημα 
Αναφοράς 
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7. ΣΥΣΤΗΜΑΤΑ ΓΕΩΓΡΑΦΙΚΩΝ ΠΛΗΡΟΦΟΡΙΩΝ - ΣΓΠ 
 
7.1. Γενικά 
 
«....Τα δύσκολα προβλήματα του Φυσικού Περιβάλλοντος δεν λύνονται με απλές 
γλαφυρές περιγραφές. Απαιτούν ακριβείς μετρήσεις των διαφόρων παραμέτρων τους και 
κατανόηση των διεργασιών. Το πλήθος των φυσικών δεδομένων και η συνεχής μεταβολή 
τους, καθιστούσαν τα περισσότερα από αυτά τα προβλήματα άλυτα, πριν από την εποχή 
μας, την εποχή της Πληροφορικής. Σήμερα, έχει αναπτυχθεί η μεθοδολογία των 
Μαθηματικών Μοντέλων, που φέρνει στη μνήμη του Ηλεκτρονικού Υπολογιστή τις 
καταστάσεις και διεργασίες του Περιβάλλοντος, με τη μορφή εξισώσεων. Έτσι, 
επιτυγχάνεται, όχι μόνον η καλύτερη γνώση και διαχείριση της Γης, αλλά και η πρόγνωση 
για όλες τις πιθανές περιβαλλοντικές επιπτώσεις των διαφόρων δραστηριοτήτων. Η 
Γεωγραφία έπαυσε, πλέον να είναι παθητική επιστήμη. Σε πολλές περιπτώσεις μπορεί να 
γίνει ο σύμβουλος της Πολιτείας, πριν από κάθε δραστηριότητα. Αυτό, φυσικά, εξαρτάται 
από την εξοικείωση των «γεωγράφων» με τις σύγχρονες τεχνολογίες και μεθοδολογίες. 
Επιπλέον, πρέπει να συνειδητοποιηθεί η μεταβατική φάση, στην οποία βρίσκονται 
σήμερα οι γεωεπιστήμες. Στην εποχή μας, άρχισαν να εγκαταλείπονται οι παλαιοί Χάρτες. 
Όλες οι πληροφορίες του Περιβάλλοντος τεκμηριώνονται πλέον συστηματικά στις 
ηλεκτρονικές Τράπεζες Πληροφοριών, στα Συστήματα Γεωγραφικών Πληροφοριών, και, 
μέσω των διεθνών δικτύων των ηλεκτρονικών υπολογιστών, είναι προσιτές σε κάθε 
αξιόλογο ερευνητικό Κέντρο για περαιτέρω χρήση, επεξεργασία και αξιοποίηση....» 
(ΜΟΥΤΣΟΥΛΑΣ, 1994). 
 
Η πληροφορία είναι συνήθως μεγάλου όγκου, καθώς τα δεδομένα συνεχώς 
αυξάνονται, ανανεώνονται και  μεταβάλλονται με ταχείς ρυθμούς, με αποτέλεσμα την 
δύσκολη οργάνωση και διαχείρισή της. 
 
Η ανάγκη για οργάνωση και διαχείριση  των δεδομένων, ώθησε τους ειδικούς 
επιστήμονες και ερευνητές στην κατασκευή προγραμμάτων τέτοιων ώστε μέσω 
ηλεκτρονικών υπολογιστών να είναι πιο εύκολη η πρόσβαση στην πληροφορία 
γενικότερα και στην παραγωγή χαρτών ειδικότερα. 
 
Γεωπληροφορική (Geoinformation ή Geoinformatics) είναι η επιστήμη η οποία μέσω 
τεχνολογιών και τεχνικών πληροφορικής σε συνδυασμό με την θεωρία και τις μεθόδους 
της γεωδαισίας, φωτογραμμετρίας, τηλεανίχνευσης και την ανάλυση χώρου έχει στόχο 
την επιλύση προβλημάτων σχετικών με την συλλογή, διαχείριση, επεξεργασία, ανάλυση 
και απεικόνιση ψηφιακών χωρικών δεδομένων. 
 
Μεγάλες δυνατότητες διαχείρισης και επεξεργασίας της πληροφορίας δίνουν τα 
Συστήματα Γεωγραφικών πληροφοριών (ΣΓΠ) ή Geographical Information Systems 
(GIS). 
 
Δύναται να ειπωθεί ότι τα Συστήματα Γεωγραφικών Πληροφοριών (ΣΓΠ) είναι 
σχεδιασμένα ώστε να δέχονται, οργανώνουν, αναλύουν και να συσχετίζουν (γενικά να 
επεξεργάζονται) διαφόρους τύπους δεδομένων, με κύριο στόχο, εκτός από την απλή 
σύνταξη και παρουσίαση ενός χάρτη με την ταυτόχρονη δημιουργία σχεσιακών βάσεων 
δεδομένων, την λειτουργία ενός συστήματος γενικοτέρων συμπερασμάτων και λήψεως 
αποφάσεων, σε συγκεκριμένα ερωτήματα.  
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Ένα ΣΓΠ δεν δύναται να επιλύσει προβλήματα ούτε και να δώσει σωστές απαντήσεις σε 
συγκεκριμένα ερωτήματα, από μόνο του. Όλα εξαρτώνται από τα δεδομένα, την 
οργάνωση και διαχείρισή τους στο σύστημα από τον χρήστη. 
 
Κάθε δεδομένο αρχειοθετείται από τον χρήστη στο ΣΓΠ, σε μια βάση δεδομένων. Είναι 
επίσης δυνατόν, δεδομένα ή χαρακτηριστικά δεδομένων, που ανήκουν σε άλλες βάσεις 
εκτός του συστήματος, εξωτερικές βάσεις δεδομένων, να προσαρμοστούν στο ΣΓΠ, να 
ενταχθούν σε κοινή βάση με άλλα δεδομένα και να συσχετισθούν, ανάλογα με τις 
απαιτήσεις. 
 
Βάση δεδομένων (Data base) είναι ένα σύνολο από αρχεία δεδομένων, μια 
οργανωμένη συλλογή συναφών δεδομένων, που αποτελεί αντικείμενο ενιαίας 
επεξεργασίας.  
 
Η δημιουργία και διαχείριση του περιεχομένου της βάσης δεδομένων υλοποιείται με την 
βοήθεια του συστήματος διαχείρισης της βάσης δεδομένων (ΣΔΒΔ), που αναφέρεται ως 
DBMS (Data Base Management System). Τυπικά ένα σύστημα διαχείρισης της βάσης 
δεδομένων περιέχει προγράμματα για την είσοδο, αποθήκευση, επανάκτηση και 
συνδυασμό των δεδομένων. Θεωρείται μέσον αναπαράστασης –σε περιβάλλον 
συστήματος Η/Υ- του μοντέλου των δεδομένων του φυσικού κόσμου. 
 
Η διαδικασία της δημιουργίας μιας αναπαράστασης της γεωγραφικής πραγματικότητας 
αποκαλείται εννοιολογική μοντελοποίηση.  
 
Εννοιολογκό μοντέλο είναι η σαφής αναπαράσταση των οντοτήτων, οι οποίες 
απαιτούνται γα να καλύψουν τις απαιτήσεις ένταξης και ανάκλησης από την βάση 
δεδομένων. Η αντίστοιχη περιγραφή στην βάση καλείται εννοιολογικό σχήμα (conceptual 
schema). Το εννοιολογικό μοντέλο είναι ανεξάρτητο από τις δομές των δεδομένων και 
τους μηχανισμούς ανάκλησης, από τους οποίους εξαρτάται η αποτελεσματική λειτουργία 
της βάσης δεδομένων. 
 
Λογικό μοντέλο είναι η απόδοση των στοιχείων του εννοιολογικού μοντέλου με όρους, 
οι οποίοι  εναρμονίζονται με τις ιδιαιτερότητες του ΣΔΒΔ. Το λογικό μοντέλο είναι 
ανεξάρτητο από την φυσική οργάνωση των δεδομένων στο μέσον αποθήκευσης.  
 
Φυσικό μοντέλο είναι το επίπεδο όπου τα περιγραφικά χαρακτηριστικά ορίζονται με 
παραμέτρους, όπως ο αριθμός των bytes που καταλαμβάνουν στο μέσον αποθήκευσης 
και η δεύθυνση στην οποία καταχωρούνται στην μνήμη του συστήματος. 
 
Τα ΣΓΠ έχουν την δυνατότητα δημιουργίας - οργάνωσης - διαχείρισης βάσεων 
δεδομένων, μέσω των συστημάτων διαχείρισης και μάλιστα μέσω σχεσιακών 
συστημάτων διαχείρισης της βάσης δεδομένων  (Relational Data Base Management 
System - RDBMS). 
 
Σχεσιακό σύστημα διαχείρισης της βάσης δεδομένων (RDBMS) είναι ένα σύστημα 
διαχείρισης βάσης δεδομένων με την δυνατότητα εισόδου δεδομένων σε οργανωμένα 
αρχεία -υπό μορφήν πίνακα- τα οποία συσχετίζονται μεταξύ τους με ένα κοινό αρχείο. 
Ένα RDBMS έχει την ιδιότητα ανασυνδυασμού των χαρακτηριστικών των δεδομένων 
από διάφορα αρχεία. 
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7.2. Ψηφιακή Χαρτογραφία και ΣΓΠ 
 
Η λειτουργία του χάρτη ως μέσου μετάδοσης και αξιολόγησης της χαρτογραφικής 
πληροφορίας, εμπλουτισμένη με την δυνατότητα αλληλεπίδρασης με τα στοιχεία που 
προσδιορίζουν το περιεχόμενο του χάρτη, καθιστά την Ψηφιακή Χαρτογραφία και τα 
ΣΓΠ τεχνολογίες συγγενείς και εξαρτημένες στον βαθμό που να θεωρούνται 
αλληλοσυμπληρούμενες. 
 
7.3. Δυνατότητες ΣΓΠ 
 
Tα ΣΓΠ προσφέρουν τις εξής δυνατότητες: 
• Εισαγωγή διαφόρου είδους δεδομένων μέσω Η/Υ, όπως: αναλογικών (θεματικοί 

χάρτες σε αναλογική μορφή), ψηφιακών (χάρτες σε ψηφιακή μορφή από άλλες πηγές, 
δορυφορικές εικόνες κ.ά.) αρχείων ascii,  καθώς επίθεση και ταξινόμηση-
κωδικοποίηση αυτών και δημιουργία σχεσιακών βάσεων δεδομένων. 

• Αποθήκευση και υποστήριξη των δεδομένων με τις απαραίτητες χωρικές σχέσεις. 
• Προσαρμογή-ένταξη των δεδομένων σε ένα κοινό χαρτογραφικό σύστημα 

συντεταγμένων. 
• Διαχείριση των δεδομένων (όπως έρευνα και ανάκτηση πληροφοριών, υπολογισμούς 

και συσχετισμούς μέσω μαθηματικών πράξεων κ.λ.π.). 
• Εκμάθηση-χρήση προγραμματισμού, για την ανάπτυξη ειδικών προγραμμάτων ή και 

μοντέλων απαραίτητων για τις ανάγκες μελετών και γενικότερα την αλληλεπίδραση με 
τον χρήστη. 

• Παρουσίαση αποτελεσμάτων, για ολόκληρη την περιοχή μελέτης ή και για επιμέρους 
τμήματα αυτής, συγκεκριμένων χαρακτηριστικών και σε οποιαδήποτε κλίμακα, με μια 
μεγάλη ποικιλία διαφορετικών τρόπων (έντυπης ή ηλεκτρονικής μορφής), όπως: 
χάρτες, πίνακες, παρουσίαση σε video, σε CD κ.ά. 

• Έχουν αρθρωτή δομή, ώστε να είναι μικρά σχετικά σε όγκο και εύχρηστα. 
• Και φυσικά, το κυριότερο όλων την ικανότητα λήψεως αποφάσεων, σε συγκεκριμένα 

ερωτήματα. 
 
 Προκειμένου να λειτουργήσει ένα σταθμός ΣΓΠ, απαραίτητο είναι να υποστηρίζεται από 
έναν ή περισσότερους  εξελιγμένους, υψηλών προδιαγραφών Η/Υ, ένα ισχυρό πακέτο 
επεξεργασίας, ένα ευέλικτο και πλήρες σύστημα περιφερειακών εισαγωγής και εξαγωγής 
δεδομένων και φυσικά από προσωπικό κατάλληλα εκπαιδευμένο (εικ. 7.1). 
 

 

 
 
Εικόνα 7.1. ΣΓΠ είναι ένα Σύστημα 
αποτελούμενο από 5  βασικά 
συστατικά:  
Ανθρώπινο Δυναμικό – Δεδομένα – 
Ανάλυση - Εξοπλισμό – Λογισμικό 
(ESRI, 2000). 
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Στις εικόνες 7.2 και 7.3 φαίνονται η διαφορετικού είδους πληροφορία που δύναται να 
επεξεργασθεί ένα ΣΓΠ, οι αντίστοιχοι παραγόμενοι θεματικοί χάρτες και η βάση 
δεδομένων ενός θεματικού επιπέδου με την περιγραφική πληροφορία του. 
 
7.4. Δεδομένα 
 
7.4.1. Κατηγορίες Δεδομένων 
 
Τα ψηφιακά δεδομένα, ανάλογα με την φύση και το περιεχόμενό τους διακρίνονται σε 
δυο κατηγορίες, τα χωρικά και τα περιγραφικά: 
 
α) Τα χωρικά δεδομένα (spatial data), χαρακτηρίζονται από την θέση, το σχήμα και τις 
υφιστάμενες σχέσεις μεταξύ γεωγραφικών χαρακτηριστικών. Συνήθως αποθηκεύονται 
ως συντεταγμένες. Προκειμένου να επεξεργασθούν από το σύστημα πρέπει να 
μετασχηματισθούν σε ψηφιακή μορφή, εαν δεν είναι. Αυτό επιτυγχάνεται είτε με την 
απευθείας ψηφιοποίηση των χαρτών μέσω του ψηφιοποιητή (digitizer), ή από την οθόνη 
του υπολογιστή με αυτόματη ή ημιαυτόματη σάρωση (scanning) μέσα από το σύστημα, 
εφόσον πρώτα έχει υποστεί σάρωση μέσω σαρωτή και έχει μετατραπεί σε αρχείο 
εικόνας (tiff, ipg κ.ά.). Τα ψηφιακά δεδομένα ταξινομούνται σε τέσσερις κατηγορίες : 

• Σημειακά δεδομένα

• 

: αφορούν σημεία και δεν εξαρτώνται από την κλίμακα. Είναι 
επίκεντρα σεισμών, θέσεις μετρήσεων GPS, θέσεις γεωτρήσεων ή 
δειγματοληψίας, υψομετρικά σημεία, σημεία αρχής και τέλους γραμμικών 
δεδομένων κ.ά. 
Γραμμικά δεδομένα

• 

: ορίζονται από διαδοχικά σημειακά δεδομένα και έχουν σημείο 
αρχής και τέλους. Κύριο χαρακτηριστικό τους είναι το μήκος. Το υδρογραφικό 
δίκτυο, οι υδροκρίτες, το οδικό δίκτυο, τα ρήγματα, οι άξονες πτυχών, οι 
επωθήσεις, οι εφιππέυσεις, οι μορφολογικές ασυνέχειες, οι μετακινήσεις γραμμών 
ακτών, τα  όρια γεωλογικών σχηματισμών, κ.ά. είναι γραμμικά δεδομένα. 
Επιφανειακά δεδομένα

• 

, όπου καταλαμβάνουν μια έκταση (πολύγωνο), το οποίο 
ορίζεται από γραμμικά δεδομένα και έχει συγκεκριμένο σημείο αρχής και τέλους. 
Επηρεάζονται από την κλίμακα του χάρτη. Τα πολύγωνα των γεωλογικών 
σχηματισμών, των επιφανειών επιπέδωσης, των ρηξιτεμαχών, των 
μακροσεισμικών εντάσεων, των επικινδύνων ζωνών για κατολίσθηση κ.ά. 
αποτελούν επιφανειακά δεδομένα. 
Δεδομένα αναγλύφου ή τρισδιάστατα

 

, όπου δεν καταλαμβάνουν μόνο μια 
συγκεκριμένη επιφάνεια αλλά επεκτείνονται και στον χώρο, έχουν δηλαδή τρεις 
διαστάσεις και αποτελούν επιφάνειες όπου περιέχουν και την διάσταση του ύψους, 
όπως η τρισδιάστατη εμφάνιση του αναγλύφου. 

β) Τα περιγραφικά δεδομένα (descriptive data), σχετίζονται ή περιγράφουν τα 
γεωγραφικά χαρακτηριστικά της υπόψην χωρικής θέσης και δίδονται υπό μορφήν 
πινάκων ή κειμένου. Είναι ποιοτικά (χαρακτηριστικά - ιδιότητες) ή ποσοτικά (αριθμητικά - 
στατιστικά), για το συγκεκριμένο σημειακό, γραμμικό, επιφανειακό δεδομένο, ή δεδομένο 
αναγλύφου που προσδιορίζουν και καταχωρούνται στην βάση δεδομένων (πίνακα 
χαρακτηριστικών). Δίνουν πληροφορίες σχετικά με το όνομα - το πάχος - την ηλικία - την 
φάση - τα τεχνικο-γεωλογικά χαρακτηριστικά ενός γεωλογικού σχηματισμού, το άλμα - το 
μήκος - την διεύθυνση - την κλίση του ρήγματος, το μέγεθος - το βάθος - την ημερομηνία 
γένεσης του σεισμού, την επί τοις % μορφολογική κλίση του αναγλύφου, αποτελέσματα 
γεωχημικών αναλύσεων, εδαφικών μετακινήσεων και παραμορφώσεων κ.ά. 
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Εικόνα 7.2. Ένα ΣΓΠ διαχειρίζεται πλήθος δεδομένων του γεωγραφικού χώρου 

Τεκτονική 
 
Γεωλογία 
 
Σκιασμένο Ανάγλυφο 
 
Πραγματικότητα - 
Σύνθεση Θεματικών 
επίπεδων: 

• Ισοϋψείς 
• Τριγωνομετικά Σημεία 
• Υψομετρικά Σημεία 
• Υδρογραφικό Δίκτυο 
• Γεωλογικοί 

Σχηματισμοί 
• Τεκτονικά Δεδομένα 
• Ρήγματα 
• Τεκτονικά και 

Γεωλογικά Δεδομένα 
από ερμηνεία 
Δορυφορικών Εικόνων 
................. 
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Εικόνα 7.3. Γεωλογικός Χάρτης Αργολίδας με το ΣΓΠ ArcGIS και τμήμα από την βάση δεδομένων 
του θεματικού επιπέδου των γεωλογικών σχηματισμών (Βασιλοπούλου, 1999). 
 
 
7.4.2. Ψηφιακή Αναπαράσταση των Χωρικών Οντοτήτων - Δομή Δεδομένων 
 
Η καταγραφή των γεωγραφικών στοιχείων-φαινομένων-οντοτήτων στην βάση 
δεδομένων του συστήματος, αφορά τόσο στον μετασχηματισμό των δεδομένων από 
αναλογικά σε ψηφιακά, όσο και στην δημιουργία ενός προτύπου μοντέλου οργάνωσης 
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και επεξεργασίας των πληροφοριών του γεωγραφικού χώρου. Συνοπτικά η διαδικασία 
αναπαράστασης των χωρικών οντοτήτων-φαινομένων σε ψηφιακή μορφή, αναλύεται σε 
τέσσερα επίπεδα φάσεις: 
 

Εξέταση των χωρικών οντοτήτων-φαινομένων, όπως αυτά πραγματικά υφίστανται, 
περιέχοντας όλα τα χαρακτηριστικά, τα οποία υποπίπτουν ή όχι στην ανθρώπινη 
αντίληψη. 

Πραγματικότητα  

 

Αφαίρεση της πραγματικότητας που περιέχει μόνο τα χαρακτηριστικά εκείνα των 
χωρικών οντοτήτων-φαινομένων, που είναι χρήσιμα στην συγκεκριμένη εφαρμογή. 

Μοντέλο 

 

Αναπαράσταση του μοντέλου σχεδιασμένη για την ψηφιακή εγγραφή και επεξεργασία 
των δεδομένων χωρικών οντοτήτων-φαινομένων. 

Δομή Δεδομένων 

 

Αποθήκευση των χωρικών οντοτήτων-φαινομένων στις περιφερειακές μονάδες του Η/Υ 
με οργάνωση που να καλύπτει τις ιδιαίτερες απαιτήσεις της εφαρμογής.  

Αρχειοθέτηση 

 
Τα συστήματα ψηφιακής χαρτογραφίας και τα ΣΓΠ χρησιμοποιούν εννοιολογικά χωρικά 
μοντέλα για την ψηφιακή καταγραφή των γωγραφικών μοντέλων. Τα βασικά 
εννοιολογικά χωρικά μοντέλα είναι τα διανυσματικά (vector) και τα μοντέλα καννάβου 
(grid ή raster), (Εικ. 7.4). 
 

• Στην διανυσματική δομή οι χωρικές οντότητες παρουσιάζονται ως έχουν στις 
τρεις διαστάσεις, όπου οι δύο αναπαριστούν την θέση και το σχήμα τους στην 
επιφάνεια του εδάφους, ενώ η τρίτη ορίζει την πληροφορία.  

 
Ένα σημείο στην επιφάνεια είναι ένα απλό στοιχείο και ορίζεται από ένα απλό 
ζευγάρι ψηφιακών συντεταγμένων. Οι γραμμές αναπαρίστανται από τις 
συντεταγμένες των σημείων αρχής-τέλους και των ενδιαμέσων κορυφών τους. 
Περιοχές του εδάφους εκφράζονται ως πολύγωνα -συντιθέμενα από ευθύγραμμα 
τμήματα- και ορίζονται ψηφιακά από τις συντεταγμένες των κορυφών τους. 
Οσιαστικά, η διανυσματική δομή δεδομένων επιπέδου είναι η απ’ ευθείας 
μετάφραση των πρωτογενών χαρτών.  

 
• Η δομή grid βασίζεται  στην αναπαράσταση (μέσω του συστήματος) της 

μελετούμενης περιοχής με πίνακα αποτελούμενο από κελιά (cells) ομοιομόρφου 
μεγέθους και σχήματος, διατεταγμένα σε γραμμές και στήλες. Τα κελιά είναι 
τετράγωνα, τρίγωνα, εξάγωνα ή άλλα κανονικά πολύγωνα.  Άν και η δομή 
καννάβου είναι γενικά απλούστερη στην χρήση από την διανυσματική, δεν 
καταγράφει περιοχές ή γραμμές με μεγάλη ακρίβεια. Η ακρίβεια εξαρτάται από το 
μέγεθος του κελιού. Μικρότερης διαστάσεως κελιά αναπαριστούν καλύτερα την 
πληροφορία. Οι διαστάσεις των κελιών δεν δίδονται αυθαίρετα. Εξαρτώνται από 
την πυκνότητα των δεδομένων, κλίμακα μελέτης κ.ά.  
 

• Η δομή raster διαφέρει από την δομή grid στην έννοια της εισαγωγής των 
δεδομένων. Τα raster δεδομένα δύνανται να παραχθούν αυτόματα με σάρωση. Η 
δομή raster είναι η καλύτερη μέθοδος για την παρουσίαση των χωρικών 
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δεδομένων αλλά είναι ικανή επίσης να χρησιμοποιήσει την θεματική πληροφορία. 
Τα αντικείμενα μιας εικόνας παράγονται ανάλογα με την τιμή της κυψελίδας που 
καθορίζεται από τον χρήστη ή αυτόματα. Το εύρος των αναλογικών τιμών 
μετατρέπεται στο κανονικό εύρος από 0-255 που χρησιμοποιείται στην 
επεξεργασία εικόνας και η τιμή κάθε κυψελίδας αντικαθίσταται. Η raster δομή 
είναι ουσιώδης για τα δεδομένα τηλεανίχνευσης, πολλά από τα οποία ούτως ή 
άλλως λαμβάνονται σε αυτήν την δομή (ψηφιακές δορυφορικές εικόνες). Επίσης 
είναι η πιο συμβατή δομή δεδομένων στους υπολογιστές από οποιαδήποτε άλλη. 

 
Τα δεδομένα καννάβου είναι: 
 

• Συνεχή (συνήθως είναι πραγματικοί ή ακέραιοι αριθμοί), όπως υψόμετρα 
• Ασυνεχή ή διακριτά ή κατηγοριοποιημένα (συνήθως είναι φυσικοί αριθμοί), όπως 

κωδικοποίηση ποιοτικών χαρακτηριστικών (καλλιέργειες κ.ά.). 
 

                                    
Διανυσματική Δομή 

                       
Σημείο                          Γραμμή                              Πολύγωνο 

 
 

 Δομή Καννάβου 

 
 

        Εικόνα 7.4. Αναπαράσταση δεδομένων με διανυσματική δομή και δομή καννάβου  
 
 
 7.4.3. Πηγές Δεδομένων 
 
Τα δεδομένα που μελετώνται και επεξεργάζονται σε ΣΓΠ, όσον αφορά τις γεωεπιστήμες, 
αφορούν σε εργασίες πεδίου (γεωλογική ή άλλου είδους χαρτογράφηση όπως χρήσεων 
γης, τοπογραφική κ.ά., μετρήσεις GPS, μελέτη γεωφυσικά ιδιοτήτων, βυθομετρικά 
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δεδομένα κ.ά.), βιβλιογραφικές αναφορές (παλαιότεροι χάρτες και μελέτες), ascii αρχεία 
(κατάλογοι σεισμικών επικέντρων) δορυφορικές εικόνες, αεροφωτογραφίες, κ.ά. 
 
7.4.4. Είδη Δεδομένων 
 

 
α) Επίγεια Δεδομένα 

Γεωλογικά  (λιθολογία ή γεωλογική δομή μιας περιοχής) 
Τεκτονικά (ρήγματα, τεκτονικές επαφές κ.ά.) 
Γεωφυσικά (μαγνητοτελλουρικά, βαρυτικά κ.ά.) 
Σεισμολογικά (επίκεντρα σεισμών με τα χαρακτηριστικά τους) 
Υδρογεωλογικά (θέσεις γεωτρήσεων, χαρακτηριστικά υδροφόρου ορίζοντα, κ.ά) 
Τοπογραφικά (υψομετρικά, οδικό δίκτυο, οικοδομικά τετράγωνα κ.ά.)  
Μορφολογικά (μορφολογικές κλίσεις, προσανατολισμός κλίσεων, επιφάνειες 
επιπέδωσης κ.ά.) 
Γεωχημικά (χημικές ιδιότητες ορυκτών και πετρωμάτων) 
Ωκεανογραφικά (χαρτογράφιση και παρακολούθηση θαλασσίων ρευμάτων, γραμμών 
ακτών, ρύπανσης κ.ά.) 
Γεωτεχνικά (Γεωτεχνικές ιδότητες γεωλογικών σχηματισμών) 
Διαφόρου είδους θεματικά δεδομένα (βλάστηση, δασοκάλυψη, χρήσεις γης, είδος 
εδάφους, κατανομή επιφανειακής θερμοκρασίας εδάφους κ.ά.) 
 

 
β) Δορυφορικά Δεδομένα  

Οι μετρήσεις GPS και οι δορυφορικές εικόνες είναι δορυφορικά δεδομένα, τα οποία 
δύνανται να αποτελέσουν επίπεδα πληροφορίας σε ένα ΣΓΠ. Συνδυάζονται και 
διαχειρίζονται από το σύστημα. Ερμηνεύονται και βοηθούν στην εξαγωγή 
συμπερασμάτων.  
 
Τα δεδομένα GPS δίνουν συντεταγμένες και στοιχεία για την επιφανειακή 
παραμόρφωση (οριζόντια και κατακόρυφη) μιας περιοχής μελέτης. 
 
Οι δορυφορικές εικόνες δίνουν στοιχεία για την επιφανειακή παραμόρφωση μιας 
περιοχής (εικόνες ραντάρ – συμβολομετρία) αλλά και για την τεκτονική (διάκριση 
τεκτονικών ζωνών), γεωλογία (διάκριση γεωλογικών σχηματισμών), μορφολογία 
(διάκριση γεωμορφολογικών δομών) κ.ά., μέσω φωτοερμηνείας ή ταξινόμησης-
κατηγοριοποίησης μέσω ειδικών λογισμκών επεξεργασίας δορυφορικών εικόνων. 
Επίσης, εξάγονται πληροφορίες για την επιφανειακή θερμοκρασία περιοχών μελέτης 
(ηφαιστείων κ.ά), πλημμύρων, πυρκαγιών, tsunamis κ.ά., μέσω επεξεργασίας των 
εικόνων από ειδικά λογισμκά. Τα εξαγόμενα αποτελούν θεματικά επίπεδα σε ένα ΣΓΠ. 
Σε επόμενο κεφάλαιο θα αναπτυχθούν οι δορυφορικές εικόνες και η χρήση τους. 
 
7.4.5. Επεξεργασία Δεδομένων 
 
Προκειμένου να πραγματοποιηθεί οποιαδήποτε μελέτη, μέσω Συστήματος Γεωγραφικών 
Πληροφοριών, ακολουθείται μια σειρά από διαδικασίες (επεξεργασία δεδομένων), 
ξεκινώντας από την συγκέντρωση και εισαγωγή  των δεδομένων στο σύστημα έως την 
εξαγωγή των συμπερασμάτων. Ακολουθούνται οι αρχές της Ψηφιακής Χαρτογραφίας, με 
τα επιπλέον πλεονεκτήματα των ΣΓΠ ως προς την οργάνωση  και διαχείριση βάσης 
δεδομένων καθώς και την δημιουργία συστήματος λήψεως αποφάσεων. Η επεξεργασία 
των δεδομένων περιλαμβάνει γενικά τα ακόλουθα στάδια: 
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α) Συλλογή - Εισαγωγή Δεδομένων στο Σύστημα:
 

  

Το πρώτο στάδιο περιλαμβάνει την συλλογή και προετοιμασία των διαφόρων 
γεωγραφικών δεδομένων, τα οποία είναι χάρτες σε αναλογική μορφή (γεωλογικοί, 
σεισμοτεκτονικοί, γεωφυσικών δεδομένων, γεωπεριβαλλοντικοί κ.ά.), δορυφορικές 
εικόνες, στατιστικά αρχεία, πίνακες, αρχεία ascii  (επίκεντρα σεισμών, μετρήσεις  GPS) 
κ.ά. Τα δεδομένα ταξινομούνται σε γεωγραφικές ενότητες (θεματικά επίπεδα-
επικαλύψεις), όπου κάθε στοιχείο μέσα σε αυτές ορίζεται από την γεωγραφική θέση 
(χωρική πληροφορία) και τα περιγραφικά χαρακτηριστικά του (περιγραφική 
πληροφορία). Οι ενότητες αυτές αναπαρίστανται στην εικόνα 7.5 και είναι των:  

• Σημειακών χαρτογραφικών στοιχείων 
• Γραμμικών χαρτογραφικών στοιχείων 
• Πολυγωνικών-Επιφανειακών χαρτογραφικών στοιχείων  

Εν συνεχεία, οι ενότητες χωρίζονται σε υπο-ενότητες (θεματικές ενότητες) ανάλογα με τα 
χαρακτηριστικά που εμπεριέχουν και τις απαιτήσεις της μελέτης, όπως:  

* των ρηγμάτων  
* των επωθήσεων και εφιππεύσεων 
* των γεωλογικών σχηματισμών 
* των τοπογραφικών στοιχείων (οδικό δίκτυο, οικοδομικά τετράγωνα κ.ά.) 
* των γεωμορφολογικών ορίων 
* των σεισμικών επικέντρων 
* των μακροσεισμικών εντάσεων 
* των μετρήσεων GPS (θέσεις μετρήσεων, κατακόρυφη εδαφική 

παραμόρφωση, οριζόντια εδαφική παραμόρφωση) 
* των χρήσεων γης 
* κ.ά. 
 

Ακολουθεί η εισαγωγή στο σύστημα καθεμιάς από τις παραπάνω θεματικές ενότητες 
των χωρικών δεδομένων, η μετατροπή τους σε ψηφιακή μορφή αν δεν είναι (μέσω 
ψηφιοποίησης, σάρωσης) και η διόρθωση λαθών, που προέκυψαν κατά την 
ψηφιοποίηση. 
 
β) Αναγωγή Συντεταγμένων σε συγκεκριμένη Χαρτογραφική Απεικόνιση ή Γεωαναφορά  
(Georeference) δεδομένων:
 

  

Επιτυγχάνεται η ένταξη των δεδομένων σε ένα κοινό σύστημα συντεταγμένων. Είναι 
απαραίτητη η γνώση της χαρτογραφικής απεικόνισης ή των χαρτογραφικών 
απεικονίσεων των επιμέρους χαρτών. Επιτυγχάνεται μέσω συγκεκριμένων 
μετασχηματισμών μέσα από το σύστημα. 
 

 
γ) Δόμηση τοπολογίας: 

Τοπολογία ορίζεται η μαθηματική διαδικασία που προσδιορίζει τις χωρικές σχέσεις των 
στοιχείων του γεωγραφικού χώρου, οι οποίες παραμένουν αμετάβλητες σε κάθε 
μαθηματικό μετασχηματισμό (απεικόνιση, γενίκευση). Χατογραφικά, μέσω της 
τοπολογίας, προσδιορίζεται η σύνδεση μεταξύ των στοιχείων. Καθορίζεται ο τρόπος 
ένωσης μεταξύ γραμμών, κόμβων, πολυγώνων κ.ά. 
 
Η κάθε θεματική ενότητα-θεματικό επίιπεδο πληροφορίας, μετά την ψηφιοποίηση, 
περιέχει μόνο χωρική πληροφορία. Στο συγκεκριμένο στάδιο δομείται η τοπολογία. 
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Δίδονται, δηλαδή, οι χωρικές σχέσεις μεταξύ των γεωγραφικών στοιχείων κάθε 
θεματικού επιπέδου, με συγκεκριμένες εντολές. Δημιουργούνται και ενημερώνονται οι 
πίνακες χαρακτηριστικών (βάση δεδομένων) των γεωγραφικών στοιχείων. 
Δημιουργούνται οι κωδικοί αναγνώρισης (εσωτερικός κωδικός και κωδικός χρήστη) κάθε 
στοιχείου και υπολογίζονται τα γεωμετρικά χαρακτηριστικά του.  
Εάν δεν υπάρχει τοπολογία δεν είναι δυνατή η ανάλυση της βάσης, η δημιουργία 
ερωτήσεων και η λήψη απαντήσεων και κυρίως η δημιουργία συστήματος λήψεως 
αποφάσεων. 
 
Ανάλογα με την κατηγορία των δεδομένων που περιέχει το κάθε θεματικό επίπεδο 
(σημεία, γραμμές και πολύγωνα), δομείται τοπολογία σημείου, γραμμής, πολυγώνου. 
Είναι επίσης δυνατή η δημιουργία διπλής τοπολογίας, όπως γραμμής και πολυγώνου σε 
ένα πολυγωνικό θεματικό επίπεδο, ανάλογα με τις ανάγκες της μελέτης. 
 
Τοπολογία σημείου 

• Δημιουργούνται οι κωδικοί αναγνώρισης, χαρακτηριστικοί κάθε σημείου του 
θεματικού επιπέδου 

 
Τοπολογία γραμμής 

• Δημιουργούνται οι κωδικοί αναγνώρισης, χαρακτηριστικοί για κάθε γραμμή-τόξο 
• Δίδονται πληροφορίες σχετικές με την αρχή και το τέλος της γραμμής (αριθμός 

κόμβου αρχής και τέλους) 
• Οι γραμμές που τέμνονται πρέπει να ταυτίζονται σε κόμβο 
• Υπολογίζεται το μήκος τόξου 
• Δίδονται πληροφορίες για τα πολύγωνα αριστερά και δεξιά του τόξου (εάν το 

θεματικό επίπεδο είναι πολυγωνικό και έχει διπλή τοπολογία). 
 
Τοπολογία πολυγώνου 

• Δημιουργούνται οι κωδικοί αναγνώρισης, χαρακτηριστικοί για κάθε πολύγωνο 
• Ένα πολύγωνο δεν είναι ποτέ ανοικτό. 
• Υπολογίζεται η περίμετρος και το εμβαδόν κάθε πολυγώνου 
• Δίδονται πληροφορίες για τα γειτονικά πολύγωνα κάθε πολυγώνου 
• Εάν το θεματικό επίπεδο έχει και γραμμική τοπολογία δίδονται και οι 

πληροφορίες των τόξων των πολυγώνων. 
 

 
δ) Ανάπτυξη της Βάσης: 

Εφόσον δομηθεί η τοπολογία, ενημερώνεται ο πίνακας χαρακτηριστικών κάθε θεματικού 
επιπέδου μέσω νέων πεδίων (Εικ. 7.6). Τα πεδία ενημερώνονται με κωδικούς, κοινούς 
για όμοια στοιχεία ή οποιαδήποτε απαραίτητη πληροφορία.   
 
Χωρίζονται κατηγορίες-υποδιαιρέσεις μιας συγκεκριμμένης ενότητας, όπως: στην 
ενότητα των ρηγμάτων τα ενεργά ρήγματα με άλμα > 150m έχουν κοινό κωδικό και 
ορίζουν συγκεκριμένη ομάδα, διαφορετική από εκείνη των ενεργών ρηγμάτων με άλμα < 
150m. Το ίδιο ισχύει για τους γεωλογικούς σχηματισμούς τα σεισμολογικά δεδομένα κ.ά.  
 
Σημειώνεται ότι στα γραμμικά και στα σημειακά δεδομένα μια αρχική κατηγοριοποίηση 
δύναται να ξεκινήσει από το στάδιο της ψηφιοποίησης, προσδίδοντας εκεί 
συγκεκριμένους κωδικούς. Στα πολυγωνικά δεδομένα η κατηγοριοποίηση ξεκινά μετά 
την δόμηση τοπολογίας, με την εισαγωγή ετικετών, κοινών για κάθε ομάδα πολυγώνων.  
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Στο συγκεκριμένο στάδιο, όπου αναπτύσσεται η βάση δεδομένων, προστίθεται η 
διαθέσιμη περιγραφική πληροφορία των χωρικών δεδομένων, είτε απευθείας μέσα στο 
σύστημα, είτε από έτοιμα αρχεία-πίνακες που προστίθενται στην βάση δεδομένων.  
 

 
 
Εικόνα 7.5. Διάκριση δεδομένων σε σημειακά, γραμμικά και πολυγωνικά. 

 
ε) Γεωγραφική Ανάλυση της Βάσης:
 

  

Εφόσον εμπλουτιστεί η βάση δεδομένων όσο το δυνατόν με περισσότερη πληροφορία 
και δομηθεί όσο το δυνατόν καλύτερα ως προς τον τρόπο εισαγωγής και ταξινόμησης 
αυτής της πληροφορίας, ξεκινάει η διαχείριση - ανάλυση της βάσης μέσω των 
Προγραμμάτων RBMS, ώστε να δοθούν απαντήσεις στα ερωτήματα που τέθηκαν σαν 
στόχος από την αρχή (Εικ. 7.7). Ανά πάσα στιγμή βέβαια, η βάση δύναται να 
διορθώνεται ή να εμπλουτίζεται με νέα στοιχεία, ανάλογα με τα νεώτερα δεδομένα και τις 
εκάστοτε εξελίξεις και ανάγκες.  
 
στ) Παρουσίαση Αποτελεσμάτων:
 

  

Το τελικό προϊόν ενός ΣΓΠ είναι η σύνθεση - παρουσίαση ενός ή περισσοτέρων χαρτών 
με τα επιθυμητά επίπεδα πληροφορίας που εμφανίζονται με συγκεκριμένα χρώματα ή 
σύμβολα ανά συγκεκριμένη ομάδα όμοιων δεδομένων. Επίσης είναι δυνατή η παραγωγή 
διαγραμμάτων καθώς και πινάκων (Εικ. 7.8 – 7.10). 
 
Σημειώνεται ότι συνήθως το ζητούμενο κατά την ανάπτυξη ενός ΣΓΠ, είναι η δημιουργία 
συστήματος λήψεως αποφάσεων, μέσα από την οργάνωση, ανάλυση και διαχείριση μιας 
σχεσιακής βάσης δεδομένων, η οποία ανά πάσα στιγμή δίναται να ενημερωθεί.  
 

Γραμμές 
Ισοϋψείς 

Σημεία 
Υψομετρικά Σημεία 

    Βάση  
Δεδομένων 

Πολύγωνα 

 

Γεωλογικοί Σχηματισμοί 
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Εικόνα 7.6. Κάθε στοιχείο του θεματικού επιπέδου αντιστοιχίζεται σε συγκεκριμένη 
εγγραφή μέσω μοναδικού κωδικού. 

 

 
Εικόνα 7.7. Κατόπιν αναλύσεως της βάσης δεδομένων της Νήσου Κεφαλληνίας με το ArcGIS, 
δόθηκε απάντηση (γκρι πολύγωνα) στην ερώτηση: Ποια περιοχή είναι κατάλληλη να 
οικοδομηθεί? Οι περιοχές που θα οριοθετηθούν από το σύστημα, πρέπει να πληρούν τις 
προϋποθέσεις: ασβεστόλιθοι με μικρές κλίσεις (0% - 15%), και σε 1km απόσταση από τις 
ρηξιγενείς ζώνες. Η κατακόρυφη παραμόρφωση, πρέπει να κυμαίνεται μεταξύ -20mm έως 20mm 
(Vassilopoulou et al., 2007). Δίδονται λεπτομέρειες στο κεφ. 14.1.1. 
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Εικόνα 7.8.  
Ορθο-αναγώμενη 
Δορυφορική Εικόνα 
Νισύρου LANDSAT-7 
(θερμικό κανάλι 6-1). 
Διακρίνεται η επιφανειακή 
κατανομή της 
θερμοκρασίας, όπως 
προέκυψε από την 
επεξεργασία της εικόνας με 
το λογισμικό ATCOR-2. Η 
ανάπτυξη ΣΓΠ για την 
παρακολούθηση του 
ηφαιστείου, έγινε με χρήση 
του ArcGIS (Lagios et al., 
2007). 
Δίδονται λεπτομέρειες στο 
κεφ. 14.2.3. 

 

 

 
 
 
 
Εικόνα 7.9.  
Κατανομή Φαινόμενης 
Ειδικής Αντίστασης στις 
Συχνότητες  108,835 Hz, 
0,469 Hz,   0,070 Hz και 
0,035 Hz:, στην Νίσυρο 
(περιοχή Λακκί και νότια)  
με την μέθοδο IDW, στο 
ArcGIS. Οι μετρήσεις 
πραγματοποιήθηκαν κατά 
τον Μάϊο 1989 και Ιούνιο 
1991 από τον Καθηγητή κ. 
Ευάγγελο Λάγιο & 
συνεργάτες, Τομέας 
Γεωφυσικής-Γεωθερμίας,  
Τμ. Γεωλογίας & 
Γεωπεριβάλλοντος, ΕΚΠΑ. 
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Εικόνα 7.10. Χάρτης Οριζόντιας και Κατακόρυφης Εδαφικής Παραμόρφωσης Ευρύτερης Περιοχής Αταλάντης, όπως προέκυψε από 
μετρήσεις GPS, με το λογισμικό «ΠΡΩΑΝΑ».   Η ανάπτυξη ΣΓΠ για την μελέτη της περιοχής, έγινε με χρήση του ArcGIS (Λάγιος κ.ά, 
2002). 
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7.5. Ποιότητα Δεδομένων 
 
Τα χωρικά δεδομένα που εισάγονται σε ένα ΣΓΠ θεωρούνται ότι είναι απαλλαγμένα 
σφαλμάτων. Φυσικά αυτό δεν ισχύει στην πραγματικότητα. Η ποιότητα των δεδομένων 
εξαρτάται από την ακρίβεια αυτών, από τον τρόπο κωδικοποίησησής τους και την 
προέλευσή τους (αναλογικοί χάρτες, ascii αρχεία, μετρήσεις ή παρατηρήσεις πεδίου, 
δορυφορικά δεδομένα κ,ά.). Η ανακρίβεια των δεδομένων γενικά σχετίζεται με τα όργανα 
μέτρησης και των τεχνικών μετάφρασης των αποτλεσμάτων, τον τρόπο χρησιμοποίησης 
των οργάνων, των τεχνικών επεξεργασίας δεδομένων. Οι παράγοντες που 
διαμορφώνουν την ποιότητα των δεδομένων σχετίζονται με την ακρίβεια, την ορθότητα, 
την ανάλυση, την κλίμακα και το σφάλμα: 
 
Ακρίβεια (Accuracy): Θεωρείται η διαφορά ανάμεσα σε μια καταγεγραμμένη τιμή 
(μέτρηση ή παρατήρηση) και στην πραγματική τιμή. Αφορά στην υπαρκτή πιθανότητα 
διαφοράς της καταγεγραμένης τιμής και της αληθούς τιμής του φαινομένου που 
αναφέρεται. Ποσοτικοποιείται μέσω του σφάλματος. 
 
Ορθότητα (Precision): Αναφέρεται στον βαθμό λεπτομέρειας με τον οποίο 
καταγράφεται μια τιμή. Για αριθμητικά δεδομένα συνδέεται με τον αριθμό σημαντικών 
ψηφίων. 
 
Ανάλυση (Resolution): Θεωρείται η μικρότερη διακριτή διαφορά ανάμεσα σε δύο 
μετρούμενες τιμές, δηλαδή η μικρότερη απόσταση στην οποία δύναται να καταγραφεί 
μεταβολή. Σε έναν χάρτη, ο οποίος είναι αναγνώσιμος από το ανθρώπινο μάτι, η 
ανάλυση καθορίζεται από το μικρότερο πάχος γραμμής (π.χ. όριο γεωλογικού 
σχηματισμού). Σε συστήματα σχεδίασης γραφικών, η καλύτερη ανάλυση καθορίζεται 
θεωρητικά από απόσταση μεταξύ των φατνίων του συστήματος.   

 
Κλίμακα (Scale): Η κλίμακα σμίκρυνσης αναφέρεται σε μια καταγεγραμμένη απόσταση 
σε έναν χάρτη και στην πραγματική απόσταση που αναπαριστά. Είναι ενδεικτική της 
ακρίβειας των δεδομένων και του επιπέδου γενίκευσης των δεδομένων. 

 
Σφάλμα (RMS): Είναι ένα μέτρο της αναμενόμενης ακρίβειας μιας μέτρησης. Πρόκειται 
για μια στατιστική έννοια που βασίζεται σε κάποια υπόθεση για την φύση της 
διαδικασίας μέτρησης. 

 
7.6. Διαφορές GIS – CAC – CAD 
 
Στο σημείο αυτό αξίζει να σημειωθεί η διαφορά των προγραμμάτων CAC (Computer 
Assisted Cartography) σε σχέση με τα GIS (Geographical Information Systems) και τα 
CAD (Computer Aided Design). 
 
 Τα συστήματα CAC είναι εξειδικευμένα προγράμματα, τα οποία αποτελούνται από 
επιμέρους προγράμματα που συνεργάζονται μεταξύ τους με σκοπό να διεκπεραιώσουν 
τις διάφορες χαρτογραφικές διαδικασίες που απαιτεί η Αυτοματοποιημένη Χαρτογραφία. 
Τέτοια επιμέρους προγράμματα είναι της διαχείρισης και απεικόνισης γραφικών, των 
χαρτογραφικών προβολών, της διαχείρισης της γεωμετρικής πληροφορίας, της 
διαχείρισης της θεματικής πληροφορίας, της δημιουργίας και διαχείρισης χαρτογραφικών 
συμβόλων και επιφανειών διαγράμμισης, της δημιουργίας και διαχείρισης 
γραμματοσειρών, δημιουργίας πλαισίου και υπομνήματος. Επίσης περιλαμβάνει βάση 
χαρτογραφικών δεδομένων και σχεδιαστικό αρχείο. 
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Η διαφορά τους με τα GIS και τα CAD έγκειται στον βασικό σκοπό της χρήσης του κάθε 
συστήματος, οπότε και στις δυνατότητες που κατά συνέπεια αυτά έχουν. Τα GIS σκοπό 
έχουν εκτός από την παρουσίαση χαρτών, την διαχείριση των δεδομένων για την λήψη 
αποφάσεων, κάτι που δεν έχουν τα CAC ούτε και τα CAD. Τα συστήματα CAD 
θεωρούνται υποσύνολα των GIS, διαχειρίζονται γραφικά και μη γραφικά δεδομένα αλλά 
όχι μεγάλου όγκου και ποικιλίας και τα οποία δεν μπορούν να αναλύσουν όπως το GIS 
αλλά ούτε και παρέχουν τις δυνατότητες χαρτογραφικών απεικονίσεων, όπως τα CAC. 
 
7.7. ΣΓΠ και Γλώσες Προγραμματισμού 
  

Ένα ΣΓΠ δεν δίνει λύσεις σε όλα τα προβλήματα και ιδιαίτερα σε απαιτήσεις 
εξειδικευμένης έρευνας. Ο προγραμματισμός αποτελεί βασικό εργαλείο στην ανάπτυξη 
ΣΓΠ και στην δημιουργία Συστημάτων Λήψης Αποφάσεων, ώστε να επιλύονται 
συγκεκριμένα  προβλήματα τόσο σε τοπικό όσο και σε εθνικό επίπεδο. Για τον λόγο 
αυτόν κάθε ΣΓΠ έχει ενσωματωμένη δική του γλώσσα προγραμματισμού. Με την χρήση 
της επιτυγχάνεται: 

• Αυτοματοποίηση λειτουργιών 
• Δημιουργία νέων εντολών 
• Προσαρμογή περιβάλλοντος εργασίας σύμφωνα με τις 

ανάγκες του χρήστη ή των απαιτήσεων εφαρμογής. 
• Απαντήσεις σε συγκεκριμένα ερωτήματα 

 
7.8.  ΣΓΠ  &  Διαδίκτυο (Web GIS) 
 
Τα διαδικτυακά ΣΓΠ ή Web GIS αποτελούν Συστήματα Γεωγραφικών Πληροφοριών 
μεγάλης κλίμακας, τα οποία παρέχουν τα απαραίτητα εργαλεία για την εισαγωγή, 
διαχείριση, επεξεργσία, ανάλυση και απεικόνιση των δεδομένων σε διαδικτυακές πύλες 
γεωγραφικού περιεχομένου. Πιο αναλυτικά επιτυγχάνονται τα ακόλουθα: 
• Ελεύθερη πρόσβαση, υψηλή ποιότητα και δυνατή η χρήση διαφόρων έτοιμων 

χαρτών και εργαλείων. 
• Δημιουργία διαφόρων ομάδων και συνεργασία σε διάφορα ερευνητικά 

προγράμματα. 
• Ανάπτυξη εφαρμογών στο διαδίκτυο. 
• Όλες οι εφαρμογές κάθε χρήστη αποτελούν επιμέρους τμήματα της κοινότητας 

των χρηστών και όλοι οι χάρτες είναι διαθέσιμοι στην κοινότητα. 
• Εξοικονόμηση χρόνου και χρήματος  

 
7.9. Μοντελοποίηση Επιφανειών 
 
Στα ΣΓΠ, η «επιφάνεια» είναι μια συνεχής δομή που αποτελείται έως και από έναν 
άπειρο αριθμό σημείων. Επί παραδείγματι, για την αναπαράσταση μιας περιοχής του 
αναγλύφου της γήινης επιφάνειας, χρησιμοποιούνται υψομετρικά σημεία. Η μεταβολή 
ορισμένων γεωφυσικών μεγεθών, όπως της «φαινόμενης ειδικής αντίστασης» σε μια 
συγκεκριμένη περιοχή μελέτης, αναπαρίσταται μετά από επεξεργασία (μέσω μεθόδων 
παρεμβολής) των μετρήσεων σε συγκεκριμένες θέσεις-σημεία της φαινόμενης ειδικής 
αντίστασης (εικ. 7.9). Όλα τα μεγέθη αναπαρίστανται στον άξονα (z) του τρισδιάστατου 
(x,y,z) συστήματος συντεταγμένων. Οι επιφάνειες αναπαρίστανται με σημειακά μοντέλα, 
τριγωνικά δίκτυα (ΤΙΝ) ή μοντέλα καννάβου (raster), (Κεφ. 8). 
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Πολλές μέθοδοι παρεμβολής παράγουν μοντέλα καννάβου. Αναφέρονται οι: IDW, 
Natural Neighbors, Spline, Kriging, Trend, topo to raster (ESRI, 2005
 

). 

Η μέθοδος IDW (Inverse Distance Weighted) ενδείκνυται για πυκνά και 
ισοκατανεμημένα δείγματα. Υπολογίζει τον μέσο όρο των τιμών των δειγμάτων πλησίον 
του κελιού που θα προσδιορισθεί η τιμή του. Μεγαλύτερη επιρροή έχουν τα πλησιέστρα 
σημεία. Η επιφάνεια δεν διέρχεται ανάμεσα από τα δείγματα αλλά χρησιμοποιεί τον μέσο 
όρο. Δεν δύναται να υπολογίσει λόφους και πεδιάδες.  
 
Η μέθοδος Natural Neighbors είναι μια πολύ καλή τεχνική όσον αφορά την επιλογή 
περιοχής επιρροής που είναι η πλησιέστερη περιοχή, για τα ζητούμενα σημεία και 
υπολογίζει τις τιμές των κελιών αναλογικά. Επίσης είναι πολύ καλή τεχνική για πολύ 
πυκνά δείγματα. 
 
Η μέθοδος Spline υπολογίζει τις τιμές των κελιών με μαθηματικές συναρτήσεις και 
ομαλοποιεί τις επιφάνειες. Η επιφάνεια διέρχεται ανάμεσα από τα σημεία της 
δειγματοληψίας. Υπολογίζει λόφους και πεδιάδες. Κατάλληλη μέθοδος για τον 
υπολογισμό ομαλά μεταβαλλόμενων επιφανειών (π.χ. θερμοκρασία).  
 
Η μέθοδος Kriging είναι μια γεωστατική μέθοδος, η οποία υποθέτει ότι η χωρική 
μεταβλητότητα στα δεδομένα είναι η ίδια παντού. Μοντελοποιεί την μεταβλητότητα με 
πολλές μεθόδους. Υπολογίζει λόφους και πεδιάδες.  
 
Η μέθοδος Trend ταιριάζει μια μοναδική πολυωνυμική επιφάνεια σε όλα τα δείγματα, η 
οποία είναι ομαλοποιημένη.  
 
Η μέθοδος topogrid ή topo to raster είναι η καλύτερη για την απόδοση του αναγλύφου 
μιας περιοχής. Δημιουργεί μια υδρολογικά ορθή επιφάνεια. Χρησιμοποεί, γραμμές, 
σημεία και πολύγωνα. 
 
Στις γεω-επιστήμες η αναπαράσταση των επιφανειών αφορά γενικά σε δύο τύπους 
επιφανειακών μοντέλων που διαφοροποιούνται ανάλογα με τα φαινόμενα που 
αναπαριστούν. Ο ένας έχει σκοπό την μοντελοποίηση φυσικών επιφανειών όπως πχ. 
του αναγλύφου, της γεωλογίας κ.ά. Ο δεύτερος έχει σκοπό την μοντελοποίηση 
αφηρημένων επιφανειών που αναπαριστούν την κατανομή λιγότερο απτών χωρικά 
μεταβαλλόμενων στατιστικών.  
 
Η αναπαράσταση μιας επιφάνειας είναι δυνατόν να επιτευχθεί με δύο ειδών τύπους 
αναπαράστασης, των ολοκληρωμένων ή μη ολοκληρωμένων: 
 
• Δειγματοληπτικά δεδομένα που είναι σημεία και αποδίδονται ως σημειακά δείγματα, 

γραμμικά δείγματα ή πολυγωνικά δίκτυα συνιστούν μη ολοκληρωμένες 
αναπαραστάσεις μιας επιφάνειας.  

 
• Η ολοκληρωμένη αναπαράσταση μιας επιφάνειας προκύπτει 
• από ένα σύνολο γειτονικών ζωνών που καθεμιά έχει μοναδική τιμή (πολυγωνικές 

ζώνες, δίκτυα τριγώνων – ΤΙΝ, τριγωνισμός Delaunay). 
• από μαθηματικές συναρτήσεις (γενικές μαθηματικές συναρτήσεις – πολυωνυμικές 

συναρτήσεις, ανάλυση Fourier, εκτίμηση επιφάνειας με πολυώνυμα ελαχίστων 
τετραγώνων, συναρτήσεις τύπου Spline). 
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8. ΨΗΦΙΑΚΑ ΜΟΝΤΕΛΑ ΑΝΑΓΛΥΦΟΥ - ΨΜΑ 
 
8.1. Γενικά  
 
Η επιφάνεια του εδάφους δεν είναι επίπεδη και μεταβάλλεται σε σχέση με τον χρόνο. 
Αποτελείται από βουνά, λόφους, πεδιάδες, έντονες χαράδρες, μορφολογικές ασυνέχειες, 
κ.λ.π., τα οποία διαφέρουν από περιοχή σε περιοχή και εκφράζουν στο σύνολό τους το 
ανάγλυφο (Εικόνα 8.1). 
 
Το ανάγλυφο αναπαρίσταται σε τρεις διαστάσεις ώστε η απόδοσή του σε χαρτί δύο 
διαστάσεων απαντά δυσκολίες.  Απαραίτητη είναι η απόδοση και η μελέτη του 
αναγλύφου σε πολλές εφαρμογές,  κυρίως γεωπεριβαλλοντικές. 
 

 
 
Εικόνα 8.1. Τμήμα αναγλύφου Νισύρου. Διακρίνεται τμήμα της καλδέρας και ο Κρατήρας 
Στέφανος. 
 
 
Ψηφιακό Μοντέλο Αναγλύφου (ΨΜΑ / Digital Terrain Model - DTM) ή Ψηφιακό 
Υψομετρικό Μοντέλο (Digital Elevation Model - DEM / ειδικότερα όταν πρόκειται για το 
υψόμετρο) ορίζεται ως:   
       η αναπαράσταση του αναγλύφου σε ψηφιακή μορφή 
       η μοντέρνα μορφή ενός τοπογραφικού χάρτη 
       η απόδοση της γεωμετρίας της γήινης επιφάνειας 
Είναι δυνατή η χρωματική απόδοση των υψομέτρων για καλύτερα οπτικά αποτελέσματα 
(Εικόνα 8.2).  
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Εικόνα 8.2.  Υψηλής ακριβείας ΨΜΑ (pixel size 2m) Νισύρου, παραγώμενο από τοπογραφικά 
δεδομένα των τοπογραφικών χαρτών κλίμακας 1/5000 της ΓΥΣ, με χρήση του αλγορίθμου 
“topogrid” του ArcGIS software (ESRI, 2001) από Vassilopoulou & Hurni (2001). Hellenic 
Geodetic Reference System 1987, Projection TM. 
 
 
8.2.  Είδη ΨΜΑ 
 
Τα είδη των ψηφιακών μοντέλων αναγλύφου είναι πολλά και εξαρτώνται από την δομή  
αποθήκευσης και τον τρόπο διαχείρισης των δεδομένων. Οι παρακάτω δομές 
χρησιμοποιούνται συνήθως: 
 
Σημειακά Μοντέλα: το ανάγλυφο αναπαρίσταται ως ένας κάνναβος σημείων, τα οποία 
ισαπέχουν μεταξύ τους (Εικόνα 8.3).  Σε κάθε σημείο (με συντεταγμένες χ,y) 
αποθηκεύεται μια τιμή υψομέτρου (z).  
 
Μοντέλα Καννάβου (GRID): ως σημειακό μοντέλο θεωρείται επίσης το μοντέλο 
καννάβου (GRID), παρ’ ότι εμφανίζει  ουσιαστικά διαφορετική μορφή της σημειακής 
δομής. Κάθε κυψελίδα του καννάβου δίνει τις υψομετρικές μεταβολές της επιφάνειας, 
όπου περιγράφονται μαθηματικά σαν υψόμετρο (z) σε συνάρτηση με τη θέση του 
(Εικόνα 8.4). Η θέση ορίζεται τόσο με γεωγραφικές συντεταγμένες (φ, λ) όσο και με 
ορθογώνιες συντεταγμένες (x,y) σε μια χαρτογραφική προβολή (π.χ. UTM). Στο κεφ. 
14.4.5 δίδεται η δημιουργία ΨΜΑ μορφής GRID μέσω του αλγορίθμου topogrid ή topo to 
raster ArcGIS. 
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Τριγωνικά Δίκτυα (TIN): το ανάγλυφο αναπαρίσταται από ένα σύνολο ακανόνιστων 
τριγώνων (Εικόνα8.5). Στην κορυφή κάθε τριγώνου (με συγκεκριμένες συντεταγμένες 
χ,y), αποθηκεύεται συγκεκριμένη τιμή υψομέτρου (z). Ο αλγόριθμος ΤΙΝ του ArcGIS 
χρησιμοποιεί σημεία γραμμές και πολύγωνα για την δημιουργία ακανονίστων τριγώνων 
τα οποία ικανοποιούν  κριτήριο Delaunay, όπου ένας κύκλος που διέρχεται από τις τρεις 
κορυφές κάθε τριγώνου δεν περιλαμβάνει άλλο σημείο. 

 
 

 
 
Εικόνα 8.4. Μοντέλο Καννάβου (με χρήση topogrid αλγορίθμου του ArcGIS) 

Εικόνα 8.3 . Σημειακό Μοντέλο 
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Εικόνα 8.5. Τριγωνικό δίκτυο - Μοντέλο TIN (με χρήση TIN αλγορίθμου του ArcGIS) 
 
 
8.3. Πηγές Δεδομένων ΨΜΑ 
  
ΨΜΑ δύναται να παραχθούν μέσω διαφόρων αλγορίθμων και με χρήση διαφόρου 
είδους δεδομένων. Αυτά είναι ως ακολούθως: 
 
• Δεδομένα υπαίθρου, με απ’ ευθείας εδαφικές μετρήσεις (π.χ. GPS). Επιτρέπουν την 

άμεση καταγραφή των δεδομένων και μεταφορά τους σε έναν Η/Υ. 

Μοντέλο TIN 
(με χρήση TIN 
αλγορίθμου του ArcGIS) 

Κορυφές, ακμές και επιφάνειες 
σε μοντέλο ΤΙΝ 

Η δημιουργία ακανονίστων 
τριγώνων κα τά τον αλγόριθμο ΤΙΝ 
ικανοποιούν  το κριτήριο Delaunay, 
όπου ένας κύκλος που διέρχεται 
από τις τρεις κορυφές κάθε 
τριγώνου δεν περιλαμβάνει άλλο 
σημείο. 
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• Δεδομένα τοπογραφικων χαρτών, τα οποία μετατρέπονται σε ψηφιακή μορφή 
χρησιμοποιώντας την μέθοδο της χαρτογραφικής ψηφιοποίησης.  

 
Η εισαγωγή των δεδομένων γίνεται μέσω ψηφιοποιητή ή σαρωτή και εν συνεχεία 
ακολουθεί η επεξεργασία αυτών σε ένα ΣΓΠ. 
 
Η φωτογραμμετρία και η τηλεανίχνευση αποτελούν επίσης πηγές δεδομένων, μέσω των 
δορυφορικών εικόνων ή αεροφωτογραφιών. 
 
8.4. Μεθοδολογία – Ακρίβεια ΨΜΑ 
 
Η επιλογή της μεθοδολογίας για την ανάπτυξη του ΨΜΑ, οπότε προκύπτει και η 
αντίστοιχη δομή (Tin ή Lattice ή  Grid), εξαρτάται από το ζητούμενο σε κάθε μελέτη. Η 
ακρίβεια των αποτελεσμάτων, είναι συνάρτηση: 

• της αξιοπιστίας των δεδομένων  
• της πυκνότητας αυτών και του τρόπου εισαγωγής τους  
• της μεθοδολογίας που ακολουθήθηκε   
• των παραμέτρων που χρησιμοποιήθηκαν 

 
Το αποτέλεσμα εξαρτάται από τις παραμέτρους του αλγορίθμου, το μέγεθος κυψελίδας, 
την κλίμακα κ.λ.π. 
 
8.5. Επαλήθευση – Επιβεβαίωση ΨΜΑ 
 
Δημιουργία ισοϋψών καμπύλων από το ΨΜΑ (συνήθως στο μισό της ισοδιάστασης των 
αρχικών) και σύγκριση με αρχικές.  
 
Σύγκριση του εξαγόμενου θεματικού επιπέδου –drainage- με το αρχικό-εισαγόμενο 
υδρογραφικό δίκτυο και τους υδρικρίτες. 
 
Αφήνοντας έναν αριθμό υψομετρικών σημείων εκτός επεξεργασίας για  σύγκριση τους 
με τα υψόμετρα ίδιας θέσης ως προς (χ,y) στο παραγόμενο ΨΜΑ. 
 
8.6. Χωρικά Μοντέλα Αναγλύφου (Παράγωγα του ΨΜΑ) 
 
Από το ΨΜΑ προκύπτουν με κατάλληλους αλγορίθμους, χωρικά μοντέλα αναγλύφου 
(spatial models), όπως : 

• σκιασμένο ανάγλυφο  και τρισδιάστατες όψεις  
• χάρτες αναλύσεως αναγλύφου (μορφολογικών κλίσεων, προσανατολισμού των 

κλίσεων, μορφολογικές ασυνέχειες, επιφάνειες επιπέδωσης, υδρογραφικό 
δίκτυο, λεκάνες απορροής κ.ά.). 

• τοπογραφικές τομές - προφίλ του αναγλύφου σε   οποιαδήποτε διεύθυνση 
• ισοϋψείς με την επιθυμητή κάθε φορά ισοδιάσταση 
• υπολογισμός όγκων, εμβαδών 
• καθορισμός συνθηκών ορατότητας από ένα ή περισσότερα σημεία κ.λ.π. 
• διαγράμματα 
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8.7. Εφαρμογές ΨΜΑ στις Γεωεπιστήμες 
 
Τα ψηφιακά μοντέλα αποτελούν τον βασικό πυρήνα σε έναν μεγάλο αριθμό εφαρμογών. 
Μερικές από τις εφαρμογές σχετικές με την Γεωλογία (International Institute for 
Aerospace Survey and Earth Sciences-1991) είναι:  
 
• Η χαρτογράφηση υψομέτρων, κλίσεων, προσανατολισμού των κλίσεων 
• Ο ψηφιακός συσχετισμός και πρόβλεψη των αρχικών τιμών για δεύτερη δημιουργία 

ψηφιακών μοντέλων εδάφους 
• Η ταξινόμηση και γένεση εδαφικών μορφών 
• Η μελέτη διάβρωσης (με μελέτη κλίσεων, περιγραφή γεωμορφολογικών μονάδων 

κ.λ.π.) 
• Η μελέτη επιφανειακής απορροής υδάτων και γενικά η ανάλυση υδρογραφικού 

δικτύου και υδροκριτών 
• Ο ψηφιακός έλεγχος ορθοφωτογραφιών 
• Η παραγωγή στερεοσκοπικών προϊόντων (υψομετρικά προφίλ) 
• Η καλύτερη επεξεργασία σεισμικών - βαρυτικών και μαγνητικών μετρήσεων 
• Η γεωμετρική διόρθωση και ορθοαναγωγή δορυφορικών εικόνων εικόνων  
• Η περιβαλλοντική διαχείριση και ο έλεγχος  φυσικών καταστροφών (σεισμοί, 

ηφαίστεια, πλημμύρες, tsunamis κ.ά.) 
• Η κατασκευή μεγάλων τεχνικών έργων όπως : σχεδιασμός (κατασκευή και 

συντήρηση) δρόμων, αεροδρομίων, αυτοκινητοδρόμων, λιμανιών, διωρύγων, 
δεξαμενών νερού, κατασκευή βιομηχανικών περιοχών, σταθμών παροχής 
ηλεκτρικής ενέργειας, πετρελαιαγωγών, κ.ά. 

 
Σημειώνεται, ότι ένας από τους βασικότερους παράγοντες διαμόρφωσης του αναγλύφου 
είναι οι τεκτονικές διεργασίες, οι οποίες όσο πιο πρόσφατες είναι στον γεωλογικό χρόνο, 
τόσο πιο αναλλοίωτες μένουν σε σχέση με τις διεργασίες της διάβρωσης - απόθεσης 
κ.λ.π. Συνεπώς, μελετώντας το ανάγλυφο εξάγονται συμπεράσματα για την τεκτονική, 
μορφοτεκτονική και γεωδυναμική της περιοχής, σε συνδυασμό και με άλλα δεδομένα 
(γεωλογικά, τεκτονικά, σεισμολογικά κ.ά.), προερχόμενα από παρατηρήσεις πεδίου, 
βιβλιογραφικές αναφορές, δορυφορικές εικόνες, αεροφωτογραφίες κ.λ.π.  
 
Τα ΨΜΑ αποτελούν βάση σε πλήθος θεματικών εφαρμογών, τόσο στο εργαστήριο, 
όπου έχοντας μια εικόνα της περιοχής μελέτης επιτυγχάνεται ποιοτική και ποσοτική 
ανάλυση αναγλύφου, διάκριση δομών (γεωλογικά όρια, τεκτονικές επαφές, 
μορφολογικές δομές, τοπογραφικά δεδομένα κ.ά), προσδιορισμός θέσεων σταθμών 
GPS, προσδιορισμός θέσων για γεωφυσική διασκόπηση κ..ά.,  όσο και στην ύπαιθρο, 
για επαλήθευση-πιστοποίηση, διορθώσεις και τελική εξαγωγή συμπερασμάτων, σχετικά 
με: γεωλογία, τεκτονική, γεωμορφολογία, χρήσεις γης κ.ά. 
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9. ΔΕΔΟΜΕΝΑ ΤΗΛΕΑΝΙΧΝΕΥΣΗΣ ΚΑΙ ΣΓΠ 
 
9.1. Γενικά 
 
Οι χάρτες, οι γραφικές παραστάσεις, οι πίνακες και οι εικόνες είναι οι μορφές με τις 
οποίες τα διάφορα δεδομένα είναι διαθέσιμα στην Γεωλογία και στις γεω-
περιβαλλοντολογικές επιστήμες γενικότερα. Η προσπάθεια συνδυασμού αυτών των 
δεδομένων (ή και επανασυνδυασμού ήδη συνδυαζομένων δεδομένων) αρκετές φορές 
είναι εξαιρετικά δύσκολη, όπως επίσης είναι εξίσου δύσκολος ο διαχωρισμός και η 
ανάλυση από τον χρήστη, των πολύπλευρων δεδομένων. 
 
Όσο περισσότερο αυξάνονται και γίνονται προσπελάσιμες, οι διάφορες πληροφορίες 
που αφορούν μια περιοχή, τόσο καθίσταται αναγκαίος ο συνδυασμός των επιμέρους 
δεδομένων ώστε να δημιουργηθεί μια πλήρης βάση πληροφοριών μέσω των ΣΓΠ.  
 
Το βασικό πλεονέκτημα της πολυδιάστατης προσέγγισης είναι ότι ελαχιστοπιούνται 
ασάφειες και τυχόν σφάλματα που δύνανται να παρουσιασθούν από έναν μόνο τύπο 
δεδομένων. Σε ένα πολυδιάστατο σύστημα, οι πηγές των δεδομένων είναι διαφόρων 
ειδών δεδομένα Τηλεανίχνευσης, καθώς και επίγειων, τα οποία δύνανται να 
συνδυασθούν μεταξύ τους (Εικόνα 9.1).  
 
Η εισαγωγή δεδομένων Τηλεανίχνευσης σε ένα ΣΓΠ ενώ έχει πλεονεκτήματα απαντά και 
δυσκολίες. Τα βασικότερα πλεονεκτήματα που προσφέρονται στους ερευνητές είναι: 

α) Η Τηλεανίχνευση αποτελεί σημαντική πηγή πληροφοριών γενικότερα και 
φυσικά και για τα ΣΓΠ. 

β) Η μορφή των δεδομένων Τηλεανίχνευσης είναι συμβατή με τα ΣΓΠ. 
γ) Η Τηλεανίχνευση προσφέρει πρόσφατα δεδομένα με χαμηλό κόστος, γεγονός 

που χρησιμεύει και για την ενημέρωση της βάσης δεδομένων. 
δ) Με την χρησιμοποίηση πολυκλαδικών δεδομένων, είτε μόνο Τηλεανίχνευσης 

είτε και από άλλες πηγές, ο αριθμός των χαρακτηριστικών πληροφορίας αυξάνεται 
σημαντικά, ώστε βελτιώνεται η ικανότητα διάκρισης και κατηγοριοποίησής τους. 

ε) Επιτυγχάνεται συνδυασμός των δορυφορικών εικόνων με άλλου είδους 
δεδομένα όπως π.χ. τοπογραφικά ή και με το ΨΜΑ με αποτέλεσμα την διόρθωση των 
εικόνων. 

 
Δυσκολίες κατά την εισαγωγή και χρήση των δεδομένων Τηλεανίχνευσης σ’ ένα ΣΓΠ 
θεωρούνται : 

α) ο συνδυασμός μιας σειράς δεδομένων διαφορετικού τύπου που 
περιλαμβάνουν σύνθετα και συνεχόμενα χαρακτηριστικά, απαιτεί ξεχωριστή στατιστική 
επεξεργασία και ειδικές ικανότητες χρήσης και οργάνωσης. 

β) η γεωγραφική ή γεωμετρική ακρίβεια των δορυφορικών δεδομένων συνήθως 
είναι διαφορετική είτε μεταξύ τους είτε σε σχέση με τα υπόλοιπα δεδομένα.  Αυτό 
σημαίνει ότι τα δορυφορικά δεδομένα πρέπει να αναδομηθούν και να διορθωθούν 
γεωμετρικά σε μια κοινή βάση, χρησιμοποιώντας κατάλληλα εδαφικά σημεία ελέγχου 
(ground control points – GCPs).  

γ) η διακριτική ικανότητα των δορυφορικών δεδομένων είναι συνήθως 
διαφορετική των δεδομένων άλλων πηγών, γεγονός που δημιουργεί πρόβλημα κατά την 
ταξινόμηση των δεδομένων και την εξαγωγή συμπερασμάτων.  

δ) ο μεγάλος όγκος πληροφοριών/δεδομένων ίσως δημιουργεί προβλήματα στον 
χειρισμό και την επεξεργασία τους και απαιτείται μια ορθολογικότερη χρήση τους. 
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ε) η αξιοπιστία μιας σειράς δεδομένων ίσως είναι εξεταστέα και έχει αρνητική 
επίδραση στην αξιοπιστία της όλης επεξεργασίας. Για τον λόγο αυτόν, απαιτείται 
ιδιαίτερη φροντίδα στην άσκηση της συλλογής των δεδομένων. 

στ) για τον συνδυασμό Τηλεανίχνευσης και ΣΓΠ γενικότερα, απαιτείται 
εξειδικευμένο προσωπικό και φυσικά ένα ισχυρό ηλεκτρονικό σύστημα με δυνατότητα 
επεξεργασίας μεγάλου όγκου δεδομένων. 

 
Παρά τους περιορισμούς, με τον συνδυασμό των πολυδεδομένων  προσεγγίζεται ένα 
μεγάλο φάσμα εφαρμογών εξαιτίας της τεράστιας ισχύος τους στο να παρουσιάζουν 
διάφορα δεδομένα και χαρακτηριστικά με μεγάλη ακρίβεια διάκρισης και ερμηνείας.  
 
9.2. Δορυφορικές Εικόνες και Γεωεπιστήμες 
 
Οι δορυφορικές εικόνες καλύπτουν ευρύ φάσμα εφαρμογών στις Γεωεπιστήμες και στις 
Γεωπεριβαλλοντικές Εφαρμογές που σχετίζονται με Γεωλογία – Τεκτονική – 
Γεωδυναμική – Γεωφυσική - Γεωμορφολογία – Τοπογραφία – Ωκεανογραφία – Φυσικές 
Καταστροφές (σεισμοί, ηφαίστεια, tsunamis, πλημμύρες κ.ά) και αφορούν σε: 
  

•  Προσδιορισμό Ρηξιγενών Ζωνών 
•  Προσδιορισμό Τεκτονικών Επαφών (επωθήσεις, εφιππεύσεις) 
•  Χαρτογράφηση Γεωλογικών Επαφών 
•  Αναγνώριση Τεκτονικών Στοιχείων (άξονες πτυχών) 
•  Χαρτογράφηση Τοπογραφικών Στοιχείων  
•  Δημιουργία ΨΜΑ 
•  Χαρτογράφηση Γεωμορφολογικών Ενοτήτων 
•  Χρήσεις Γης 
•  Οριοθέτηση Λεκανών Απορροής 
•  Χάραξη και μελέτη Υδρογραφικού Δικτύου και Υδροκριτών 
•  Προσανατολισμό - Χαρακτηριστικά Οροσειρών 
•  Χαρτογράφηση των Δέλτα των Ποταμών 
•  Χαρτογράφηση Ηφαιστειακών Δομών (ροών λάβας, ηφαιστειακών κώνων  κ.λ.π.). 
•  Μετρήσεις Θερμοκρασίας Εδάφους 
•  Μελέτη Μεταβολής Γραμμών Ακτών 
•  Χαρτογράφηση Ρευμάτων και Φαινομένων Ανόδου Ρευμάτων 
•  Μελέτη Εδαφικής Παραμόρφωσης 
•  Περιβαλλοντική Διαχείριση και Έλεγχος Φυσικών Καταστροφών κ.ά. 

 
Η χρήση των δορυφορικών εικόνων με σκοπό την εξαγωγή πληροφοριών προϋποθέτει 
την επεξεργασία αυτών.  
 

 
ΚΥΡΙΟΣ ΣΤΟΧΟΣ: Ερµηνεία Εικόνων - Εξαγωγή συµπερασµάτων 

H Τηλεανίχνευση γενικότερα αλλά και οι δορυφορικές εικόνες ειδικότερα, αποτελώντας 
αναπόσπαστο τμήμα στην έρευνα των γεωεπιστημόνων, αναλύονται λεπτομερώς σε 
ακόλουθα κεφάλαια. 
 
 
 
 
 



 75 

Στις εφαρμογές που θα ακολουθήσουν παρουσιάζονται αρκετές από τις 
χρήσεις των δορυφορικών εικόνων ως προς τις γεωλογικές και γεω-
περιβαλλοντικές εφαρμογές και ο συνδυασμός τους με άλλα δεδομένα σε ένα 
ΣΓΠ. 
 
Σκοπός των εφαρμογών είναι να γίνει κατανοητό πως διαφόρου είδους 
δεδομένα (γεωλογικά - τεκτονικά - μορφολογικά - σεισμολογικά - γεωφυσικά - 
χρήσεων γης κ.ά. ), διαφορετικής μορφής (αναλογικοί χάρτες, αρχεία εικόνας, 
ascii αρχεία κ.ά.),  επίγεια ή δορυφορικά, συνδυάζονται μεταξύ τους  σε ένα 
ΣΓΠ, με σκοπό την παραγωγή χαρτών, την δημιουργία σχεσιακών βάσεων 
δεδομένων, την επίλυση προβλημάτων  και την δημιουργία συστημάτων 
λήψεως αποφάσεων. 
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Εικόνα 9.1. Ορθο-φωτοχάρτης Τεκτονικού Ιστού Ν. Αργολίδας με υπόβαθρο την δορυφορική εικόνα LANDSAT 5, TΜ, Ψευδέγχρωμη, 4-7-2 (RGB), 
Νότιας Αργολίδας (Βασιλοπούλου, 1999).       Ρήγμα  (από ερμηνεία δορυφορικών εικόνων και επιβεβαίωση στην ύπαιθρο)            
 
                                                                    Πιθανό Ρήγμα, Τεκτονική Επαφή ή άλλου είδους γραμμικό στοιχείο (από ερμηνεία δορυφορικών εικόνων) 
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10. ΔΟΡΥΦΟΡΙΚΗ ΤΗΛΕΑΝΙΧΝΕΥΣΗ 
 
10.1. Διαστημική Τεχνολογία - Δορυφόροι 
 
Η διαστημική τεχνολογία, η οποία  απασχολεί τον άνθρωπο από το παρελθόν με 
στόχο την μελέτη του Διαστήματος και της Γης, είχε αλματώδη ανάπτυξη με την 
εξέλιξη των ηλεκτρονικών υπολογιστών. Τεχνητοί δορυφόροι κατασκευάσθηκαν και 
ετέθησαν σε επιθυμητές τροχιές από την Γη, ώστε μέσω αυτών επιτυγχάνεται η 
μελέτη του φυσικού και ανθρωπογενούς περιβάλλοντος σε πραγματικό χρόνο αλλά 
και διαχρονικά. 
 
Όλα τα αντικείμενα που έχουν κατασκευασθεί από τον άνθρωπο και έχουν τεθεί σε 
τροχιά γύρω από την Γη, τον Ήλιο ή κάθε άλλο Ουράνιο Σώμα, αποτελούν τους 
τεχνητούς δορυφόρους (Εικόνα 10.1).  
 
Ολα τα ουράνια σώματα που αποτελούν συστατικά του Ηλιακού Συστήματος, 
συμπεριλαμβανομένης και της Γης, τα οποία κινούνται σε τροχιά γύρω από τον Ήλιο 
αποτελούν τους φυσικούς δορυφόρους του Ηλιακού Συστήματος. 
 

 
 
 
10.2. Τροχιά Δορυφόρων  
 
Οι δορυφόροι είναι δυνατόν να παραμείνουν σε τροχιά γύρω από την Γη (Εικόνα 
10.2) για μεγάλη χρονική περίοδο, καθώς η έλξη της βαρύτητας της Γης εξισορροπεί 
την φυγόκεντρο δύναμη που αναπτύσσεται στον δορυφόρο. Οι δορυφόροι έχουν 
τεθεί σε τροχιά εκτός της ατμόσφαιρας όπου δεν υπάρχει η αντίσταση από τον αέρα, 
ώστε σύμφωνα με τον νόμο της αδράνειας η ταχύτητα του δορυφόρου να είναι 
σταθερή, με αποτέλεσμα να διατηρείται σταθερή η τροχιά του δορυφόρου γύρω από 
την Γη για πολλά έτη. 
 
Η βαρύτητα ελλατώνεται κατά την απομάκρυνση από την Γη, ενώ η φυγόκεντρος 
δύναμη αυξάνεται με την αύξηση της τροχιακής ταχύτητας. Σύμφωνα με αυτά 
ισχύουν τα ακόλουθα: 

Εικόνα 10.1.   Δορυφόρος UFO 
(Ultra High Frequency Follow-On, 
UHF-F/O).  
Πηγή 
http://www.au.af.mil/au/awc/awcg
ate/afspc-fs/uhf.htm {{PD-USGov-
Military-Air Force}}  
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• Ένας δορυφόρος χαμηλής τροχιάς (συνήθως σε απόσταση 800km από την Γη) 
στον οποίο ασκείται μεγάλη έλξη από την βαρύτητα πρέπει να κινηθεί με 
μεγάλη ταχύτητα για να ανπτυχθεί μια αντίστοιχη φυγόκεντρος δύναμη. Ως εκ 
τούτου η τροχιακή ταχύτητα ενός δορυφόρου συνδέεται άμεσα με την 
απόστασή του από την Γη. 

 
• Ένας δορυφόρος σε απόσταση 36000 km από την Γη έχει περίοδο 

περιστροφής 24 ώρες, δηλαδή χρόνο ίσο με τον χρόνο περιστροφής της Γης. Ο 
συγκεκριμένος δορυφόρος όταν ευρίσκεται επάνω από τον Ισημερινό θα είναι 
στάσιμος σε σχέση με την Γη. 

 
Η τροχιά των Δορυφόρων χαρακτηρίζεται: α) Γεωσύγχρονη / Γεωστατική και β) 
Ηλιοσύγχρονη / Πολική 

 

 
Εικόνα 10.2. Διάγραμμα που απεικονίζει τη Γη και τις διάφορες τροχιές

Τυρκουάζ Περιοχή: 160-2000km  

. Η απόσταση από την 
Γη (ακτίνα Γης ~ 6370 km) αποδίδεται ως ακολούθως: 

Κίτρινη Περιοχή: 2000-34780km 
Κόκκινη στικτή Γραμμή: 500km 
Πράσινη στικτή Γραμμή: 20,230km 
Μαύρη στικτή Γραμμή: 35,794km 
 (http://en.wikipedia.org/wiki/File:Orbits_around_earth_scale_diagram.svg). 
 

http://en.wikipedia.org/wiki/File:Orbits_around_earth_scale_diagram.svg�


 79 

Α. Γεωστατική Τροχιά – Χαρακτηριστικά 
 
Η γεωστατική τροχιά είναι κυκλική τροχιά στο επίπεδο του Ισημερινού με μηδενική 
κλίση (Εικόνα 10.3).  
 
Οι γεωστατικοί δορυφόροι περιστρέφονται γύρω από την Γη με περίοδο 
περιστροφής ίση με την περίοδο περιστροφής της Γης (23h 56’) και με την ίδια φορά. 
Για αυτόν τον λόγο ένας τέτοιου είδους δορυφόρος φαίνεται από την Γη ως 
σταθερός. Η απόσταση αυτών των δορυφόρων από την επιφάνεια της Γης, στην 
περιοχή του Ισημερινού είναι περίπου 35.855km. Η απόστασή τους από την 
επιφάνεια της Γης, στην περιοχή της Ελλάδας είναι περίπου  37.500km.Οι 
γεωστατικοί δορυφόροι βλέπουν την Γη πάντοτε υπό την ίδια οπτική γωνία, δηλαδή 
καταγράφεται η ίδια εικόνα ανά τακτά χρονικά διαστήματα. Αυτό αποτελεί 
πλεονέκτημα για την παρατήρηση των καιρικών συνθηκών. Οι γεωστατικοί 
δορυφόροι επομένως, κινούνται συγχρόνως με την Γη, με σταθερή ταχύτητα, σε 
σταθερό ύψος και με συγκεκριμένο πεδίο κάλυψης της επιφάνειας της Γης (περίπου 
το 43%). Ένα μειονέκτημα των γεωστατικών δορυφόρων είναι η μεγάλη απόστασή 
τους από την Γη, που έχει ως αποτέλεσμα την χαμηλή χωρική διακριτική ικανότητα 
των δορυφορικών εικόνων που δίνουν. 
 
Οι τηλεπικοινωνιακοί και οι μετεωρολογικοί δορυφόροι είναι γεωστατικοί δορυφόροι. 
Προκειμένου να παρέχονται εικόνες των καιρικών συνθηκών για ολόκληρο τον 
πλανήτη αρκετοί μετεωρολογικοί δορυφόροι έχουν κατανεμηθεί ομοιόμορφα σε 
τροχιές γύρω από την Γη (Εικόνα10.3). 
 

 

 
 
Εικόνα 10.3. 
Δορυφόρος 
Meteosat και άλλοι 
γεωστατικοί 
δορυφόροι 
ευρισκόμενοι σε 
τροχιά γύρω από 
τη Γη 
(http://www.esa.int/
specials/eduspace_
gr). 
 

.  

Β. Ηλιοσύγχρονη Τροχιά – Χαρακτηριστικά 
 
Οι ηλιοσύγχρονοι δορυφόροι κινούνται σε κυκλική τροχιά γύρω από την Γη και 
διέρχονται από μια συγκεκριμένη περιοχή της γήινης επιφάνειας την ίδια περίπου 
τοπική ώρα, ώστε ο ήλιος να ευρίσκεται στο ίδιο σημείο επάνω από τον ορίζοντα και 
το επίπεδο της δορυφορικής τροχιάς να διατηρεί σταθερή γωνία ως προς το φως του 
ήλιου. 
 
Οι δορυφόροι που φέρουν παθητικούς δέκτες εξαρτώνται από την ηλιακή 
ακτινοβολία και επομένως οι τροχιές τους πρέπει να είναι προσαρμοσμένες στην 
εναλλαγή ημέρας-νύχτας. Επίσης, οι εικόνες που λαμβάνουν σε δεδομένη χρονική 
περίοδο και αποτυπώνουν συγκεκριμένη περιοχή της γήινης επιφάνειας θα πρέπει 
να έχουν τις ίδιες συνθήκες φωτισμού, δηλαδή να πραγματοποιούνται την ίδια τοπκή 
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ώρα της ημέρας, ώστε να είναι συγκρίσιμες. Συμπεραίνεται ότι οι συγκεκριμένοι 
δορυφόροι κινούνται σε ηλιοσύγχρονη τροχιά.   
 
Οι ηλιοσύγχρονοι δορυφόροι κινούνται γύρω από την Γη (Εικόνα 10.4), ενώ 
ταυτόχρονα η Γη περιστρέφεται γύρω από τον άξονά της, με αποτέλεσμα να 
σαρώνεται ολόκληρη η επιφάνεια της Γης ανά λωρίδες. Κάθε λωρίδα της γήινης 
επιφάνειας σαρώνεται από τον δορυφόρο σε μια πλήρη περιστροφή του. 
   

 
 
 
10.3. Δορυφορικά Συστήματα και Διαστημικές Εφαρμογές  
 
Οι διαστημικές εφαρμογές γενικά, προκύπτουν από τρία μεγάλα δορυφορικά 
συστήματα: 
 

1. Δορυφόροι Παρατήρησης Γης 
 

Μετεωρολογικοί (π.χ. NOAA, GOES, GMS) 
Οπτικοί (π.χ. LANDSAT, SPOT, ASTER, IKONOS, QUICK BIRD, 
WorldView-1) 
Ραντάρ (π.χ. RADARSAT, ERS -1 & 2, ENVISAT, SAOCOM) 

 
2. Δορυφόροι Προσδιορισμού Θέσης (π.χ. GPS, GLONASS) 

 
3. Δορυφόροι Τηλεπικοινωνίας (π.χ. HELLAS SAT) 

 
Οι διαστημικές εφαρμογές αποτελούν βασικό εργαλείο για τις Γεωεπιστήμες 
(γεωλογία, τεκτονική, γεωδυναμική, γεωφυσική, γεωμορφολογία κ.ά) καθώς και για 
την διαχείριση και παρακολούθηση φυσικών καταστροφών  και άλλων 
γεωπεριβαλλοντικών προβλημάτων. 
 
10.4. Βασικές Αρχές Τηλεανίχνευσης 
 
Τηλανίχνευση είναι η μελέτη των ιδιοτήτων ενός αντικειμένου από μακριά με την 
βοήθεια ανθρωπίνων αισθήσεων ή τεχνητών μέσων. Σχεδόν αποκλειστικά έχει 
συνδεθεί η Τηλανίχνευση με την μελέτη της επιφάνειας της Γης και των σωμάτων 
πάνω σε αυτήν από δορυφόρο. Σε περιπτώσεις που η μελέτη γίνεται με καταγραφή 
της φυσικής ακτινοβολίας από παθητικούς δέκτες, η Τηλανίχνευση ονομάζεται και 
Τηλεσκόπηση ή Τηλεπισκόπηση, εφόσον η λήψη γίνεται από πάνω. Στην Αγγλική 
βιβλιογραφία χρησιμοποιείται ο όρος Remote Sensing (Τηλαίσθηση) και στην Γαλλική 
ο όρος Teledetection (Τηλεανίχνευση), (ΜΟΥΤΣΟΥΛΑΣ, 1987). 

Εικόνα 10.4. Ηλιοσύγχρονη Τροχιά 
(http://www.esa.int/specials/eduspace_gr) 
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Ένα σύστημα Τηλεανίχνευσης (Εικόνα 10.5) αποτελείται από μια πηγή ακτινοβολίας 
(συνήθως ο Ήλιος), τις αλληλεπιδράσεις της με την γήινη επιφάνεια και την 
ατμόσφαιρα και τέλος τον αισθητήρα (sensor). Ο συνδετικός κρίκος μεταξύ αυτών 
είναι η ηλεκτρομαγνητική ενέργεια, η οποία εκπέμπεται, ανακλάται, απορροφάται ή 
διαπερνά την ύλη και μέρος αυτής καταγράφεται από τους αισθητήρες. 
 
Ηλεκτρομαγνητική Ακτινοβολία: Η ηλεκτρομαγνητική ενέργεια παρέχεται υπό 
μορφήν ηλεκτρομαγνητικής ακτινοβολίας. Η ηλεκτρομαγνητική ακτινοβολία διαδίδεται 
υπό μορφήν κυμάτων, τα οποία ονομάζονται ηλεκτρομαγνητικά κύματα. Αυτά 
αποτελούνται από ένα ηλεκτρικό πεδίο (Ε) και ένα μαγνητικό πεδίο (Β) (Εικόνα10.6), 
τα οποία ταλαντώνονται σε κάθετα επίπεδα μεταξύ τους και κάθετα προς την 
διεύθυνση διάδοσης (κ). Διαδίδονται στο κενό με την ταχύτητα του φωτός (c). 
Χαρακτηριστικό της ακτινοβολίας είναι το μήκος κύματος (λ), (Εικόνα 10.7). 
 
Κύμα ονομάζεται μια διαταραχή που μεταδίδεται στον χώρο και στον χρόνο. Η 
διαταραχή αφορά σε ένα συγκεκριμένο φυσικό μέγεθος, ανάλογα με το είδος του 
κύματος. Επί παραδείγματι, στο ηλεκτρομαγνητικό κύμα η διαταραχή αφορά στην 
ένταση του ηλεκτρικού και του μαγνητικού πεδίου. 
 
Μήκος Κύματος (λ): Το μήκος ενός κυματικού κύκλου (η απόσταση που διανύει το 
κύμα σε χρόνο μιας περιόδου) και δίδεται ως η απόσταση μεταξύ των κορυφών δύο 
γειτονικών κυμάτων. Μετράται σε m, cm, μm, nm, A0. 
 
Περίοδος (Τ): Tο χρονικό διάστημα μεταξύ δύο διαδοχικών διαταραχών, ή της 
διέλευσης δύο διαδοχικών χαρακτηριστικών μιας διαταραχής, όπως δυο κορυφών 
του κύματος από ένα συγκεκριμένο σημείο του χώρου. Συμβολίζεται με Τ και 
μετράται σε δευτερόλεπτα (s). Εκφράζει τον αριθμό των διαταραχών Ν σε χρονικό 
διάστημα Δt και δίδεται από την σχέση: Τ=Δt/Ν. 
 
Συχνότητα (v): Ο αριθμός των μεγίστων του ηλεκτρομαγνητικού κύματος, που 
διέρχεται από ένα σημείο στην μονάδα του χρόνου. Εκφράζει τον αριθμό των 
κυμάτων ανά δευτερόλεπτο (c.p.s ή Hz). 
 
Η σχέση του (λ) και (ν) με την ταχύτητα του φωτός (c) είναι:  
                 c = λ.ν      όπου c = 3*108

 
 m/s 

Ταχύτητα κύματος (υ): Η ταχύτητα της διαταραχής ονομάζεται ταχύτητα του 
κύματος και μετράται συνήθως σε μέτρα ανά δευτερόλεπτο (m/s), ανάλογα με τις 
μονάδες μέτρησης των μεγεθών μήκος και περίοδος του κύματος. Από τον ορισμό 
του μήκους κύματος προκύπτει ότι υ=λ/Τ. Τα κύματα έχουν ταχύτητα χαρακτηριστική 
του συγκεκριμένου μέσου διάδοσης και του συγκεκριμένου είδους κύματος. 
Τα ηλεκτρομαγνητικά κύματα διαδίδονται και μέσα στην ύλη και στο κενό. Η ταχύτητά 
τους στο κενό θεωρείται μία από τις σημαντικότερες σταθερές στην Φυσική. 
 
Ηλεκτρομαγνητικό Φάσμα: Ολόκληρο το εύρος της ηλεκτρομαγνητικής 
ακτινοβολίας αποτελεί το ηλεκτρομαγνητικό φάσμα (EMS-Electromagnetic Spectrum, 
Εικόνα 10.7).  
 
Φασματικές Ζώνες-Φασματικά κανάλια: Το ηλεκτρομαγνητικό φάσμα διαχωρίζεται 
σε φασματικές ζώνες (bands) οι οποίες συγκροτούνται από μικρές ομάδες συνεχών 
φασματικών γραμμών. Οι φασματικές ζώνες, οι οποίες συνθέτουν το 
ηλεκτρομαγνητικό φάσμα είναι οι ακτίνες GΑΜΜΑ (Gamma Rays), ακτίνες Χ (X 
Rays), η υπεριώδης (Ultraviolet, UV), η ορατή (Visible), η υπέρυθρη (Infrared, IR), 
η μικροκυματική (Microwaves) και τα ραδιοκύματα (Radio Waves) (Εικ. 10.7).  Η 
ορατή ζώνη καθορίζεται με βάση την ανθρώπινη όραση (Εικόνα 10.8).  

http://el.wikipedia.org/w/index.php?title=%CE%94%CE%B9%CE%B1%CF%84%CE%B1%CF%81%CE%B1%CF%87%CE%AE&action=edit&redlink=1�
http://el.wikipedia.org/wiki/%CE%A6%CF%85%CF%83%CE%B9%CE%BA%CF%8C_%CE%BC%CE%AD%CE%B3%CE%B5%CE%B8%CE%BF%CF%82�
http://el.wikipedia.org/wiki/%CE%97%CE%BB%CE%B5%CE%BA%CF%84%CF%81%CE%BF%CE%BC%CE%B1%CE%B3%CE%BD%CE%B7%CF%84%CE%B9%CE%BA%CF%8C_%CE%BA%CF%8D%CE%BC%CE%B1�
http://el.wikipedia.org/wiki/%CE%97%CE%BB%CE%B5%CE%BA%CF%84%CF%81%CE%B9%CE%BA%CF%8C_%CF%80%CE%B5%CE%B4%CE%AF%CE%BF�
http://el.wikipedia.org/wiki/%CE%9C%CE%B1%CE%B3%CE%BD%CE%B7%CF%84%CE%B9%CE%BA%CF%8C_%CF%80%CE%B5%CE%B4%CE%AF%CE%BF�
http://el.wikipedia.org/wiki/%CE%A0%CE%B5%CF%81%CE%AF%CE%BF%CE%B4%CE%BF%CF%82�
http://el.wikipedia.org/wiki/%CE%94%CE%B5%CF%85%CF%84%CE%B5%CF%81%CF%8C%CE%BB%CE%B5%CF%80%CF%84%CE%BF�
http://el.wikipedia.org/wiki/%CE%97%CE%BB%CE%B5%CE%BA%CF%84%CF%81%CE%BF%CE%BC%CE%B1%CE%B3%CE%BD%CE%B7%CF%84%CE%B9%CE%BA%CE%AE_%CE%B1%CE%BA%CF%84%CE%B9%CE%BD%CE%BF%CE%B2%CE%BF%CE%BB%CE%AF%CE%B1�
http://el.wikipedia.org/wiki/%CE%A4%CE%B1%CF%87%CF%8D%CF%84%CE%B7%CF%84%CE%B1_%CF%84%CE%BF%CF%85_%CF%86%CF%89%CF%84%CF%8C%CF%82�
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Εικόνα10.5. Περιγραφή της Διαδικασίας Εκπομπής - Λήψης – Ανάλυσης της Ακτινοβολίας 
μέσω της Τηλεανίχνευσης, σε ένα Παθητικό Σύτστημα (α) και σε ένα Ενεργητικό Σύστημα (β): 
Διακρίνεται η Πηγή Ακτινοβολίας, η Αλληλεπίδραση Ακτινοβολίας με Ατμόσφαιρα (Α) έως τον 
Στόχο (γηίνη επιφάνεια, βλάστηση, κτήρια κ.ά) και η αλληλεπίδραση με τον Στόχο (Β), η 
Αλληλεπίδραση της Ανακλώμενης από τον Στόχο Ακτινοβολίας με Ατμόσφαιρα (Γ) έως τον 
Αισθητήρα, η Μετάδοση της Ακτινοβολίας από τον Αισθητήρα στον Επίγειο Σταθμό (Δ), όπου 
ακολουθεί η Μετάδοση των Δεδομένων (Ε) προς Επεξεργασία, Ερμηνεία, Ανάλυση, 
Παραγωγή Δεδομένων (Δορυφορικές Εικόνες, Αεροφωτογραφίες - Ζ) με σκοπό περαιτέρω 
επεξεργασία και χρήση σε διαφόρου είδους  Εφαρμογές. 
 
 

 
 
Εικόνα 10.6. Σχηματικά δίδεται το ηλεκτρικό πεδίο (Ε) και το μαγνητικό πεδίο (B) που 
συνθέτουν την  ηλεκτρομαγνητική ακτινοβολία (που μεταδίδεται στην διεύθυνση κ). 
Σημειώνεται και το μήκος κύματος (λ). - ( Τροποποιημένο από: 
 http://en.wikipedia.org/wiki/Electromagnetic_radiation ) 
 
 
Ατμοσφαιρικά Παράθυρα: Η ακτινοβολία κατά την είσοδό της στην Γήινη 
ατμόσφαιρα υφίσταται απορρόφηση και σκέδαση σε ορισμένα μήκη κύματος 
ανάλογα με τις επικρατούσες ατμοσφαιρικές συνθήκες και κατά ένα ποσοστό 
υφίσταται  και ανάκλαση. Επιλεκτικά, μεταφέρεται ενέργεια από ορισμένα μήκη 

http://en.wikipedia.org/wiki/Electromagnetic_radiation�
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κύματος. Τα μήκη κύματος, τα οποία σχετικά ευκολότερα διαπερνούν την 
ατμόσφαιρα, αποτελούν τα ατμοσφαιρικά παράθυρα (atmospheric windows).  
 
Στην ποιότητα του φάσματος επιδρά, επίσης, η γωνία πρόσπτωσης της ηλιακής 
ακτινοβολίας, η οποία εξαρτάται από το ύψος του Ήλιου (sun elevation) από τον 
ορίζοντα.  
 
Φασματική Απόκριση: Το ποσόν και η φασματική κατανομή της ανακλώμενης και 
εκπεμπόμενης ενέργειας από ένα αντικείμενο αποτελεί την φασματική απόκριση 
(spectral response) του αντικειμένου.  
 
Η φασματική απόκριση καταγράφεται από τους δέκτες (sensors) των δορυφόρων 
παρατήρησης της Γης και χρησιμοποιείται ως μέσον αναγνώρισης του 
συγκεκριμένου αντικειμένου. 
 
Παθητικοί & Ενεργητικοί Αισθητήρες 
 
Οι αισθητήρες ή δέκτες ή όργανα καταγραφής διακρίνονται σε παθητικούς και 
ενεργητικούς αισθητήρες: 
 
Οι παθητικοί αισθητήρες δέχονται και καταγράφουν την ηλιακή ενέργεια, η οποία με 
φυσικό τρόπο είναι διαθέσιμη. Η ανακλώμενη από την Γη ενέργεια δύναται να 
καταγραφεί κατά την διάρκεια που ο Ήλιος φωτίζει την Γη (μόνον την ημέρα). Η 
εκπεμπόμενη ακτινοβολία  (όπως η θερμική υπέρυθρη) δύναται να καταγράφεται 
από τους δέκτες  όλο εικοσιτετράωρο. 
 
Οι ενεργητικοί αισθητήρες αποτελούν οι ίδιοι πηγή ενέργειας. Η ενέργεια εκπέμπεται 
από τους αισθητήρες, κατευθυνόμενη προς τον στόχο, ο οποίος εν συνεχεία ανακλά 
ένα ποσό ενέργειας. Ο αισθητήρας καταγράφει αυτήν την ποσότητα της 
ανακλώμενης από τον στόχο ενέργειας. Οι ενεργητικοί αισθητήρες δύναται να 
καταγράφουν καθ΄όλο το εικοσιτετράωρο και καθ΄όλη την διάρκεια του έτους. 
 
Οι κάμερες και οι σαρωτές είναι παθητικοί αισθητήρες δηλαδή δέχονται μόνο σήματα 
και μετρούν την ανακλώμενη Η/Μ ακτινοβολία (ορατή – θερμική υπέρυθρη). 
 
Τα Radar είναι ενεργητικοί αισθητήρες, δηλαδή στέλνουν και δέχονται πίσω τα 
σήματα αυτά (μικροκύματα). 
 
Οι αισθητήρες των δορυφόρων καταγράφουν την ΗΜ ακτινοβολία είτε φωτογραφικά 
(αναλογική εικόνα) είτε ηλεκτρονικά (ψηφιακή εικόνα).  
 
Οι αισθητήρες, αναλόγως με την διεύθυνση σάρωσης ως προς την τροχιά, 
κατηγοριοποιούνται σε: α) Σαρωτές με εγκάρσια ως προς την τροχιά διεύθυνση, β) 
Σαρωτές κατά μήκος της τροχιάς. 
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Εικόνα 10.7. Κύρια περιοχή του ηλεκτρομαγνητικού φάσματος με τις φασματικές ζώνες, το μήκος κύματος και τη συχνότητα, (Πηγή  World of Beams). 
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Εικόνα 10.8. Δίδεται το Η/Μ φάσμα και σε μεγέμθυνση η ορατή ζώνη του φάσματος (http://en.wikipedia.org/wiki/Electromagnetic_radiation). 
Συγκεκριμένα μήκη κύματος αντιστοιχούν σε συγκεκριμένο χρώμα. Τα κύρια χρώματα ή μήκη κύματος της ορατής φασματικής ζώνης είναι Μπλε – 
Πράσινο – Κόκκινο. Ο συνδυασμός τους δίνει μεγάλο αριθμό χρωμάτων 

http://en.wikipedia.org/wiki/Electromagnetic_radiation�
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11.  ΔΟΡΥΦΟΡΟΙ  
 
11.1. Σύντομη Αναδρομή  
 
Η ΝΑSΑ (Εθνική Υπηρεσία Αεροναυτικής και Διαστήματος) κατά την περίοδο 1946-
1950, με την παρότρυνση της Κυβέρνησης των ΗΠΑ, τοποθέτησε σε πυραύλους U-2 
(οι οποίοι είχαν περιέλθει στα χέρια τους από τους Γερμανούς κατά τον Β΄ Παγκόσμιο 
πόλεμο) φωτογραφικές μηχανές 35 mm και τους οποίους εκτόξευσαν από το Νέο 
Μεξικό. Ως αποτέλεσμα ήταν οι πρώτες εικόνες της Γης και η αρχή της παρατήρησής 
της με μεθόδους Τηλεανίχνευσης. Η ποιότητα των φωτογραφιών ήταν πολύ χαμηλή 
και αφορούσε σε στοιχεία της γήινης επιφάνειας, όπως δεδομένα για τα 
χαρακτηριστικά των υδάτων, του χιονιού και του πάγου.  
 
Οι δορυφόροι σχεδιάζονται ανάλογα  με την εφαρμογή στην οποία στοχεύει η 
δορυφορική αποστολή.     Οι δορυφόροι διαφέρουν ανάλογα με το είδος της τροχιάς 
που εκτελούν, το ωφέλιμο φορτίο που μεταφέρουν, την οπτική γωνία των οργάνων 
απεικόνισης, την χωρική διακριτική ικανότητα, τα φασματικά χαρακτηριστικά και το 
πλάτος λωρίδας σάρωσης.  
 
Στις 4 Οκτωβρίου 1957 η εκτόξευση του πρώτου τεχνητού δορυφόρου της Γης από 
την ΕΣΣΔ, Sputnic-1, έδειξε τις δυνατότητες της πυραυλικής τεχνολογίας ως μέσου 
για την αποδέσμευση από το ελκτικό πεδίο της Γης. Η ανάπτυξη της ηλεκτρονικής 
τεχνολογίας οδήγησε στον εξοπλισμό των δορυφόρων με ποικίλλα συστήματα 
συλλογής πληροφοριών, στην μετάδοση των πληροφοριών αυτών στη Γη και στην 
μετέπειτα επεξεργασία και αξιοποίησή τους. 
 
Μετά τον Sputnic-1, ακολούθησε o Sputnic-2 και κατόπιν ο Explorer-1 που 
εκτοξεύθηκε από τις ΗΠΑ το 1958 ενώ εν συνεχεία ετέθησαν σε τροχιά και άλλοι 
δορυφόροι, οι οποίοι είχαν προγραμματισθεί να φέρουν αυτόματες φωτογραφικές 
μηχανές, όπως  ο  Cosmos-4  από  την ΕΣΣΔ και οι δορυφόροι της σειράς Discover 
των ΗΠΑ. Ο δορυφόρος TIROS (Television and Infrared Observation Sattelite)  που 
εκτοξεύθηκε τον Απρίλιο του 1960 από τις ΗΠΑ ήταν ο πρώτος που έφερε 
τηλεοπτική κάμερα.  
 
Από το 1960 υπήρξαν μεγάλα διαστημικά προγράμματα όπως το Mercury, Gemini 
και Apollo της ΝΑSΑ καθώς και τα  Vostoc, Voskod και Soyuz, και τα διαστημικά 
λεωφορεία και εργαστήρια Skylab της ΕΣΣΔ και Space Shuttles των ΗΠΑ. Ετέθησαν 
οι βάσεις για την δημιουργία νέων  διαστημικών προγραμμάτων συστηματικής και 
επαναλαμβανόμενης κάλυψης με εικόνες της Γης, γεγονός που οδήγησε στην 
ανάπτυξη της  Δορυφορικής Τηλεανίχνευσης. Σημαντικά προγράμματα είναι το 
Αμερικάνικο πρόγραμμα LANDSAT και το Γαλλικό SPOT, ενώ ακολούθησαν 
δορυφορικά προγράμματα άλλων χωρών. 
 
11.2. Η σειρά των Δορυφόρων LANDSAT 
 
Το πρώτο πρόγραμμα που έθεσε σε λειτουργία η ΝΑSΑ το 1967 ήταν το ERTS 
(Earth Resource Technology Sattelite). Το πρόγραμμα αυτό είχε σαν σκοπό την 
εκτόξευση 5 δορυφόρων οι οποίοι μεταφέρουν διάφορα συστήματα Τηλεανίχνευσης, 
τα οποία αρχικά είχαν σχεδιαστεί για να αποκτούν πληροφορίες σχετικά με τις 
πλουτοπαραγωγικές πηγές της Γης. Ο πρώτος δορυφόρος τέθηκε σε τροχιά στις 
23/7/1972 έως τις 5/8/1972 και ονομαζόταν   ERTS-1. Έπειτα ακολούθησε ο ERTS-2 
στις 22/1/1975, τον οποίο προτού τεθεί σε τροχιά η ΝΑSΑ τον μετονόμασε σε 
LANDSAT-2, για να τον διακρίνει από τον ωκεανογραφικό δορυφόρο SEASAT, που 
τέθηκε σε τροχιά  στις 26/6/1978. Ο ERTS-1 ονομάστηκε αναδρομικά LANDSAT-1. Ο 
LANDSAT-3 τέθηκε σε τροχιά στις 5/3/1978, ο LANDSAT-4 στις 16/7/1982 και ο 
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LANDSAT-5 την 1/3/1984. Οι LANDSAT-2, -3 λειτούργησαν επιτυχώς έως τις 
27/7/’83 και 7/9/83, διότι διάφορες μηχανικές βλάβες επέσπευσαν την διακοπή της 
λειτουργίας αυτών των δύο αλλά και μερικών άλλων δορυφόρων LANDSAT. Ο 
LANDSAT-6 έπεσε λίγο μετά την λειτουργία του στην θάλασσα εξαιτίας βλάβης. 
Σήμερα, ο δορυφόρος LANDSAT-5 είναι σε λειτουργία.  
 
Οι δορυφόροι LANDSAT-1,2,3 (βάρους 815 Kgr και διαστάσεων περίπου 3 m ύψος 
και 4 m πλάτος και 1,5 m διάμετρο) είχαν παρόμοια χαρακτηριστικά στην λειτουργία 
τους και χαρακτηρίζονται ως δορυφόροι πρώτης γενιάς.  
 
Οι δορυφόροι LANDSAT-4 και LANDSAT-5 αποτελούν την συνέχεια των δορυφόρων 
πρώτης γενιάς. Η τροχιά τους μειώθηκε από τα 900 στα 705 km. Αυτή η μείωση του 
ύψους της τροχιάς έγινε κυρίως με σκοπό την δυνατή επιδιόρθωσή τους από τα 
διαστημικά λεωφορεία και την βελτίωση της χωρικής διακριτικής ικανότητας. Η τροχιά 
παραμένει κυκλική, ηλιοσύγχρονη και σχεδόν πολική, όπως και στους τρεις 
προηγούμενους. Οι δορυφόροι περνούν από τον Ισημερινό στις 9:45 π.μ. τοπική 
ώρα. Κάθε πλήρης τροχιά διαρκεί 99min περίπου, δηλαδή πραγματοποιούν 14,5 
περιστροφές γύρω από τη Γη την ημέρα και επαναλαμβάνουν την σάρωση του ίδιου 
σημείου κάθε 16 ημέρες, με κλίση 98.20

 

. Επειδή όμως οι δορυφόροι έχουν τεθεί σε 
τροχιά με διαφορά φάσεως 8 ημερών η επανάληψη ενός σημείου γίνεται κάθε 8 
ημέρες. 

Οι συσκευές καταγραφής του LANDSAT ήταν αρχικά σχεδιασμένες να κάνουν μια 
αυτόματη παρατήρηση χρησιμοποιώντας μια κάμερα επιστρεφόμενης δέσμης RVB 
(Return Beam Vidicon Cameras) και έναν πολυφασματικό σαρωτή MSS 
(Multispectral Scanner).  
 
Ο πολυφασματικός σαρωτής MSS ενσωματώθηκε στους πέντε πρώτους 
δορυφόρους του προγράμματος LANDSAT. Πρόκειται για έναν γραμμικό σαρωτή, ο 
οποίος σαρώνει την επιφάνεια κάτω από τον δορυφόρο και δημιουργεί μια εικόνα της 
γήινης επιφάνειας καθώς κινείται. Ο σαρωτής συλλέγει δεδομένα σε τέσσερα 
διαφορετικά φασματικά κανάλια, στην περιοχή του ορατού και του εγγύς υπέρυθρου 
(ένα πέμπτο κανάλι στην περιοχή του θερμικού υπέρυθρου που έφερε ο LANDSAT-3 
έδωσε πολύ λίγα δεδομένα λόγω συνεχών βλαβών που συνέβησαν μετά την 
εκτόξευση).  
 
Έξι παράλληλοι, ευαίσθητοι ανιχνευτές ήταν στραμμένοι συγχρόνως προς το έδαφος: 
από 0,5 έως 0,6 μm (πράσινο), από 0,6 έως 0,7 μm (κόκκινο), από 0,7 έως 0,8 μm 
(μπλε) και από 0,8 έως 1,1 μm (ανακλώμενο υπέρυθρο). Οι συγκεκριμένες 
φασματικές ζώνες προσδιορίσθηκαν ως  4, 5, 6 και 7, διότι το υποσύστημα 
ανακλώμενης δέσμης (RVB) περιλαμβάνει τις ζώνες 1, 2 και 3 (Πίνακας 12.1). Το 
ανακλώμενο φως από την επιφάνεια της Γης  κατευθύνεται από το κινούμενο 
περιοδικά κάτοπτρο σε μια σειρά οπτικά νήματα, τα οποία μεταδίδουν το φως σε μια 
σειρά από φίλτρα. Τα φίλτρα αυτά διαχωρίζουν το εισαγώμενο σήμα στα τέσσερα 
κανάλια. Τα δεδομένα μεταδίδονται από τον δορυφόρο σε επίγειους σταθμούς που 
υπάρχουν σε διάφορα σημεία του πλανήτη. 
 
Η ερμηνεία των εικόνων του  MSS αποδείχθηκε ότι συνεισφέρει σε πολλούς τομείς 
όπως στην Γεωπονία, Βοτανική, Δασολογία, Οικολογία, Γεωγραφία, 
Προγραμματισμός χρήσης Γης, Ωκεανογραφία, ανάλυση υδάτων κ.α. Οι εικόνες 
LANDSAT δίνουν συνοπτική εικόνα μιας πολύ μεγάλης περιοχής, αρκεί να σημειωθεί 
ότι χρειάζονται 1600 αεροφωτογραφίες κλίμακας 1:20.000 χωρίς επικάλυψη για να 
καλύψουν την περιοχή που περικλείεται σε μία εικόνα LANDSAT MSS. Ο MSS των 
δορυφόρων LANDSAT-4, -5 είναι ίδιος με αυτόν των προηγούμενων δορυφόρων, 
μόνο που τα τέσσερα κανάλια 4, 5, 6, 7 μετονομάστηκαν σε 1, 2, 3, 4.  



 88 

 
Ο θεματικός χαρτογράφος TM είναι ένας πολυφασματικός γραμμικός σαρωτής, ο 
οποίος περιλαμβάνει έναν σημαντικό  αριθμό  βελτιώσεων σε σχέση με τον MSS και 
προσαρμόστηκε στους LANDSAT-4, -5. Οι βασικότερες βελτιώσεις είναι οι 
ακόλουθες: 
• Έχει 7 φασματικές ζώνες που σημαίνει καλύτερη φασματική διακριτική ικανότητα. 
Η επιλογή των φασματικών ζωνών στον θεματικό χαρτογράφο, έγινε για να 
ικανοποιηθούν ερευνητικές ανάγκες των επιστημών σχετικά με την παρακολούθηση 
και τον έλεγχο του περιβάλλοντος. Οι 7 φασματικές ζώνες καλύπτουν την περιοχή 
του φάσματος από 0,45 ως 12,5, δηλαδή από το ορατό ως το θερμικό υπέρυθρο. Η 
πρόσθεση της ζώνης 1, βοηθάει τους χρήστες να σχηματίσουν αληθείς έγχρωμες 
εικόνες (συνδυασμός καναλιών 1, 2, 3), κάτι που δεν γίνεται με τις εικόνες του MSS. 
Με την πρόσθεση επίσης της φασματικής ζώνης 6 υπάρχει η δυνατότητα απόκτησης 
θερμικών υπέρυθρων εικόνων.  
• Η χωρική ανάλυση του θεματικού χαρτογράφου είναι 30 m εκτός του καναλιού 6 
που είναι 120 m.  
• Ο  θεματικός χαρτογράφος αντί να χρησιμοποιεί οπτικές ίνες για να μεταφέρει την 
ακτινοβολία στους ανιχνευτές, οι ίδιοι οι ανιχνευτές είναι τοποθετημένοι στο εστιακό 
επίπεδο του οπτικού συστήματος. Επίσης το κάτοπτρο-σαρωτής συλλέγει δεδομένα 
και στις δύο κινήσεις που κάνει. 
• Ενώ ο MSS έχει 6 ανιχνευτές για να αποτυπώνει δεδομένα (σύνολο 24 
ανιχνευτές), ο θεματικός χαρτογράφος χρησιμοποιεί 16 ανιχνευτές για όλα τα κανάλια 
εκτός του θερμικού που έχει 4 ανιχνευτές (σύνολο 100 ανιχνευτές). 
• Ραδιομετρικά ο θεματικός χαρτογράφος αναπαριστά την μετατροπή του σήματος 
από αναλογικό σε ψηφιακό σε μια τιμή 256 ψηφιακών τιμών (8 bits). Αυτό αντιστοιχεί 
σε μια τετραπλή αύξηση στην τιμή της κλίμακας του γκρί σε σχέση με τους 64 
ψηφιακούς αριθμούς (6 bits) που χρησιμοποιούνται από τον MSS. Αυτή η υψηλότερη 
ραδιομετρική ακρίβεια επιτρέπει την παρατήρηση μικρότερων αλλαγών στα 
ραδιομετρικά μεγέθη σε ένα δεδομένο κανάλι. 
• Τα γεωμετρικά χαρακτηριστικά του θεματικού χαρτογράφου είναι ανώτερα από 
εκείνα του MSS. Αποτέλεσμα αυτού του γεγονότος είναι ότι τα δεδομένα του 
απαιτούν λιγότερες γεωμετρικές διορθώσεις και τα δεδομένα του μπορούν να 
χρησιμοποιηθούν για έρευνες σε μικρότερες κλίμακες.  
• Τέλος η όλη βελτίωση των σαρωτών συνοδεύτηκε και με τη βελτίωση των  
συστημάτων μετάδοσης των δεδομένων από τους LANDSAT-4, -5 στους επίγειους 
σταθμούς λήψης μέσω βοηθητικών δορυφόρων αναμετάδοσης των δεδομένων που 
τέθηκαν σε τροχιά. 
• Γενικά, οι εικόνες LANDSAT TM είναι χρήσιμες για ένα ευρύτερο φάσμα 
εφαρμογών σε σχέση με τις εικόνες LANDSAT MSS. Μερικές από τις εφαρμογές 
αυτές έχουν εξαπλωθεί σε πολλού τομείς όπως: Γεωλογία, Δασοπονία και Γεωπονία, 
στη χρήση γης και εδαφοκάλυψη, στη χαρτογράφηση περιβαλλοντολογικών αλλαγών, 
την απογραφή των φυσικών πλουτοπαραγωγικών πηγών, την παρακολούθηση 
ρύπανσης και μελέτη ακτών κ.ά. 
 
Χρήσιμη στην Γεωλογία, αλλά και γενικότερα, είναι η δυνατότητα παραγωγής 
συνθέτων ψευδέγχρωμων εικόνων του  θεματικού χαρτογράφου TM. Αυτές 
προέρχονται από τον συνδυασμό τριών διαφορετικών φασματικών καναλιών, τριών 
εικόνων που αντιπροσωπεύουν μια συγκεκριμένη περιοχή μελέτης, με την 
χρωματική απόδοση RGB (Red - Green - Blue / Κόκκινο - Πράσινο - Μπλε). Το 
αποτέλεσμα αυτού του συνδυασμού είναι μια ψευδέγχρωμη εικόνα η οποία δίνει τη 
δυνατότητα, ανάλογα με τον αντίστοιχο συνδυασμό των τριών εκ των 7 φασματικών 
ζωνών του TM, για καλύτερη ερμηνεία και ανάλυση ορισμένων χαρακτηριστικών που 
ενδιαφέρουν τους ερευνητές. 
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Επί παραδείγματι, οι τρεις ορατές ζώνες 1, 2 και 3 δίνουν μια εικόνα (αληθινή 
έγχρωμη) για την γήινη επιφάνεια, όπως θα την έβλεπε το ανθρώπινο μάτι από το 
δορυφόρο. Εάν π.χ. η περιοχή έχει υψηλή υγρασία τότε οι τρεις παραπάνω ζώνες 
δεν δίνουν πολύ καλά αποτελέσματα λόγω της χαμηλής χωρικής διακριτικής 
ικανότητας που παρουσιάζουν, επηρεασμένες από την μεγάλη διάχυση που 
παρουσιάζουν τα μικρά μήκη κύματος που έχουν και τα οποία είναι ευαίσθητα στην 
διάχυση. Αντίθετα εάν γίνει ο συνδυασμός των ζωνών  2, 3 και 4 δίνεται μεγαλύτερη 
λεπτομέρεια, διότι η ζώνη 4 αναπληρώνει την χαμηλή αντίθεση της ζώνης 1 (ορατό-
μπλε). 
 
 

Πίνακας 11.1. Οι Δορυφόροι    LANDSAT 1-7, Mήκος Kύματος και Aκρίβεια Αισθητήρων 

 
 
Ο συνδυασμός των καναλιών 4, 5 και 7 (ως μπλε - πράσινο - κόκκινο) δίνει καλά 
αποτελέσματα για τροπικές περιοχές διότι επιδεικνύει πολύ καλή χρωματική αντίθεση, 
μείωση των νεφών και καλύτερη έκφραση των γεωλογικών χαρακτηριστικών. Τα 
χαρακτηριστικά της βλάστησης είναι περισσότερο ευδιάκριτα, διότι τα κανάλια 4, 5, 7 
συμπίπτουν με την σημαντική αύξηση της κατανομής στο ηλεκτρομαγνητικό φάσμα 
εκπομπής της βλάστησης. 
 
Επίσης, ένας πολύ καλός συνδυασμός που χρησιμοποιείται ευρύτατα (ιδιαίτερα σε 
ξηρές και ημίξηρες περιοχές) είναι των καναλιών  2, 4, 7 ο οποίος θεωρείται 
πλεονεκτικότερος από τον συνδυασμό 1, 4, 7  διότι το κανάλι 2 επηρεάζεται λιγότερο 
από την ατμοσφαιρική σκέδαση. 
 
Ο συνδυασμός των καναλιών 7, 4, και 1 σε κλίμακα RGB, επίσης έδωσε πολύ καλά 
αποτελέσματα για γεωλογική ερμηνεία και κυρίως για αναγνώριση ενεργών 
ρηγμάτων σε ημίξηρη περιοχή, ορεινή, με μικρές επίπεδες εκτάσεις. 
 
Θεωρητικά υπάρχουν 120 δυνατοί συνδυασμοί οι οποίοι χρησιμοποιούνται σε 
πλήθος εφαρμογών. Το κανάλι 6 χρησιμοποιείται σπάνια λόγω της χαμηλής χωρικής 
διακριτικής ικανότητας, για τον λόγο αυτόν οι συνδυασμοί αφορούν τα υπόλοιπα έξη 

Δορυφόρος   Αισθητήρας   Μήκος Κύματος   Ακρίβεια    Δορυφόρος   Αισθητήρας    Μήκος Κύματος   Ακρίβεια 
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κανάλια. Στην πράξη, έχει αποδειχθεί ότι ένας μικρός σχετικά αριθμός συνδυασμών 
είναι ικανός για πλήθος εφαρμογών. Ταυτόχρονα είναι αρκετά συχνή η χρήση του 
λόγου δύο φασματικών καναλιών ως μια εικόνα. 
 
Όλες οι εικόνες του LANDSAT αναφέρονται σε κάποιους παγκοσμίως 
κατανεμημένους δείκτες σειρών, κάθετων στην διεύθυνση ροής (paths) και τροχιών 
παράλληλων στην διεύθυνση ροής του δορυφόρου (rows), οι οποίοι είναι 
διαφορετικοί για τις δύο γενιές των δορυφόρων LANDSAT. Οι σειρές, που είναι 
κάθετες στην διεύθυνση ροής,  λαμβάνονται ως το βόρειο-όριο, τμήμα της τροχιάς 
του δορυφόρου, ενώ οι οριζόντιες τέμνονται με  κατεύθυνση Α - Δ και είναι 
παράλληλες μεταξύ τους, ενώ απέχουν απόσταση 165 km. 
O LANDSAT-7, τέθηκε σε τροχιά στις 15/4/1999. Το ύψος τροχιάς παραμένει στα 
705km και η περίοδος περιστροφής είναι 98.8min. Είναι ηλιοσύγχρονος και η 
επαναληψιμότητα παραμένει στις 16 ημέρες, με κλίση 98.20

 

. Η διαφορά του από τους 
προηγούμενους δορυφόρους της σειράς, είναι στο όργανο καταγραφής ETM+ 
(Enhanced Thematic Mapper Plus / Βελτιωμένος Θεματικός Χαρτογράφος), ο οποίος 
αποτυπώνει δεδομένα σε επτά φασματικές ζώνες, όπως και ο ΤΜ και μια επιπλέον 
παγχρωματική 0.52-0.90μm (πράσινο – υπέρυθρο ανάκλασης), με διακριτική 
ικανότητα 15m. Η διαφορά επίσης από τον ΤΜ είναι και η βελτιωμένη διακριτική 
ικανότητα του  θερμικού καναλιού 6 (Πίνακας 11.2). 

Πίνακας 11. 2. Εφαρμογές των φασματικών καναλιών του LANDSAT 7 ΕTM+ 
 

Φασματική 
Ζώνη 

 
ΕΦΑΡΜΟΓΗ 

1 
(ανάλυση 

30m) 

Μπλε - πράσινη (0.45 - 0.52 μm): κατάλληλη για να διεισδύει στις υδάτινες 
μάζες και να δίνει πληροφορίες για τη θολότητά τους κ.ά, για χαρτογράφηση 
παράκτιων περιοχών, την διαφοροποίηση εδαφών και βλάστησης, καθώς 
και τον διαχωρισμό κωνοφόρων και φυλλοβόλων. 

2 
(ανάλυση 

30m) 

Πράσινη (0.52 - 0.60 μm): κατάλληλη για την μέτρηση των μεγίστων 
ανακλάσεων του ορατού πρασίνου για εκτίμηση της ευρωστίας της 
βλάστησης και για τα χαρακτηριστικά αστικών περιοχών. 

3 
(ανάλυση 

30m) 

Ερυθρή (0.63 - 0.69 μm): κατάλληλη για τον προσδιορισμό των φυτικών 
ειδών μέσω της μέτρησης της απορρόφησης της χλωροφύλλης, για 
διαχωρισμό περιοχών καλυπτόμενων και μη καλυπτόμενων από βλάστηση. 

4 
(ανάλυση 

30m) 

Εγγύς υπέρυθρη (0.76 - 0.90 μm): κατάλληλη για την περιγραφή των 
υδάτινων μαζών και τον  προσδιορισμό της περιεχόμενης βιομάζας, καθώς 
και της υγρασίας του εδάφους. 

5 
(ανάλυση 

30m) 

Mέση υπέρυθρη (1.55 - 1.75 μm): επιτρέπει την διείσδυση μέσα από αραιά 
σύννεφα, κατάλληλη για τον υπολογισμό της υγρασίας στα φυτά και στο 
έδαφος καθώς και για τον διαχωρισμό των σύννεφων από τα χιόνια. 

6 
(ανάλυση 

60m) 

Θερμική υπέρυθρη (10.4 - 12.5 μm): κατάλληλη για θερμική χαρτογράφηση - 
θερμικές εικόνες - ανάλυση θερμικού στρες των φυτών, προσδιορισμό 
εδαφικής υγρασίας, συλλογή πληροφοριών σχετικά με την κατάσταση της 
βλάστησης. Αν και η χωρική διακριτική της ικανότητα είναι 60m 
συμπληρώνει τις πληροφορίες που δίδονται από τις άλλες ζώνες. 

7 
(ανάλυση 

30m) 

Μέση υπέρυθρη (2.08 - 2.35 μm): κατάλληλη για τον προσδιορισμό της 
λιθολογίας, των ορυκτών και για υδροθερμική εξαλλοίωση. 

ΡΑΝ 
(ανάλυση 

15m) 

Πανγχρωματική (0.52 – 0.90μm) 
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O LANDSAT-8 ((LDCM) ετέθη σε τροχιά στις 11/2/2013. Το ύψος τροχιάς παραμένει 
στα 705km και η περίοδος περιστροφής είναι 98.9min. Είναι ηλιοσύγχρονος και η 
επαναληψιμότητα παραμένει στις 16 ημέρες, με κλίση 98.2°. Ο δορυφόρος περνά 
από τον Ισημερινό στις 10:00 π.μ. τοπική ώρα (+/- 15 minutes). Δίνει σκηνές 
διαστάσεων 

Πίνακας 11. 3. Mήκος Kύματος και Aκρίβεια Αισθητήρων Δορυφόρου   LANDSAT 8 

170 km x 185 km (106 mi x 115 mi). Το πλήθος των σκηνών δίνει την 
δυνατότητα στους χρήστες για επιστημινική μελέτη και παρακολούθηση των αλλαγών 
στην επιφάνεια της γης. Ορισμένα από τα χαρακτηριστικά δίδονται στον Πίνακα 11.3. 

 
Αισθητήρας Φασματικό Κανάλι / Μήκος Κύματος Ακρίβεια 
 
Operational Land 
Imager (OLI) 

 

Band 1 Visible (0.43 - 0.45 µm)  

Band 2 Visible (0.45 - 0.51 µm)  

Band 3 Visible (0.53 - 0.59 µm)  

Band 4 Red     (0.64 - 0.67 µm)  

Band 5 Near-Infrared (0.85 - 0.88 µm)  

Band 6 SWIR 1 (1.57 - 1.65 µm)  

Band 7 SWIR 2 (2.11 - 2.29 µm)  

Band 8 PAN      (0.50 - 0.68 µm)  

Band 9 Cirrus   (1.36 - 1.38 µm)  

 

 

30 m 

30 m 

30 m  

30 m  

30 m  

30 m  

30 m 

15 m 

30 m 

 

Thermal Infrared 
Sensor (TIRS 
 

 

Band 10 TIRS 1 (10.6 - 11.19 µm)  

Band 11 TIRS 2 (11.5 - 12.51 µm)  

 

 

100 m  

100 m 

 
 
11.3.  Η σειρά των Δορυφόρων SPOT  
 
Το πρόγραμμα σχεδιάστηκε το 1978 και είναι από τα τυπικά συστήματα δεύτερης 
γενιάς των δορυφόρων παρατήρησης της Γης. Ο πρώτος δορυφόρος αυτού του 
προγράμματος ο SPOT-1 τέθηκε σε τροχιά τον Φεβρουάριο του 1986 και 
λειτούργησε έως τον Νοέμβριο του 2003. Είναι ο πρώτος δορυφόρος που εστάλη 
στο διάστημα από την Ευρώπη καθοδηγούμενος από το Εθνικό Κέντρο 
Χωροταξικών Ερευνών της Γαλλίας, το Ινστιτούτο Εικόνων SPOT και την συμμετοχή 
του Βελγίου και της Σουηδίας. Η τροχιά του δορυφόρου είναι σχεδόν πολική, 
ηλιοσύγχρονη, σε ύψος 830 km και διέρχεται από τον Ισημερινό κατερχόμενος, στις 
10:30΄ τοπική ώρα επαναλαμβάνοντας μία πλήρη περιστροφή της Γης σε 26 ημέρες, 
με κλίση 98,70. Περιοχές του Ισημερινού δύνανται να παρατηρηθούν επτά φορές, 
ενώ περιοχές με γεωγραφικό πλάτος 45ο, ένδεκα φορές.
 

  

Ο δορυφόρος φέρει δύο σαρωτές. Καθένας από τους δύο σαρωτές σαρώνει τη Γη σε 
ζώνη πλάτους 60 km. Η μία ζώνη σάρωσης με την άλλη έχει επικάλυψη 3 km, ώστε 
συνολικά η ζώνη σάρωσης από τους δύο σαρωτές είναι 117 km (2 x 60 μείον 3 km). 
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Ο SPOT-2 τέθηκε σε τροχιά τον Ιανουάριο του 1990 και λειτούργησε έως τον Ιούνιο 
του 2009. Ακολουθούσε την τροχιά  του SPOT-1 με διαφορά φάσης, ώστε οι 
δορυφόροι να διέρχονται από την ίδια περιοχή κάθε 13 ημέρες, ενώ οι σαρωτές των 
SPOT-1, 2 είναι ίδιοι. 
  
Ο  SPOT-3 (25/09/1993 - 14/11/1996) φέρει δύο δέκτες HRV1 και HRV2 (High 
Resolution Visible). Πρόκειται για σαρωτές ωστικής σάρωσης και δίνουν 
πολυφασματικές (XS) εικόνες σε τρεις φασματικές ζώνες (πράσινη, κόκκινη και εγγύς 
υπέρυθρη από 0,79 ως 0,89 μm) με ραδιομετρική ανάλυση 8-bits και χωρική 
διακριτική ικανότητα (στο ναδίρ) 20 m. Επίσης δίνουν και πανχρωματικές (P) με 
χωρική ανάλυση 10 m και ραδιομετρική 6-bits. Έχει δηλαδή μεγαλύτερη ανάλυση 
(resolution) από τον θεματικό χαρτογράφο του LANDSAT TM και ιδιαίτερα στο 
πανχρωματικό (10m). Επίσης, έχει την δυνατότητα να καταγράφει δεδομένα της ίδιας 
περιοχής που αποκτήθηκαν από διαφορετικές οπτικές γωνίες κατά την διάρκεια της 
κίνησης του δορυφόρου, χάρη στην παρουσία ενός επίπεδου καθρέπτη που 
ευρίσκεται στην περιοχή του καταγραφέα και ο οποίος δίνει, σε ένα εύρος -270 ως 
+270

 

, την δυνατότητα: α) της επανάληψης λήψης εικόνας ενός στόχου μεταξύ των 
διαφορετικών ευθειών πτήσης του και β) της λήψης στερεοσκοπικών εικόνων.  

Ο SPOT-4 (24/3/1998 - 11/01/2013) διαθέτει το γνωστό σύστημα καταγραφής HRV 
με τέσσερα φασματικά κανάλια, δύο στο ορατό και δύο στο υπέρυθρο και χωρική 
διακριτική ικανότητα 20m. Επίσης δημιουργεί εικόνες πανχρωματικές με χωρική 
διακριτική ικανότητα 10m. Το εύρος των εκόνων είναι περίπου 60km x 60km. 
Διαθέτει ένα όργανο καταγραφής της βλάστησης (VEGETATION 1, το οποίο στον 
SPOT-5 μετονομάσθηκε σε VEGETATION 2) με τέσσερα φασματικά κανάλια και 
χωρκή διακριτική ικανότητα περίπου 1km. Τα φασματικά κανάλια είναι τα B2 (0.61-
0.68) για παρακολούθηση βλάστησης, B3 (0.79 – 0.89 µm) για διεργασίες 
φωτοσύνθεσης, mid-IR (1.58-1.75) για υγρασία εδάθους και βλάστησης και το B0 
(0.43-0.47 µm) για ωκεανογραφικές εφαρμογές και ατμοσφαιρικές διορθώσεις.  
 
Ο SPOT-5 ετέθηκε σε τροχιά στις 3/5/2002. Στον Πίνακα 11.4 δίδεται η σειρά των 
δορυφόρων SPOT με τα φασματικά κανάλια και τα χαρακτηριστικά τους. 
 
To SPOT high resolution optical instruments (HRV – High Resolution Visible στον 
SPOT 2, HRVIR - High Resolution Visible Infra Red στον SPOT 4 και HRG - High 
Geometric Resolution στον SPOT 5) προσφέρει δυνατότητα πλάγιας παρατήρησης 
με γωνία παρατήρησης +/- 270 

 
ως προς την κατακόρυφο (Εικόνα 11.1). 

Η στερεοσκοπική παρατήρηση ενός αντικειμένου προσδίδει πλεονεκτήματα όπως: 
• βελτίωση της αντίληψης και ερμηνείας μεγάλης κλίμακας καλλιεργειών και 
ανθρωπογενών χαρακτηριστικών. 
• μεγάλο εύρος εικόνων, αφού κάθε στερεολήψη καλύπτει 60x60km, ενώ οι εικόνες 
που καταγράφονται με μεγαλύτερη οπτική γωνία (±270

• η δυνατότητα επιλογής κλίμακας, από 1:400.000 ως και 1:25.000 
) καλύπτουν έκταση 60x80 km. 

• η ομοιομορφία στις συνθήκες παρατήρησης, χαρακτηριστικό γενικότερα των 
δορυφορικών εικόνων. 
• η παρουσίαση των δεδομένων σε ψηφιακή μορφή, η οποία επιτρέπει να γίνονται 
ποικίλες επεξεργασίες, ενώ ταυτόχρονα υπάρχει η δυνατότητα δημιουργίας 
ψηφιακού μοντέλου ανάγλυφου DEM (Digital Elevation Model).  
• Οι πλάγιες εικόνες SPOT βοηθούν στην αναγνώριση τοπογραφικών και 
γεωμορφολογικών χαρακτηριστικών αναγλύφου (απότομες κορυφές, κοιλάδες, 
μεγάλης έκτασης κατολισθήσεις, υδρογραφικά δίκτυα) που είναι δυνατόν να 
καθορίσουν λιθολογικές ενότητες στη βάση της διαφορετικής τους γεωμορφολογίας. 
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• Αναγνωρίζονται οι κλίσεις και διευθύνσεις των σχηματισμών, καθώς επίσης και 
πτυχές, ρήγματα, διακλάσεις και άλλα τεκτονικά στοιχεία.  
• Γενικά, η μεγάλη διακριτική ικανότητα των εικόνων SPOT βοηθάει στην 
αναγνώριση και μελέτη φλεβών (dykes) και εκρηξιγενών πετρωμάτων όπως ροές 
λαβών κ.λ.π.  

 
Εικόνα 11.1. Το HRS (High Resolution Stereoscopic) όργανο του SPOT 5 έχει την 
δυνατότητα να λαμβάνει δύο στερεοσκοπικές πανχρωματικές εικόνες. Οι στερεοσκοπικές 
εικόνες είναι χρήσιμες για την παραγωγή ψηφιακού μοντέλου αναγλύφου. 
 
 
Ο SPOT 6 ετέθηκε σε τροχιά στις 9/9/ 2012 και ο SPOT 7 στις 30/6/3014. Οι SPOT-6 
and 7 σχεδιάστηκαν να λειτουργούν σε κοινή τροχιά με της υψηλής διακριτικής 
ικανότητας δορυφόρους Pleiades 1A και 1B για λεπτομερέστερη μελέτη της γης, με 
σκοπό την χαρτογράφηση σε  εθνικό επίπεδο κλίμακας 1/25000. 
 
Οι νέες δυνατότητες του SPOT 6 έγιναν εμπορικές τον Φεβρουάριο του 2013. 
Προσφέρει δυνατότητες χαρτογράφησης εθνικού επιπέδου σε κλίμακα 1/25000, για 
εφαρμογές σχετικές με γεωλογία και χρήσεις γης, περιβαλλοντικές εφαρμογές, 
θαλάσσια έρευνα, μελέτη πετρελαιοκηλίδων κ.ά. Παρέχει άνω των 750 εικόνων ανά 
ημέρα. Δίνει αυτόματη παραγωγή ορθο-εικόνων, διακριτικής ικανότητας 10m. 
Επίσης, λαμβάνει  stereo και tri-stereo εικόνες of 60 Km x 60 Km για παραγωγή 
ΨΜΑ. Στην Εικόνα 11.2. φαίνεται η διαφορά στην διακριτική ικανότητα των 
δορυφόρων SPOT 5 και SPOT 6. 
 
Τα δεδομένα  SPOT είτε με την πανχρωματική τους, είτε με την πολυφασματική τους 
μορφή είναι διαθέσιμα στους χρήστες και ως ζεύγη ψηφιακών εικόνων για 
στερεοσκοπική παρατήρηση είτε ως  μονές εικόνες για απλή παρατήρηση. Είναι 
χρήσιμα στην γεωλογία, τεκτονική, γεωπεριβαλλοντικές μελέτες, διαχείριση φυσικών 
καταστροφών, χρήσεις γης κ.ά. 
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Πίνακας 11.4 . Οι δορυφόροι SPOT με τα φασματικά κανάλια και τα χαρακτηριστικά τους. 

Δορυφόρος Ηλεκτρομαγνητικό 
Φάσμα 

Μέγεθος  
Κυψελίδας  

Φασματικά κανάλια 

 
SPOT6 & 7 
 
 

Μπλε 
Πράσινο  
Κόκκινο 
Εγγύς υπέρυθρο  
Πανχρωματικό 

6.0m 
6.0m 
6.0m 
6.0m 
1.5m 

0.455 µm – 0.525 µm  
0.530 µm – 0.590 µm  
0.625 µm – 0.695 µm 
0.760 µm – 0.890 µm  
0.450 µm – 0.745 µm 

 
SPOT5 

Πανχρωματικό 

HRG 
sensors 

Β1:  πράσινο 
Β2:  κόκκινο 
Β3:  εγγύς υπέρυθρο 
Β4:  SWIR 

2.5m ή 5m 
10m 
10m 
10m 
20m 

0.51-0.73 μm 
0.50-0.59 μm 
0.61-0.68 μm 
0.79-0.89 μm 
1.58-1.75 μm 

 
SPOT4 

Μονοφασματικό (PAN) 

HRVIR 
sensors 

Β1:  πράσινο 
Β2:  κόκκινο 
Β3:  εγγύς υπέρυθρο 
ΜIR  (μέσο υπέρυθρο) 

10 m 
20 m 
20 m 
20 m 
20 m 

0.61-0.68 μm 
0.50-0.59 μm 
0.61-0.68 μm 
0.79-0.89 μm 
1.58-1.75 μm 

 
SPOT1 
SPOT2 
SPOT3 

Πανχρωματικό 
XS1:  πράσινο 
XS2:  κόκκινο 
XS3:  εγγύς υπέρυθρο  

10 m 
20 m 
20 m 
20 m 

0.50-0.73 μm 
0.50-0.59 μm 
0.61-0.68 μm 
0.78-0.89 μm 

 

 
 

Εικόνα 11.2. Σύγκριση εικόνων SPOT 5 (2.5 m) και SPOT 6 (1.5 m) από την Νέα Υόρκη 
(http://www.astrium-geo.com/en/147-spot-6-7-satellite-imagery). 
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11.4. Δορυφόρος TERRA (Earth Observing System – EOS) 

Ο υψηλής ποιότητας πολυφασματικός απεικονιστής Advanced Spaceborne Thermal 
Emission and Reflection Radiometer (ASTER), είναι εγκατεστημένος στον δορυφόρο 
TERRA της NASA, ο οποίος τέθηκε σε τροχιά στις 18/12/1999.  

Η τροχιά του δορυφόρου είναι σχεδόν πολική, ηλιοσύγχρονη, σε ύψος 700-737km 
και διέρχεται από τον Ισημερινό κατερχόμενος, στις 10:30΄ τοπική ώρα 
επαναλαμβάνοντας μία πλήρη περιστροφή της Γης σε 16 ημέρες, με κλίση 98,20

Συλλέγει δεδομένα σε 14 φασματικές ζώνες, από το ορατό έως το θερμικό υπέρυθρο 
με υψηλή χωρική, φασματική και ραδιομετρική ικανότητα (Πίνακας 11.5). Μια 
επιπρόσθετη αντικρυνή (backward-looking) στο εγγύς υπέρυθρο ζώνη δίνει στερεο-
κάλυψη. Κάθε σκηνή ASTER καλύπτει περιοχή 60 x 60 km.  

  

Καλύπτει ευρύ φάσμα εφαρμογών σχετικά με την χαρτογράφηση της γήινης 
επιφάνειας και παρακολούθηση διαφόρων φαινομένων στον χρόνο, όπως: 
προσδιορισμός γεωλογικών και τεκτονικών δομών, χαρτογράφηση βλάστησης, 
χαρτογράφηση και παρακολούθηση μεταβολής της επιφανειακής θερμοκρασίας 
εδάφους, η οποία βοηθά στην κατανόηση της αλληλεπίδρασης ατμόσφαιρας και 
γήινης επιφανείας, προσδιορισμός μορφολογίας νεφών και μελέτη φυσικών 
ιδιοτήτων, παρακολούθηση φυσικών καταστροφών (ενεργών ηφαιστείων, 
παγετώνων, πλημμυρών, πυρκαγιών, tsunamis). 
 

Πίνακας 11.5. Φασματικές Ζώνες του πολυφασματικού απεικονιστή ASTER 

 

11.5. Ο Δορυφόρος IKONOS 
 
Ο Δορυφόρος IKONOS τέθηκε σε τροχιά την September 24, 1999 , από την Space 
Imaging (Η ORBIMAGE και η Space Imaging συνιστούν πλέον την GeoEye). Ήταν  ο 
πρώτος εμπορικός δορυφόρος με ακρίβεια 1m. Καλύπτει κάθε σημείο της Γης. Δίνει 
πολυ-φασματικές εικόνες χρησιμοποιώντας τέσσερα φασματικά κανάλια (τρία στο 
ορατό και ένα στο υπέρυθρο) με ραδιομετρική ανάλυση 11bit και χωρική διακριτική 
ικανότητα 4m, καθώς επίσης και παγχρωματικές εικόνες με χωρική διακριτική 
ικανότητα 1m (Πίνακας 11.6). 
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Ο IKONOS συλλέγει εικόνες σε μια γωνία μετρούμενη από την επιφάνεα της  Γης ως 
προς τον ήλιο (sun elevation)  μεγαλύτερη των 1500

Το οπτικό τηλεσκόπιο καταγράφει μία λωρίδα της επιφάνειας της γης πλάτους από 
11 έως 13 km και την ανακλά στους ψηφιακούς αισθητήρες.  

 και με αζιμούθιο απεριόριστο. Η 
τροχιά είναι ηλιοσύγχρονη σε ύψος 680km. Όλες οι εικόνες περιέχουν λιγότερο από 
20% νεφοκάλυψη.  

Ο IKONOS δίνει με μεγάλη ακρίβεια τις μεταβολές που συμβαίνουν στην επιφάνεια 
της Γης, σχετικά με το ανάγλυφο, τις κατοικημένες περιοχές κ.ά. Καλύπτει πλήθος 
εφαρμογών σε εθνικό και τοπικό επίπεδο σχετικά με την ασφάλεια, τις φυσικές 
καταστροφές, χρήσεις γης, γεωλογία, τεκτονική, κ.ά. Τον δορυφόρο IKONOS 
χειρίζεται η εταιρία GeoEye, της οποίας ο στόλος δορυφόρων περιλαμβάνει και τις 
σειρές δορυφόρων OrbView και GeoEye  

Πίνακας 11.6. Φασματική Κανάλια του Δορυφόρου IKONOS 

 
 
11.6. Ο Δορυφόρος QuickBird 
 
Ο  δορυφόρος QuickBird είναι ένας εμπορικός δορυφόρος της εταιρίας DigitalGlobe. 
Εκτοξεύτηκε στις 18/10/2001 από την αεροπορική βάση Βάντενμπεργκ στην 
Καλιφόρνια. Την εποχή της εκτόξευσής του ήταν ο εμπορικός δορυφόρος με την 
υψηλότερη χωρική διακριτική ικανότητα (0.65m). Σήμερα. υπάρχουν οπτικοί 
αισθητήρες δορυφόρων με υψηλότερη χωρική διακριτική ικανότητα, όπως οι 
δορυφόροι WorldView που ανήκουν επίσης στην DigitalGlobe.  
 
Ο Quickbird είναι σε τροχιά γύρω από την Γη σε ύψος 600km και συλλέγει εικόνες 
της επιφάνειας της γης κατά την διάρκεια της ημέρας. Οι εικόνες που συλλέγονται 
είναι στερεοσκοπικές με χωρική διακριτική ικανότητα 61cm για τις πανχρωματικές και 
με χωρική διακριτική ικανότητα 2,5m για τις πολυφασματικές. Ο δορυφόρος συλλέγει 
άνω των 75 εκατομμυρίων τετραγωνικών μέτρων απεικονιστικών δεδομένων ανά 
έτος. Τα δεδομένα καλύπτουν ευρύ φάσμα μελετών (γεωλογία, τεκτονική, χρήσεις 
γης, γεωμορφολογία, μετεωρολογία, στρατιωτική παρακολούθηση κ.ά.). 
Επεξεργάζονται και συνδυάζονται, μέσω προγραμμάτων επεξεργασίας εικόνων, με 
άλλα δεδομένα (επίγεια ή δορυφορικά) σε ΣΓΠ για λεπτομερή παρατήρηση, ανάλυση 
και σχεδίαση διαφόρων δομών ή φαινομένων, διαχείριση φυσικών καταστροφών κ.ά. 
 
11.7. Δορυφόρος WorldView 
 
Οι δορυφόροι WorldView-1 και 2 είναι εμπορικοί, οπτικοί δορυφόροι εικόνων υψηλής 
ευκρίνειας που ανήκουν στην εταιρία DigitalGlobe. Εκτελούν ηλιοσύγχρονη τροχιά 
και υπερύπτανται του Ισημερινού στις 10:30 π.μ., σε κάθε τροχιά. 
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Ο δορυφόρος WorldView-1 ετέθη σε τροχιά στις 18/9/2007, ενώ ο δορυφόρος 
WorldView-2 στις 8/10/2009. Και οι δύο δορυφόροι εκτοξεύτηκαν με πυραύλους 
Delta 7920 από την αεροπορική βάση Βάντενμπεργκ. Οι κύριες εφαρμογές των 
δορυφόρων WoldView είναι η χαρτογράφηση υψηλής ευκρίνειας, η ανίχνευση 
αλλαγών της γήινης επιφάνειας, η στερεοσκοπική τρισδιάστατη απεικόνιση κ.ά. 
Στους Πίνακες 11.7 - 11.8 δίδονται τα χαρακτηριστικά των δορυφόρων WoldView1 & 
2 και των αισθητήρων αυτών, αντιστοίχως. 
 
Ο WorldView-3 ετέθη σε τροχιά στις 13 Αυγούστου 2014 με τα χαρακτηριστικά όπως 
δίδονται στον Πίνακα 11.9. Στην Εικόνα 11.3. δίδεται μια από τις πρώτες εικόνες του 
δορυφόρου. 

 
Πίνακας 11.7. Μερικά από τα Χαρακτηριστικά του Δορυφόρου WorldView-1 

 

Φασματική 
Διακριτική 
Ικανότητα 

(nm) 

Χωρική 
Διακριτική 

Ικανότητα (m) 

Πλάτος 
Σάρωσης (km) 

Περίοδος 
Επανεμφάνισης 

στην ίδια 
περιοχή 

Τροχιά 

Αναμενόμενη 
Περίοδος 

Λειτουργίας 

400 - 900 
πανχρωματικό 

0,50 στο ναδίρ 
 
0,59 σε γωνία 
25° off-nadir, 
κατά μήκος της 
τροχιάς 

17,6 στο ναδίρ ̴  1,7 ημέρες  496 km 
ηλιοσύγχρονη 

2007-2018 

 
Πίνακας 11.8. Μερικά από τα Χαρακτηριστικά Δορυφόρου WorldView-2 

 

Φασματική 
Διακριτική Ικανότητα 

(nm) 

Χωρική Διακριτική 
Ικανότητα (m) 

Πλάτος 
Σάρωσης 

(km) 

Περίοδος 
Επανεμφάνισης 

στην ίδια 
περιοχή 

Τροχιά 

Αναμενόμενη 
Περίοδος 

Λειτουργίας 

Panchromatic 
450-800 nm 

Panchromatic: 
0.46 m GSD στο ναδίρ 
0.52 m GSD σε γωνία 
200

 
 off-Nadir 

 
Multispectral: 
1.84 m GSD στο 
Ναδίρ  
2.08 meters GSD σε 
γωνία 200 

 
off-nadir 

 
 
 
 

16,4 στο 
ναδίρ 

1,1 ημέρες στο 
ναδίρ  
 
3,7 ημέρες στις 
20° off-nadir 

770 km 
ηλιοσύγχρονη 

2009-2017 

450-510 (μπλε) 

510-580 (πράσινο)  
 

 
 

 
 

 
 630-690 (κόκκινο)  

 
 
 

 
 

 
 770-895 (εγγύς 

υπέρυθρο) 
 
 

 
 

 
 

 
 

400 - 450 
(παράκτια ζώνη) 

 
 

 
 

 
 

 
 

585 - 625 
(κίτρινο) 

 
 

 
 

 
 

 
 

705-745 (ερυθρό 
άκρο του 

φάσματος) 

 
 

 
 

 
 

 
 

860-1040 (εγγύς 
υπέρυθρο 2) 
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Πίνακας 11.9. Μερικά από τα Χαρακτηριστικά του Δορυφόρου WorldView-3. 
 

Φασματική Διακριτική 
Ικανότητα (nm) 

Χωρική 
Διακριτική 

Ικανότητα (m) 
( or GSD, Ground 
Sample Distance; 

off-nadir is 
geometric mean) 

Πλάτος 
Σάρωσης (km) 

Περίοδος 
Επανεμφάνισης 

στην ίδια περιοχή 
(σε 40°N 
Latitude) Τροχιά 

Αναμενόμενη 
Περίοδος 

Λειτουργίας 

Panchromatic:  450-800 
nm 
 
 
 
 
8 Multispectral:  (red, 
red edge, coastal, blue, 
green, yellow, near-IR1 
and near-IR2) 400 nm - 
1040 nm 
 
 
8 SWIR: 1195 nm - 
2365 nm 

 
 
 
12 CAVIS Bands: 
(desert clouds, 
aerosol-1, aerosol-2, 
aerosol-3, green, 
water-1, water- 2, 
water-3, NDVI-
SWIR, cirrus, snow) 
405 nm - 2245 nm 
 

0.31 m GSD στο 
ναδίρ  
0.34 m σε γωνία 
20° Off-Nadir 
 
 
1.24 m στο Nadir 
1.38 m σε γωνία 
20° Off-Nadir 
 
 
 
 
3.70 m at Nadir 
4.10 m σε γωνία 
20° Off-Nadir 
 
 

 
30.00 m 

 
 

13.1 km στο 
ναδίρ 

1 m GSD:  
<1.0 ημέρα 
 
4.5 ημέρες σε 
γωνία 20° off-
nadir ή μικρότρη 

617 km 
Ηλιοσύγχρονη 
 1:30 pm 
descending Node  
 
Περίοδος: 97 min 

7.5 – 12 έτη 

 
 

 
 

 
 

 
 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
11.8. Οι Δορυφόροι TIROS/NOAA 
 
Οι μετεωρολογικοί δορυφόροι είχαν τεθεί σε τροχιά γύρω από τη Γη αρκετές 
δεκαετίες πριν. Ο πρώτος μετεωρολογικός δορυφόρος με πολική τροχιά ονομαζόταν 
TIROS (Television Infrared Observation Satellite) και ετέθηκε σε λειτουργία την 
1/4/1960 από την Εθνική Επιτροπή Ωκεανών και Ατμόσφαιρας των Η.Π.Α. 
Το πρόγραμμα μετονομάσθηκε σε ΝΟΑΑ-N (National Oceanic and Atmospheric 
Administration) και πιο πρόσφατοι δορυφόροι αριθμήθηκαν ως ΝΟΑΑ-6 (1979), 
ΝΟΑΑ-7 (1981), ΝΟΑΑ-8 (1983), ΝΟΑΑ-9 (1984),  ΝΟΑΑ-10 (1986) από ΝΟΑΑ-A, -
C, -E, -F, -G αντίστοιχα κ.λ.π. 
 
11.9. Οι Δορυφόροι IRS-MOS-METEOR 
 
Το Ινδικό Δορυφορικό Πρόγραμμα Τηλεανίχνευσης IRS στοχεύει στην ανάπτυξη  
δυνατότητας παρακολούθησης της γήινης επιφάνειας, ιδιαίτερα πάνω από την 
περιοχή της Ινδίας, σε διαφορετικές περιοχές του ηλεκτρομαγνητικού φάσματος. Ο 
IRS-1A εκτοξεύθηκε με το διαστημικό πύραυλο Proton από τον Ινδικό Οργανισμό 
Διαστημικής Έρευνας στις 17/3/1988 και τον Αύγουστο του 1991 εκτοξεύθηκε ο IRS-
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1Β και αργότερα ο IRS-C. Οι εφαρμογές του IRS είναι ο εντοπισμός υπογείων 
υδάτων, χαρτογράφηση χρήσης γης, δασών και πλημμύρων και καταγραφή της 
επιφάνειας υδάτινων μαζών. 
 
Ο πρώτος Ιαπωνικός ερευνητικός δορυφόρος είναι ο MOS-1 ο οποίος τέθηκε σε 
τροχιά τον Φεβρουάριο του 1987 και είναι ο πρώτος μιας σειράς δορυφόρων που 
πρόκειται να ολοκληρωθεί στην δεκαετία του '90. Ήδη τον Φεβρουάριο του 1990 
τέθηκε σε τροχιά ο MOS-1b. Σκοπός του MOS-1 είναι η παρατήρηση φαινομένων 
που συμβαίνουν στην επιφάνεια της θάλασσας και των ηπείρων. Από τους 
αισθητήρες του MOS-1 βασικά ανιχνεύονται το χρώμα και η θερμοκρασία της 
θάλασσας, τα αιωρούμενα σωματίδια στις υδάτινες μάζες, οι υδρατμοί της 
στρατόσφαιρας, οι μεταβολές στο χιόνι και στον πάγο, οι θερμοκρασίες της 
επιφάνειας της Γης και τέλος χαρακτηριστικά της βλάστησης. 
 
Η πρώην Σοβιετική Ένωση ξεκίνησε ένα δορυφορικό πρόγραμμα με χρήση 
αισθητήρων για την παρακολούθηση του περιβάλλοντος τη δεκαετία του ΄80 με τη 
σειρά METEOR. Από το 1994  η EURIMAGE  αντιπροσωπεύει εικόνες και αυτού του 
προγράμματος με εικόνες KFA με χωρική ανάλυση 2 m. 
 

 

 
 
Εικόνα 11.3.  Η  Μαδρίτη 
όπως φαίνεται από τις 
πρώτες εικόνες του 
δορυφόρο WorldView-
3. http://www.satimagingc
orp.com/gallery/worldview
-3/worldview-3-satellite-
image-madrid-spain/ 
 

 
 
11.10. Συστήματα RADAR 
 
Ο όρος «radar»  προέρχεται από τα αρχικά των λέξεων Rαdio  Detection  and 
Ranging (Ράδιο Ανίχνευση και Εμβέλεια). Τα Radar αποτελούν ενεργητικό σύστημα 
Tηλεανίχνευσης διότι λειτουργούν τα ίδια ως πηγή ενέργειας, δηλαδή εκπέμπουν 
προς την γήινη επιφάνεια ηλεκτρομαγνητική ενέργεια και κατόπιν ανιχνεύουν την 
ενέργεια που επιστρέφει  στον δορυφόρο (backscattered signals), την οποία 
καταγράφουν ως εικόνα, με σκοπό την ανίχνευση αντικειμένων και χαρακτηριστικών 
του αναγλύφου. Λειτουργούν στην μικροκυματική περιοχή του Η/Μ φάσματος.  Ένα 
σύστημα Ραντάρ δεν κοιτάζει προς το ναδίρ, αλλά προς τα κάτω και πλαγίως (Eικόνα 
11.4 ). 

http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-spain/�
http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-spain/�
http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-spain/�
http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-spain/�
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Η καταγραφή των τόνων μιας εικόνας Radar συνίσταται στην μέτρηση της ισχύος του 
μικροκυματικού αντίλαλου (echo strength) και είναι ένα προϊόν  συνδυασμού πολλών 
επιφανειακών ιδιοτήτων του γήινου περιβάλλοντος και του συστήματος Radar. 
Αντικείμενα, τα οποία είναι πολύ καλοί ανακλαστές, αντιπροσωπεύονται σε μια 
εικόνα με ανοιχτόχρωμους τόνους, ενώ εκείνα που είναι φτωχοί ανακλαστές με 
σκούρα χρώματα. Τα αντικείμενα, τα οποία δεν έχουν μετρήσιμη ανάκλαση 
αποδίδονται ως μαύρα. 
 
Η χρήση των συστημάτων Radar προσφέρει αρκετά πλεονεκτήματα, όπως: 
λειτουργούν καθόλο το εικοσιτετράωρο ανεξάρτητα από την ηλιακή ακτινοβολία και 
δύνανται να λαμβάνουν δεδομένα και με νεφοκάλυψη. Για μήκη κύματος μεγαλύτερα 
των 3cm ή συχνότητας μικρότερης των 10MHz τα σύννεφα είναι περατά, οπότε και 
δεν αποτυπώνονται στην εικόνα. Το γεγονός αυτό οφείλεται κυρίως στο ότι τα υγρά 
σωματίδια των νεφών έχουν μια μέση διάμετρο 0,01mm, που είναι σαφώς μικρότερη 
από τα μήκη κύματος του Radar. Βέβαια, παρ’ όλα αυτά μια ισχυρή καταιγίδα 
δύναται να καταστήσει ασθενέστερο το εκπεμπόμενο και λαμβανόμενο σήμα και σε 
σπάνιες περιπτώσεις να καταγράψει και το φαινόμενο. Επίσης, εαν και δεν 
ανιχνεύουν χρωματικές ή θερμοκρασιακές πληροφορίες, ανιχνεύουν πολύ καλά την 
τραχύτητα του εδάφους, τις κατωφέρειες και δίνουν πληροφορίες για την ηλεκτρική 
αγωγιμότητα. 
 
Με την εφαρμογή των RADAR, δύνανται να διακριθούν ευκολότερα γεωλογικές - 
τεκτονικές - γεωμορφολογικές δομές, αρκεί να έχει προηγηθεί η γεωμετρική 
διόρθωση των εικόνων και η απαλλαγή από τις παραμορφώσεις. Επίσης η 
συμβολομετρία (interferometry) χρησιμοποιείται για την μελέτη της εδαφικής 
παραμόρφωσης αλλά και της γεωδυναμικής μιας περιοχής.  
 

 
Εικόνα 11.4. Γεωμετρία σάρωσης ενός συστήματος Ραντάρ: 
(α) Διεύθυνση πτήσης (Α), Ναδίρ (Β), πλάτος εδαφικής λωρίδας που σαρώνεται (swath - 
C), κάθετα στην διεύθυνση πτήσης (across-track dimension / Range - D) , παράλληλα στην 
διεύθυνση πτήσης (along-track dimension / azimuth – E), τμήμα λωρίδας σάρωσης 
πλησίον του Ναδίρ (near range - Ν), τμήμα λωρίδας σάρωσης μακριά από το Ναδίρ (far 
range - F). 
(β) Γωνία πρόσπτωσης (incidence αngle – A),   Γωνία Παρατήρησης (look angle - Β) 
καλείται η γωνία που σχηματίζεται από την διεύθυνση παρατήρησης και την κάθετη στο 
έδαφος. Η γωνία παρατήρησης επηρεάζει σημαντικά την ένταση οπισθοσκέδασης,  
απόσταση από το ραντάρ έως τον στόχο (slant range distance – C), πραγματική οριζόντια 
απόσταση στο έδαφος αντίστοιχη της «slant range distance» για κάθε σημείο-στόχο 
(ground range distance – D) 
Η λήψη των απεικονίσεων πραγματοποιείται είτε κατά την ανοδική τροχιά (από Νότο προς 
Βορρά), είτε κατά την καθοδική τροχιά (από Βορρά προς Νότο).  
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Δορυφόροι με χρήση Radar είναι οι ERS-1, ERS-2, ENVISAT, SEASAT-1, JERS-1, 
RADARSAT-1 & 2, TerraSAR-X, ALMAZ, Cosmo-SkyMed, TerraSAR-X, TanDEM-X . 
 
11.10.1. Δορυφόροι ERS 
 
Οι δορυφόροι ERS-1 και ERS-2 κατασκευάσθηκαν από την ευρωπαϊκή βιομηχανία, 
υπό την διεύθυνση της Ευρωπαϊκής Υπηρεσίας Διαστήματος (ESA). Έθησαν σε 
τροχιά το 1991 και 1995, αντιστοίχως και προσφέρουν εικόνες με χωρική διακριτική 
ικανότητα 30m. 
 
Ο δορυφόρος ERS-1 λειτούργησε έως τον Μάρτιο του 2000 και ήταν ο πρώτος 
δορυφόρος παρακολούθησης της Γης με χρήση Radar. O ERS-2 λειτούργησε έως 
τον Σεπτέμβριο του 2011. 
 
Οι δορυφόροι ήταν εξοπλισμένοι με αισθητήρες που εδύναντο να μετρήσουν 
διάφορα χαρακτηριστικά. Επί παραδείγματι, αισθητήρες μετρούν την διεύθυνση και 
την ταχύτητα του ανέμου επάνω από τους ωκεανούς, το ύψος των κυμάτων κ.ά. 
 
Ο αισθητήρας C-band SAR (Synthetic Aperture Radar - Συνθετικού Ανοίγματος 
Ραντάρ) απεικονίζει την επιφάνεια της Γης και χρησιμοποιείται κυρίως για 
χαρτογραφικούς σκοπούς. Παράγει εικόνες της επιφάνειας της Γης, ανεξαρτήτως των 
καιρικών συνθηκών, καθόλο το εικοσιτετράωρο, με υψηλή χωρική διακριτική 
ικανότητα, προσφέροντας πληροφορία σχετικά με τα φυσικά χαρακτηριστικά της γης. 
Τα συστήματα συνθετικού ανοίγματος ραντάρ καταγράφουν την ένταση και την φάση 
του σήματος οπισθοσκέδασης. Η ένταση του σήματος δημιουργεί εικόνες με την 
μορφή αποχρώσεων του γκρι, σύμφωνα με τις τιμές της έντασης. Η ανάλυση και 
ερμηνεία μιας εικόνας SAR είναι διαφορετική από εκείνη ενός οπτικού ή ενός 
υπέρυθρου αισθητήρα. Οι εικόνες SAR δεν είναι έγχρωμες, αλλά παρέχουν στοιχεία 
για την τραχύτητα της επιφάνειας. Οι συχνότητες που χρησιμοποιούνται στο SAR 
δίδονται στην εικόνα 11.5. To πλάτος σάρωσης είναι 100 km ενώ η χωρική διακριτική 
ικανότητα είναι 26 m κάθετα στην διεύθυνση πτήσης και 6–30 m παράλληλα στην 
διεύθυνση πτήσης.  
 
Ο δορυφόρος ERS-2 επανδρώθηκε με ένα ραδιόμετρο σαρώσεως κατά μήκος της 
τροχιάς του δορυφόρου (Along Track Scanning Radiometer, ATRS). Αυτό αποτελεί 
έναν παθητικό αισθητήρα με 7 κανάλια στο ορατό, το εγγύς υπέρυθρο και το θερμικό 
υπέρυθρο του Η/Μ φάσματος. Το θερμικό υπέρυθρο είναι ιδιαίτερα χρήσιμο για την 
χαρτογράφηση της θερμοκρασίας στην επιφάνεια της θάλασσας. Το ορατό και το 
εγγύς υπέρυθρο κανάλι με χωρική ανάλυση 1km δύνανται να να χρησιμοποιηθούν 
για τη χαρτογράφηση της βλάστησης σε παγκόσμια κλίμακα.  

Επίσης, ο ERS-2 ήταν εξοπλισμένος με όργανα κατάλληλα για την παγκόσμια 
χαρτογράφηση του στρώματος του όζοντος. Τα δεδομένα του ERS-2 έχουν 
ουσιαστική σημασία για την έρευνα και επιστήμη ως προς την κατανόηση των 
διαφόρων μεταβολών στο στρώμα του όζοντος και στον προσδιορισμό της 
επίδρασης που έχει η ανθρωπογενής ρύπανση. 
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Εικόνα 11.5. Οι συχνότητες και τα μήκη κύματος που χρησιμοποιούνται στο SAR. 
(http://www.radartutorial.eu/07.waves/Waves%20and%20Frequency%20Ranges.en.
html) 
 
11.10.2. Δορυφόρος Envisat 

 
Την 1η Μαρτίου του 2002, η Ευρωπαϊκή Υπηρεσία Διαστήματος έθεσε σε τροχιά τον 
ENVISAT, έναν εξελιγμένο δορυφόρο πολικής τροχιάς, ο οποίος ελάμβανε μετρήσεις 
από την ατμόσφαιρα, τους ωκεανούς, τη γη και τους πάγους. Δυστυχώς σταμάτησε 
να λειτουργεί τον Απρίλιο του 2012. Τα δεδομένα του ENVISAT συνεισέφεραν στην 
επιστημονική μελέτη του πλανήτη και στην παρακολούθηση των περιβαλλοντικών 
και κλιματικών αλλαγών καθώς και στην ανάπτυξη διαφόρων τεχνολογικών και 
εμπορικών εφαρμογών. Εξοπλισμένος με δέκα διάφορου είδους αισθητήρες 
καταγράφει διάφορα χαρακτηριστικά της γήινης επιφάνειας (ξηρά και θάλασσα) και 
της ατμόσφαιρας. 
 
Το Προηγμένο Ραδιόμετρο Σαρώσεως AATSR (κατά μήκος της τροχιάς) 
δημιουργήθηκε για να συνεχίσει το έργο των AATRS-1 και AATRS-2 (των 
δορυφόρων ERS). Παρέχει ακριβείς μετρήσεις της θερμοκρασίας στην επιφάνεια της 
θάλασσας (με διακριτική ικανότητα 0,3ο

Το Προηγμένο Ραντάρ Συνθετικού Ανοίγματος Κεραίας (ASAR), εκπέμπει στη ζώνη 
C και έχει ενισχυμένες δυνατότητες σε ό,τι αφορά το εύρος γεωγραφικής κάλυψης, τη 
γωνία πρόσπτωσης, την πολικότητα και τον τρόπο λειτουργίας.  

 Κ ή καλύτερη), οι οποίες χρησιμοποιούνται 
στην έρευνα του κλίματος. 

Το MERIS είναι ένα απεικονιστικό φασματόμετρο που μετρά την ηλιακή ακτινοβολία 
που ανακλάται από τη γη. Έχει χωρική διακριτική ικανότητα 1040 x 1200 m για 
εφαρμογές στην θάλασσα και 2360 x 300 m για εφαρμογές στην ξηρά και σε 
παράκτιες περιοχές. Διαθέτει 15 φασματικές ζώνες στην περιοχή του ορατού και του 
υπέρυθρου(390– 1040 nm)
 
Το MERIS είχε κατασκευασθεί ώστε να καλύπτει ολόκληρη την Γη σε 3 ημέρες. 
Πρωταρχική αποστολή του MERIS είναι η μέτρηση του χρώματος της θάλασσας 
στους ωκεανούς και τις παράκτιες περιοχές και κατά συνέπεια τη συγκέντρωση της 
χλωροφύλλης, τη συγκέντρωση αιωρούμενων ιζημάτων και το φόρτο αιωρούμενων 
σωματιδίων πάνω από διάφορες θαλάσσιες περιοχές. Όλες οι παράμετροι βοηθούν 
στη μελέτη του κύκλου του άνθρακα και των θερμικών συνθηκών στην επιφάνεια των 
ωκεανών. Αυτά τα δεδομένα είναι χρήσιμα για τη σωστή διαχείριση της αλιείας στις 
παράκτιες ζώνες.  

. 

 
Προκειμένου να κατανοθούν οι διαδικασίες που προσδιορίζουν την φυσική και 
φωτοχημική συμπεριφορά της ατμόσφαιρας, απαιτούνται ακριβείς μετρήσεις, σε 
παγκόσμιο επίπεδο, της απόλυτης ποσότητας της οριζόντιας και της κατακόρυφης 
κατανομής του όζοντος σε συνδυασμό με τις μετρήσεις πολλών άλλων 

http://www.radartutorial.eu/07.waves/Waves%20and%20Frequency%20Ranges.en.html�
http://www.radartutorial.eu/07.waves/Waves%20and%20Frequency%20Ranges.en.html�
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ατμοσφαιρικών αερίων ιχνοστοιχείων. Όλα αυτά τα δεδομένα παράγονται από τους 
αισθητήρες του Envisat: GOMOS, MIPAS, SCIAMACHY. 
 
11.10.3. Δορυφόροι Radarsat - 1 & 2 
 
Ο Δορυφόρος RADARSAT-1 ετέθη σε τροχιά το 1995. Φέρει ένα right-looking C-
band SAR όργανο με πόλωση H-H. Λαμβάνει δεδομένα με διαφορετικούς τρόπους: 
fine, standard, wide, ScanSAR narrow, ScanSAR wide, Extended High and Extended 
Low.  Τα πλάτη σάρωσης και η χωρική διακριτική ικανότητα διαφέρουν.  
 
Ο RADARSAT-2 ετέθη σε τροχιά τον Δεκέμβριο του 2007. Φέρει ένα  C-band SAR 
όργανο. Έχει την δυνατότητα διαφόρων πολώσεων και διαφόρων τρόπων λήψης 
δεδομένων: Ultra-Fine, Multi-Look Fine, Fine-Quad-Pol, Standard-Quad Pol, Fine, 
Standard, Wide, ScanSAR narrow, ScanSARwide.  
 
11.10.4. Δορυφόροι Cosmo-SkyMed 
 
Η Ιταλική αποστολή Cosmo-SkyMed αποτελεί μια ομάδα τεσσάρων δορυφόρων που 
καθένας φέρει έναν αισθητήρα X-band SAR. Ο τέταρτος δορυφόρος ετέθη σε τροχιά 
το 2010. Η αποστολή λαμβάνει δεδομένα με τρεις τρόπους: 

StripMap με έκταση 3040 km και διακριτική ικανότητα 3–15 m. 
ScanSar με έκταση 100×100×200×200 km και διακριτική ικανότητα από 30×30 
m έως 100×100 m  
Spotlight-2 με έκταση 10×10 km και διακριτική ικανότητα 1×1 m.  

Χρησιμοποιείται για πολιτικούς και στρατιωτικούς σκοπούς. Τα προιόντα του 
αποτελούν χρήσιμο εργαλείο στην διαχείριση φυσικών και ανθρωπογενών 
καταστροφών (πλημμύρες, πυρκαγιές κ.ά.), στην υδρογεωλογία, κλιματολογία, 
παρακολούθηση θαλάσσιων και παράκτιων περιοχών κ.ά. 
 
11.10.5.   Δορυφόρος TERRASAR-X 
 
Ο Γερμανικός Δορυφόρος TerraSAR-X (ελέγχεται από German Aerospace Center 
(DLR) και Astrium GmbH) ετέθη σε τροχιά το 2007 και φέρει έναν υψηλής ακρίβειας 
αισθητήρα τον X-band SAR. Η λήψη δεδομένων επιτυγχάνεται με τρεις τρόπους: 

SpotLight διακριτικής ικανότητας 1m και έκτασης 5×10 km 
StripMap διακριτικής ικανότητας 3m και έκτασης 30×50 km  
ScanSAR διακριτικής ικανότητας 16 m και έκτασης 100×150 km. 

 
11.10.6.    Δορυφόρος TanDEM-X 
 
Ο Γερμανικός Δορυφόρος TanDEM-X (ελέγχεται από το German Aerospace Center 
(DLR) και Astrium GmbH) ετέθη σε τροχιά το 2010 και είναι σχεδόν όμοιος με τον 
and TerraSAR-X. Οι δύο δορυφόροι πετούν σε ελεγχόμενο σχηματισμό. Σκοπός είναι 
η δημιουργία ενός παγκόσμιου ΨΜΑ με υψηλή ακρίβεια. Τα προϊόντα των 
TerraSAR-X και TanDEM-X αποτελούν χρήσιμο εργαλείο για επιστημονικές 
εφαρμογές. 
 
11.10.7. Εφαρμογές των Συστημάτων Ραντάρ 
 

• Τα συστήματα ραντάρ επιτρέπουν την παρακολούθηση και μελέτη του 
περιβάλλοντος καθόλο το εικοσιτετράωρο αναξαρτήτως των καιρικών συνθηκών. 

• Καταγράφουν και μετρούν τον κυματισμό της θάλασσας, το οποίο χρησιμεύει 
στην μετεορολογία και στην έγκαιρη προειδοποίηση για επερχόμενη 
καταστροφή. 
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• Κατά μήκος των ακτών και στην ανοικτή θάλασσα δύνανται να ανιχνευθούν 
πετρελαιοκηλίδες αρκετά χρόνο έως να φθάσουν στις ακτές. 

• Οι εικόνες ραντάρ είναι χρήσιμες για την χάραξη πορείας των παγοθραυστικών 
πλοίων στην Αρκτική και Ανταρκτική, ιδιαίτερα κα τ΄την νύχτα ή στην ομίχλη. 

• Στην ξηρά οι εικόνες ραντάρ είναι σημαντικές για την παρακολούθηση 
πλημμύρων καθώς και άλλων φυσικών καταστροφών. Η παρακολούθηση - 
διαχείριση φυσικών καταστροφών σχετικών με σεισμούς, ηφαίστεια και 
κατολισθήσεις μέσω της ανίχνευσης και παρακολούθησης της εδαφικής 
παραμόρφωσης επιτυγχάνεται σε μεγάλο βαθμό με την συμβολομετρία ραντάρ. 
Η μελέτη της εδαφικής παραμόρφωσης σε συνδυασμό με την γεωλογία, 
τεκτονική, υδρογεωλογία, μετρήσεις GPS κ.ά. δύναται να χρησιμοποιειθεί για την 
γεωδυναμική μελέτη μιας περιοχής, την μελέτη καθιζήσεων κ.ά. Επίσης χρήσιμες 
είναι στην γεωργία με την μέτρηση καλλιεργειών κ.ά. καθώς και στον 
προσδιορισμό δασικών εκτάσεων κ.ά. 

• Γενικά τα συστήματα ραντάρ αποτελούν σημαντικό εργαλείο για την 
παρακολούθηση και προστασία του περιβάλλοντος. 

11.10.8. Επιλογή εικόνων Ραντάρ μέσω EOLI-sa της ESA 
 
H Ευρωπαϊκή Υπηρεσία Διαστήματος (ESA) παρέχει την δυνατότητα απόκτησης 
εικόνων ραντάρ για ερευνητικούς σκοπούς σε Πανεπιστήμια κ.ά. Η επιλογή των 
κατάλληλων εικόνων είναι δυνατή μέσω του προγράμματος EOLI-sa της ESA 
(Εικόνα 11.6). 
 

 
 
Εικόνα. 11.6.   Μέσω του διαθέσιμου στο Internet λογισμικού είναι δυνατή η επιλογή εικόνων 
Ραντάρ ώστε να γίνει η παραγγελία στην ESA. 
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11.10.9. Συμβολομετρία Συνθετικού Ανοίγματος Ραντάρ  
 
Η τεχνική της Συμβολομετρίας Συνθετικού Ανοίγματος Ραντάρ (Interferometry 
SAR / InSAR) βασίζεται στην επεξεργασία δύο ή περισσοτέρων εικόνων ραντάρ 
(SAR), οι οποίες απεικονίζουν την ίδια περιοχή και έχουν ληφθεί από δύο 
διαφορετικές αλλά με μικρή απόκλιση θέσεις στον χώρο ή στον χρόνο, ώστε 
παρουσιάζουν διαφορά στην φάση του σήματος οπισθοσκέδασης, με σκοπό την 
εξαγωγή πληροφοριών σχετικών με το ανάγλυφο της γήινης επιφάνειας και τον 
προσδιορισμό των εδαφικών μετακινήσεων μιας περιοχής.  
 
Η διαφορά φάσης σχετίζεται με το ανάγλυφο και δύναται να χρησιμοποιηθεί για την 
παραγωγή ΨΜΑ. Όταν ένα αντικείμενο παρατηρείται από δύο ελαφρώς διαφορετικές 
γωνίες είναι δυνατόν να υπολογισθεί το υψόμετρο και να προκύψει η τρισδιάστατη 
αναπαράσταση της εικόνας. 
 
Το εύρος (amplitude - Α)  και η φάση (phase - φ) του κύματος καθώς και η ένταση 
της Η/Μ ακτινοβολίας αποτελούν σημαντικές παραμέτρους στην συμβολομετρία (Εικ.   
11.7-11.8). 

Εύρος ή Πλάτος Κύματος (Α): Το σημείο που διαταράσσεται περιοδικά λαμβάνει 
μία μέγιστη και μία ελάχιστη τιμή. Θεωρώντας ως μηδέν το μέσον της μέγιστης και 
της ελάχιστης τιμής, συνεπάγεται ότι η απόλυτη τιμή της ελάχιστης τιμής είναι ίση με 
την απόλυτη τιμή της μέγιστης και αποτελεί το πλάτος του κύματος. Μετράται σε 
μονάδες μήκους (m). Το πλάτος ενός κύματος δεν είναι πάντοτε σταθερό και 
συνήθως εξαρτάται, όπως και η φάση, από την θέση και τον χρόνο στον οποίο 
μελετάται ένα σημείο. Το πλάτος του κύματος σε ένα σημείο έχει άμεση σχέση με την 
ενέργεια του κύματος σε αυτό το σημείο.  

Φάση Κύματος (φ) ορίζεται ως το μέγεθος που εκφράζει την απομάκρυνση ενός 
σημείου που εκτελεί ταλάντωση από την θέση ισορροπίας του σε δεδομένη χρονική 
στιγμή. Είναι γωνία, μετράται σε ακτίνια (rad) και κυμαίνεται από 0 - 2π. 
 
Η τιμή της φάσης είναι σημαντική διότι συνδέεται με την απόσταση δέκτη-στόχου. Η 
φάση συνήθως είναι γραμμική συνάρτηση της θέσης και του χρόνου, δηλαδή της 
μορφής:        φ = αt + βχ          
 
Συμφασικά ή σε φάση είναι δύο σημεία όταν ευρίσκονται στο ίδιο σημείο της 
διαταραχής και άρα συμπεριφέρονται λόγω του κύματος κατά τον ίδιο τρόπο. Εάν 
υποτεθεί ότι η φάση ενός σημείου Α είναι φΑ και ενός σημείου Β είναι φΒ, 
φ

ισχύει:  
Α - φΒ = 

 
2κπ. 

Σε αντίθεση φάσης είναι δύο σημεία που απέχουν το ήμισυ του μήκους κύματος και 
συμπεριφέρονται αντίθετα λόγω του κύματος. Εάν υποτεθεί ότι η φάση ενός σημείου 
Α είναι φΑ και ενός σημείου Β είναι φΒ, ισχύει: φΑ - φΒ = 
 

2κπ + π. 

 

 
Εικόνα 11.7. Μήκος Κύματος, 
Φάση και Εύρος Κύματος 
(πηγή: GAMMA Remote 
Sensing). 
 

http://el.wikipedia.org/wiki/%CE%91%CF%80%CF%8C%CE%BB%CF%85%CF%84%CE%B7_%CF%84%CE%B9%CE%BC%CE%AE�
http://el.wikipedia.org/wiki/%CE%9C%CE%AE%CE%BA%CE%BF%CF%82�
http://el.wikipedia.org/wiki/%CE%95%CE%BD%CE%AD%CF%81%CE%B3%CE%B5%CE%B9%CE%B1�
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Όσον αφορά στην Ένταση της ηλεκτρομαγνητικής ακτινοβολίας, εκφράζει  το 
μέγεθος το οποίο εξαρτάται από την απόσταση που διανύει η ηλεκτρομαγνητική 
ακτινοβολία και είναι αντιστρόφως ανάλογο του τετράγωνου της απόστασης που έχει 
διανυθεί.  Αυτό σημαίνει ότι όταν η ηλεκτρομαγνητική ακτινοβολία διανύει μεγαλύτερη 
απόσταση, η ένταση ελλατώνεται. 
 
Τα όργανα απεικόνισης τύπου συνθετικού ανοίγματος ραντάρ (SAR), παράγουν 
εικόνες της επιφάνειας της Γης, ανεξαρτήτως των καιρικών συνθηκών, ημέρα και 
νύχτα, με υψηλή χωρική διακριτική ικανότητα, προσφέροντας πληροφορία σχετικά με 
τα φυσικά χαρακτηριστικά της. Τα συστήματα συνθετικού ανοίγματος ραντάρ 
καταγράφουν την ένταση και την φάση του σήματος οπισθοσκέδασης. Η 
ηλεκτρομαγνητική ακτινοβολία σκεδάζεται προς διάφορες κατευθύνσεις κατά την 
πρόσπτωση σε ηλεκτρικά αγώγιμα σώματα. Το σήμα οπισθοσκέδασης αποτελεί το 
τμήμα της ηλεκτομαγνητικής ακτινοβολίας που επιστρέφει από τον στόχο πίσω στην 
πηγή εκπομπής (οπισθοσκέδαση – backscattering) λόγω του φαινομένου της 
σκέδασης.  
Η ένταση του σήματος δημιουργεί εικόνες με την μορφή αποχρώσεων του γκρι, 
σύμφωνα με τις τιμές της έντασης (Εικόνα 11.8.). 

 
Εικόνα 11.8. Δορυφορική Εικόνα ERS-1 Αργολίδας (14/12/1992) 

 
Κάθε κυψελίδα σε μία εικόνα συνθετικού ανοίγματος ραντάρ, περιέχει πληροφορίες 
που αντιστοιχούν σε τρεις διαφορετικές παραμέτρους (Werle, 1992): 
• Την διαδρομή από τον απεικονιστή προς την επιφάνεια της Γης και πίσω στο 

όργανο, διαιρούμενο από το μήκος κύματος του σήματος που αντιστοιχεί σε 
εκατομμύρια κύκλους φάσεων. 

• Την αλληλεπίδραση μεταξύ του προσπίπτοντος κύματος και των ανακλαστήρων, 
εντός της κυψελίδας εδαφικής διακριτικής ικανότητας. 

• Την διαφορά φάσης που προκαλείται από το σύστημα επεξεργασίας που 
χρησιμοποιείται για την εστίαση της εικόνας.  

 
Η θέση, από την οποία ο δορυφόρος καταγράφει μία περιοχή, μεταβάλλεται σε κάθε 
λήψη με αποτέλεσμα η αντίστοιχη διαφορά στην απόσταση δορυφόρου - Γης να 
προκαλεί διαφορά στην φάση των σημάτων των διαφόρων λήψεων. Η διαφορά στην 
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απόσταση εκφράζεται με έναν ακέραιο αριθμό μηκών κύματος συν ένα κλάσμα ενός 
μήκους κύματος. 
 
Η διαφορά φάσης συνδέεται με το φαινόμενο της συμβολής των κυμάτων.  
 
Συμβολή των κυμάτων παρατηρείται όταν σε ένα μέσον διάδοσης μεταδίδονται 
ταυτόχρονα δύο κύματα από δύο κυματικές πηγές, οι οποίες είναι σύμφωνες, δηλαδή 
έχουν ίδια συχνότητα και μονοχρωματικές, δηλαδή εκπέμπουν αποκλειστικά κύμα 
μιας συγκεκριμένης συχνότητας και μήκους κύματος. Σε όλα τα σημεία, στα οποία τα 
δύο κύματα φθάνουν σε φάση, οι δύο ταλαντώσεις αλληλοενισχύονται (ενισχυτική 
συμβολή). Αυτό σημαίνει ότι στα συγκεκριμένα σημεία συναντώνται δύο κορυφές ή 
δύο κοιλίες των δύο κυμάτων. Τα σημεία ταλαντώνονται έως και με μέγιστο πλάτος. 
Τα συγκεκριμένα σημεία κατανέμονται σε κλάδους μιας ομάδας καμπυλών 
(υπερβολών), οι οποίες ονομάζονται κροσσοί συμβολής (Εικόνα 11.9). Σε όλα τα 
σημεία, στα οποία τα δύο κύματα φθάνουν με διαφορά φάσης π, εξασθενούν ως 
προς την ταλάντωση και δημιουργείται ένα πιο ασθενές κύμα. Στα συγκεκριμένα 
σημεία συναντώνται μια κορυφή με μια κοιλία των δύο κυμάτων. Όταν τα δύο κύματα 
που συμβάλλουν έχουν το ίδιο πλάτος, οι ταλαντώσεις αλληλοαναιρούνται και τα 
σημεία παραμένουν συνεχώς ακίνητα. Τα συγκεκκριμένα σημεία κατανέμονται σε 
κλάδους μιας ομάδας καμπυλών (υπερβολών), οι οποίες παρεμβάλλονται μεταξύ 
των προηγουμένων και ονομάζονται κροσσοί συμβολής (Εικόνα 11.9). 
 
Συμβολομετρική φάση, ορίζεται ως η διαφορά φάσης μεταξύ δύο εικόνων ραντάρ, 
οι οποίες έχουν ληφθεί από ελαφρώς διαφορετικές θέσεις, συμπεριλαμβανομένου 
της «πληροφορίας της γεωμετρίας». 
 
Το σήμα οπισθοσκέδασης, το οποίο λαμβάνεται από ένα σύστημα ραντάρ σε 
απόσταση R, έχει πλάτος Α που σχετίζεται με την ένταση της σκέδασης του στόχου 
και φάση φ, η οποία σχετίζεται με την διπλής κατεύθυνσης διαδρομή του σήματος 
μεταξύ του ραντάρ και του στόχου. Η φάση φ του σήματος ενός ραντάρ εκφράζεται 
μαθηματικά ως:          
                            φ = - 4πR/λ + φscatter    + φdelay 
Όπου: ο όρος (4πR/λ) εκφράζει την συμβολή της φάσης της διπλής κατεύθυνσης 
διαδρομής μεταξύ του στόχου και του ραντάρ, ενώ το αρνητικό πρόσημο εκφράζει 
την καθυστέρηση της φάσης του σήματος επιστροφής, 
(φscatter) η καθυστέρηση φάσης λογω οπισθοσκέδασης,  
(φdelay) η καθυστέρηση φάσης λογω ατμοσφαιρικών επιδράσεων 
 
Η διαφορά φάσης (Δφ) μεταξύ των φάσεων (φ1 και φ2) ενός στόχου στην επιφάνεια 
της Γης, από δύο ελαφρώς διαφορετικές θέσεις στο διάστημα, με αποστάσεις R1 και 
R2 
 

υπολογίζεται ως εξής:  

                      Δφ = φ2 – φ1 = -4π(R2-R1)/λ + Δφscatter + Δφ
 

delay 

Το αποτέλεσμα αυτής της διαφοράς φάσης καλείται συμβολογράφημα ή εικόνα 
συμβολομετρίας. 
 
Η διαφορά φάσης για κάθε σημείο στην επιφάνεια της γης λαμβάνει μία τιμή μεταξύ 
των 0° και των 360°. Για μία σειρά σημείων σε μία δεδομένη περιοχή, οι 360 πιθανές 
τιμές διαφοράς φάσης αποδίδονται ποσοτικά με τις 256 αποχρώσεις του γκρι και 
απεικονίζονται ως κροσσοί αποχρώσεων έντασης (Εικόνα 11.9). 
 
Η εικόνα Συμβολομετρίας δημιουργείται από τους κροσσούς συμβολής που 
προκύπτουν στο σύνολο της περιοχής. Ως κροσσός συμβολής θεωρείται μια σειρά 
από ισοδιαστάσεις στις οποίες διαφορετική απόχρωση του γκρι εντός και κατά μήκος 
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του κροσσού αντιστοιχεί στην ίδια διαφορά φάσης. Η σταθερή διαφορά φάσης εντός 
ενός κροσσού συμβολής σχετίζεται άμεσα με την σταθερή διαφορά της διαδρομής 
από τον απεικονιστή προς την επιφάνεια της Γης και πίσω, ώστε σχετίζεται έμμεσα 
με το ανάγλυφο της επιφάνειας που απεικονίζεται.  
 
Συμπεραίνεται πως η διαφορά στην απόσταση δορυφόρου - Γης είναι συνάρτηση του 
αναγλύφου. Η σταθερή διαφορά στην απόσταση μεταξύ των κροσσών συμβολής 
συσχετίζεται με ένα επίπεδο ανάγλυφο. Καθώς ο δορυφόρος καλύπτει μία μεγάλη 
έκταση (περίπου 100Χ100 km), δημιουργείται μία σειρά από διαδοχικούς κροσσούς 
συμβολής, που στο εσωτερικό του καθενός η διαφορά φάσης εκφράζεται με τις 256 
αποχρώσεις του γκρι (αντίστοιχα, γωνία φάσης 0° - 360°). Η έκταση και το σχήμα 
των κροσσών συμβολής εξαρτώνται από τα τεχνικά χαρακτηριστικά του δορυφόρου, 
από το μήκος κύματος του σήματος και φυσικά από την τοπογραφία.  
 

 
 

Εικόνα 11.9. Κροσσοί συμβολής με διαφορά φάσης σε μια επίπεδη επιφάνεια (α) και 
σε επιφάνεια με ανάγλυφο (β). 

 
Η τεχνική της συμβολομετρίας έχει αναπτυχθεί σημαντικά καθώς είναι από τις πιο 
σημαντικές τεχνικές παρακολούθησης της παραμόρφωσης του εδάφους. Η εδαφική 
παραμόρφωση προκαλεί αρκετές φορές σημαντικές επιπτώσεις, τόσο σε αγροτικές 
όσο και σε αστικές περιοχές. Ο έλεγχος και η παρακολούθηση της εδαφικής 
παραμόρφωσης είναι αναγκαίος, ιδιαιτέρως σε περιοχές υψηλού κινδύνου με σκοπό 
τον μετριασμό του φαινομένου ή και την πρόληψη των επιπτώσεων, κυρίως σε 
αστικές περιοχές. 
 
Η συμβολομετρική φάση ουσιαστικά αποτελεί το άθροισμα επιμέρους συνιστωσών 
και δίδεται με την μαθηματική εξίσωση: 
 

φ = φflat_earth + φtopo  + φdisp + φpath  + φnoise  + n.2π 
 
φflat_earth: φάση λόγω επίπεδης Γης 
φtopo: φάση λόγω τοπογραφίας 
φdisp:  φάση λόγω εδαφικής παραμόρφωσης 
φpath:  φάση λόγω  των ατμοσφαιρικών επιδράσεων 
φnoise:  φάση λόγω θορύβου 
n.2π: όρος ακέραιης ασάφειας ή παράγοντας ξετυλίγματος της φάσης (phase 
unrwrapping), προστίθεται στην μετρούμενη τιμή της φάσης προκειμένου να 
ανακτηθεί η πραγματική τιμή της. 
 
 

(α) (β) 
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Είδη Συμβολομετρίας 
Η συμβολομετρία διακρίνεται σε διάφορα είδη σε σχέση με την διάταξη των κεραίων 
και της μεθόδου λήψης των απεικονίσεων: 

• Κατά πλάτος συμβολομετρία (across-track interferometry) 
• Κατά μήκος συμβολομετρία (along-track interferometry) 
• Επαναληπτική συμβολομετρία  (repeat- track interferometry    
• Διαφορική συμβολομετρία (differential interferometry). 

 
Παράμετροι κατά την Τεχνική της Συμβολομετρίας 
Σημαντικές παράμετροι που υπεισέρχονται κατά την τεχνική  συμβολομετρίας και 
σχετίζονται με το ζεύγος των εικόνων που θα επεξεργασθούν είναι: 
 
• Tο άνυσμα βάσης (baseline), ορίζεται ως η απόσταση μεταξύ των στιγμιαίων 

θέσεων των δύο αισθητήρων που παρατηρούν τον ίδιο στόχο-περιοχή στην 
επιφάνεια του εδάφους. Το άνυσμα βάσης αναλύεται στην παράλληλη συνιστώσα 
(parallel baseline – bn) ως προς την διεύθυνση των αποστάσεων της απεικόνισης 
και στην εγκάρσια συνιστώσα (perpendicular baseline – Bp). 

• Η συμβολομετρική συνάφεια, η οποία αποτελεί το μέτρο ποιότητας της 
συμβολομετρικής φάσης και ορίζεται από τον συντελεστή συσχέτισης δύο SAR 
απεικονίσεων. Η τιμή της κυμαίνεται από 0 (πλήρης αποσυσχέτιση μεταξύ των 
απεικονίσεων) έως την τιμή 1 (πλήρης συσχέτιση των απεικονίσεων). 

 

11.11. Υπερφασματικά δεδομένα 
Η υπερφασματική απεικόνιση (Ηyper Spectral Imaging) αποτελεί ένα σημαντικό 
εργαλείο για την ουσιαστική κατανόηση της Γης και του περιβάλλοντός της. Τα 
συστήματα HIS εμφανίσθηκαν κυρίως  στα τέλη της δεκαετίας του 1970. Ένα από τα 
πρώτα συστήματα ήταν το Airborne Imaging Spectrometer (AIS), ενώ ακολούθησε 
ραγδαία ανάπτυξη στα συστήματα HIS έως σήμερα, με ταυτόχρονη βελτίωση σε όλα 
τα τεχνικά χρακτηριστικά σχετικά με την λήψη μιας απεικόνισης. Η πολυφασματική 
απεικόνιση έχει την δυνατότητα συλλογής δεδομένων για τοπικής ή ευρύτερης 
κλίμακας μελέτες και παρατηρήσεις διαφόρων περιοχών. Η υψηλή διακριτική 
ικανότητα, το εύρος του χρησιμοποιούμενου φάσματος και ο μεγάλος αριθμός των 
διακεκριμένων στενών καναλιών αποτελούν σημαντικά πλεονεκτήματα για την 
συλλογή δεδομένων. Επί παραδείγματι, ο αισθητήρας του Airborne Visible/Infrared 
Imaging Spectometer (AVIRIS) συλλέγει δεδομένα σε 224 φασματικά κανάλια με 
εύρος φάσματος από 0.4 έως 2.5μm και χωρική διακριτική ικανότητα 20m.  Η 
χρησιμότητα των δεδομένων είναι μεγάλη καθώς έχουν την δυνατότητα να 
καταγράφουν με πολύ καλή ακρίβεια τα φασματικά και χωρικά χαρακτηριστικά της  
επιφάνειας της γης και των αντικειμένων σε αυτήν  ώστε χρησιμοποιούνται σε 
πλήθος εφαρμογών.  
 
11.12. Δεδομένα  LIDAR  
 
Ενεργητικό σύστημα τηλεανίχνευσης αποτελεί το σύστημα  Lidar (LIght Detection 
αnd Ranging), το οποίο είναι παρόμοιο με το RADAR και λειτουργεί στην φασματική 
περιοχή του ορατού και εγγύς υπέρυθρου. Ακτινοβολία Laser υπό μορφήν σειράς 
παλμών, εκπέμπεται από τον αισθητήρα και ανιχνεύεται από τον στόχο. Ο χρόνος 
διαδρομής από τον  αισθητήρα στον  στόχο και πίσω στον αισθητήρα, 
χρησιμοποιείται για την μέτρηση της απόστασης αισθητήρα – στόχου. 
Χρησιμοποιείται για την μέτρηση των υψομέτρων της επιφάνειας της Γης και του 
βάθους υδάτων σε σχέση με την επιφάνεια των υδάτων. Χρησιμοποιείται επίσης σε 
μελέτες σχετικές με την ατμόσφαιρα, την ανίχνευση πετρελαιοκηλίδων, 
υποθαλάσσιας χλωροφύλλης κ.ά.  
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12. ΔΟΡΥΦΟΡΙΚΕΣ ΕΙΚΟΝΕΣ 
 
12.1. Γενιικά 
 
Εξαγόμενα της Δορυφορικής Τηλεανίχνευσης αποτελούν τα δορυφορικά δεδομένα 
και ειδικότερα οι δορυφορικές εικόνες. Παραθέτονται βασικές έννοιες σχετικές με τις 
δορυφορικές εικόνες. 
 
Οι δορυφορικές εικόνες, απεικονίζουν μεγάλες εκτάσεις της επιφάνειας της Γης 
υπό σταθερή κλίμακα και συνθήκες σταθερού φωτισμού (Εικόνα 12.1). 

 
Εικόνα 12.1. Ορθο-αναγώμενη δορυφορική εικόνα IKONOS 2 Νισύρου, στο ΕΓΣΑ΄87  με 
μέγεθος εικονοστοιχείου-pixel 1m ( Vassilopoulou et al., 2002). 
 
Η ψηφιακή δορυφορική εικόνα αποτελείται από μικρού μεγέθους δομικά στοιχεία 
(εικονοστοιχεία-κυψελίδες), διατεταγμένα σε στήλες και σειρές, σχηματίζοντας 
πλέγμα-κάνναβο (Εικόνα12.2). Κάθε εικονοστοιχείο προσδιορίζεται από τις 
συντεταγμένες του (χ,y) και αντιπροσωπεύει την τιμή της φωτεινότητας (z) για την 
συγκεκριμένη περιοχή της εικόνας, η οποία εκφράζεται με μια αριθμητική τιμή-έναν 
ψηφιακό αριθμό (digital number – DN). Κάθε ψηφιακή τιμή (DN) καταγράφεται σαν 
ένα σύνολο ψηφιακών δυάδων (bits). 
 
Ο διεθνής όρος για τα στοιχεία του πίνακα-εικονοστοιχεία είναι image elements ή 
pixels (picture elements). 
 
Κάθε ψηφίο (bit) καταγράφει ένα αντιπροσωπευτικό σήμα σε δύναμη του 2. Αν το 
σύστημα σχεδιάστηκε ώστε να καταγράφει οκτώ ψηφία για κάθε ψηφιακή τιμή, τότε 
οκτώ δυαδικές περιοχές είναι διαθέσιμες να καταγράψουν την φωτεινότητα που 
δέχονται για κάθε φασματική ζώνη-μπάντα οι δέκτες.  
 
Οι 8 τιμές καταγράφονται συνεχόμενα, σε δύναμη του 2 (καθοριζόμενα από την θέση 
τους).  Επί παραδείγματι, τα 8 ψηφία τοθ δυαδικού αριθμού  "11111111"  
ισοδυναμούν με τον αριθμό:  
1*27 + 1*26 + 1*25 + 1*24 + 1*23 + 1*22 + 1*21 + 1*20

 

 = 128 + 64 + 32 + 16 + 8 + 4 + 2 
+ 1 = 255 στο δεκαδικό σύστημα. 
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Επίσης, τα 8 ψηφία του δυαδικού αριθμού "11001011"  ισοδυναμούν με τον αριθμό :  
1*27 + 1*26 + 0*25 +0*24+ 1*23 + 0*22 + 1*21 + 1*20

 

 = 128 + 64 + 0 + 0 + 8 + 0 + 2 + 1 
= 203 στο δεκαδικό σύστημα.  

Οπότε, κατά αυτόν τον τρόπο μεταφράζεται η τιμή φωτεινότητας που καταγράφεται 
κάθε φορά. 
 
Οι διακυμάνσεις της φωτεινότητας της εικόνας αντιπροσωπεύουν τις 
διακυμάνσεις στην ένταση της ΗΜ ακτινοβολίας, η οποία καταγράφεται από τον 
αισθητήρα και εξαρτάται από τα  χαρακτηριστικά των υπό παρατήρηση αντικειμένων. 
 
H ασπρόμαυρη εικόνα αποδίδεται με χρωματική κλίμακα του γκρι. Στην έγχρωμη 
εικόνα κάθε εικονοστοιχείο λαμβάνει ένα χρώμα από την σύνθεση των τριών κυρίων 
χρωμάτων κόκκινου – πράσινου - μπλε (Red – Green – Blue / RGB). 
 

 
 

Εικόνα 12.2. Η µαθηµατική θεώρηση µιας ψηφιακής εικόνας είναι ένας διδιάστατος πίνακας, 
του οποίου οι στήλες και οι γραµµές ορίζουν τις διαστάσεις της. Η ψηφιακή εικόνα ορίζεται ως 
f(x,y) ή από µια τριάδα αριθµών (χ,y,z), όπου (z) ορίζει την απόχρωση της εικόνας (η οποία 
εκφράζεται με μια αριθμητική τιμή-έναν ψηφιακό αριθμό (digital number – DN) σε 
συγκεκριµένο σηµείο – pixel µε συντεταγµένες θέσης (χ,y). Όπου (χ): οι οριζόντιες γραµµές 
(lines) των pixels.  Όπου (y) : οι κάθετες γραµµές-στήλες (columns) των pixels. 
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Διακριτική Ικανότητα 
 
H χωρική διακριτική ικανότητα (spatial resolution) αντιπροσωπεύει την πλευρά του 
τετραγώνου (pixel) ή την διάµετρο του κύκλου που σαρώνει ο δέκτης και εν συνεχεία 
καταγράφει ο καταγραφέας την κάθε χρονική στιγµή. Αναφέρεται, δηλαδή, στο 
μέγεθος του μικρότερου χαρακτηριστικού το οποίο δύναται να ανιχνευθεί και 
εκφράζεται σε µέτρα (m), (Εικόνα 12.3). 
 

  
 

Εικόνα 12.3. H χωρική διακριτική ικανότητα εκφράζεται σε μέτρα (m) και όσο μικρότερη είναι η 
τιμή της τόσο μικροτέρων διαστάσεων στοιχεία-αντικείμενα αναγνωρίζονται στην εικόνα. 
 
 
Η χρονική διακριτική ικανότητα (time resolution) εκφράζει πόσο συχνά ο 
καταγραφέας καταγράφει µια συγκεκριµένη περιοχή. Για παράδειγµα, ο LANDSAT 
υπερίπταται  κάποιας περιοχής κάθε 16 ηµέρες, ενώ ο SPOT κάθε 3 ηµέρες. 
 
Η φασµατική διακριτική ικανότητα (spectral resolution).  Αναφέρεται στην διάσταση 
και τον αριθμό των ειδικών περιοχών του μήκους κύματος του ΗΜ φάσματος, στα 
οποία είναι ευαίσθητος ένας δέκτης. Εκφράζει την δυνατότητα αναγνώρισης 
επιφανειών µε διάφορες φασµατικές περιοχές (Εικόνα 12.4).  
 

 

 

 
 
 
Εικόνα 12.4. Η φασµατική 
διακριτική ικανότητα 
εκφράζει την δυνατότητα 
αναγνώρισης επιφανειών 
µε διάφορες φασµατικές 
περιοχές. Μεγάλος αριθμός 
φασματικών περιοχών 
συνεπάγεται καλύτερη 
δυνατότητα διάκρισης 
αντικειμένων στην εικόνα. 
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Η ραδιοµετρική διακριτική ικανότητα (radiometric resolution) αντιπροσωπεύει την 
δυνατότητα βαθµονόµησης του ποσού ενέργειας που δέχεται ο δέκτης και 
καταγράφει ο καταγραφέας για την σύνθεση της εικόνας. Εκφράζεται µε τον αριθµό 
διαβαθµίσεων τόνου (Εικόνα 12.5.).  

                           

 
Εικόνα 12.5. Ο μεγαλύτερος αριθμός διαβαθμίσεων τόνου (16bit – αριστερά και 8-bit  δεξιά) 
συνεπάγεται μεγαλύτερο αριθμό bits και καλύτερη ραδιοµετρική διακριτική ικανότητα, με 
αποτέλεσμα την καλύτερη διάκριση στοιχείων-αντικειμένων στην εικόνα. 

 
12.2. Δορυφορικές Εικόνες και Γεωεπιστήμες 
 
Οι δορυφορικές εικόνες καλύπτουν ευρύ φάσμα εφαρμογών στις Γεωεπιστήμες και 
στις Γεωπεριβαλλοντικές εφαρμογές: Γεωλογία – Τεκτονική – Γεωδυναμική – 
Γεωφυσική - Τοπογραφία - Γεωμορφολογία – Ωκεανογραφία – Φυσικές Καταστροφές. 
 

•  Προσδιορισμό Ρηξιγενών Ζωνών 
•  Προσδιορισμό Τεκτονικών Επαφών (επωθήσεις, εφιππεύσεις) 
•  Χαρτογράφηση Γεωλογικών Επαφών 
•  Χαρτογράφηση Μεταλπικών Σχηματισμών 
•  Αναγνώριση Τεκτονικών Στοιχείων (άξονες πτυχών) 
•  Χαρτογράφηση Τοπογραφικών Στοιχείων (οδικό δίκτυο) 
•  Δημιουργία Ψηφιακών Μοντέλων Αναγλύφου 
•  Χαρτογράφηση Γεωμορφολογικών Ενοτήτων 

 Χάραξη και Μελέτη Υδρογραφικού Δικτύου και Υδροκριτών 
 Οριοθέτηση Λεκανών Απορροής  
 Προσανατολισμό - Χαρακτηριστικά Οροσειρών 
 Χαρτογράφηση των Δέλτα των Ποταμών 

•  Χαρτογράφηση Ηφαιστειακών Δομών (ροών λάβας, ηφαιστειακών  κώνων  
κ.λ.π.).  

•  Χρήσεις Γης 
•  Μετρήσεις Θερμοκρασίας Εδάφους και Θάλασσας 
•  Μελέτη Μεταβολής Γραμμών Ακτών 
•  Μετρήσεις Χλωροφύλλης σε Θαλάσσιο Περιβάλλον 
•  Χαρτογράφηση Ρευμάτων και Φαινομένων Ανόδου Ρευμάτων 
•  Μελέτη Εδαφικής Παραμόρφωσης 
•  Παρατήρηση και Παρακολούθηση Πετρελαιοκηλίδων και Ρύπανσης    

Θαλασσίου Περιβάλλοντος γενικότερα 
•  Περιβαλλοντική Διαχείριση και Έλεγχος Φυσικών Καταστροφών (ηφαίστεια, 

σεισμοί, κατολισθήσεις, πλημμύρες, πυρκαγιές, tsunamis) κ.ά. 
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12.3.  Επιλογή Δορυφορικών Εικόνων 
 
Αρκετές είναι οι παράμετροι που πρέπει να λαμβάνονται υπ΄όψιν για την επιλογή των 
κατάλληλων δορυφορικών εικόνων σε μια γεωπεριβαλλοντική μελέτη. Η κλίμακα 
μελέτης, η περιοχή (έκταση, μορφολογία κ.ά.) και ο στόχος-το ζητούμενο, αποτελούν 
σημαντικές παραμέτρους. 
 
Για την διάκριση και μελέτη μεγάλων δομών όπως ρηξιγενών ζωνών και άλλων 
τεκτονικών επαφών, γεωλογικών σχηματισμών και γεωμορφολογικών ενοτήτων, 
χρησιμοποιούνται τόσο οι δορυφορικές εικόνες μέτριας χωρικής διακριτικής 
ικανότητας (LANDSAT, SPOT κ.ά.) όσο και οι εικόνες υψηλης χωρικής διακριτικής 
ικανότητας (IKONOS, QUICKBIRD κ.ά.). Σχετικά με την αναγνώριση τοπογραφικών 
στοιχείων (οδικό δίκτυο, κτίσματα, οικοδομικά τετράγωνα), χρήσεων γης και 
γραμμικών γεωμορφολογικών χαρακτηριστικών, συνήθως χρησιμοποιούνται εικόνες 
IKONOS, QUICKBIRD κ.ά. Για την δημουργία ΨΜΑ, χρησιμοποιούνται δορυφορικές 
εικόνες υψηλής ακριβείας (IKONOS) αλλά και ASTER, SPOT κ.ά. ανάλογα με την 
απαιτούμενη διακριτική ικανότητα του ΨΜΑ και το είδος της μελέτης. Για την 
διαχείριση των φυσικών καταστροφών απαιτούνται εικόνες υψηλής ακριβείας, όταν η 
κλίμακα μελέτης είναι μεγάλη (1/1000 κ.ά) και πρόκειται για παρακολούθηση, 
καθιζήσεων, κατολισθήσεων κ.ά. έως και εικόνες μετεωρολογικών δορυφόρων 
χαμηλής διακριτικής ικανότητας, όταν πρόκειται για την παρακολούθηση μεγάλης 
εκτάσεως πυρκαγιών, πλημμύρων, tsunamis κ.ά. 
 
Επίσης σημαντικές παράμετροι που πρέπει να λαμβάνονται υπ΄όψιν είναι η εποχή 
και ημερομηνία λήψεως της εικόνας, το ποσοστό νεφοκάλυψης και η περιοχή που 
καλύπτεται από νέφη. Τα συστήματα RADAR, τα οποία χρησιμοποιούνται σε 
γεωλογικές και άλλες εφαρμογές, έχουν το πλεονέκτημα ότι λαμβάνουν δεδομένα και 
με νεφοκάλυψη. 
 
 
 
 
 
 
΄ 
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13. ΕΠΕΞΕΡΓΑΣΙΑ ΨΗΦΙΑΚΩΝ ΔΟΡΥΦΟΡΙΚΩΝ ΕΙΚΟΝΩΝ 
 
Τα βασικά στάδια επεξεργασίας ψηφιακών δορυφορικών εικόνων (κυρίως στο οπτικό 
φάσμα και μέσο υπέρυθρο) ώστε να είναι δυνατή η ερµηνεία τους είναι : 
 
A) Αποκατάσταση ή προεπεξεργασία της εικόνας (Image Restoration) 
     Ραδιομετρικές διορθώσεις (Radiometric Corrections) 
     Γεωμετρικές διορθώσεις (Geometrical Corrections) 
 
B) Βελτίωση της εικόνας (Image Enhancement) 
     Βελτίωση της αντίθεσης της φωτεινότητας (Contrast Stretching) 
     Χρήση φίλτρων (Filters) 
     Συνδυασµός φασµατικών καναλιών (Combination of Spectral Zones) 
     Ανάλυση κυρίων συνιστωσών (Principal components analysis) 
     Συγχώνευση φασματικών καναλιών (Fusion or Mergin of Spectral Zones) κ.ά. 
 
C) Ψηφιακή Ταξινόµηση της εικόνας (Digital Image Classification) 
      Μη επιβλεπόμενη (Unsupervised) 
      Επιβλεπόμενη (Supervised) 
 

ΚΥΡΙΟΣ ΣΤΟΧΟΣ: Ερµηνεία Εικόνων - Εξαγωγή Συµπερασµάτων 
 
Μετά τα δύο πρώτα στάδια επεξεργασίας της εικόνας, όπου τα δεδοµένα της είναι 
διαθέσιµα σε ψηφιακή µορφή, χωρικά κατανεµηµένα σε pixels και ραδιοµετρικά 
κατανεµηµένα σε διακριτά επίπεδα φωτεινότητας, δύο τρόποι χρησιµοποιούνται για 
την ερµηνεία της µε σκοπό την εξαγωγή των πληροφοριών - συµπερασµάτων: 
 
I) Η ποσοτική ανάλυση (quantitative analysis), η οποία γίνεται µε χρήση Η/Υ. Κάθε 
pixel της εικόνας εξετάζεται ατοµικά, µε γνώµονα την δηµιουργία µιας φόρµας (για το 
καθένα), που βασίζεται στα χαρακτηριστικά καθενός (ψηφιακή ταξινόµηση της 
εικόνας). 
 
II) Η ερµηνεία της εικόνας (image interpretation), ή κλασική οπτική φωτοερµηνεία, η 
οποία σχετίζεται µε τον ανθρώπινο παράγοντα που επιθεωρεί / ερµηνεύει τα 
δεδοµένα της εικόνας και αποσπά τις πληροφορίες µε οπτική παρατήρηση. Σε αυτές 
τις πληροφορίες παρατηρούνται γενικά µεγάλης κλίµακας χαρακτηριστικά και συχνά 
αγνοούνται η χωρική και ραδιοµετρική ψηφιακή µορφή των δεδοµένων. Η επιτυχία 
της εξαρτάται από τον αναλυτή που θα εκµεταλλευτεί αποτελεσµατικά τα χωρικά, 
ραδιοµετρικά και χρονικά στοιχεία, τα οποία είναι παρόντα στο σύνθετο προϊόν µιας 
εικόνας. Φυσικά, απαραίτητη είναι η επιβεβαίωση δομών στην ύπαιθρο. 
 
Τονίζεται ότι σε κάθε γεω-περιβαλλοντική μελέτη είναι απαραίτητος ο συσχετισμός 
πολύ-δεδομένων (γεωλογικών, τεκτονικών, γεωφυσικών, γεωχημικών, δορυφορικών 
κ.ά.) σε ψηφιακή βάση δεδομένων. Προκειμένου να συσχετισθούν οι δορυφορικές 
εικόνες με τα υπόλοιπα δεδομένα, είναι απαραίτητη η επεξεργασία αυτών. Όλα τα 
δεδομένα προσαρμόζονται σε κοινό Γεωδαιτικό Σύστημα Αναφοράς.  
 
Η επεξεργασία των δορυφορικών εικόνων έχει ως ακολούθως: 
 
13.1. Προεπεξεργασία - Ραδιομετρική και Γεωμετρική Διόρθωση 
 
Η προ-επεξεργασία περιλαμβάνει ποσοτικές προκαταρκτικές διεργασίες με σκοπό 
την διόρθωση των σφαλμάτων στα δεδομένα και την βελτίωση αυτών. 
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Ραδιομετρικές διορθώσεις 
 
Διεργασίες σχετικές με διόρθωση σφαλμάτων από την ατμοσφαιρική διάχυση και 
απορρόφηση, τις μεταβολές της γωνίας σάρωσης, τις μεταβολές της γωνίας 
πρόσπτωσης του ήλιου και τον «θόρυβο» του συστήματος. Οι ραδιομετρικές 
διορθώσεις επιδρούν και επαναπροσδιορίζουν τις τιμές λαμπρότητας και ουσιαστικά η 
εικόνα γίνεται «ευανάγνωστη». 

 
Γεωμετρικές διορθώσεις  
 
Διορθώσεις σε γεωμετρικές παραμορφώσεις οφειλόμενες στην μεταβολή της 
γεωμετρίας αισθητήρα – Γης (κίνηση Γης, κίνηση δορυφόρου, υψομετρικές διαφορές 
κ.ά) και προσαμογή των εικονοστοιχείων σε πραγματικές συντεταγμένες. Οι 
γεωμετρικές διορθώσεις επιτυγχάνονται με τις διαδικασίες της γεω-αναφοράς και της 
ορθο-αναγωγής. 
 
Η γεω-αναφορά περιλαμβάνει: 
 
α.  Tον προσδιορισμό των συντεταγμένων (γραμμές, στήλες) ενός αριθμού σημείων 
(εδαφικών σημείων ελέγχου / ground control points «GCPs») της αρχικής 
παραμορφωμένης εικόνας και επανατοποθέτηση αυτών στην πραγματική τους θέση 
με πραγματικές συντεταγμένες (Εικόνα 13.1). 
 

 
 
β. Την μεταφορά της τιμής λαμπρότητας του κατάλληλου εικονοστοιχείου των 
αδιόρθωτων δορυφορικών δεδομένων στο αντίστοιχο της διορθωμένης εικόνας (Εικ. 
13.2 – 13.4). 
 
Η διαδικασία της αναδόμησης της εικόνας (resampling) κατά την οποία το ποσό της 
ακτινοβολίας για κάθε εικονοστοιχείο υπολογίζεται με τις μεθόδους της πλησιέστερης 
γειτονίας (nearest neighbor), της διγραμμικής παρεμβολής (bilinear interpolation), και 
της κυβικής συστροφής (cubic convolution),  όπως φαίνονται στις ακόλουθες εικόνες: 
 

 

 
 
Εικόνα 13.2. Μέθοδος πλησιέστερης γειτονίας 
(nearest neighbor): Χρησιμοποιεί την τιμή 
λαμπρότητας από το εικονοστοιχείο της 
αρχικής εικόνας, το οποίο είναι πλησιέστερο 
στη νέα θέση του εικονοστοιχείου της 
διορθωμένης εικόνας. 
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Εικόνα 13.1. Τα εδαφικά 
σημεία ελέγχου Α1, Α2, Α3 
και Α4, στην αρχική 
παραμορφωμένη εικόνα, 
επανατοποθετούνται στην 
πραγματική τους θέση Α1’, 
Α2’, Α3’ και Α4’ ως προς 
ένα συγκεκριμένο Σύστημα 
Συντεταγμένων. 
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Εικόνα 13.3. Μέθοδος  
διγραμμικής παρεμβολής (bilinear 
interpolation): Χρησιμοποιεί την μέση τιμή 
τεσσάρων εικονοστοιχείων της αρχικής εικόνας, 
πλησιέστερων στην νέα θέση του 
εικονοστοιχείου. 

 
 

         

 
Εικόνα 13.4. Μέθοδος κυβικής συστροφής 
(cubic convolution): Χρησιμοποιεί την μέση τιμή 
δεκαέξι εικονοστοιχείων της αρχικής εικόνας, τα 
οποία περιβάλλουν το εικονοστοιχείο στην νέα 
θέση του. 

 
 
 
Η τελική γεω-αναφερόμενη εικόνα προκύπτει από την αρχική μετά την προσαρμογή 
των εικονοστοιχείων σε πραγματικές συντεταγμένες και την απόδοση  σε αυτά της 
κατάλληλης τιμής λαμπρότητας.  
 
 
Ορθο-αναγωγή 
 
Συχνά, η διαχείριση των δορυφορικών εικόνων με άλλα δεδομένα (επίγεια ή 
δορυφορικά) σε ψηφιακή βάση δεδομένων, επιβάλει την διεργασία της ορθο-
αναγωγής. Η ορθο-αναγωγή σημαίνει προσαρμογή της εικόνας σε πραγματικές 
συντεταγμένες με ταυτόχρονη απαλοιφή της τοπογραφίας (ελαχιστοποίηση 
γεωµετρικών σφαλµάτων προερχομένων από το ανάγλυφο). Κατά την διεργασία, 
απαιτούνται εδαφικά σημεία ελέγχου (GCPs) και ψηφιακό μοντέλο αναγλύφου (ΨΜΑ). 
Η εικόνα αποκτά «ιδιότητες χάρτη». 
 
13.2. Βελτίωση – Ενίσχυση Αντίθεσης 
 
Οι τεχνικές βελτίωσης αντίθεσης (Contrast Stretching) αποσκοπούν στην οπτική 
βελτίωση της εικόνας με αποτέλεσμα την διευκόλυνση της φωτοερμηνείας.  
 
Κατά την τεχνική της βελτίωσης, τονίζεται η αντίθεση μεταξύ των χαρακτηριστικών 
της ψηφιακής εικόνας με αρκετές μεθοδολογίες (γραμμική επέκταση της αντίθεσης, 
ισοδυναμοποίηση του ιστογράμματος, χρήση φίλτρων). 
 
Στην αρχική μορφή της εικόνας δεν χρησιμοποιούνται όλες οι διαβαθμίσεις 
φωτεινότητας ώστε η εικόνα εμφανίζεται άνευ χρωματικής αντίθεσης και με μειωμένη 
φωτεινότητα (contrast).  

80 100 

90 110 

80 100 

110 90 
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Η κατανόηση της έννοιας του Ιστογράμματος μιας εικόνας βοηθά στην κατανόηση 
της βελτίωσης της αντίθεσης της εικόνας.  
 
Ιστόγραμμα είναι η γραφική αναπαράσταση των τιμών φωτεινότητας που συνθέτουν 
την εικόνα, σε σχέση με την συχνότητα εμφάνισής τους (Εικ. 13.5). Οι τιμές 
φωτεινότητας δίδονται στον άξονα (χ), ενώ η συχνότητα εμφάνισης κάθε τιμής 
φωτεινότητας, δίδεται στον άξονα  (y). 
 

 
Εικόνα 13.5. Στο ιστόγραμμα της εικόνας αναπαρίστανται οι τιμές φωτεινότητας στον άξονα 
(χ), σε σχέση με την συχνότητα εμφάνισης κάθε τιμής φωτεινότητας στον άξονα  (y). 
 
 
Η βελτίωση της αντίθεσης στην εικόνα επιτυγχάνεται  με αρκετές μεθοδολογίες: 
 
α. Γραμμική Επέκταση Αντίθεσης (Linear Contrast Stretching) στην πιο απλή της 
μορφή, περιλαμβάνει την αποτύπωση των τιμών των εικονοστοιχείων στην πλήρη 
εξάπλωση της κατανομής των τιμών, από την παρατηρούμενη κατάσταση PVmin ως 
PVmax (Εικόνα 13.6). 
 
Οι τιμές των εικονοστοιχείων ορίζονται με τρόπο ώστε τα PVmin να αποτυπώνονται 
στην τιμή 0 και τα PVmax στην τιμή 255. Οι ενδιάμεσες τιμές κρατούν τις σχετικές 
θέσεις με τρόπο ώστε οι μέσες τιμές μεταξύ PVmin και PVmax να αντιστοιχούν στο 
127. Με γραμμική επέκταση της αντίθεσης επιτυγχάνεται αύξηση της αντίθεσης στην 
ψηφιακή εικόνα ενώ διατηρούνται οι συσχετισμοί της αρχικής ακτινοβολίας. 
 
β. Ισοδυναμοποίηση Ιστογράμματος (Histogram Equalization Streching) 
 
Ακολουθώντας την κανονική κατανομή, τα εικονοστοιχεία κοντά στην μέση τιμή είναι 
αυτά που απαντώνται πιο συχνά. Η συγκεκριμένη μέθοδος επεκτείνει όλα τα DNs και 
τα μετατρέπει σε ισοδύναμη συχνότητα. Η νέα εικόνα που δημιουργείται έχει 
ομοιόμορφη πυκνότητα των εικονοστοιχείων κατά τον άξονα DN (Εικόνα 13.7).  
 
γ. Χρήση Φίλτρων 
 
Πρόκειται για τεχνικές οι οποίες δίνουν έμφαση στην επιλεκτική πληροφόρηση που 
περιέχεται στην εικόνα.  
 
Προκειμένου να υποβαθμισθεί ο "θόρυβος" που δημιουργείται από τους ανιχνευτές 
(και ο οποίος είναι από τους βασικότερους παράγοντες προσπελασιμότητας στα 
δεδομένα μιας εικόνας) ή προκειμένου να δοθεί έμφαση σε ορισμένα χαρακτηριστικά 
μιας εικόνας χρησιμοποιούνται ειδικά διαμορφωμένα φίλτρα που βοηθούν στο να 
"καθαρισθεί" η εικόνα και να γίνουν ορατά τα χαρακτηριστικά της. Η διαδικασία 
φιλτραρίσματος περιλαμβάνει την μετακίνηση ενός  «παραθύρου» μερικών 
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διατεταγμένων εικονοστοιχείων (3x3, 5x5 κ.ά.) επάνω από κάθε εικονοστοιχείο της 
εικόνας, εφαρμόζοντας έναν μαθηματικό υπολογισμό, χρησιμοποιώντας τις τιμές των 
εικονοστοιχείων κάτω από το παράθυρο και δίνοντας στο κεντρικό εικονοστοιχείο την 
νέα τιμή. 
 
Τα σχήματα των φίλτρων είναι τετράγωνα ή ορθογώνια:  

• Τα τετράγωνα έχουν ενιαίο βάρος εξασφαλίζοντας ότι η βελτίωση είναι όμοια 
σε όλες τις κατευθύνσεις μέσα στην εικόνα.  
• Τα ορθογώνια εξασφαλίζουν μέγιστη βελτίωση των χαρακτηριστικών με 
κατακόρυφη τάση στους μεγάλους άξονες των φίλτρων. 

 
Τα φίλτρα διακρίνονται σε 

• υψηλής διάβασης (high-pass filter) ή φίλτρα τονισμού αντιθέσεων οπότε και 
επιτυγχάνεται βελτίωση - ενίσχυση των άκρων (γραμμικών στοιχείων - edge 
enhancement, εικόνα 13.8). 
• χαμηλής διάβασης (low-pass) ή φίλτρα εξομάλυνσης οπότε επιτυγχάνεται 
εξομάλυνση της εικόνας (image smoothing). 

 
Τα χαμηλής διάβασης φίλτρα χρησιμοποιούνται για την εξάλειψη των θορύβων, που 
συχνά παρατηρούνται στις εικόνες, καθώς και στις ταξινομημένες εικόνες. 
 
Τα υψηλής διάβασης φίλτρα χρησιμοποιούνται συχνά σε γεωλογικές εφαρμογές 
προκειμένου: 
 
• Να ληφθεί τραχεία εικόνα τονίζοντας λεπτομέρειες. Οι λεπτομέρειες δύνανται να 

αναδείξουν  γεωμορφολογικά ή γεωλογικά χαρακτηριστικά (διαφορές στην μικρο-
τοπογραφία, στην τοπική βλάστηση, στους διάφορους εδαφικούς τύπους, στην 
λιθολογία, αλλά και στην τεκτονική δομή, όπως συστήματα διαρρήξεων, 
ρηγμάτων, άξονες πτυχών κ.ά.). 

• Να τονισθούν τα γραμμικά συστήματα σχετικών με την τεκτονική δομή της 
περιοχής. Προϋποτίθεται ότι ερμηνεία πρέπει να γίνει πολύ προσεκτικά. 

• Να τονισθούν διαφορές στην φωτεινότητα ώστε να οριοθετηθούν καλύτερα 
λιθολογικά όρια. 
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Εικόνα 13.6. Κατά την γραμμική επέκταση της αντίθεσης, οι τιμές λαμπρότητας των 
εικονοστοιχείων επαναπροσδιορίζονται στην πλήρη εξάπλωση της κατανομής τους κατά 
τον ίδιο τρόπο, οπότε προκύπτει ιστόγραμμα ίδιας μορφής. Στο παράδειγμα, οι τιμές 
λαμπρότητας με εύρος από 77-180, οι οποίες εμφανίζουν την μεγαλυτερη συχνότητα 
εμφάνισης, επαναπροσδιορίζονται και εξαπλώνονται στις τιμές από 0 – 255. Επιτυγχάνεται 
αύξηση της αντίθεσης της εικόνας και διατήρηση των συσχετισμών της αρχικής 
ακτινοβολίας. 
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Εικόνα 13.7. Κατά την ισοδυναμοποίηση του ιστογράμματος οι τιμές λαμπρότητας των 
εικονοστοιχείων επαναπροσδιορίζονται ανάλογα με την συχνότητα εμφάνισής τους. Το νέο 
ιστόγραμμα παρουσιάζεται με διαφορετική μορφή, αλλά με ομοιόμορφη πυκνότητα των 
εικονοστοιχείων κατά τον άξονα της τιμής λαμπρότητας.  
 

 
Εικόνα 13.8. Μετά την εφαρμογή φίλτρου υψηλής διάβασης η εικόνα γίνεται τραχεία και 
αναδεικνύονται, τοπογραφικά, γεωλογικά, γεωμορφολογικά, τεκτονικά κ.ά. χαρακτηριστικά. 
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δ. Μετασχηματισμός Εικόνας - Image Transformation 
 
Διαχείριση φασματικών καναλιών μιας πολυφασματικής εικόνας ή περισσοτέρων 
εικόνων ίδιας περιοχής, διαφορετικής χρονικής περιόδου κ.ά. και παραγωγή νέων 
εικόνων (με μαθηματικές πράξεις), οι οποίες αναδεικνύουν συγκεκριμένα 
χαρακηριστικά σε σχέση με τις αρχικές εικόνες.  
        
Αφαίρεση Εικόνων

 

 (Image Subtraction): Συχνά χρησιμοποιείται ώστε να 
προσδιορισθούν διαφορές σε εικόνες διαφορετικής ημερομηνίας λήψεως. 

Διαίρεση Εικόνων ή Φασματική Διαίρεση

 

 (Image division - Spectral Ratioing): Είναι 
ένας από τους πιο κοινούς μετασχηματισμούς εικόνων. Αναδεικνύει (μέσω της 
φασματικής απόκρισης) τους διαφόρους εδαφικούς καλλυμματικούς τύπους.   

Περισσότερο σύνθετοι τύποι φασματικής διαίρεσης συμπεριλαμβάνουν τους λόγους 
αθροισμάτων ή διαφορών μεταξύ φασματικών καναλιών, για διαφόρους αισθητήρες. 
Έχουν αναπτυχθεί για την παρακολούθηση συνθηκών βλάστησης.   
 
Δείκτης βλάστησης NDVI

 

: Ένας διαδεδομένος τύπος μετασχηματισμού εικόνας είναι 
ο δείκτης NDVI (Normalized Difference Vegetation Index), ο οποίος χρησιμοποιείται 
για την παρακολούθηση συνθηκών βλάστησης σε ηπειρωτικές και παγκόσμιες 
κλίμακες, χρησιμοποιώντας τον αισθητήρα Advanced Very High Resolution 
Radiometer (AVHRR) της σειράς δορυφόρων  NOAA. 

ε. Ανάλυση κυρίων συνιστωσών (principal components analysis)  
 
Η μέθοδος έχει ως σκοπό την μείωση του αριθμού των δεδομένων, στην περίπτωση 
των πολυφασματικών δεδομένων, ενώ ταυτόχρονα διατηρείται το σύνολο σχεδόν της 
πληροφορίας των αρχικών δεδομένων. Σε μια πολυφασματική εικόνα, γειτονικές 
φασματικές ζώνες έχουν υψηλό ποσοστό συσχέτισης. Η παρουσία συσχετισμών 
μεταξύ των ζωνών μιας πολυφασματικής εικόνας σημαίνει ότι υπάρχει επικάλυψη 
των δεδομένων, γεγονός που αντανακλάται στους συσχετισμούς αυτούς. 
 
στ. Συγχώνευση Εικόνων 
 
Η διαφορετική ραδιομετρική, φασματική, χωρική και χρονική διακριτική ικανότητα που 
παρουσιάζουν οι δορυφορικές εικόνες δημιούργησε την ανάγκη για συνδυασμό-
συγχώνευση (fusion ή mergin) εικόνων διαφορετικών χαρακτηριστικών, ώστε να 
εξαχθούν όσο το δυνατόν περισσότερες πληροφορίες. Επί παραδείγματι, η 
συγχώνευση μιας δορυφορικής εικόνας υψηλής χωρικής διακριτικής ικανότητας με 
μια εικόνα υψηλής φασματικής διακριτικής ικανότητας έχει ως αποτέλεσμα την 
δημιουργία μιας εικόνας  η οποία περιλαμβάνει τα καλύτερα χαρακτηριστικά των δύο. 
Η συγχώνευση των εικόνων επιτυγχάνεται μέσω μαθηματικού μετασχηματισμού.  
 
13.3. Ψηφιακή Ταξινόμηση και Ανάλυση 
 
Η ψηφιακή επεξεργασία της εικόνας επιτυγχάνεται με την αυτόματη ταξινόμηση των 
pixels αυτής, δηλαδή, περιλαμβάνει την απόδοση σε κάθε pixel ενός χαρακτηριστικού 
της γήινης επιφάνειας. Ουσιαστικά πρόκειται για ταυτοποίηση των αριθμητικών τιμών 
των pixels με τα διάφορα αντικείμενα της επιφάνειας.  
 
Η μη επιβλεπόμενη ταξινόμηση δεν δίνει πολλές φορές ικανοποιητική πληροφορία 
για την περιοχή. Στις περιπτώσεις αυτές η ταξινόμηση βασίζεται αποκλειστικά στο 
λογισμικό ώστε ονομάζεται μη ελεγχόμενη. Τα εικονοστοιχεία μιας εικόνας 
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αποδίδονται σε φασματικές τάξεις χωρίς ο χρήστης να έχει γνώση της ύπαρξης ή των 
ονομάτων των τάξεων αυτών (Εικόνα 13.9).  
 
Η επιβλεπόμενη ταξινόμηση βασίζεται στην καλή γνώση κριτηρίων τα οποία 
ανιχνεύονται και χρησιμοποιούνται συγκεκριμένες διεργασίες προσέγγισης, της 
περιοχής μελέτης που αντιστοιχεί στην εικόνα. Η μέθοδος απαιτεί από τον χρήστη  
την εισαγωγή ορισμένης πληροφορίας πριν την επιλογή του κατάλληλου αλγορίθμου 
που θα δώσει την αναγκαία πληροφορία (Εικόνα 13.10). Η πληροφορία προέρχεται 
από κατάλληλους χάρτες, αεροφωτογραφίες και εργασία υπαίθρου. 
 

 
 

 
 
Εικόνα 13.9. Στην μη επιβλεπόμενη 
ταξινόμηση η κατηγοριοποίηση της 
εικόνας βασίζεται αποκλειστικά στο 
λογισμικό. Τα όρια των κατηγοριών, 
ο αριθμός των κατηγοριών κ.ά. δεν 
είναι πάντοτε τα πραγματικά 
(Παρατηρείστε διαφορές με την εικ. 
13.10). 
 
 
 

 

 

 

 
Εικόνα 13.10. Η επιβλεπόμενη ταξινόμηση βασίζεται στην εισαγωγή κριτηρίων και 
ορισμένης γνωστής πληροφορίας (από δειγματοληψία, βιβλιογραφικές αναφορές κ.ά.) 
από τον χρήστη, πριν την εφαρμογή του αλγορίθμου για την ταξινόμηση της εικόνας. Στο 
παράδειγμα βάσει δειγματοληψίας επτά κατηγοριών χρήσεων γης η εικόνα ταξινομήθηκε 
σε επτά κατηγορίες (απόδοση με διαφορετικά χρώματα).  
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13.4. Ερμηνεία και Ανάλυση 
 
Η Επεξεργασία των δορυφορικών εικόνων έχει σκοπό την βελτίωση των εικόνων για 
την ευκολότερη ερμηνεία τους και την διεξαγωγή συμπερασμάτων. 
 
Η ερμηνεία ή φωτοερμηνεία των δορυφορικών εικόνων αφορά στην διάκριση 
σημειακών, γραμμικών ή επιφανειακών χαρακτηριστικών. Στις γεω-επιστήμες 
χρησιμοποιείται για την διάκριση τεκτονικών, γεωλογικών, τοπογραφικών, γεω-
μορφολογικών δομών, χρήσεων γης κ.ά., βάσει κριτηρίων. Σε αυτές τις περιπτώσεις 
η ψηφιακή ταξινόμηση των εικόνων δεν δίνει συνήθως τα επιθυμητά αποτελέσματα, 
καθώς στις τιμές λαμπρότητας των εικονοστοιχείων της εικόνας επιδρά η υγρασία, 
φυτοκάλυψη κ.ά και δεν είναι εντελώς αντιπροσωπευτική των γεωλογικών, 
λιθολογικών κ.ά. σχηματισμών. Στο Κεφάλαιο 14 δίδεται ο Χάρτης Χρήσεων Γης 
Νισύρου (Εικόνα 14.18), ο οποίος είχει προκύψει από την φωτοερμηνεία της 
δορυφορικής εικόνας ορθο-IKONOS 2 της Νισύρου (εικ. 12.1). Διακρίνονται διαφορές 
σε σχέση με τις χρήσεις γης όπως έχουν προκύψει με ψηφιακή επεξεργασία της 
προαναφερόμενης δορυφορικής εικόνας μέσω της επιβλεπόμενης και μη 
επιβλεπόμενης ταξινόμησης (Εικόνες 13.9 και 13.10).  
 
Η φωτοερμηνεία επιτυγχάνεται μέσω της οθόνης του υπολογιστή όπου είναι δυνατή 
η αλλαγή κλίμακας, ο συνδυασμός των φασματικών καναλιών, οι πράξεις μεταξύ των  
καναλιών καθώς και άλλες διεργασίες – τεχνικές επεξεργασίας εικόνας. Εξαρτάται δε 
από τον γεω-επιστήμονα που θα επεξεργασθεί την εικόνα και θα  ερμηνεύσει τις 
δομές που θα παρατηρήσει-διακρίνει στην εικόνα. 
 
Τα σημαντικότερα διαγνωστικά χαρακτηριστικά που χρησιμοποιούνται στην ανάλυση 
των εικόνων και τα οποία χρησιμοποιούνται γενικότερα από τους γεωλόγους – 
γεωεπιστήμονες  είναι: 
 
 
• Απόχρωση - Χρωματική 

φωτεινότητα: σχετίζεται με την 
ένταση, με την οποία το φως 
ανακλάται από ένα αντικείμενο.  

 
• Αντίθεση: η σχέση απόχρωσης 

μεταξύ ενός αντικειμένου και του 
γύρω περιβάλλοντος. 

 
 
 
 
 
 
 
• Υφή: που δείχνει το συσχετισμό 

των αλλαγών αποχρώσεων των 
pixels μιας  εικόνας. 
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• Πρότυπο: η επαναληψιμότητα των 

απoχρώσεων μιας εικόνας, 
περιγράφει την χωρική κατανομή 
των στοιχείων που ενδιαφέρουν 
κάθε φορά. 

 
 
 
 
 
 
 
 
• Σχήμα και Μέγεθος: το σχήμα 

σχετίζεται με την γενική μορφή, το 
περίγραμμα ενός αντικειμένου, ενώ 
το μέγεθος σχετίζεται με την 
διάσταση της επιφάνειάς του. 

 
 
 
 
 
 
 
• Σκίαση: χρήσιμη, καθώς δύναται να 

δώσει μια ιδέα της τοπογραφίας και 
του σχετικού υψομέτρου 
παρατηρούμενων χαρακτηριστικών. 
Χρήσιμη στον προσδιορισμό 
τεκτονικών, τοπογραφικών 
γεωμορφολογικών κ.ά. 
χαρακτηριστικών, ιδιαίτερα στις 
εικόνες  radar. 

 
 
 
 
• Συσχέτιση:  Προκειμένου να 

προσδιορισθούν τα ζητούμενα 
χαρακτηριστικά-αντικείμενα, 
χρησιμοποιεί άλλα 
προσδιοριζόμενα αντικείμενα και με  
συσχετισμό καταλήγει στον 
προσδιορισμό του ζητούμενου.  
Επί παραδείγματι, ένα λιμάνι 
σχετίζεται με την ύπαρξη μώλου ,  
με σκάφη κ.ά.  
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Προκειμένου να προσδιορισθούν πιθανά ρήγματα και όχι απλά φωτογραμμώσεις 
(lineanments), χρησιμοποιούνται επιπλέον κριτήρια φωτοερμηνείας. κυρίως κριτήρια 
νεοτεκτονικής, με αποτέλεσμα την διάκριση κυρίως νεοτεκτονικών ρηγμάτων, δηλαδή 
ενεργών και σεισμικών. Φυσικά η επιβεβαίωση στην ύπαιθρο είναι απαραίτητη.  
 
Ο Gupta (1991), αναφέρει κριτήρια για την διάκριση των ρηγμάτων και σημειώνει 
πως είναι πιο εύκολο να διακριθούν ρήγματα με μεγάλη κλίση - έως κατακόρυφα, 
παρά με μικρή κλίση. Τα κριτήρια που δίνει είναι: 

 
* Μετατόπιση γεωλογικού στρώματος ή ορίζοντα κλειδί 
* Απότομη διακοπή στρώματος 
* Παρατήρηση κάμψης στρωμάτων 
* Παρουσία απότομης κατωφέρειας – γκρεμού (μορφολογικές ασυνέχειες) 
* Παρουσία τριγωνικών επιφανειών 
* Τοπογραφία σε ευθύγραμμη διάταξη 
* Απότομες στροφές υδρογραφικού δικτύου 
* Ευθύγραμμη διάταξη μικρών λιμνών ή κλειστών κοιλοτήτων 
* Ευθύγραμμη διάταξη πηγών 
* Ευθύγραμμη διάταξη βλάστησης 
* Ευθύγραμμη διάταξη ποταμών 
* Απότομες κλίσεις από χείμαρρους – μορφολογικές ασυνέχειες 
* Διάσπαση - διαμελισμός ρεμάτων και κοιλάδων 
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14. ΓΕΩΛΟΓΙΚΕΣ ΚΑΙ ΓΕΩ-ΠΕΡΙΒΑΛΛΟΝΤΙΚΕΣ ΕΦΑΡΜΟΓΕΣ ΜΕ ΣΓΠ ΚΑΙ ΧΡΗΣΗ 
ΔΟΡΥΦΟΡΙΚΩΝ ΔΕΔΟΜΕΝΩΝ 
 
Tα ΣΓΠ έχουν κατακτήσει το ενδιαφέρον επιστημόνων και ερευνητών όλων των 
ειδικοτήτων, με αποτέλεσμα την ανάπτυξη πλήθους εφαρμογών με την χρήση τους. 
Συνεχώς ανακαλύπτονται νέες δυνατότητες αυτών, στην προσπάθεια των ερευνητών να 
τα προσαρμόσουν στις απαιτήσεις τους ώστε να επιλύσουν συγκεκριμένα προβλήματα, 
με ή άνευ της χρήσεως προγραμματισμού και την κατασκευή ειδικών λογισμικών. 
 
Η διαχείριση και ο συνδυασμός επίγειων και δορυφορικών δεδομένων σε ΣΓΠ κρίνονται 
απαραίτητα σε γεωλογικές και γεωπεριβαλλοντικές εφαρμογές καθώς και γενικότερα σε 
όλους τους κλάδους των γεωεπιστημών. Σχετικά με τις γεωλογικές και τις 
γεωπεριβαλλοντικές μελέτες, τα τελευταία έτη καθημερινά αναπτύσσονται νέες 
εφαρμογές από Πανεπιστήμια, Δημόσιες Υπηρεσίες και Ιδιωτικές Εταιρείες σε ολοένα 
και περισσότερους τομείς: 

 
Α. Κατασκευή διαφόρων θεματικών και συνθετικών χαρτών (χερσαίων αλλά και 

υποθαλασσίων) όπως: Γεωλογικοί, Τεκτονικοί, Νεοτεκτονικοί, Μορφοτεκτονικοί, 
Μορφολογικών Κλίσεων Αναγλύφου, Γεωμορφολογικοί, Τοπογραφικοί, Τρισδιάστατα 
Μοντέλα Αναγλύφου, Εδαφικής Παραμόρφωσης, Υδρογεωλογικοί, Σεισμολογικοί, 
Σεισμοτεκτονικοί, Γεωφυσικών Δεδομένων, Γεωτεχνικοί, Ωκεανίων Ρευμάτων, 
Ρύπανσης Ακτών, Ορυκτολογικοί, Κοιτασματολογικοί, Γεωχημικοί, Θέσεων 
Εκμετάλλευσης Πετρελαίου, Φυσικού Αερίου κ.ά., όπου όλοι συνοδεύονται από τις 
αντίστοιχες βάσεις δεδομένων.  

 
Β.  Λήψη αποφάσεων σε συγκεκριμένα ζητήματα, μέσω της κατασκευής 

θεματικών χαρτών, όπου απαιτείται συνδυασμός αυτών και προϋποθέτεται καλύτερη 
οργάνωση, ανάλυση και διαχείριση της  βάσης δεδομένων. Τα ζητήματα και οι 
αποφάσεις που πρέπει να ληφθούν σχετίζονται με απλά γεωλογικά ερωτήματα έως και 
πιο σύνθετα, σε επίπεδο Δήμου ή και Εθνικό (σχετικά με γεωλογικές - 
γεωπεριβαλλοντικές - γεωμορφολογικές – γεωφυσικές - σεισμολογικές κ.ά. μελέτες, 
όπως αναφέρθηκαν αντίστοιχοι χάρτες, ανωτέρω). Ενδεικτικά αναφέρονται:  
• Ποσοστό εμφάνισης συγκεκριμένου γεωλογικού σχηματισμού, ή κοιτάσματος 

κ.ά. σε συγκεκριμένη περιοχή 
• Διαχείριση δεδομένων υδρογονανθράκων κ.ά. 
• Προτεινόμενες θέσεις κατάλληλες για γεωτρήσεις με σκοπό την άντληση ύδατος 

με συγκεκριμένα χαρακτηριστικά (ποιότητα, ποσότητα) 
• Οριοθέτηση επικίνδυνων ζωνών λόγω σεισμικών ή και ενεργών ρηξιγενών 

ζωνών 
• Οριοθέτηση περιοχών επικίνδυνων για κατολισθήσεις 
• Οριοθέτηση περιοχών με έντονη εδαφική παραμόρφωση 
• Εύρεση κατάλληλης τοποθεσίας για διάφορα τεχνικά έργα, όπως φράγματα, 

χάραξη δρόμων, σηράγγων κ.λ.π. 
• Εύρεση κατάλληλης τοποθεσίας για ΧΥΤΑ 
• Διαχείριση φυσικών καταστροφών, όπως σεισμοί, ηφαίστεια, πλημμύρες, 

καθιζήσεις, κατολισθήσεις, τσουνάμι, πυρκαγιές κ.ά. όπου απαιτούνται: 
o  πλήθος και διαφόρων ειδών δεδομένων, επίγειων ή δορυφορικών: 

γεωλογικών, τεκτονικών, τεχνικογεωλογικών, αναγλύφου, σεισμολογικών, 
γεωφυσικών, γεωχημικών, ωκεανογραφικών, μετεωρολογικών, 
πολεοδομικών, μετρήσεων GPS, δορυφορικές εικόνες κ.ά. 
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o  διαφόρου είδους θεματικών χαρτών: ΨΜΑ και παράγωγα θεματικά επίπεδα 
αναλύσεως αναγλύφου υψηλής ακριβείας (μορφολογικών κλίσεων, 
μορφολογικών ασυνεχειών, επιφανειών επιπέδωσης κ.ά.), ενημερωμένος 
τοπογραφικός χάρτης υψηλής ακριβείας, πολεοδομικός χάρτης, χωροταξικός 
χάρτης, χάρτες τρωτότητας κτηρίων, χάρτες κυκλοφοριακού φόρτου, ορθο-
αναγώμενες δορυφορικές εικόνες (IKONOS, QUICKBIRD, SPOT, LANDSAT, 
ASTER, κ.ά.), χάρτες σεισμολογικών δεδομένων (σεισμικότητας, σεισμικών 
εντάσεων, μηχανισμοί γένεσης κ.ά.), χάρτες επιφανειακών μετατοπίσεων 
(από GPS και DΙnSAR), χάρτες γεωλογικών δεδομένων (γεωλογικός, 
τεκτονικός, μορφο-τεκτονικός κ.ά.), χάρτης χρήσεων γης, προτεινόμενοι 
χάρτες (οδικού δικτύου, εγκατάστασης πληθυσμού, εγκατάστασης Κυρίων 
Υπηρεσιών κ.ά.), χάρτης επιφανειακής θερμοκρασίας εδάφους, χάρτης 
επακολούθων καταστροφικών φαινομένων κ.ά.  

 
Στόχος είναι η διαχείριση των δεδομένων σε ΣΓΠ, η οργάνωση σε επίπεδο 
Δήμου - Κοινότητας - Νομού ή και Χώρας καθώς και η Επιχειρησιακή Σχεδίαση 
Οργάνωση  και Ετοιμότητα ενάντια στον σεισμικό, ηφαιστειακό ή άλλο κίνδυνο, 
τις επακόλουθες δευτερογενείς καταστροφές και την επίλυση συγκεκριμμένων 
προβλημάτων.  
 

Ακολουθούν Εφαρμογές σχετικές με  Ανάπτυξη ΣΓΠ σε συνδυασμό με Τεχνικές 
Τηλεανίχνευσης ως προς τις Γεωεπιστήμες, όπου δίδεται η φιλοσοφία και τα 

στάδια επεξεργασίας των πολυθεματικών δεδομένων, με σκοπό  να 
αποτελέσουν βοήθημα για την διαχείριση αρκετών γεω-περιβαλλοντικών 

προβλημάτων. 
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14.1.  Διαχείριση Σεισμικού Κινδύνου  
 
Η παρακολούθηση  Σεισμικών Περιοχών απαιτεί (εί δυνατόν): 
• Παρακολούθηση σε Πραγματικό Χρόνο 
• Εφαρμογή Δορυφορικής Τεχνολογίας 
• Εκτίμηση Επικινδυνότητας 
• Εφαρμογή Συστημάτων Έγκαιρης Προειδοποίησης (Early Warning   System)  
 

Οι μεθοδολογίες που χρησιμοποιούνται για την διαχείριση του σεισμικού κινδύνου είναι: 
• Σεισμικά Δίκτυα (για σεισμική παρακολούθηση) 
• Γεωδαιτικά Δίκτυα (DGPS) σε συνδυασμό με Διαφορική Συμβολομετρία Ραντάρ 

(DInSAR) ή Συμβολομετρία Μονίμων Ανακλαστήρων   (PSI) για παρακολούθηση 
εδαφικής παραμόρφωσης 

• Γνώση Γεωλογίας 
• Γνώση Γεωτεχνικών Συνθηκών και Εδαφικών Παραμέτρων 
• Γνώση Σεισμο-πολεοδομικών – Σεισμο-χωροταξικών Δεδομένων 
• Διαχείριση Στοιχείων σε ΣΓΠ (GIS) 

 
Η ανάπτυξη ενός ΣΓΠ για την διαχείριση του σεισμικού κινδύνου και τον αντισεισμικό 
σχεδιασμό πόλεων, προϋποθέτει γενικά την  συλλογή και επεξεργασία πολυ-θεματικών 
δεδομένων. Πλήθος και διαφόρου είδους θεματικά και συνθετικά επίπεδα, συνοδευόμενα 
με την απαραίτητη βάση δεδομένων, καθώς και χάρτες παράγονται:  
• ΨΜΑ υψηλής ακρίβειας  
• Παράγωγα των ΨΜΑ θεματικά επίπεδα (Χάρτες Αναλύσεως Αναγλύφου: 

μορφολογικοί χάρτες κλίσεων και προσανατολισμού των κλίσεων, μορφολογικές 
ασυνέχειες, επιφάνειες επιπέδωσης κ.ά.) 

• Ενημερωμένος Τοπογραφικός Χάρτης, υψηλής ακρίβειας 
• Πολεοδομικός Χάρτης 
• Χωροταξικός Χάρτης 
• Χάρτες Τρωτότητας Κτηρίων 
• Χάρτες Κυκλοφοριακού Φόρτου 
• Ορθο-αναγώμενες δορυφορικές εικόνες (IKONOS, QUICKBIRD, LANDSAT, SPOT, 

ASTER, κ.ά.) 
• Χάρτες Σεισμολογικών Δεδομένων (Σεισμικότητας, Σεισμικών Εντάσεων, 

Μηχανισμοί Γένεσης κ.ά.) 
• Χάρτες Επιφανειακών Μετατοπίσεων (από GPS και DInSAR) 
• Χάρτες Γεωλογικών Δεδομένων (Γεωλογικός, Τεκτονικός, Νεοτεκτονικός, Μορφο-

τεκτονικός κ.ά) 
• Χάρτης Χρήσεων Γης 
• Προτεινόμενοι Χάρτες (Οδικού Δικτύου, Εγκατάστασης Πληθυσμού, Εγκατάστασης 

Κυρίων Υπηρεσιών κ.ά.) 
• Χάρτης Επακόλουθων Καταστροφικών Φαινομένων (Kατολισθήσεων, Kαθιζήσεων, 

Tsunamis κ.ά., Εικ. 14.1) 
 

Είναι δυνατή η ποιοτική και ποσοτική ανάλυση των θεματικών επιπέδων πληροφορίας 
και των παραγώμενων διαγραμμάτων, με σκοπό τις απαντήσεις συγκεκριμένων 
ερωτημάτων. Η ανάπτυξη Έξυπνου Συστήματος Λήψεως Αποφάσεων μέσω ΣΓΠ, 
Εκτίμησης Επικινδυνότητας και Διαχείρισης κατά και μετά την Κρίση είναι το τελευταίο 
βήμα της διαχείρισης των δεδομένων. 
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Εικόνα 14.1.  Ο Χάρτης  Γεωδυναμικών Καταστροφικών Φαινομένων και Επιχειρησιακής 
Σχεδίασης – Οργάνωσης – Ετοιμότητας Δήμου Ρόδου. Ο χάρτης παρήχθη κατά το 
εφαρμοσμένο ερευνητικό πρόγραμμα «Αντισεισμικός Σχεδιασμός – Οργάνωση Δήμου 
Ρόδου» (Λέκκας & συνεργάτες 1995). Η διαχείριση των δεδομένων έγινε σε ΣΓΠ (W/S 
Arc/Info). Στον χάρτη απεικονίζονται οι τομείς στους οποίους έχει διαχωρισθεί η πόλη, οι 
χώροι συγκέντρωσης και παρoχής άμεσης βοήθειας, οι χώροι καταυλισμών καθώς και οι 
χώροι μετεγκατάστασης κρίσιμων υπηρεσιών. Επίσης, διακρίνονται οι περιοχές στις οποίες 
αναμένεται η εκδήλωση καταστροφικών γεωδυναμικών φαινομένων. 
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14.1.1. Διαχείριση Δεδομένων Εδαφικής Παραμόρφωσης Νήσου Κεφαλληνίας – 
Οργάνωση Βάσης Δεδομένων 
 
Η Δυτική Ελλάδα αποτελεί μια σεισμο-τεκτονικά σύνθετη και ενεργή περιοχή. Σημαντική 
εδαφική παραμόρφωση παρατηρείται στην Κεφαλληνία, Ζάκυνθο και σε άλλες περιοχές.   
 

A. Διαφορικές Μετρήσεις GPS (DGPS) 
 
Οι Διαφορικές μετρήσεις GPS, οι οποίες δίνουν  σημειακή αλλά μεγάλης ακρίβειας (2-6 
mm) παρατήρηση,  προέκυψαν από δίκτυο, το οποίο εγκαταστάθηκε και μετρήθηκε 
αρχικά τον Οκτώβριο του 2001, επανα-μετρήθηκε τον Σεπτέμβριο του 2003 (μετά τον 
σεισμό της Λευκάδας τον Αύγουστο του  2003 (Mw=6.2)) και τον Ιούλιο του 2006 από 
τον Καθηγητή κ. Ε. Λάγιο & συνεργάτες, Τομέας Γεωφυσικής & Γεωθερμίας, Τμήματος 
Γεωλογίας και Γεωπεριβάλλοντος, ΕΚΠΑ. 
 
Σημειώνεται πως δόθηκε μεγάλη προσοχή κατά την εγκατάσταση του δικτύου ως προς 
την γεωμετρία του και την επιλογή των θέσεων των σημείων που το απαρτίζουν.  Η 
κατανομή των σημείων μέτρησης του GPS δικτύου έγινε βάσει των γεωλογικών, 
λιθολογικών και τεκτονικών χαρακτηριστικών της νήσου, αλλά και του υφισταμένου 
οδικού δικτύου, ώστε τα τελικά αποτελέσματα της επεξεργασίας των μετρήσεων να είναι 
αντιπροσωπευτικά των παραμορφώσεων και των τεκτονικών κινήσεων.  
 

B. Διαχείριση Δεδομένων σε ΣΓΠ 
 
Η διαχείριση των δεδομένων εδαφικής παραμόρφωσης της Κεφαλληνίας έγινε σε 
Σύστημα Γεωγραφικών Πληροφοριών και συγκεκριμένα στο ArcGIS 9.1 (Vassilopoulou 
et al. 2007). Πλήθος ετερογενών δεδομένων (διανυσματικά, καννάβου και ascii αρχεία), 
σχετιζόμενα με γεωλογία, τεκτονική, σεισμολογία, τοπογραφία και γεωμορφολογία της 
περιοχής, επεξεργάσθηκαν  μαζί με τις Διαφορικές μετρήσεις GPS.   
 
Η δημιουργία-διαχείριση των θεματικών επιπέδων της οριζόντιας και κατακόρυφης 
εδαφικής παραμόρφωσης επιτεύχθηκε με τα νέα εργαλεία που έχουν προστεθεί στο 
ειδικό λογισμικό «ΠΡΩΑΝΑ» (Βασιλοπούλου, 1999), όπως έγινε και η ανάλυση 
αναγλύφου της Κεφαλληνίας με την παραγωγή χαρτών αναλύσεως αναγλύφου (ΨΜΑ, 
μέσες μορφολογικές κλίσεις και προσανατολισμός κλίσεων, μορφολογικές ασυνέχειες 
κ.ά). 
 
Ένας μεγάλος αριθμός θεματικών και συνθετικών επιπέδων και χαρτών παρήχθηκε, με 
την κατάλληλη χωρική ανάλυση (Εικ. 14.2, 14.3). Ταυτόχρονα, οργανώθηκε μια βάση 
δεδομένων σε Σύστημα Γεωγραφικών Πληροφοριών, απαραίτητη για την διεξαγωγή 
συμπερασμάτων ως προς την εδαφική παραμόρφωση σε συνδυασμό με τα σεισμολογικά 
δεδομένα, την περαιτέρω δημιουργία συστήματος λήψεως αποφάσεων για τον 
αντισεισμικό σχεδιασμό της περιοχής κ.ά. Στους πίνακες που ακολουθούν δίδεται η 
απαραίτητη περιγραφική πληροφορία για την οργάνωση της βάσης δεδομένων (14.1 – 
14.4). 
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Πίνακας 14.1 – Βάση Δεδομένων 

Εισαγώμενα Εξαγώμενα Θεματικά Επίπεδα και Συνθετικά 
Επίπεδα (Coverages & Grids) 

Παραγώμενοι 
Χάρτες 

Τοπογραφία – 
Μορφολογία 
(ακτογραμμή, ισοϋψείς, 
υψομετρικά σημεία, 
υδρογραφικό δίκτυο, από 
τοπογραφικούς χάρτες 
1:50000 της Γεωγραφικής 
Υπηρεσίας Στρατού, 1976) 

coast (τόξα-γραμμές) 

contours (τόξα) 

elevpnt (σημεία) 

river (τόξα) 

ΨΜΑ 
 
Σκιασμένο 
Ανάγλυφο 
 
Χάρτες 
Αναλύσεως 
Αναγλύφου 

boundary (το εξωτερικό όριο της περιοχής, για 
την δημιουργία ΨΜΑ / μια περιοχή εκτεινόμενη 
περίπου 200m από την ακτή και περικλύοντας 
την νήσο) 

dem20 (ΨΜΑ) 

slope (μορφολογικές κλίσεις % - πολύγωνα) 

aspect, aspnt (προσανατολισμός των 
μορφολογικών κλίσεων – πολύγωνα και σημεία 
αντιστοίχως) 

discontinuity (μορφολογικές ασυνέχειες - τόξα) 

Γεωλογία (γεωλογικοί 
σχηματισμοί) 

geology (πολύγωνα) 

geolslp, geolslv, geolslve, geolslvf 
(πολύγωνα)  

(συνδυασμός “geology”, “slope”, “v0306”και 
“tectbuf”) 

Γεωλογικός 
Χάρτης 

Τεκτονική (επωθήσεις, 
εφιππεύσεις, ρήγματα) 

Ρηξιτεμάχη  

tectonic (τόξα) 

tectbuf (πολύγωνα-buffer zone του «tectonic») 

faultblock (πολύγωνα) 

Τεκτονικός 
Χάρτης 

GPS μετρήσεις 
(Sept2001-Sept2003, 
Sept2003-Jul2006, 
Sept2001-Jul2006)  

GPS σταθμός για κάθε 
περίοδο 

Οριζόντια μετακίνηση 
από GPS δέκτες 
αναπαριστόμενη ως βέλος 

Κατακόρυφη μετακίνηση 
από GPS δέκτες 

Σφάλμα Οριζόντιας 
μετακίνησης 
αναπαριστόμενο ως κύκλο   

 
 
gpsp01, gps03sscale, gps06jscale (σημεία) 
gps0103s, gps03s06j, gps01s06j (τόξα) 
Z0103s, Z03s06j, Z01s06j (κάνναβος) 
 
v0306 (κατακόρυφη μετακίνηση σε πολυγωνικό 
coverage) 

stddifscale0103s , stddifscale03s06j 
stddifscale01s06j (πολύγωνα – buffer zone) 
“question” το θεματικό επίπεδο-απάντηση σε 
συγκεκριμένα ερωτήματα  

Χάρτες 
Οριζόντιας και 
Κατακόρυφης 
Παραμόρφω-
σης  

Σεισμολογία (επίκεντρα 
σεισμών) 

epicenter (σημεία) Χάρτης 
Σεισμικών 
Επικέντρων 



 133 

Πίνακας 14.2 – Περιγραφική Πληροφορία των Θεματικών και Συνθετικών Επιπέδων, 
σχετιζομένων με Τεκτονική, Γεωλογία και Σεισμολογία  

Τεκτονική 
Γεωλογία 

Σεισμολογία 
 

Πεδία Περιγραφή 

tectonic code Μοναδικός Αριθμός για κάθε στοιχείο 

 name Όνομα Ρήγματος ή Ρηξιγενούς Ζώνης  

 zone Όνομα Ρήγματος ή Ρηξιγενούς Ζώνης κατά σύντμηση 

 activity Χαρακτηρισμός Ρήγματος ως ενεργό ή πιθανώς 
ενεργό  

 order Χαρακτηρισμός ρήγματος ως κυρίου ή δευτερεύοντος  

 visible  Χαρακτηρισμός ρήγματος ως ορατού ή όχι  

faultblock name 

code 

Χαρακτηρισμός κάθε ρηξιτεμάχους με όνομα και 
κωδικό αριθμό 

geology formation Ταξινόμηση γεωλογικών σχηματισμών  

coast elevation υψόμετρο 

contours elevation υψόμετρο 

elevpnt elevation υψόμετρο 

epicenter 
(earthquake 
epicenters of 
August-October 
2003) 

 

Year Έτος γέννεσης σεισμού 

Date Ημερομηνία γέννεσης σεισμού 

hr_min_sec  Ώρα γέννεσης σεισμού  

long_e, lat_n Συντεταγμένες επικέντρου 

H Βάθος επικέντρου 

M Μέγεθος σεισμού 

Codem Κατηγοριοποίηση επικέντρων ως προς M 

Codemh Κατηγοριοποίηση επικέντρων ως προς M και H 

 
Πίνακς 14.3 – Περιγραφική Πληροφορία των Θεματικών Επιπέδων των GPS Μετρήσεων 

Πεδία των 
θεματικών επιπέδων 
των GPS μετρήσεων 

Περιγραφή 

“easting_a”, 
“northing_a”, 
“easting_b”, 
“northing_b” 

Συντεταγμένες των σταθμών GPS για κάθε περίοδο  

(a: αρχή διανύσματος/πρώτη μέτρηση,  

b: πέρας διανύσματος/τελευταία μέτρηση)  

“ellip_h_a”, “ellip_h_b” Z συντεταγμένη σταθμού GPS  
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“stdeast_a”, 
“sd_east_b” 

Τυπική Απόκλιση κατά Χ  

“sd_north_a”, 
“sd_north_b” 

Τυπική Απόκλιση κατά Υ  

“sd_h_a”, “sd_h_b” Τυπική Απόκλιση κατά Ζ 

“azimuth” Οριζόντια Μετατόπιση 

“elldif_mm”, “hightdif” Οριζόντια και Κατακόρυφη Παραμόρφωση σε mm 

 “stdevdifn” “stdevdife” Τυπική Απόκλιση Οριζόντιας Μετατόπισης κατά τον Χ και Υ άξονα 

“stdevh_mm” Τυπική Απόκλιση Οριζόντιας Μετατόπισης κατά τον Z άξονα 

“xscale”, “yscale” “ψευδο-συντεταγμένες” πέρατος του διανύσματος οριζόντιας 
μετατόπισης (δημιουργούνται από τις πραγματικές συντεταγμένες με 
σκοπό την μεγένθυνση του διανύσματος για την παρουσίαση σε 
χάρτη) 

“stdevdifscale” “ψευδο-σφάλμα” της οριζόντιας μετατόπισης κατά Χ για την 
παρουσίαση του σφάλματος σε χάρτη (το σφάλμα σε συγκεκριμένη 
κλίμακα μεγένθυνσης) 

“value” Κατακόρυφη Μετατόπιση 
 
 

Πίνακας 14. 4 – Περιγραφική Πληροφορία των Μορφολογικών Θεματικών Επιπέδων 

 

Θεματικά 
Επίπεδα  

Πεδία Περιγραφή 

dem20  value Υψόμετρο 

slope 
 

percent 
_slope 

Κατηγοριοποίηση  των  Μέσων Μορφολογικών Κλίσεων 
%  

slope-
code 

Κωδικός ανά Κατηγορία  των Μέσων Μορφολογικών 
Κλίσεων %  

code2 Κωδικός ανά Κατηγορία  των Μέσων Μορφολογικών 
Κλίσεων % (για συγκεκριμένες κατηγορίες)  

aspect 
 

aspect Κατηγοριοποίηση του Προσανατολισμού των Κλίσεων  

aspect-
code 

Κωδικός ανά Κατηγορία  του Προσανατολισμού των 
Κλίσεων  

discontinuity 
 

lcode, 
rcode 

Κωδικοί σχετιζόμενοι με το αριστερό και δεξί πολύγωνο, 
των οποίων η μορφολογική ασυνέχεια αποτελεί κοινό 
όριο  

lmedh, 
rmedh 

Το μέσο υψόμετρο του αριστερού και δεξιού πολυγώνου 
της ασυνέχειας 

newID Νέο  ID  για κάθε μορφολογική ασυνέχεια  

code Κωδικός  για κάθε μορφολογική ασυνέχεια  

range  code Κωδικός για κάθε κατηγορία υψομετρικών ζωνών  



 135 

 
 

Εικόνα 14.2. Η εδαφική παραμόρφωση Κεφαλληνίας όπως προέκυψε από τις διαφορικές μετρήσεις 
GPS (Σεπτ. 2003-Ιούλιος 2006) και την δημιουργία-διαχείριση των θεματικών επιπέδων της 
οριζόντιας και κατακόρυφης εδαφικής παραμόρφωσης σε ΣΓΠ με το ειδικό λογισμικό «ΠΡΩΑΝΑ» 
(Βασιλοπούλου, 1999).  
Η οριζόντια παραμόρφωση (horizontal deformation – με απόδοση βέλους) στο Δ και Β τμήμα της 
νήσου δεν παρουσιάζει σημαντικές διαφορές σε σχέση με την προηγούμενη περίοδο μετρήσεων 
(Οκτ. 2001-Σεπτ. 2003).  Στο Ν τμήμα μικρές μεταβολές παρατηρούνται κυρίως σε σταθμούς 
εγκατεστημένους σε σύνθετα τεκτονικά ρηξιτεμάχη (ΝΑ τμήμα).  
Σχετικά με την κατακόρυφη παραμόρφωση (vertical deformation – αναπαριστάμενη με 
διαβαθμισμένη χρωματική κλίμακα),  το Δ και Ν τμήμα δείχνουν σημαντική ανύψωση ενώ το 
υπόλοιπο τμήμα της νήσου έχει παρόμοια  συμπεριφορά με τις προηγούμενες μετρήσεις. 
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Εικόνα 14.3. Κατόπιν ανάλυσης της βάσης δεδομένων σχετικά με το υποθετικό ερώτημα 
«Ποια περιοχή είναι κατάλληλη να οικοδομηθεί», δόθηκε η απάντηση και οριοθετήθηκαν οι 
κατάλληλες περιοχές (γκρι χρώμα), οι οποίες πληρούν τις ακόλουθες προϋποθέσεις: 

1. Aσβεστόλιθοι (a)  

2. Mέσες μορφολογικές κλίσεις 0% - 15% (b) 

3. Aπόσταση 1km από ρηξιγενείς ζώνες και  

-20mm < κατακόρυφη εδαφική παραμόρφωση < 20mm (c) 

 

 

 (a)    
(b) 

 (c) 



 137 

14.1.2. Διαχείριση Επίγειων και Δορυφορικών Δεδομένων Νήσου Ζακύνθου – 
Οργάνωση Βάσης Δεδομένων 
 
Πλήθος ετερογενών δεδομένων σχετικών με τοπογραφία, γεωλογία, τεκτονική, εδαφική 
παραμόρφωση, σεισμολογία και δορυφορικές εικόνες από την Νήσο Ζάκυνθο 
συνδυάσθηκαν με σκοπό την ανάπτυξη ψηφιακής βάσεως δεδομένων σε ΣΓΠ 
(Vassilopoulou et al, 2007). Θεματικά και συνθετικά επίπεδα καθώς και χάρτες 
παρήχθησαν σε ένα κοινό χαρτογραφικό σύστημα (Ελληνικό Γεωδαιτικό Σύστημα 
Αναφοράς ΄87 / ΕΓΣΑ’87), με σκοπό την επίλυση συγκεκριμένων προβλημάτων. 
 

Α. Δημιουργία ΨΜΑ από Δορυφορικές Εικόνες ASTER 
 
Ένα Ψηφιακό Μοντέλο Αναγλύφου (ΨΜΑ) με μέγεθος κυψελίδας 30m*30m (Εικ. 14.8), 
παρήχθη με χρήση δορυφορικών εικόνων ASTER (Εικ.14.6, 14.7). 
 
Το ΨΜΑ δημιουργήθηκε μέσω του Geomatica OrthoEngine Basics (2001) και του ENVI 
(2007). Η επιλογή σημείων ελέγχου (Ground Control Points / GCPs), σημείων 
αγκίστρωσης (Tie Points / TPs) και ο καθορισμός συγκεκριμένων παραμέτρων 
αποτελούν βασικά στοιχεία για την παραγωγή του ΨΜΑ. Το παραγόμενο ΨΜΑ δύναται 
να διορθωθεί-επεξεργασθεί μέσα από το λογισμικό, ώστε να επιτευχθεί το καλύτερο 
αποτέλεσμα .  
 
Στην εικόνα 14.4, δίδεται ένα διάγραμμα ροής παραγωγής ΨΜΑ από δορυφορικές 
εικόνες μέσω ειδικών λογισμικών. 
 

 
 
Εικόνα 14.4. Διάγραμμα ροής παραγωγής ΨΜΑ από δορυφορικές εικόνες μέσω ειδικών 
λογισμικών. 
 
 

Εισαγωγή Στερεοζεύγους 

Προσθήκη/Επεξεργασία 
Σημείων Ελέγχου (GCPs) 

Προσθήκη/Επεξεργασία 
Σημείων Αγκίστρωσης 

(TPs) 

Στερεοσκοπικές  
Παράμετροι 

Επιλογή Προβολικών 
Παραμέτρων ΨΜΑ 

Επιλογή Παραμέτρων  
Δημιουργίας ΨΜΑ 

 

Απόδοση ΨΜΑ 
 & 

Επισκόπηση 

Επεξεργασία – Διόρθωση 
ΨΜΑ 
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Τα βήματα που ακολουθήθηκαν για την παραγωγή του ΨΜΑ έχουν ως 
ακολούθως: 
 

α. Γεωαναφορά Τοπογραφικών Χαρτών 
 

Ο τοπογραφικοί χάρτες της Γεωγραφικής Υπηρεσίας Στρατού,  Φύλλα: «ΖΑΚΥΝΘΟΣ», « 
ΑΓΙΟΣ ΠΕΤΡΟΣ», « ΑΘΕΡΑΣ», «ΙΘΑΚΗ», ΑΡΓΟΣΤΟΛΙΟΝ»,  «ΑΓΙΑ ΕΙΡΗΝΗ», 
«ΒΟΛΙΜΑΙ»,  κλίμακας 1:50000, σαρώθηκαν και παρήχθησαν αρχεία μορφής «tif», τα 
οποία γεωαναφέρθησαν στο European Datum 1950 (ED 50) με την χρήση του 
λογισμικού πακέτου ArcGIS 9.1. Θα χρησιμοποιηθούν για την εύρεση σημείων 
αγκίστρωσης TPs (κοινά σημεία των δύο εικόνων) και εδαφικών σημείων ελέγχου GCPs 
(σημείων με γνωστές συντεταγμένες). 
 
Σημειώνεται ότι για καλύτερης ακρίβειας δορυφορικές εικόνες και παραγωγή υψηλής 
ακρίβειας ΨΜΑ οι τοπογραφικοί χάρτες 1/50000 δεν είναι χρήσιμοι. Σε αυτές τις 
περιπτώσεις τα GCPs πρέπει να δίδονται μέσω μετρήσεων GPS ή να λαμβάνονται από 
άλλες διορθωμένες εικόνες ή χάρτες υψηλής ακρίβειας.  

 
Συλλογή TPs και GCPs 

Η σκηνή ASTER της Ζακύνθου (17/07/2001) περιλαμβάνει την Κεφαλληνία και την 
Ζάκυνθο εκτός από το νότιο τμήμα της. Συνολικά εσυλλέχθησαν 49 TPs  και 11 GCPs. 
Τα ΤPs και τα GCPs πρέπει να είναι ισοκατανεμημένα τόσο κατά την οριζόντια όσο και 
κατά την κατακόρυφη διάσταση της εικόνας και το σφάλμα τους να είναι μικρότερο του 
pixel της εικόνας. Επιλέγονται σημεία σε διασταυρώσεις δρόμων, γωνίες κτηρίων, 
αιχμηρά ακρωτήρια κ.ά. 

 
Επίσης, από 18 Stereo GCPs που εσυλλέχθησαν αρχικά, τα 7 ορίσθηκαν λόγω μεγάλου 
σφάλματος ως σημεία ελέγχου CP (Control Points) και δεν υπολογίσθηκαν στο τελικό 
μαθηματικό μοντέλο. Τα στατιστικά  των δύο καναλιών 3Β και 3Ν έχουν ως εξής: 

 
Στην εικόνα 14.5 διακρίνεται ο προσδιρισμός εδαφικού σημείου ελέγχου στην 
δορυφορική εικόνα σε σχέση με τον τοπογραφικό χάρτη. Η κατανομή των TPs και GCPs 
φαίνεται στην εικόνα 14.6. 
 
Το νότιο τμήμα της Ζακύνθου περιλαμβάνεται σε μια τέταρτη σκηνή. Το γεγονός ότι η 
σκηνή αυτή αποτελείται σχεδόν εξολοκλήρου από θάλασσα λειτουργεί αρνητικά διότι δεν 
δυναται να συλλεχθούν TP και GCP με αρκετά καλή κάλυψη της σκηνής και ως εκ 
τούτου είναι αδύνατη η εξαγωγή ΨΜΑ από την συγκεκριμένη σκηνή. Το συγκεκριμένο 
τμήμα της Ζακύνθου θα συμπληρωθεί σε μεταγενέστερο στάδιο από ΨΜΑ που θα 
δημιουργηθεί από τους τοπογραφικούς χάρτες. 
 

β. Δημιουργία Epipolar Εικόνας 
 

Σε αυτό το στάδιο δημιουργούνται epipolar εικόνες. Οι epipolar εικόνες είναι 
στερεοσκοπικές εικόνες των οποίων η προβολή τους είναι τέτοια έτσι ώστε η αριστερή 
και δεξιά εικόνα να έχουν ένα κοινό προσανατολισμό και τα κοινά χαρακτηριστικά 
ανάμεσα στις δυο εικόνες εμφανίζονται κατά μήκος ενός κοινού άξονα Χ. 
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Εικόνα 14.5. Προσδιορισμός σημείου κατάλληλου για 
GCP. Το σημείο ευρίσκεται στην κορυφή μιας πολύ 
κλειστής στροφής δρόμου και δύναται να 
προσδιορισθεί με μεγάλη ακρίβεια τόσο στις δύο 
εικόνες όσο και στον τοπογραφικό χάρτη όπου 
φαίνεται ότι ευρίσκεται σε υψόμετρο 1200 m. Το 
σημείο αναπαρίσταται με κόκκινο σταυρό. 
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Εικόνα 14.6. Η φασματιική ζώνη 3B δορυφορικής εικόνας  ASTER Νήσου Ζακύνθου, σε 
συνδυασμό με την φασματική ζώνη 3Ν χρησιμοποιήθηκε για την δημιουργία ΨΜΑ της περιοχής. 
Διακρίνονται τα σημεία αγκίστρωσης TPs (μπλε), τα εδαφικά σημεία ελέγχου GCPs (κόκκινο) 
καθώς και τα CPs  (πράσινο χρώμα) με σκοπό τον συνδυασμό των εκόνων μεταξύ τους και την 
προσαρμογή τους σε πραγματικές συντεταγμένες.  

 
 

γ.  Εξαγωγή και επεξεργασία ΨΜΑ 
 

Το ΨΜΑ δημιουργείται σε αυτό το στάδιο βάσει των epipolar εικόνων. Στην εικόνα 14.8 
δίδεται μια μεγέθυνση περιοχής του ΨΜΑ της Ζακύνθου. Διακρίνεται η αποτυχία του 
ΨΜΑ κατά μήκος των ακτών και είναι έντονη η παρουσία λωρίδων που εισέρχονται μέσα 
στην θάλασσα κάθετα στις ακτές στην βόρεια πλευρά της νήσου. Επίσης διακρίνονται 
περιοχές με ανωμαλίες υψομέτρου με την μορφή απότομων βυθισμάτων (sinks) και 
απότομων κορυφών (peaks) καθώς επίσης «τρύπες» χωρίς υψόμετρο όπου δεν ήταν 
δυνατή η εξαγωγή υψομέτρου. 

 

 
Εικόνα 14.7. Το κανάλι 3Ν της τέταρτης σκηνής 
που περιλαμβάνει ένα μικρό μόνο τμήμα ξηράς 
στο βόρειο-ανατολικό άκρο.     
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Εικόνα 14.8. Λεπτομέρεια από 
το ΨΜΑ της Ζακύνθου όπου 
εμφανίζονται τα προβλήματα 
που προέκυψαν κατά την 
επεξεργασία των εξαγόμενων 
ΨΜΑ. 

 
 

 
Συνοπτικά τα προβλήματα που εντοπίσθηκαν και διορθώθηκαν κατά το στάδιο της 
παραγωγής του ΨΜΑ είναι τα εξής: 
 

• Αδυναμία ακριβούς απεικόνισης της ακτογραμμής. Κελιά που ευρίσκοντο 
σε περιοχή θάλασσας εμφάνιζαν τιμές υψομέτρου διαφορετικές από το μηδέν όπως 
θα έπρεπε.  

• Παρουσία περιοχών, συνήθως μικρών, με ανώμαλα υψόμετρα με την 
μορφή απότομων βυθισμάτων (sinks) και απότομων κορυφών (peaks). Αυτές οι 
μορφές εμφανίσθηκαν κυρίως σε απότομες κοιλάδες του υδρογραφικού δικτύου. 

• Ολοκληρωτική αδυναμία εξαγωγής υψομέτρου σε περιοχές με πολύ 
έντονη αντανάκλαση καθώς επίσης σε περιοχές με νεφοκάλυψη και με σκιές από 
αυτή.  

 
Μεγάλες περιοχές με σφάλματα ειδικά σε σημεία με έντονο ανάγλυφο ήταν αδύνατο να 
συμπληρωθούν με παρεμβολή. Σε αυτήν την περίπτωση τα κενά συμπληρώθηκαν με 
ΨΜΑ που παρήχθησαν από τους τοπογραφικούς χάρτες μέσω του ArcGIS 9.1. 
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δ. Ακρίβεια Ψηφιακού Μοντέλου Αναγλύφου και Αξιολόγηση 
 
Απαραίτητη είναι η αξιολόξηση του ΨΜΑ ως προς την ακρίβειά του. Αυτό θα 
πραγματοποιηθεί ως προς ένα ΨΜΑ , το οποίο έχει δημιουργηθεί μέσω ΣΓΠ κατόπιν 
ψηφιοποίησης τοπογραφικών στοιχείων από τοπογραφικούς χάρτες της ΓΥΣ 1/50000. Η 
σύγκριση έγινε με τρείς τρόπους:  

• Με αφαίρεση του ενός ΨΜΑ από το άλλο 
• Από 75 τυχαία κατανεμημένα τριγωνομετρικά σημεία 
• Από παρατήρηση τομών σε επιλεγμένα σημεία του ΨΜΑ καθώς επίσης από 

ποιοτική σύγκριση των δύο ΨΜΑ. 
 

Β. Δεδομένα Ανάλυσης Αναγλύφου και Δεδομένα Εδαφικής Παραμόρφωσης 
 

Το παραγόμενο ΨΜΑ αποτέλεσε βάση για την δημιουργία πολλών θεματικών και 
συνθετικών επιπέδων ανάλυσης αναγλύφου (μορφολογικές κλίσεις και 
προσανατολισμός κλίσεων, επιφάνειες επιπέδωσης, μορφολογικές ασυνέχειες κ.ά). Στην 
εικόνα 14.9 δίδεται το σκιασμένο ανάγλυφο της Ζακύνθου με τα τεκτονικά στοιχεία, ενώ 
στην εικόνα 14.10 τμήμα του Χάρτη Ανάλυσης Αναγλύφου. 
 
Χάρτες οριζόντιας και κατακόρυφης εδαφικής παραμόρφωσης δημιουργήθηκαν από 
διαφορικές μετρήσεις GPS (Εικόνα 14.11). Το δίκτυο GPS της Ζακύνθου, εγκαταστάθηκε 
και μετρήθηκε για πρώτη φορά τον Αύγουστο του 2005, ενώ επαναμετρήθηκε στο 
σύνολό του τον Ιούλιο του 2006. Μεταξύ αυτών των δύο περιόδων μέτρησης 
σημειώθηκε η σεισμική ακολουθία νότια της Ζακύνθου στην θαλάσσια κυρίως περιοχή 
τον Απρίλιο και τον Μάιο του 2006, κατά την οποία τουλάχιστον τέσσερα γεγονότα είχαν 
μέγεθος σεισμικής ροπής Mw

Η βάση δεδομένων είναι δυνατόν να ενημερώνεται με νέα πληροφορία, ανάλογα με τις 
εκάστοτε ανάγκες, με σκοπό την  ευκολότερη διεξαγωγή συμπερασμάτων και την 
περαιτέρω δημιουργία συστήματος λήψεως αποφάσεων για αντισεισμικό σχεδιασμό της 
περιοχής, διαχείριση γεω-περιβαλλοντικών προβλημάτων, κατασκευή μεγάλων τεχνικών 
έργων κ.ά. 

=5,5 – 5,7, ενώ δεκάδες άλλα είχαν μέγεθος κυμαινόμενο 
από 5,0 έως 5,5. Κατέστη δυνατόν να ελεγχθεί η τεκτονική συμπεριφορά της περιοχής 
μετά από την προαναφερθείσα σεισμική ακολουθία.  
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Εικόνα 14.9. Σκιασμένο Ανάγλυφο Ζακύνθου (azimuth 450, altidute 450) από το ΨΜΑ 
ακριβείας 30m, το οποίο προέκυψε από τις δορυφορικές εικόνες ASTER, με τις ρηξιγενείς 
ζώνες της περιοχής. 

 
Εικόνα 14.10. Τμήμα Χάρτη Ανάλυσης Αναγλύφου Νήσου Ζακύνθου μέσω του λογισμικού 
«ΠΡΩΑΝΑ». Διακρίνονται οι μέσες μορφολογικές κλίσεις (morphological slopes) ανά 
κατηγορίες (0%-5%, 5%-15%, 15%-30%, 30%-45%, 45%-65% και άνω του 65%) και με 
χρωματισμό από ανοικτό κίτρινο έως σκούρο καφέ από τις μικρότερες προς τις μεγαλύτερες 
κλίσεις αντίστοιχα. Δικρίνεται με το σύμβολο του βέλους ο προσανατολισμός των 
μορφολογικών κλίσεων (aspect). Επίσης διακρίνονται οι ενεργές (active)  ρηξιγενείς ζώνες 
κατηγοριοποιημένες σε κύριες (main), δευτερεύσουσες (secondary) κ.ά. 
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Εικόνα 14.11. Οριζόντια και κατακόρυφη παραμόρφωση Νήσου Ζακύνθου, όπως μετρήθηκε 
από δίκτυο DGPS  την περίοδο Αυγούστου 2005 - Ιουλίου 2006, από τον Τομέα Γεωφυσικής 
& Γεωθερμίας του Τμήματος Γεωλογίας & Γεωπεριβάλλοντος του ΕΚΠΑ με Υπεύθυνο τον 
Καθηγητή κ. Ε. Λάγιο και προέκυψε μέσω του ειδικού λογισμικού «ΠΡΩΑΝΑ-ΙΙ». 

 
 
14.2.  Διαχείριση Ηφαιστειακού Κινδύνου 
 
14.2.1. Γενικά 
 
Ενεργά ηφαίστεια σε περιοχές γεωδυναμικά ενεργές, όπως η Νίσυρος, διέπουν 
συνήθως υψηλούς κινδύνους, ώστε η διαρκής παρακολούθησή τους μέσω δορυφόρων 
και η μοντελοποίησή τους κρίνεται απαραίτητη. Οι κίνδυνοι που συνήθως εμφανίζονται 
είναι: 
 
 Σεισμική Δραστηριότητα από επαγώμενη δραστηριοποίηση τεκτονικών κινήσεων 
  Ηφαιστειακή και Τεκτονική Σεισμική Δραστηριότητα  

-   Κινήσεις μάγματος στον Φλοιό 
- Υδροθερμικές εκρήξεις από Αέρια  
- Υδροθερμικές εκρήξεις από Ατμό (υδροθερμικών πεδίων) 

  Τυπικές Φρεατο-Μαγματικές Εκρήξεις (συνοδευόμενες από στάχτη, ροές λάβας 
κ.λ.π.) 

  Πρόκληση Κατολισθήσεων και Τσουνάμι  
 Ηφαιστειακές Εκρήξεις 

Οι φυσικές καταστροφές (ηφαίστεια, σεισμοί, τσουνάμι, πλημμύρες, κατολισθήσεις, 
καθιζήσεις κ.ά) δύναται  να ελαχιστοποιηθούν με την κατάλληλη διαχείριση που αφορά 
σε: 

• Προ-Σχεδιασμό 
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• Προετοιμασία και Πρόβλεψη 
• Ανταπόκριση στον Κίνδυνο 
• Ελαχιστοποίηση, Διαχείριση Έκτακτης Ανάγκης, Ανάκαμψη και Ανακατασκευή 

 
Η παρακολούθηση  Ενεργών Ηφαιστείων απαιτεί (εί δυνατόν): 

• Παρακολούθηση σε Πραγματικό Χρόνο 
• Εφαρμογή Δορυφορικής Τεχνολογίας 
• Εκτίμηση Επικινδυνότητας 
• Εφαρμογή Συστημάτων Έγκαιρης Προειδοποίησης (Early Warning   System)  

 
Οι παράμετροι  εκτίμησης  ηφαιστειακού  κινδύνου αφορούν σε: 

• Εκτίμηση Συστήματος Ρευστών 
• Συμπιεστικούς Μηχανισμούς Γενέσεως των Σεισμών 
• Αναγνώριση Αλλαγών στην Χημική και Ισοτοπική Σύσταση των Αερίων των 

Φουμαρόλων  
• Αλλαγών στην εξαέρωση του μάγματος σε βάθος ή αλλαγές συνθηκώνθερμο- 

πίεσης  
 
Ο Όγκος και Χρόνος εισροής Μάγματος προξενεί 

• Ραγδαίες Φυσικές και Χημικές Μεταβολές 
• Αλλαγές στο Τοπικό Πεδίο Τάσεων (Τεκτονικοί Σεισμοί) 

 
14.2.2. Επίγειες και Διαστημικές Τεχνικές 
 
Οι μεθοδολογίες που ακολουθούνται για την παρακολούθηση σε πραγματικό χρόνο 
είναι: 
 

• Συμβολομετρία Ραντάρ (Ανίχνευση Εδαφικής Παραμόρφωσης) 
Α.   Διαστημικές Τεχνικές 

• Θερμικές Εικόνες LANDSAT ETM+, ASTER (Χάρτες Επιφανειακής 
Θερμοκρασίας)  

• Πλοήγηση – Χρήση GPS Δορυφόρων  
• Δορυφορική Μετεωρολογία : 

Πρόγνωση καιρού και υποστηρικτικές δραστηριότητες για την διαχείριση φυσικών 
καταστροφών. Επίσης, σε περίπτωση ηφαιστειακών εκρήξεων ή σεισμικού 
γεγονότος, δύναται να επακολουθήσουν δευτερογενή καταστροφικά φαινόμενα 
όπως αστάθεια πρανών, κατολισθήσεις, τσουνάμι κ.λ.π.,  τα οποία 
παρατηρούνται από τους μετεωρολογικούς δορυφόρους. 

• Γεωστατικοί Δορυφόροι Τηλεπικοινωνίας (π.χ. Δορυφορικά Τηλέφωνα) 
• Δορυφορικές Εμπορικές Υπηρεσίες (μετάδοση φωνής ή δεδομένων, ανεξάρτητες 

από τα Τοπικά Δίκτυα τα οποία καταρρέουν σε περίπτωση κρίσεων). 
• Δορυφορική Πλοήγηση στην Ξηρά, η οποία επιτυγχάνεται με Oρθο-διορθωμένες 

υψηλής ακρίβειας εικόνες IKONOS, QUICKBIRD κ.ά. σε συνδυασμό με GPS και 
αποτελούν λίαν χρήσιμες δυνατότητες στα ακόλουθα: Σχεδιασμό Εκτάκτων 
Αναγκών - 
Διαχείριση Κρίσεων από Φυσικές Καταστροφές (Άμεσες στρατηγικές 
επιχειρήσεων διάσωσης και επανόρθωσης, καθώς και ποσοτικός προσδιορισμός 
της καταστροφής κτηρίων και ανθρώπινης έκθεσης). Ο τρόπος λειτουργίας έχει 
ως ακολούθως: 
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Προγενέστερη της καταστροφής εικόνα IKONOS ή QUICKBIRD ( με όλες τις 
πληγείσες θέσεις) συνδυάζεται στον υπολογιστή με επίγειας ή εναέριας λήψης 
ψηφιακές εικόνες της πληγείσας περιοχής  (θερμικές ή οπτικές ή και τα δύο). 
Μέσω GPS επιτυγχάνεται ο ακριβής προσδιορισμός  θέσης, ανεύρεση 
εξοπλισμού και οχημάτων κατά την διάρκεια και μετά την κρίση. Η μετάδοση 
γίνεται με GSM ή δορυφόρων τηλεπικοινωνίας, μέσω διαδικτύου στον κεντρικό 
υπολογιστή του Κέντρου Επιχειρήσεων με σκοπό την λήψη Αποφάσεων. 

 
Συμπεραίνεται ότι οι δορυφορικές εικόνες υψηλής ακρίβειας (οπτικές και ραντάρ) είναι 
βασικό συστατικό στην διαχείριση Φυσικών Καταστροφών (πριν, κατά την διάρκεια και 
μετά) καθόσον αποτελούν βάση για θεματικές εφαρμογές αλλά και εργαλείο για την 
παραγωγή ΨΜΑ. 
 

Η επίγεια θερμική κάμερα έχει την δυνατότητα να λαμβάνει θερμικές εικόνες με πολύ 
καλή ανάλυση, οι οποίες κατόπιν επεξεργασίας απεικονίζουν την επιφανειακή 
θερμοκρασία εδάφους, θάλασσας ή διαφόρων αντικειμένων σε δεδομένη χρονική στγμή. 
Οι χρήσεις της έχουν ως εξής: 

Β.  Επίγεια Θερμική Κάμερα 

• Θερμική Ανάλυση Εδάφους (κατά την διάρκεια κρίσης, καταστροφής)  
• Σχεδιασμός - Διαχείριση (μετά την κρίση: χρήσιμη στα συνεργεία διάσωσης για 

διάσωση ζώντων, κατεστραμένων ζωτικών περιοχών και κτηρίων, διαρροή 
αερίου κ.λ.π.).  

• Καλή ανταπόκριση στην ταυτοποίηση αστικών ζεστών σημείων λόγω πυρκαγιάς 
ως επακόλουθο σεισμικού γεγονότος ή σε δασικές πυρκαγιές. 

• Παρακολούθηση σε Πραγματικό Χρόνο Θερμοκρασίας Θερμών Πηγών, 
Φουμαρόλων, Θαλασσίου Ύδατος πλησίον Θερμών Πηγών. 

• Δυνατότητα Βαθμονόμησης λαμβανομένων Δορυφορικών Εικόνων (LANDSAT, 
ASTER κ.λ.π.). 

• Δυνατότητα Ανάλυσης In Situ 
 

Με την Τεχνολογία Νυχτερινής όρασης επιτυγχάνεται η παρατήρηση αντικειμένων 
καθαρά την νύχτα σε απόσταση έως αρκετές εκατοντάδες μέτρα. 

Γ. Η Τεχνολογία Νυχτερινής Όρασης 

 
Άνθρωποι, κτήρια, σχήματα και λεπτομέρειες του τοπίου εμφανίζονται μέσω ενός 
μοντέρνου συστήματος νυχτερινής όρασης σχεδόν ως να φωτίζονται. 
 
Η συγκεκριμένη τεχνολογία είναι αρκετά χρήσιμη κατά και μετά την κρίση. 
 

Οι Επίγειες μεθοδολογίες που εφαρμόζονται για την παρακολούθηση ηφαιστείων έχουν 
ως ακολούθως: 

Δ.  Επίγειες Εφαρμογές Παρακολούθησης Ηφαιστείων 

• Σεισμολογικά Δίκτυα, για σεισμική παρακολούθηση 
• Γεωδαιτικά Δίκτυα (DGPS) για παρακολούθηση εδαφικής παρμόρφωσης 
• Εσωτερική Δομή Ηφαιστείων (Εφαρμογή Γεωφυσικών Μεθοδολογιών)  
• Γνώση Γεωλογίας 
• Παρακολούθηση Φυσικών και Χημικών Παραμέτρων Αερίων και Υπογείων 

Υδάτων 
• Γνώση Γεωτεχνικών Συνθηκών και Εδαφικών Παραμέτρων 
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• Γνώση Σεισμο-πολεοδομικών & Σεισμο-χωροταξικών Δεδομένων 
• Μελέτη Επιφανειακής Θερμοκρασίας Εδάφους 

 

Η διαχείριση ηφαιστειακού κινδύνου μέσω ΣΓΠ, απαιτεί την συλλογή, οργάνωση και 
διαχείριση πλήθους δεδομένων, την παραγωγή θεματικών και συνθετικών επιπέδων 
πληροφορίας και χαρτών, την ποιοτική και ποσοτική ανάλυση της πληροφορίας, με 
απώτερο στόχο τον Σχεδιασμό Σεναρίου, την Εκτίμηση Καταστροφών καθώς και την 
λειτουργία ενός συστήματος λήψεως γενικοτέρων αποφάσεων, όπως: 

Ε. Ανάπτυξη ΣΓΠ – Σύστημα Λήψεως Αποφάσεων 

• Πρόβλεψη δραστηριοποίησης ηφαιστείου ή σεισμικού γεγονότος 
(μακροπρόθεσμα) μέσω παρακολούθησης πρόδρομων φαινομένων.  

• Αλλαγές παραμέτρων σε πραγματικό χρόνο, οι οποίες προειδοποιούν για πιθανό 
γεγονός.  

• Πρόγνωση επαναδραστηριοποίησης μάγματος, επακόλουθης ηφαιστειακής 
έκρηξης και σεισμικότητας επιτυγχάνουν ένα ολοκληρωμένο, πιθανό αλλά 
καθορισμένο πλαίσιο. 

• Εκτίμηση καταστροφών, τρωτότητα επικινδύνων ζωνών, σύνθεση σχετικών 
χαρτών σε 2, 3, and 4-D και εξαγωγή σε πολυμέσα.  

 
14.2.3. Παρακολούθηση Ηφαιστείου Νισύρου 
 
Κατά την χρονική περίοδο 2000-2003, διεξήχθη έρευνα από Πανεπιστήμια και Ινστιτούτα 
της Ελλάδας και του Εξωτερικού, σχετικά με την παρακολούθηση του Ηφαστείου της 
Νισύρου με σύγχρονες τεχνολογίες, στο πλαίσιο του επιστημονικού ερευνητικού 
προγράμματος GEOWARN (www.geowarn.org). Στόχος στο γενικότερο πλαίσιο του 
προγράμματος ήταν και η ανάπτυξη  Συστήματος Γεωγραφικών Πληροφοριών στο 
ArcGIS για την διαχείριση της πολυ-θεματικής πληροφορίας σχετική με γεωφυσική, 
γεωλογία, τεκτονική, σεισμολογία, γεωχημεία, εδαφική παραμόρφωση, δορυφορικές 
εικόνες κ.ά., με σκοπό την εύκολη διεξαγωγή συμπερασμάτων και την δημιουργία 
συστήματος λήψης αποφάσεων. Αυτό προϋποθέτει την αναγωγή όλων των δεδομένων 
σε ένα κοινό χαρτογραφικό σύστημα. Δίδονται μερικά βασικά θεματικά και συνθετικά 
επίπεδα και χάρτες που απαιτήθηκαν κατά την διαχείριση του Ηφαιστείου της Νισύρου. 

• ΨΜΑ υψηλής ακρίβειας 
• Παράγωγα των ΨΜΑ θεματικά επίπεδα (Χάρτες Αναλύσεως Αναγλύφου: 

μορφολογικοί χάρτες κλίσεων και προσανατολισμού των κλίσεων, μορφολογικές 
ασυνέχειες, επιφάνειες επιπέδωσης κ.ά.). 

• Ενημερωμένος Τοπογραφικός Χάρτης, υψηλής ακρίβειας 
• Πολεοδομικός Χάρτης 
• Ορθο-αναγώμενες δορυφορικές εικόνες (IKONOS, QUICKBIRD, LANDSAT, 

ASTER, κ.ά.) 
• Χάρτες Γεωλογικών Δεδομένων (Γεωλογικός, Τεκτονικός, Νεοτεκτονικός, Μορφο-

τεκτονικός κ.ά) 
• Χάρτες Σεισμολογικών Δεδομένων (Σεισμικότητας, Σεισμικών Εντάσεων, 

Μηχανισμοί Γένεσης κ.ά.) 
• Χάρτες Επιφανειακών Μετατοπίσεων (από GPS και DΙnSAR) 
• Χάρτες Βαρυτικών Δεδομένων 
• Χάρτες Γεωχημικών Δεδομένων 
• Χάρτης Χρήσεων Γης 
• Χάρτης επακόλουθων καταστροφικών φαινομένων (κατολισθήσεων, καθιζήσεων, 

tsunamis κ.ά.) 

http://www.geowarn.org/�
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Παραθέτονται μερικοί αντιπροσωπευτικοί χάρτες που παρήχθησαν από την διαχείριση 
επίγειων και δορυφορικών δεδομένων της Νισύρου, κατά την διεξαγωγή του ερευνητικού 
προγράμματος και στο πλαίσο ερευνητικών δημοσιεύσεων (Eικ. 14.12-14.24 &   Eικ. 
14.27 – 14.28). 
 
Α. Επεξεργασία Δορυφορικής Εικόνας PAN/MSI IKONOS 2 Νισύρου 
 
Η Δορυφορική Εικόνα PAN/MSI IKONOS 2 της Νισύρου επεξεργάσθηκε ώστε μέσω της 
φωτοερμηνείας να επιτευχθεί η διάκριση τοπογραφικών στοιχείων χρήσεων γης καθώς 
και τεκτονικών δομών με σκοπό την παραγωγή αντίστοιχων ορθοφωτοχαρτών. Η 
δημιουργία ενός λεπτομερούς Τοπογραφικού Χάρτη της Νισύρου 1/100000 ήταν ένας 
από τους βασικούς στόχους της μελέτης.  
 
Η επεξεργασία της εικόνας έχει ως ακολούθως: 
 
Α.  Ορθο-αναγωγή Δορυφορικής Εικόνας PAN/MSI IKONOS 2 (8/4/2001) Νισύρου (Εικ. 
14.12, Vassilopoulou et al. 2002) μέσω του λογισμικού Geomatica OrthoEngine Basics 
(2001) και με χρήση: 

• 38 επιλεγμένων επίγειων σημείων ελέγχου (Ground Control Points - GCPs) 
υψηλής ακριβείας (εικ. 14.12), ισοκατανεμημένα τόσο κατά την οριζόντια όσο και 
κατά την κατακόρυφη διάσταση της εικόνας. 

• Ψηφιακού Μοντέλου Αναγλύφου με μέγεθος κυψελίδας (pixel size): 2m (εικ. 
14.13-14.15). 

 
Η αρχική 11-bit εικόνα μετασχηματίσθηκε γραμμικά από (min,max) 3 RGB κανάλια σε 
(0,255), τα οποία κανάλια διαχωρίσθηκαν σε 1 αρχείο / κανάλι με το λογισμικό IDL. 
Ένα μοντέλο ομοπαραλληλικού μετασχηματισμού διόρθωσης αναγλύφου και  το μοντέλο 
των πολυωνυμικών συναρτήσεων απεικόνισης 4ου

 

 βαθμού Kratky (Kratky, 1989) 
χρησιμοποιήθηκαν ώστε η ορθο-αναγώμενη εικόνα IKONOS 2 Νισύρου παρήχθη, στο 
Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς 1987 (ΕΓΣΑ΄87). Το σφάλμα RMS ήταν 
περίπου 1.5m και 1.3m  ως προς X και Y αντίστοιχα. 
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Εικόνα 14.13. Υψηλής ακριβείας ΨΜΑ Νισύρου (pixel size 2m), παραγώμενο από τοπογραφικά 
δεδομένα των τοπογραφικών χαρτών κλίμακας 1/5000 της ΓΥΣ, μέσω του αλγορίθμου “topogrid” 
του ArcGIS (ESRI, 2001) από Vassilopoulou & Hurni (2001). 

 
Εικόνα 14.12. Η 
δορυφορική IKONOS 2 
της Νισύρου, με τα 
GCPs υπερκείμενα, τα 
οποία 
προσδιορίσθηκαν στην 
ύπαιθρο με χρήση ενός 
φορητού PC και του 
λογισμικού ERDAS 
Imagine (2001), κατά 
την διάρκεια DGPS 
μετρήσεων. 
 



 150 

 
 

Εικόνα 14.14. Σκιασμένο Ανάγλυφο Νισύρου. Διακρίνεται το έντονο ανάγλυφο και οι 
τεκτονικές δομές. Χρήσιμο στην χαρτογράφηση τεκτονικών και άλλων δομών. Αποτελεί 
υπόβαθρο για τα θεματικά επίπεδα των υδροθερμικών κρατήρων, των ρηξιγενών ζωνών, 
των θέσεων σταθμών GPS, των μικροβαρυτομετρικών σταθμών, των φουμαρόλων και των 
θερμών πηγών. (Lagios et al., 2001). 

 

 
 
 
 
 
 

 
 
 
 
 
 
Εικόνα 14.15. 
Το σκιασμένο 
ανάγλυφο της 
Νισύρου της εικ. 
14.14 σε 
μεγένθυνση. 
Διακρίνεται ο 
Κρατήρας 
Στέφανος.  
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Β. Φωτοερμηνεία Ορθο-εικόνας IKONOS 2 Νισύρου 
 
Με φωτοερμηνεία της ορθο-εικόνας IKONOS 2 (εικ. 14.16) προσδιορίσθηκαν τα 
ακόλουθα τοπογραφικά δεδομένα (εικ. 14.16, 14.17):  

• οδικό δίκτυο (με ταξινόμηση ανά κατηγορίες) 
• οικοδομικά τετράγωνα 
• κτίσματα  και κατηγοριοποίηση αυτών 

 

 
Εικόνα 14.16. Ορθο-φωτοχάρτης τοπογραφικών δεδομένων Νισύρου, από 
φωτοερμηνεία της δορυφορικής εικόνας ορθο-IKONOS 2 και εργασία πεδίου. Υπόβαθρο 
αποτελεί η ορθο-ΙΚΟΝΟS -2 δορυφορική εικόνα Νισύρου (Vassilopoulou et al., 2002). 
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Εικόνα 14.17. Μεγένθυνση τμήματος του ορθο-φωτοχάρτη τοπογραφικών  

     δεδομένων της Νισύρου. Διακρίνονται το οδικό δίκτυο, τα κτήρια κ.ά. 
 

Με φωτοερμηνεία της ορθο-εικόνας IKONOS-2 (Vassilopoulou et al., 2002), 
δημιουργήθηκε ο Χάρτης Χρήσεων Γης της Νισύρου (εικ. 14.18). 

 

 
 

Εικόνα 14.18. Ο Χάρτης Χρήσεων Γης Νισύρου, ΕΤΗ Ζurich. 
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Γ. Θερμοκρασιακή Παρακολούθηση Ηφαιστείου Νισύρου 
 
Η Θερμοκρασιακή παρακολούθηση του ηφαιστείου της Νισύρου, από το διάστημα και 
από το έδαφος, επιτεύχθηκε με την εφαρμογή συγχρόνων τεχνολογιών  “state-of-the-
art”, για το χρονικό διάστημα 2000-2002.  Στόχος της μελέτης είναι η δημιουργία ενός 
συστήματος παρακολούθησης, χαμηλού κόστους, μέσω του καναλιού 6 του δορυφόρου 
LANDSAT 7 ETM+ σε συνδυασμό με επίγειες θερμικές εικόνες. 
 
Κλασική Μεθοδολογία 
 
• Επιφανειακή σημειακή λήψη θερμοκρασίας. 
 
Σύγχρονες Μεθοδολογίες 
 
• Nυχτερινής λήψεως εικόνες LANDSAT-7 ETM+ (6-1 θερμικό υπέρυθρο κανάλι 

(TIR)), διαφορετικής χρονικής στιγμής, με  χωρική διακριτική ικανότητα 60m, 
επεξεργάσθηκαν, ώστε να παραχθούν χάρτες επιφανειακής θερμοκρασίας της 
Νισύρου.  

• Πολυφασματικά δορυφορικά δεδομένα ASTER (υπέρυθρο, διακριτική ικανότητα 
90m), λαμβανόμενα κατά την ίδια χρονική στιγμή με τις εικόνες LANDSAT 7.  

• Επίγειες Θερμικές Εικόνες (υπέρυθρο, διακριτική ικανότητα έως μερικά χιλιοστά, 
εξαρτώμενη από την απόσταση λήψης), λαμβανόμενες κατά την ίδια χρονική στιγμή 
με τις εικόνες LANDSAT 7.  

 
Οι δορυφορικές και οι επίγειες εικόνες επεξεργάζονται με σκοπό την προσαρμογή τους 
σε πραγματικές συντεταγμένες μέσω της ορθο-αναγωγής και την διόρθωση από την 
επίδραση της  ατμόσφαιρας μέσω ατμοσφαιρικής διόρθωσης. 
 
Στόχος 
 
Θερμοκρασιακά διορθωμένες εικόνες απαλλαγμένες από την επίδραση της τοπογραφίας 
και της ατμόσφαιρας. Κυρίως επιλέγονται εικόνες νυχτερινής λήψης προς αποφυγήν της 
ημερήσιας ηλιακής επίδρασης. 
 
Επεξεργασία Δορυφορικών Εικόνων LANDSAT 7, ETM+ 

 
Ορθο-αναγωγή 
 

Με την διαδικασία της ορθο-αναγωγής, μέσω του λογισμικού Geomatica OrthoEngine 
Basics (2001), οι εικόνες  LANDSAT 7, ETM+ προσαρμόσθηκαν σε πραγματικές 
συντεταγμένες και απαλλάχθηκαν από παραμορφώσεις, δηλαδή, απέκτησαν ιδιότητες 
χάρτη υψηλής ακρίβειας. Η διαδικασία της ορθο-αναγωγής είναι απαραίτητη για μελέτες 
ακριβείας και για την εν συνεχεία παραγωγή ορθο-φωτο-χαρτών. 
Τα δεδομένα για την εφαρμογή της ορθο-αναγωγής είναι: 
• Υψηλής ακρίβειας Ψηφιακό Μοντέλο Αναγλύφου (μέγεθος κυψελίδας 2m) 
• Επιλεγμένα Σημεία Ελέγχου (GCPs), μετρούμενα με  DGPS χρησιμοποιήθηκαν για 

την ορθο-αναγωγή, κάθε εικόνας.  Το σφάλμα των παραγώμενων ορθο-εικόνων 
ήταν μικρότερο της κυψελίδας (1 κυψελίδα = 60m×60m, εικ. 14.19). 

 
 



 154 

Ατμοσφαιρικές Διορθώσεις 
 

Οι ατμοσφαιρικές διορθώσεις επιτυγχάνονται με την εφαρμογή εξειδικευμένων 
λογισμικών, όπου λαμβάνεται υπ’ όψιν η μεταβολή της θερμοκρασίας με το ύψος, 
υιοθετώντας ακριβή μοντέλα ατμόσφαιρας επάνω από την περιοχή μελέτης, με 
παραμέτρους την θερμοκρασία (Τ), την ατμοσφαιρική πίεση (Ρ) και την σχετική υγρασία, 
οπότε προκύπτουν 3-D ατμοσφαιρικά διορθωμένες εικόνες.  Οι παράμετροι δεν είναι 
απόλυτα ίσες αλλά πλησιάζουν προς τις πραγματικές τιμές που μετρήθησαν κατά την 
ώρα λήψεως των εικόνων.  Παράμετρος που λαμβάνεται  υπ’ όψιν επίσης είναι η 
ικανότητα εκπομπής (emissivity) του συγκεκριμμένου γεωλογικού σχηματισμού που 
μελετάται. Λαμβάνεται μια μέση τιμή (emissivity = 0.98),  η οποία αντιπροσωπεύει γενικά 
την ικανότητα εκπομπής της λάβας και των πυροκλαστικών πετρωμάτων και όχι 
ολόκληρη την περιοχή. Είναι δεδομένο ότι θα προκύψει ένα σφάλμα σε φυσιολογικά 
όρια, αλλά δεν είναι δυνατός ο ορισμός διαφορετικών τιμών emissivity στον αλγόριθμο. 
Επιλεγμένα σημεία ελέγχου επιφανειακής θερμοκρασίας (GTCPs) ελήφθησαν για τον 
έλεγχο των αποτελεσμάτων, κατά την χρονική στιγμή λήψεως των εικόνων από τον 
δορυφόρο. Σημειώνεται ότι η περιοχή του Κρατήρα Στέφανου απομονώθηκε και 
επεξεργάσθηκε χωριστά, με την λήψη διαφορετικών ατμοσφαιρικών μοντέλων 
πλησιέστερων στις ιδιαίτερες συνθήκες του κρατήρα. 
 
Στην συγκεκριμένη μελέτη οι 3-D ατμοσφαιρικά διορθωμένες εικόνες (εικ. 14.20 & 14.21) 
προέκυψαν μέσω του λογισμικού ATCOR3 του ERDAS Imagine (ATCOR, 2002). 
 
 

 

 
 
 
 
 
 
 
 
 
Εικόνα 14.19. Επιλεγμένα 
Εδαφικά Σημεία Ελέγχου 
(GCPs) στην Δορυφορική 
Eικόνα LANDSAT-7 
(διακριτική ικανότητα 60m), 
για την ορθο-αναγωγή της 
(Lagios et al., 2007). 
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Εικόνα 14.20. «Χάρτες Επιφανειακής Θερμοκρασίας Νισύρου» από επεξεργασία δορυφορικών 
εικόνων LANDSAT-7 (Oct. 20 2000, May 19, 2002 and  Oct. 26, 2002), από Lagios et al. 2007. 
 
 

 
 

Εικόνα 14.21. «Χάρτης Διαφοράς Επιφανειακής Θερμοκρασίας Νισύρου» (δεξιά εικόνα) από τις 
δορυφορικές εικόνες LANDSAT-7 (Oct. 26, 2002 και Oct. 20, 2000). Σε μεγένθυνση δίνεται η 
περιοχή Λακκί (αριστερή εικόνα), από Lagios et al. 2007. 
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Θερμική (IR) Κάμερα – Επίγειες Θερμικές Εικόνες 
 
Η επεξεργασία των επίγειων θερμικών εικόνων (Εικ. 14.22) από την περιοχή του 
κρατήρα, οι οποίες ελήφθησαν με την θερμική κάμερα NEC Thermo Tracer TH7102 
(φασματική περιοχή 8–14 μm, ανάλυση 0.08 °C, σφάλμα ± 2%) αφορά σε δύο σταδια: 
• στην θερμική διόρθωση μέσω του λογισμικού IRIS (2001), με επιλεγμένα σημεία 

ελέγχου (GTCPs). Τα σημεία ελέγχου (τιμές επιφανειακής θερμοκρασίας), τα οποία 
είναι άνω των 150,  ελήφθησαν ανά 5m, κατά μήκος συγκεκριμένων τομών στην 
επιφάνεια του κρατήρα. Όσον αφορά στην ικανότητα εκπομπής, για την περιοχή του 
κρατήρα ελήφθηκε emissivity = 0.93, η οποία πλησιάζει περισσότερο τους 
σχηματισμούς του κρατήρα (ετερογενής γεωλογία από ηφαιστειακά ιζήματα, 
υδροθερμικά εδάφη, αποθέσεις εδαφών και άλατος, με ύπαρξη φουμαρόλων και 
εξατμίσεων αερίων). Για την περιοχή εκτός κρατήρα ελήφθη emissivity = 0.98. 

• στην προσαρμογή τους σε πραγματικές συντεταγμένες μέσω ορθο-αναγωγής από το 
Geomatica OrthoEngine Basics (2001), με χρήση του ΨΜΑ 2m αναλύσεως και ενός 
αριθμού επιλεγμένων σημείων ελέγχου (GCPs). 

 
Μετά την επεξεργασία προέκυψαν οι ορθο-αναγώμενες θερμικές εικόνες (εικ. 14.23). 
 

Πλεονεκτήματα Θερμικής Κάμερας 
 

• Απεριόριστη η επιλογή Χρόνου, Ύψους & Θέσεως Λήψεως 
• Δυνατή η μετατροπή των Θερμικών Εικόνων σε ορθο-Εικόνες 
• Διαθέσιμη η πληροφορία προς εξαγωγή Γεωφυσικών Συμπερασμάτων 
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Εικόνα 14.22. α) Ο Κρατήρας 
Στέφανος (βάθους 20-25m) όπως 
φαίνεται  από τα Νικιά (400m  
υψόμετρο, περίπου 300m πάνω 
από το Λακκί όπου ευρίσκεται ο 
κρατήρας).  
 
β) Θερμική IR επίγεια εικόνα 
(αδιόρθωτη) του Κρατήρα 
Στέφανου από τα Νικιά, όπου 
δείχνει την επιφανειακή κατανομή 
θερμοκρασίας (22/7/2002).   
 

 

 

 
 
 
 
Εικόνα 14.23. α) Ορθο-αναγώμενη 
και θερμικά διορθωμένη IR επίγεια 
θερμική εικόνα (5mx5m pixel size), 
του Κρατήρα Στέφανου (22/7/2002). 
Σημειώνεται ότι στο ΝΑ τμήμα του 
κρατήρα δεν δίνονται θερμοκρασίες 
λόγω της γωνίας λήψης της εικόνας 
(διακεκομμένη γραμμή ΒΑ-ΝΔ 
διεύθυνσης στην εικόνα (β)), από 
Lagios et al. 2007. 
 
β) Η ορθο-αναγώμενη και θερμικά 
διορθωμένη IR επίγεια θερμική 
εικόνα (5mx5m pixel size), του 
Κρατήρα Στέφανου (22/7/2002) σε 
συνδυασμό με την δορυφoρική 
εικόνα ortho-LANDSAT-7 ΕΤΜ+ 
(60mx60m pixel size) ίδιας 
χρονικής στιγμής. Τα πράσινα 
σημεία κατά μήκος των τομών P1, 
P2, P3, P4 & P5 υποδηλώνουν τις 
θέσεις επίγειων μετρήσεων (ανά 
5m), από Lagios et al. 2007. 
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Δ. GPS και Συμβολομετρία Ραντάρ – Εδαφική Παραμόρφωση Νισύρου 
 
Για την μελέτη της εδαφικής παραμόρφωσης της Νισύρου εφαρμόσθηκαν Διαφορικές 
Γεωδαιτικές Μετρήσεις (DGPS) και η τεχνική της Διαφορικής Συμβολομετρίας Ραντάρ 
(DInSAR). Οι τεχνικές αυτές αποτελούν τις πλέον σύγχρονες δορυφορικές τεχνικές 
προσδιορισμού της εδαφικής παραμόρφωσης σε ηφαιστειακά περιβάλλοντα.  
 
Η παραμόρφωση της επιφάνειας της γης (εδαφική παραμόρφωση)  οφείλεται είτε σε 
φυσικά αίτια (σεισμούς, ηφαίστεια, ενεργές ρηξιγενείς ζώνες, καθιζήσεις, κατολισθήσεις 
κ.ά) είτε σε ανθρωπογενή αίτια (άντληση υπογείων υδάτων, ύπαρξη ορυχείων, 
κατασκευή σηράγγων, κ.ά.). 
 
Βάσει των παρατηρήσεων GPS επιλύονται με ακρίβεια η οριζόντια και κατακόρυφη 
συνιστώσα της κίνησης, ενώ με τα δεδομένα DInSAR εκφράζεται η παραμόρφωση στην 
διεύθυνση παρατήρησης του δορυφόρου, η οποία με την σειρά της αποδίδει κυρίως τις 
μεταβολές της επιφάνειας στην κατακόρυφη διάσταση.  

Γενικά για οποιαδήποτε μελέτη, ο συνδυασμός των θεματικών επιπέδων εδαφικής 
παραμόρφωσης με άλλα θεματικά επίπεδα (γεωλογικά, τεκτονικά, εδαφοτεχνικά, 
υδρογεωλογικά, χρήσεων γης, γεωμορφολογικά), σε ένα ΣΓΠ, οδηγεί σε μια 
πολύπλευρη μελέτη και σε τεκμηριωμένα συμπεράσματα. 

Γεωδαιτικές Μετρήσεις GPS 

Ένα Δίκτυο από 16 Σταθμούς εγκαθιδρύθηκε στην Νίσυρο τον Ιούνιο του 1997 και 
επαναμετρήθηκε αρκετές φορές έως τον Ιούνιο του 2001, από τον Καθηγ. Κ. Ε. Λάγιο 
και συνεργάτες (Εικ. 14.24). Ο Σταθμός Αναφοράς ευρίσκεται στο ΒΑ τμήμα της Κω. Η 
επεξεργασία των μετρήσεων έγινε μέσω των λογισμικών BERNESE και SKI-Pro. Τα 
γεωδαιτικά δεδομένα συμπεριλήφθησαν στην βάση δεδομένων που έχει αναπτυχθεί σε 
ΣΓΠ και επεξεργάσθηκαν με όλα τα άλλα διαφορετικού είδους δεδομένα. 

 
 

Εικόνα 14.24.  Παρατηρούμενη οριζόντια και κατακόρυφη παραμόρφωση, όπως προέκυψε από 
μετρήσεις DGPS περιόδου 1997-2001, κατά την διάρκεια του Ευρωπαϊκού Ερευνητικού 
Προγράμματος GEOWARN (Sakkas et al., 2002). 
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Διαφορική Συμβολομετρία Ραντάρ (DInSAR) 
 
Τεχνική της συμβολομετρίας ραντάρ αποτελεί η Διαφορική Συμβολομετρία Ραντάρ 
(Differential Interferometry SAR / DInSAR), βάσει της οποίας ανιχνεύονται οι εδαφικές 
κινήσεις και παράγονται χάρτες εδαφικής παραμόρφωσης, απαλλαγμένοι από την 
επίδραση της τοπογραφίας.  
 
Ουσιαστικά επιτυγχάνεται η απαλοιφή της τοπογραφίας από την παρατηρούμενη 
συμβολομετρική φάση, επιτρέποντας την απομόνωση της φάσης που σχετίζεται με 
διαφορικές κινήσεις που έλαβαν χώρα στο χρονικό διάστημα μεταξύ των δύο λήψεων. 
 
Η φάση και κατά συνέπεια ο χρόνος που απαιτείται ώστε το σήμα να ταξιδέψει από τον 
δορυφόρο στην γη και να επιστρέψει σε αυτόν, αλλάζει όταν η απόσταση δορυφόρος-γη 
μεταβληθεί λόγω φυσικών ή ανθρωπογενών αιτίων.  
 
Μέσω της τεχνικής επιτυγχάνεται κυρίως η αναγνώριση κατακόρυφων μετατοπίσεων της 
εδαφικής επιφάνειας, ενώ δεν δύναται να υπολογισθεί η μετατόπιση κατά την οριζόντια 
διάσταση. 
 
Σε μια εικόνα Διαφορικής Συμβολομετρίας η μετατόπιση υπολογίζεται μέσω του μήκους 
κύματος. Για τον δορυφόρο ERS το μήκος κύματος είναι 5,6 cm. Εφόσον το σήμα εκτελεί 
την διαδρομή από τον δορυφόρο προς την επιφάνεια της Γης και μέσω της 
οπισθοσκέδασης πίσω στον δορυφόρο, η μετατόπιση μετράται δύο φορές, επομένως η 
τιμή της μετατόπισης είναι η μισή της μετρηθείσης. Από αυτό συνεπάγεται ότι κάθε 
κροσσός συμβολής αντιπροσωπεύει 2,8 cm (5,6/2) εδαφικής μετατόπισης, κατά μήκος 
της γραμμής μετάδοσης του σήματος ραντάρ. 
 
Το σημαντικότερο πλεονέκτημα της Διαφορικής Συμβολομετρίας όσον αφορά στον 
υπολογισμό της εδαφικής μετατόπισης είναι η αυξημένη χωρική διακριτική ικανότητα σε 
σχέση με άλλες μεθόδους, όπως μέσω των μετρήσεων GPS όπου η εδαφική μετατόπιση 
μετράται σημειακά (στις θέσεις των σταθμών GPS).  
 
Η χωρική διακριτική ικανότητα είναι η ελάχιστη μετατόπιση (διαφορά φάσης), που 
αντιπροσωπεύεται από μια κυψελίδα κατά την επεξεργασία μιας εικόνας Διαφορικής 
Συμβολομετρίας. Η διακριτική ικανότητα της μετατόπισης ποικίλλει, εφόσον η επιτυχής 
μέτρηση της διαφοράς φάσης σε μια εικόνα Διαφορικής Συμβολομετρίας εξαρτάται σε 
μεγάλο βαθμό από την συμβατότητα των εικόνων που χρησιμοποιούνται. 
 
Οι παράγοντες που επηρεάζουν τη συμβατότητα μεταξύ δύο εικόνων είναι: 
• Παράμετροι σχετικοί με την επεξεργασία μιας εικόνας 
• Η κάθετη γραμμή βάσης των θέσεων του δορυφόρου κατά τις δύο λήψεις 
• Χωρικές αλλαγές, όπως αλλαγές στην κάλυψη Γης και κυρίως εποχιακές 

(φυτοκάλυψη, επιφανειακή ροή υδάτων). που προκαλούνται από διαφορετικά 
χαρακτηριστικά σκέδασης στις δύο εικόνες για το ίδιο χωρικό σημείο. Τέτοιες είναι οι 
Επομένως είναι σημαντικό να χρησιμοποιηθούν εικόνες που έχουν ημερομηνίες ίδιας 
εποχής (θέρος). 

 
Για την εκτίμηση της συμβατότητας των εικόνων δημιουργείται αρχικά μια εικόνα 
συμβατότητας, η οποία διευκολύνει την εκτίμηση του βαθμού συσχέτισης των δύο 
εικόνων και κατά συνέπεια την χωρική διακριτική ικανότητα που δύναται να επιτευχθεί. 
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Η τεχνικής της Διαφορικής Συμβολομετρίας επιτυγχάνεται με διαφορετικές μεθόδους: -
2pass, 3-pass και 4-pass. Οι δύο πρώτες μέθοδοι αναπαρίστανται στις εικόνες 14.25 και 
14.26. Η τρίτη μέθοδος (σχεδόν όμοια με την 3-pass) βασίζεται σε δύο ανεξάρτητα 
συμβολομετρικά ζεύγη (4 SAR απεικονίσεις), το ένα περιλαμβάνει την διαφορική φάση 
ενώ το άλλο χρησιμοποιείται ως αναφορά, με σκοπό την αφαίρεση της φάσης που 
αντιστοιχεί στην τοπογραφία. 

 
Εικόνα 14.25. Σχηματική παρουσίαση της μεθόδου των Δύο Απεικονίσεων και ενός ΨΜΑ 
(2-pass). 

 

 
Εικόνα 14.26. Σχηματική παρουσίαση της μεθόδου Διπλής Διαφοράς Κροσσών 
Συμβολής ή των τριών περασμάτων (3-pass), μέσω τριών εικόνων SAR. 

 
Η διαφορική συμβολομετρία έχει ένα ευρύ πεδίο εφαρμογών λόγω του χαμηλού 
κόστους. Από το 1992 χρησιμοποιείται για την μελέτη και την κατανόηση συγκεκριμένων 
φυσικών φαινομένων-διεργασιών που προκαλούν εδαφική παραμόρφωση, όπως 
σεισμοί, ηφαίστεια, κατολισθήσεις και καθιζήσεις, με άμεσες οικονομικές, 
περιβαλλοντικές και ανθρώπινες επιπτώσεις, με χρήση εικόνων SAR, διαφορετικών 
ημερομηνιών, κατά την διάρκεια των οποίων εκδηλώθηκε το φαινόμενο. 
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Στο συγκεκριμένο ερευνητικό πρόγραμμα επιλέχθηκε η πρώτη μέθοδος (2-pass), καθώς 
δίνει πολύ καλά αποτελέσματα όταν συνδυάζεται με την χρήση ενός υψηλής ακρίβειας 
ΨΜΑ.  
 
Μετά από έρευνα στην βάση δεδομένων EOLI της ΕSA/ESRIN για τα κατάλληλα ζεύγη 
συμβολομετρίας εδημιουργήθη πίνακας με τα χαρακτηριστικά των ζευγών (Bp, χρονικό 
διάστημα μεταξύ των δύο λήψεων κλπ). Επίσης, για τα ζεύγη που πληρούσαν τις 
προϋποθέσεις επιλογής  εμελετήθησαν οι μετεωρολογικές συνθήκες της ημέρας 
καραγραφής και της προηγούμενης. Κατόπιν μελέτης όλων των στοιχείων καθώς και της 
σεισμικότητας στην ευρύτερη περιοχή από το 1992 έως το 2000, απεφασίσθη η επιλογή 
ζεύγους με πολύ χαμηλή Bp, αλλά μεγάλη χρονική απόσταση μεταξύ των δύο λήψεων 
του ζεύγους. Σκοπός ήταν η πιθανότητα καταγραφής της παραμόρφωσης σε βάθος 
χρόνου από την στιγμή που δεν υπήρχε κάποιο ισχυρό σεισμικό γεγονός, ώστε να γίνει 
η κατάλληλη επιλογή για την καταγραφή της προ- και συν-σεισμικής παραμόρφωσης 
(Εικ. 14.27, 14.28). 
 

 
 
Εικ. 14.27 Εικόνα Διαφορικής Συμβολομερίας Ραντάρ Νισύρου (1996-1999). Διακρίνεται ένας 
μεγάλος κροσσός συμβολής που καλύπτει το μεγαλύτερο τμήμα της Νήσου (ανατολικά) και ένας 
μικρότερος στο νότιο-δυτικό τμήμα. Ένας κροσσός συμβολής αναπαρίσταται με τρία χρώματα: 
κόκκινο-πράσινο-μπλε και υποδειλώνει παραμόρφωση 28mm. Στο υπόλοιπο τμήμα της νήσου 
δεν δύναται να διακριθεί παραμόρφωση λόγω σφάλματος στην επεξεργασία από την 
τοπογραφία.  Διακρίνονται οι ρηξιγενείς ζώνες και οι θέσεις μετρήσεων GPS (Sakkas et al., 
2002). 
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Εικόνα 14.28. Εικόνα Διαφορικής Συμβολομερίας Ραντάρ Νισύρου (1996-1999), σε τρισδιάστατη 
όψη.  
 
 
14.3. Παρακολούθηση Εδαφικής Παραμόρφωσης με την Μέθοδο Συμβολομετρίας 
Μόνιμων Ανακλαστήρων (PSI) 
 
14.3.1. Η Τεχνική της Συμβολομετρίας Μόνιμων ή  Σταθερών Ανακλαστήρων 
 
Οι τεχνικές της Διαφορικής Συμβολομετρίας Ραντάρ εφαρμόζονται κυρίως για την 
ανίχνευση μεγάλης έντασης εδαφικών παραμορφώσεων. Τέτοιου είδους 
παραμορφώσεις συνήθως σχετίζονται με φυσικές διεργασίες όπως σεισμούς, 
ηφαιστειακές εκρήξεις κ.ά.  
 
Συνήθως, μετακινήσεις μικρότερες των 28 mm, για συστήματα SAR που λειτουργούν 
στο κανάλι-C της μικροκυματικής ηλεκτρομαγνητικής ακτινοβολίας (όπως των ERS και 
ENVISAT), δύσκολα διαχωρίζονται από τις επιμέρους επιδράσεις στο σήμα. Οι 
ατμοσφαιρικές επιδράσεις αποτελούν τον σημαντικότερο ίσως περιοριστικό παράγοντα 
στην αναγνώριση μικρότερης κλίμακας μετακινήσεων με την χρήση τεχνικών της 
συμβατικής Διαφορικής Συμβολομετρίας Ραντάρ.  
 
Τα τελευταία έτη  έχουν αναπτυχθεί περισσότερο εξελιγμένες τεχνικές επεξεργασίας των 
δεδομένων SAR, οι οποίες χρησιμοποιούνται για τον υπολογισμό παραμορφώσεων 
μερικών χιλιοστών σε μεμονωμένα εδαφικά ή δομικά σημεία σε εκτεταμένες περιοχές, 
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που καλύπτουν κυρίως αστικά ή ημιαστικά περιβάλλοντα. Σε αυτά τα σημεία (κτήρια, 
μεταλλικές κατασκευές κ.ά. – εικ. 14.29). τα χαρακτηριστικά ανάκλασης του σήματος 
Ραντάρ παραμένουν σταθερά και για αυτόν τον λόγο οι τεχνικές χαρακτηρίζονται ως 
τεχνικές Συμβολομετρίας Σταθερών ή Μόνιμων Ανακλαστήρων (Persistent Scatterer 
Interferometry - PSI). 
. 

 
 
Εικόνα 14.29. Τα κτήρια, οι μεταλλικές κατασκευές κ.ά. αποτελούν  σταθερούς ανακλαστήρες. 
 
Με βάση την τεχνική PSI, από ένα σύνολο δορυφορικών εικόνων Ραντάρ, οι οποίες 
καλύπτουν μια ευρύα χρονική περίοδο (από το 1992 και εντεύθεν) αναγνωρίζονται 
σημεία-ανακλαστήρες και πραγματοποιούνται ακριβείς υπολογισμοί των μικρο-
μετακινήσεων (σε επίπεδο μικρότερου του χιλιοστού) για την χρονική περίοδο που 
καλύπτουν οι εικόνες Ραντάρ. Ο ακριβής εντοπισμός των σταθερών ανακλαστήρων δεν 
είναι δυνατόν να προβλεφθεί πριν την επεξεργασία. Γενικά, σε αστικές περιοχές η 
πυκνότητα των ανακλαστήρων κυμαίνεται μεταξύ 200-600 σημείων ανά km2

 
. 

Το σημαντικότερο πλεονέκτημα της τεχνικής των μόνιμων ανακλαστήρων είναι η 
δυνατότητα παραγωγής χαρτών ταχύτητας της ετήσιας εδαφικής μετατόπισης 
καλύπτοντας ευρύα χρονική περίοδο. Επιπλέον παρέχεται η δυνατότητα διερεύνησης 
των διακυμάνσεων της εδαφικής μετατόπισης με τον χρόνο (χρονοσειρά) για κάθε 
ανακλαστήρα, έτσι ώστε να είναι δυνατή η αναγνώριση τυχών μεταβολών του ρυθμού 
παραμόρφωσης, επιτρέποντας με αυτό τον τρόπο την αντιμετώπισή τους. 
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Σε μεγάλο βαθμό δύναται να ανιχνευθεί και να υπολογισθεί η εδαφική καθίζηση που 
οφείλεται και σε πολλούς άλλους παράγοντες, όπως την πτώση στάθμης του 
υδροφόρου ορίζοντα.  
 
14.3.2. Μακροχρόνια Εποχιακή Παρακολούθηση  Εδαφικής Παραμόρφωσης στην 
Πεδιάδα της Λάρισας (Κεντρική Ελλάδα) με την Μέθοδο Συμβολομετρίας Μόνιμων 
Ανακλαστήρων (PSI). 
 
Η πεδιάδα της Λάρισας μελετήθηκε για το διάστημα 1992-2006 (Vassilopoulou et al., 
2012), με την μέθοδο Συμβολομετρίας Μόνιμων Ανακλαστήρων. Χάρτες 
παραμόρφωσης υψηλής χωρικής ανάλυσης παρήχθησαν από πολλαπλές εικόνες 
ραντάρ ERS and ENVISAT, για την Θεσσαλική Πεδιάδα, την περίοδο Νοεμβρίου 1992 - 
Φεβρουαρίου 2006 (εικ. 14.30 – 14.33). Η επεξεργασία πραγματοποιήθηκε από την 
GAMMA Remote Sensing AG. Το μέγεθος και η έκταση της παραμόρφωσης δεν 
ανιχνεύεται εύκολα με κλασσικές γεωλογικές και γεωτεχνικές μεθόδους, οι οποίες 
στοιχίζουν σε χρόνο και χρήμα. Η παρούσα μελέτη διεξήχθη στο πλαίσιο του 
ερευνητικού προγράμματος ESA GMES TERRAFIRMA-1 και παρουσιάζεται μια αρχική 
ερμηνεία για την καθίζηση στην ευρύτρη περιοχή της Λάρισας.  
 
Μια βάση δεδομένων σε ΣΓΠ αναπτύχθηκε και συμπεριλαμβάνει γεωλογικά, τεκτονικά, 
υδρογεωλογικά, μετεωρολογικά δεδομένα και διακυμάνσεις του υδροφόρου ορίζοντα 
(βάσει γεωτρήσεων). Η ανάπτυξη της βάσεως δίνει την δυνατότητα λεπτομερούς 
μελέτης της έντονης καθίζησης που παρατηρήθηκε στην περιοχή με εύκολο συνδυασμό 
και διαχείριση όλων των δεδομένων. 
 
Η μέθοδος PSI έδειξε ότι γενική καθίζηση λαμβάνει χώρα στην Πεδιάδα της Λάρισας, η 
οποία κυμαίνεται από 5-250mm. Ο μεγαλύτερος ρυθμός καθίζησης  (-25 mm/yr) 
παρατηρήθηκε γύρω από την αστική περιοχή της Λάρισας (ειδικά στα χωριά Γιανούλι και 
Νίκαια), ενώ η πόλη της Λάρισας φαίνεται να είναι σχετικά σταθερή με μια τάση για 
καθίζηση. Η υπόλοιπες επίπεδες περιοχές φαίνεται να καθιζάνουν με μέτριο ρυθμό 
(περίπου 5-10 mm/yr). 
 
Η περιβάλλουσα ορεινή περιοχή είναι σταθερή ή έχει ελαφρώς ανυψωθεί ως προς ένα 
σημείο αναφοράς στα ΒΑ.  
 
Παρατηρήθηκε μια συσχέτιση ανάμεσα στην εποχιακή μεταβολή της στάθμης του 
υδροφόρου ορίζοντα ως προς την απαιτούμενη εποχιακή ποσότητα ύδατος για άρδευση 
ειδικών τύπων καλλιέργειας (βαμβάκι), την βροχώπτωση ανά μήνα και την 
παρατηρούμενη καθίζηση στην αγροτική περιοχή της Θεσσαλικής Πεδιάδας. Τα αίτια της 
εδαφικής καθίζησης και των ρωγμών στην Θεσσαλική Πεδιάδα ερμηνεύθηκαν από την 
συμπίεση και την συγχώνευση χαλαρών ιζημάτων μετά την έντονη πτώση της στάθμης 
του υδροφόρου ορίζοντα, κυρίως για άρδευση. 
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Εικόνα 14.30. Χάρτης εδαφικής παραμόρφωσης υψηλής χωρικής ανάλυσης στην Πεδιάδα της Λάρισας. Απεικονίζεται ο ρυθμός 
ανύψωσης ή καθίζησης (Deformation Rate mm/y) με την μέθοδο Συμβολομετρίας Μoνίμων Ανακλαστήρων (Vassilopoulou et 
al., 2012). 
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Εικόνα 14.31. Γεωλογικός Χάρτης ευρύτερης περιοχής Πεδιάδας Λάρισας σε συνδυασμό με την 
εδαφική παραμόρφωσης (Deformation Rate mm/y) με την μέθοδο Συμβολομετρίας Μoνίμων 
Ανακλαστήρων (Vassilopoulou et al., 2012). Η γεωλογική δομή από Athanassiou, 2002. Τα 
θεματικά και συνθετικά επίπεδα δημιουργήθηκαν μέσω του ArcGIS 9.3 & 10. 
 

 
 
Εικ. 14.32. Χάρτης Αναλύσεως Αναγλύφου της ευρύτερης περιοχής της Λάρισας (Vassilopoulou 
et al., 2012), όπου περιλαμβάνται οι μορφολογικές κλίσεις (morphological slopes),  
προσανατολισμός των κλίσεων (aspect) και μορφολογικές ασυνέχειες (discontinuities of 
morphological slopes). Ο χάρτης παρήχθη μέσω του ειδικού λογισμικού ΠΡΩΑΝΑ-ΙΙ βασιμένο στο 
ΠΡΩΑΝΑ.  Τα δεδομένα αναγλύφου συνδυάζονται με την τεκτονική δομή της περιοχής (οι 
ρηξιγενείς ζώνες από Caputo, 1990 και Caputo & Pavlides, 1993). 
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Εικόνα 14.33. Η παραμόρφωση displacement (mm), όπως έχει προέλθει μετά την τεχνική PSI, σε 
σχέση με τον χρόνο (διάρκεια 14 έτη), δίδεται αυτόματα για κάθε επιλεγμένο σημείο-
ανακλαστήρα, μέσω νέων εργαλείων που έχουν προστεθεί στο ειδικό λογισμικό ΠΡΩΑΝΑ-ΙΙ. 
Συστηματική καθίζηση διακρίνεται στην Περιοχή Γιαννούλι, ενώ η Πόλη της Λάρισας φαίνεται 
σταθερή κατά τα έτη 1992-2006 (Vassilopoulou et al., 2012). 
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14.4. Ανάπτυξη ΣΓΠ Για Την Γεωδυναμική Εξέλιξη της Αργολίδας  
 
14.4.1. Γενικά 
 
Η Αργολίδα παρουσιάζει έντονο ενδιαφέρον από Γεωλογικής και Γεωμορφολογικής 
απόψεως. Η ποικιλία των γεωλογικών δομών από την μια (αλπικά – μεταλπικά – 
ηφαιστειακά) και το πως η γεωλογική δομή ελέγχει την γεωμορφολογική εικόνα από την 
άλλη,  κεντρίζουν το ενδιαφέρον για περαιτέρω μελέτη και ανάλυση. Αρκετοί 
επιστήμονες και ερευνητές ασχολούνται από το παρελθόν με την μελέτη της περιοχής, 
με σκοπό την επίλυση συγκεκριμένων προβλημάτων. Η Νότια Αργολίδα, η οποία 
εκτείνεται από τα Μέθανα και τον Πόρο προς τα ανατολικά ως τα Ίρια προς τα δυτικά και 
από τα Καρναζέϊκα και Πελεή βόρεια ως το Πόρτο-Χέλι, νότια, αποτελεί αντικείμενο της 
παρούσας μελέτης. (Βασιλοπούλου, 1999). Στόχος ήταν η πρόσφατη Γεωδυναμική 
Εξέλιξη της Νότιας Αργολίδας, μέσω της αναλύσεως αναγλύφου, με την ανάπτυξη 
Συστήματος Γεωγραφικών Πληροφοριών. Ακολουθήθηκε συγκεκριμένη μεθοδολογία 
που περιελάμβανε εκτός της κλασικής εργασίας υπαίθρου και της χρήσεως δεδομένων 
Τηλεανίχνευσης, την ανάπτυξη του ειδικού λογισμικού «ΠΡΩΑΝΑ» («ΠΡΩΤΟΤΥΠΟ 
ΑΝΑΛΥΣΗΣ ΑΝΑΓΛΥΦΟΥ»), προσαρμοσμένου στο ArcGIS, ώστε να παραχθούν 
αυτόματα αντιπροσωπευτικά θεματικά επίπεδα και χάρτες αναλύσεως αναγλύφου και να 
δοθεί η λύση στο ζητούμενο.  
 
Η μελέτη διεξήχθη σε περιβάλλον W/S του ArcGIS και τα θεματικά επίπεδα που 
αναπτύχθηκαν αποτελούν «coverages». 
 
14.4.2. Επεξεργασία  Δορυφορικών Εικόνων 
 
Σχετικά με τα δορυφορικά δεδομένα, δύο δορυφορικές εικόνες LANDSAT 5, TM και 
SPOT/PAN της περιοχής (Πίνακας 14.5), επεξεργάσθηκαν, ερμηνεύθηκαν και τα 
εξαγόμενα διαχειρίσθηκαν σε ΣΓΠ με στόχο την εξαγωγή συμπερασμάτων. 
 

Πίνακας 14.5. Χαρακτηριστικά Δορυφορικών Εικόνων 

Δορυφορική Εικόνα SPOT/PAN Δορυφορική εικόνα LANDSAT 5, TM 
Ημερομηνία λήψης: 16/8/1994 
Όργανο καταγραφής: HRVI 
Ηλιακό αζιμούθιο (sun azimuth): +136.5
Ηλιακή ανύψωση (sun elevation): 60.3

0 

 
0 

Αποτελεί τμήμα της Δορυφορικής 
εικόνας με στοιχεία: 
Ημερομηνία λήψης: 16/8/1991 
Ηλιακό αζιμούθιο: N119
Ηλιακή ανύψωση: 52

0 

Επτά (7) φασματικά κανάλια 
0 

 
 
Η ψηφιακή επεξεργασία των δορυφορικών εικόνων έγινε μέσω του Προγράμματος 
ψηφιακής επεξεργασίας IMAGINE του ERDAS, ver. 8.2 και 8.3 σε περιβάλλον PC. Η 
ψηφιακή επεξεργασία  των δύο εικόνων εστιάσθηκε στα δύο πρώτα στάδια 
(προεπεξεργασία και βελτίωση). Για την LANDSAT ακολούθησε επιπλέον η δημιουργία 
σύνθετων ψευδέγχρωμων εικόνων και η δημιουργία ψευδέγχρωμης εικόνας Κυρίων 
Συνιστωσών. Εν συνεχεία, ακολούθησε η κλασσική φωτοερμηνεία, όλων των εικόνων 
που προέκυψαν. Η ψηφιακή ταξινόμηση, από μόνη της, όσον αφορά την γεωλογική - 
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λιθολογική χαρτογράφηση, έχει περιορισμένες εφαρμογές. Τελευταίο στάδιο αποτέλεσε 
η επαλήθευση - επιβεβαίωση των δομών στην ύπαιθρο. 

Α.  Επεξεργασία της Εικόνας SPOT 

Προεπεξεργασία της Εικόνας 
Εφόσον η εικόνα έχει ήδη υποστεί ραδιομετρικές διορθώσεις (επίπεδο απόκτησης 1A), η 
λειτουργία που επιχειρείται στο στάδιο αυτό είναι η γεωμετρική διόρθωση της εικόνας, 
ώστε να της αποδοθούν ιδιότητες χάρτη (κλίμακα, προβολικές ιδιότητες κ.λ.π.). Για τον 
λόγο αυτόν, γίνονται προσαρμογή και αναγωγή των συντεταγμένων και η εικόνα 
προβάλλεται στο χαρτογραφικό σύστημα UTM. 
 
Η προσαρμογή και αναγωγή των συντεταγμένων βασίζεται σε επιλεγμένα εδαφικά 
σημεία ελέγχου (Ground Control Points – GCPs), τα οποία αναγνωρίζονται στην εικόνα 
σε συνδυασμό με τους τοπογραφικούς χάρτες της Γ.Υ.Σ. που καλύπτουν την περιοχή 
αναφοράς της. Συγκεκριμένα χρησιμοποιούνται οι τοπογραφικοί χάρτες – φύλλα: 
«Σπέτσες», «Ύδρα», «Λυγουριό», «Κόρινθος», «Ναύπλιο», «Σοφικό» και «Άστρος», 
κλίμακας 1/50.000 και χρονολογίας 1989-1992.  
 
Επιλέγεται ένας αριθμός GCPs. Μέσω της διαδικασίας του μετασχηματισμού κατά την 
οποία αφαιρούνται GCPs, τα οποία δίνουν σφάλμα μεγαλύτερο από το επιτρεπτό, τελικά 
χρησιμοποιούνται σαράντα επτά (47) σημεία και πραγματοποιείται μετατροπή 4ου

 

 
βαθμού. 

Ακολουθεί αναδόμηση της εικόνας (resampling) με την μέθοδο της πλησιέστερης 
γειτονίας (nearest neighbor) ώστε παράγεται η διορθωμένη γεωμετρικά SPOT εικόναμε 
νέα τιμή κυψελίδας = 12m (δηλαδή 12m χωρική διακριτική ικανότητα). 

Βελτίωση της Εικόνας 
Μετά την γεωμετρική διόρθωση, ακολουθεί η βελτίωση της εικόνας. Στη συγκεκριμένη 
περίπτωση εφαρμόζεται η τεχνική της γραμμικής επέκτασης του ιστογράμματος (linear 
contrast streching) ώστε βελτιώνεται η αντίθεση και η φωτεινότητα της εικόνας. 

 Β. Επεξεργασία της Εικόνας LANDSAT 
Αρχικά επιλέγονται και συνδυάζονται οι έξι από τις επτά φασματικές ζώνες (όλες εκτός 
του θερμικού υπέρυθρου, η οποία δεν είναι απαραίτητη για τη συγκεκριμένη μελέτη). 

Προεπεξεργασία της Εικόνας  
Η γεωμετρική διόρθωση των δεδομένων LANDSAT γίνεται με βάση την τεχνική «εικόνα 
προς εικόνα» (image to image - registration) σε σχέση με την γεωμετρικά διορθωμένη 
εικόνα SPOT. Στην εικόνα LANDSAT επιλέγονται GCPs αναφορικά με την SPOT, καθώς 
και επιπλέον σημεία, αναφορικά με τους τοπογραφικούς χάρτες της περιοχής, επειδή η 
SPOT καλύπτει μικρότερη περιοχή από την LANDSAT.  
 
Επιλέγεται ένας αριθμός GCPs. Μέσω της διαδικασίας του μετασχηματισμού κατά την 
οποία αφαιρούνται σημεία (GCPs), τα οποία δίνουν σφάλμα μεγαλύτερο από το 
επιτρεπτό, τελικά χρησιμοποιούνται εβδομήντα επτά (77) σημεία ελέγχου και εν συνεχεία 
πραγματοποιείται 3ου

 
 βαθμού μετασχηματισμός. 
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Ακολουθεί αναδόμηση της εικόνας με την μέθοδο της πλησιέστερης γειτονίας και 
παράγεται η γεωμετρικά διορθωμένη εικόνα με νέο μέγεθος κυψελίδας 28m. 

Βελτίωση της Εικόνας 
Μετά την γεωμετρική διόρθωση ακολουθεί η βελτίωση της εικόνας. Εφαρμόζεται η 
τεχνική της γραμμικής επέκτασης του ιστογράμματος ώστε βελτιώνεται η αντίθεση και η 
φωτεινότητα της εικόνας. 

Δημιουργία Σύνθετων Ψευδέγχρωμων Εικόνων 
Διάφοροι συνδυασμοί των φασματικών καναλιών του Θεματικού Χαρτογράφου δύνανται 
να επιλεχθούν και να παράγουν σύνθετα χρωματικά αποτελέσματα. Επίσης, διάφοροι 
χρωματικοί τόνοι χρησιμοποιηούνται για να αναδείξουν τα ζητούμενα χαρακτηριστικά. 
 
Στην εργασία δημιουργούνται οι παρακάτω συνδυασμοί: 7-3-2 (RGB), 7-5-3 (RGB), 7-5-
1 (RGB), 4-7-2 (RGB). 
 
Ειδικά η εικόνα που προκύπτει από τον συνδυασμό 4-7-2 (εικ. 14.35) αποδίδει το 
μέγιστο εύρος χρωματικών υπογραφών και θεωρείται ο ιδανικός συνδυασμός για 
γεωλογικές εφαρμογές σε ημίξερες περιοχές (Sabins, 1997). 
 
Στην συγκεκριμένη εικόνα διακρίνονται περιοχές έντονου αναγλύφου και λεκάνες με 
διάφορους καλυμματικούς τύπους, όπως γυμνά εδάφη και πετρώματα, θαμνώδεις 
εκτάσεις, πυκνή φυσική βλάστηση, καλλιέργειες κ.λ.π. Τα γυμνά πετρώματα και εδάφη 
εμφανίζονται με πράσινες αποχρώσεις έως και λευκές (περιοχές έντονα διαβρωμένες). 
Οι καλλιέργειες και η φυσική βλάστηση παρουσιάζονται με αποχρώσεις του ερυθρού. 

Ανάλυση Κυρίων Συνιστωσών 
Η συγκεκριμένη μεθοδολογία έχει ως σκοπό την μείωση του αριθμού των δεδομένων, 
στην περίπτωση των πολυφασματικών δεδομένων, ενώ ταυτόχρονα διατηρείται το 
σύνολο σχεδόν της πληροφορίας των αρχικών δεδομένων, μέσω της δημιουργίας ενός 
ανυσματικού διαστήματος με τόσους άξονες ή διαστάσεις όσες είναι οι φασματικές 
συνιστώσες (φασματικά κανάλια) που συνδέονται με κάθε κυψελίδα της εικόνας.  
 
Στην συγκεκριμένη μελέτη χρησιμοποιούνται όλα τα φασματικά κανάλια πλην του 
θερμικού υπέρυθρου (φασματικό κανάλι 6), επομένως το ανυσματικό διάστημα που 
προκύπτει έχει 6 διαστάσεις. Στον Πίνακα 14.6 δίδονται οι ιδιοτιμές, ενώ στον Πίνακα 
14.7 δίδονται τα ιδιοδιανύσματα που προκύπτουν από την επεξεργασία για την 
μετατροπή σε Κύριες Συνιστώσες. 
 
Παρατηρώντας τον πίνακα των ιδιοτιμών (Πίνακας 14.6), διεξάγονται συμπεράσματα 
σχετικά με το ποσοστό της πληροφορίας των αρχικών δεδομένων που περιέχεται στις 
διάφορες συνιστώσες. Συγκεκριμένα, η πρώτη συνιστώσα περιέχει το 88% της 
πληροφορίας, η δεύτερη το 9,4%, ενώ στις υπόλοιπες συνιστώσες το ποσοστό είναι 
μικρότερο από το 1,5%. Το γεγονός ότι οι τελευταίες συνιστώσες έχουν μικρό ποσοστό 
πληροφορίας, δεν σημαίνει ότι δεν είναι σημαντικές και ότι δεν αξιολογούνται. Αντίθετα 
συχνά περιέχουν πληροφορία συγκεκριμένη και εμφανή στην εικόνα. 
 
Από τον πίνακα των ιδιοδιανυσμάτων (Πίνακας 14.6) συμπεραίνεται η συνεισφορά των 
αρχικών φασματικών καναλιών σε κάθε μια συνιστώσα ξεχωριστά. Διακρίνεται επίσης 
ότι: 
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• Η συνιστώσα PC1 έχει θετική συνεισφορά από όλα τα αρχικά φασματικά κανάλια 
με χαμηλότερη τιμή (0,21) από το κανάλι ΤΜ2 και υψηλότερη τιμή συνεισφοράς (0.67) 
από το ΤΜ5.  

• Η συνιστώσα PC2 έχει θετικές και αρνητικές συνεισφορές. Έχει αρνητικές 
συνεισφορές από τα κανάλια της ορατής ακτινοβολίας με μέγιστη αρνητική συνεισφορά 
(–0,80) από το ΤΜ1 και θετική από τα κανάλια της υπέρυθρης με μέγιστη θετική 
συνεισφορά (0,40) από το ΤΜ5. 

• Η συνιστώσα PC3 έχει θετικές και αρνητικές συνεισφορές. Αρνητικές έχει από τα 
κανάλια ΤΜ2, ΤΜ3 και ΤΜ4 και θετική από τα κανάλια ΤΜ1, ΤΜ5 και ΤΜ7.   

• Η συνιστώσα PC4 έχει αρνητική συνεισφορά από τα κανάλια ΤΜ2, ΤΜ3 και ΤΜ7 
και θετική από τα κανάλια ΤΜ1, ΤΜ4 και ΤΜ5. 

• Η συνιστώσα PC5 έχει αρνητική συνεισφορά μόνο από ένα φασματικό κανάλι και 
συγκεκριμένα το ΤΜ3 με (-0,41), ενώ όλα τα άλλα συνεισφέρουν θετικά με 
χαρακτηριστικότερη τιμή αυτή του ΤΜ7 με (0,79). 

• Η συνιστώσα PC6 δέχεται αρνητική συνεισφορά από τα κανάλια ΤΜ2 και ΤΜ5 
και θετική από τα υπόλοιπα. 

 
Η οπτική συγκριτική μελέτη των διαφόρων συνδυασμών των συνιστωσών δείχνει ότι ο 
συνδυασμός 6-3-1 είναι ο καταλληλότερος, για την συγκεκριμένη περίπτωση. 
 
Η συνιστώσα PC1 δεν περιέχει συγκεκριμένη φασματική πληροφορία, έχει 
χαρακτηριστικά πανχρωματικής εικόνας και δίδονται πληροφορίες σχετικά με την 
τοπογραφία. Η συνιστώσα PC3 αφορά σε πληροφορία σχετικά με τους καλυμματικούς 
τύπους της περιοχής (π.χ. κατανομή της βλάστησης), ενώ η PC6 αν και περιέχει σε 
μεγάλο βαθμό «θόρυβο», η συνεισφορά από τα φασματικά κανάλια 2 και 3 θεωρείται 
σημαντική τόσο για τους καλυμματικούς τύπους, όσο και για την ανάδειξη του 
υδρογραφικού δικτύου.  
 
Συμπερασματικά, στο συνδυασμό 6-3-1, καταγράφονται με μεγάλη ευκρίνεια τα 
μορφολογικά χαρακτηριστικά της περιοχής, το υδρογραφικό δίκτυο και οι καλυμματικοί 
τύποι, χαρακτηριστικά τα οποία αποτελούν άμεσα ή έμμεσα κριτήρια αναγνώρισης 
δομών. 
 

ΠΙΝΑΚΑΣ 14.6. Πίνακας Ιδιοτιμών 
 

PC1 5093,51788056005 88% 

PC2 546,479100123459 9,4% 

PC3 85,6531488105217 1,47 

PC4 56,08028728549544 0,96 

PC5 5,487216685650998 0,09 

PC6 4,506993187638768 0,07 
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ΠΙΝΑΚΑΣ 14.7. Πίνακας Ιδιοδιανυσμάτων 
 

 PC1 PC2 PC3 PC4 PC5 PC6 

T
M1 

0,27986834
83296997 

-
0,80322412726
86298 

0,350265802227
3335 

0,386768594753
3453 

0,01430033144
890078 

0,0634360418
0467299 

T
M2 

0,21749136
04261882 

-
0,30788557290
83484 

-
0,346168917588
2385 

-
0,370017893795
6445 

0,22627993853
76432 

-
0,7415896508
985118 

T
M3 

0,33877938
05875961 

-
0,24706599261
76674 

-
0,261546011708
6974 

-
0,586493212749
4364 

-
0,41397961640
53238 

0,4903337627
933627 

T
M4 

0,42951180
50057744 

0,12819903699
66671 

-
0,681408530959
1379  

0,541787523138
5622 

0,12627448123
30969 

0,1590222166
019843 

T
M5 

0,67759484
50723359 

0,40613027476
71642 

0,406631667720
9038 

0,045474456341
62317 

0,35270284063
82624 

-
0,2900118836
955349 

T
M7 

0,34056509
26385943 

0,13273687313
99355 

0,243737015629
6144 

-
0,271883941001
3944 

0,79804086907
82749 

0,3101588323
740999 

 
 
14.4.3. Ερμηνεία των Δορυφορικών Εικόνων – Προσδιορισμός Δομών 
 

Προσδιορισμός Γεωλογικών και Γεωμορφολογικών Ενοτήτων 
Η περιοχή μελέτης, αποτελείται από αλπικούς σχηματισμούς (σερπεντινίτες, 
ασβεστόλιθους, φλύσχη) και από μεταλπικούς (κροκαλοπαγή, πλευρικά κορήματα – 
κώνους κορημάτων, αλλούβια). Η διαφορετική λιθολογία προσδίδει διαφορετική οπτική 
εικόνα, ώστε σε ορισμένους σχηματισμούς είναι ευκολότερη η διάκριση–αναγνώριση των 
ορίων τους ενώ σε άλλους δυσκολότερη.  
 
Η φωτοερμηνεία γίνεται από την οθόνη του υπολογιστή όπου επιτυγχάνονται εύκολα η 
αλλαγή της κλίμακας καθώς και οι συνδυασμοί των διαφόρων φασματικών καναλιών 
(όσον αφορά στην LANDSAT). Οι συνδυασμοί 7-3-2, 4-7-2, 7-5-3 και 7-5-1 των 
καναλιών της LANDSAT, βοηθούν στην διάκριση των δομών, όπως προαναφέρθηκε. 
Χρησιμοποιείται επίσης η εικόνα Κυρίων Συνιστωσών, καθώς και η εικόνα SPOT.  
 
Αρχικά, επιχειρείται η διάκριση γεωλογικών σχηματισμών και γεωμορφολογικών 
ενοτήτων, με χρήση των κυριοτέρων διαγνωστικών χαρακτηριστικών (Κεφ. 2). που 
χρησιμοποιούνται γενικότερα από τους γεωλόγους – γεωεπιστήμονες. Ειδικότερα 
επιτυγχάνεται: 

• Διάκριση – οριοθέτηση αλπικών – μεταλπικών σχηματισμών 
• Διάκριση - οριοθέτηση των επιμέρους σχηματισμών και κυρίως των κώνων 

κορημάτων, πλευρικών κορημάτων και αλλουβίων. 
 

Τα δεδομένα που προκύπτουν από την φωτοερμηνεία, ψηφιοποιούνται απευθείας από 
την οθόνη του υπολογιστή σε συγκεκριμένο θεματικό ανυσματικό επίπεδο. Εν συνεχεία, 
εισάγονται στο Σύστημα Γεωγραφικών Πληροφοριών (ΣΓΠ), συσχετίζονται με τα 
υπόλοιπα δεδομένα (πεδίου και βιβλιογραφικά) και παράγεται ο «Γεωλογικός Χάρτης 
της Νότιας Αργολίδας».  
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Προσδιορισμός Πιθανών Ρηγμάτων 
Προκειμένου να προσδιορισθούν πιθανά ρήγματα και όχι απλά και μόνο 
φωτογραμμώσεις, χρησιμοποιούνται επιπλέον κριτήρια φωτοερμηνείας, κυρίως του 
Gupta (1991). Χρησιμοποιούνται κυρίως κριτήρια νεοτεκτονικής, με αποτέλεσμα την 
διάκριση κυρίως νεοτεκτονικών ρηγμάτων, δηλαδή ενεργών και σεισμικών. Η 
επιβεβαίωση στο ύπαιθρο είναι απαραίτητη. Τα περισσότερα από τα ρήγματα που 
προσδιορίσθηκαν από την ερμηνεία των εικόνων επιβεβαιώθηκε ότι είναι πράγματι 
ρήγματα, κάποια  ήταν αλπικές τεκτονικές επαφές ενώ ελάχιστα ήταν δομές άλλου 
γεωμορφολογικού χαρακτήρα. 

 
Στην οθόνη του υπολογιστή υπάρχει η επιθυμητή κάθε φορά εικόνα. Οι δομές 
αναγνωρίζονται με βάση μεμονωμένων ή συνδυασμό κριτηρίων. Χαρακτηριστικά 
παραδείγματα αποτελούν οι εικόνες που παραθέτονται (Εικ. 14.36, 14.37), όπου τα 
πιθανά ρήγματα αναγνωρίζονται είτε από την πλευρική μετατόπιση γεωμορφών, είτε με 
την εκδήλωση μορφολογικών ασυνεχειών, είτε από την παρουσία κώνων κορημάτων, 
λιμνοθαλασσών, αλλουβίων ή και απότομων ακτών. 
 

Τέλος, τα δεδομένα της φωτοερμηνείας (πιθανά ρήγματα) συνδυάζονται με τα 
υπόλοιπα δεδομένα στο ΣΓΠ, ώστε προκύπτει ο «Χάρτης Ρηξιγενούς Ιστού της Νότιας 
Αργολίδας» καθώς και ροδογράμματα και άλλα στατιστικά διαγράμματα, απαραίτητα για 
την μελέτη της Γεωδυναμικής Εξέλιξης της περιοχής. 
 
Στην εικόνα 14.34 δίδεται το ανάγλυφο της περιοχής, όπως προέκυψε από το 
«ΠΡΩΑΝΑ», ενώ στις εικόνες 14.35, 14.36 και 14.37 τα τεκτονικά δεδομένα τα οποία 
διακρίθηκαν μετά από επεξεργασία και φωτοερμηνεία των δορυφορικών εικόνων. Στον 
προσδιορισμό γεωλογικών και γεωμορφολογικών ορίων χρήσιμη εκτός των 
ψευδέγχρωμων εικόνων ήταν επίσης, η εικόνα που προέκυψε μετά την εφαρμογή του 
αλγορίθμου των κυρίων συνιστωσών (Εικόνα 14.38). 

3D

 
Εικ. 14.34. Σκιασμένο Ανάγλυφο Ν. Αργολίδας από ΨΜΑ  ακρίβειας 20m. Διακρίνεται το έντονο 
ανάγλυφο, το οποίο είναι αποτέλεσμα κυρίως, της τεκτονικής και γεωλογίας της περιοχής. 
Αποτελεί βάση για την παραγωγή χαρτών ανάλυσης αναγλύφου, για την ορθο-αναγωγή των 
δορυφορικών εικόνων της περιοχής, για την διάκριση γεωλογικών ορίων, μορφολογικών και 
τεκτονικών δομών κ.ά. (Βασιλοπούλου, 1999). 
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Εικόνα 14.35. Δορυφορική Εικόνα LANDSAT 5, TΜ, Ψευδέγχρωμη, 4-7-2 (RGB), Νότιας 
Αργολίδας.LANDSAT 5, TΜ (ημερομηνία λήψης 16/8/1991, ηλιακό αζιμούθιο N1190, ηλιακή 
ανύψωση 520

 

, επτά (7) φασματικά κανάλια. Χρησιμοποιήθηκε στην διάκριση τεκτονικών, 
γεωλογικών και γεωμορφολογικών δομών. Διακρίνονται οι ρηξιγενείς ζώνες της περιοχής, οι 
οποίες προσδιορίσθηκαν από την εικόνα και επιβεβαιώθηκαν στο ύπαιθρο. (Βασιλοπούλου, 
1999).       Ρήγμα                       Πιθανό Ρήγμα (από ερμηνεία δορυφορικών εικόνων). 

 
 

 
 

 

 

 
 
 

Εικόνα 14.36. Τμήμα της 
δορυφορικής εικόνας 
LANDSAT 5, TΜ, 
Ψευδέγχρωμης, 4-7-2 
(RGB), Νότιας Αργολίδας. 
Διακρίνονται ίχνη ρηγμάτων 
(διεύθυνσης ΒΔ-ΝΑ, ΒΑ-
ΝΔ), τα οποία 
αναγνωρίζονται είτε από 
την πλευρική μετατόπιση 
γεωμορφών, είτε με την 
εκδήλωση μορφολογικών 
ασυνεχειών. Τα βέλη 
δείχνουν την θέση που 
διέρχονται τα ρήγματα. 
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Εικόνα 14.38. Ο συνδυασμός των συνιστωσών PC6-3-1, δίνει την αναγκαία πληροφορία για τους 
σκοπούς της μελέτης. Καταγράφονται με μεγάλη ευκρίνεια τα μορφολογικά χαρακτηριστικά της 
περιοχής, το υδρογραφικό δίκτυο και οι καλυμματικοί τύποι (αλλούβια, κώνοι κορημάτων κ.ά), 
χαρακτηριστικά τα οποία αποτελούν άμεσα ή έμμεσα κριτήρια αναγνώρισης δομών. 
(Βασιλοπούλου, 1999). 
 
 
 
 

Εικόνα14.37. Τμήμα της 
δορυφορικής εικόνας 
LANDSAT 5, TΜ, 
Ψευδέγχρωμης, 4-7-2 
(RGB), Νότιας Αργολίδας. 
Κατά μήκος της νότιας ακτής 
των Αδέρων παρατηρείται 
Ρήγμα παράλληλο με την 
ακτή. Κατά μήκος αυτού 
παρουσιάζονται κώνοι 
κορημάτων, λιμνοθάλασσες 
και αλλούβια ή απότομες 
ακτές. Τα βέλη δείχνουν την 
θέση που διέρχεται το 
ρήγμα. 
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 14.4.4. Ανάλυση Αναγλύφου – Ειδικό Λογισμικό «ΠΡΩΑΝΑ» 
 
Η ανάλυση αναγλύφου (ποιοτική και ποσοτική), μέσω της παραγωγής, συνδυασμού και 
ερμηνείας θεματικών επιπέδων και χαρτών καθώς ροδογραμμάτων και διαγραμμάτων, 
αποτελεί κύριο συστατικό κάθε γεωπεριβαλλοντικής μελέτης, σε συνδυασμό με άλλα 
δεδομένα (γεωλογικά, τεκτονικά, γεωφυσικά, σεισμολογικά, γεωτεχνικά, υδρογεωλογικά, 
κ.ά). 
 
Κατά την ποιοτική ανάλυση αναγλύφου περιγράφονται τα χαρακτηριστικά του 
αναγλύφου η μεταξύ τους σχέση αλλά και η σχέση τους με την γεωλογία και την 
τεκτονική, μέσα από την ερμηνεία επιμέρους χαρτών.  
 
Κατά την ποσοτική ανάλυση, προκύπτουν ποσοστά από την στατιστική επεξεργασία 
συγκεκριμένης πληροφορίας της βάσης δεδομένων, συγκεκριμένων θεματικών 
επιπέδων  και πεδίων τους. 
 
Η ποιοτική και ποσοτική ανάλυση αναγλύφου περιλαμβάνει: 
 

• δημιουργία ΨΜΑ 
• ανάλυση υδρογραφικού δικτύου και υδροκριτών 
• μελέτη μορφολογικών κλίσεων 
• μελέτη συγκεκριμένων γεωμορφολογικών χαρακτηριστικών: επιφανειών 

επιπέδωσης και μορφολογικών ασυνεχειών 
• μελέτη προσανατολισμού αναγλύφου 
• μελέτη υψομετρικής κατανομής εμβαδού κ.ά. 

 
Στόχος: Η σχέση των ιδιαιτεροτήτων του αναγλύφου με την τεκτονική. 
 
Η αυτόματη παραγωγή χαρτών αναλύσεως αναγλύφου, μέσω της διαχειρίσεως 
τοπογραφικών, μορφολογικών, γεωλογικών και τεκτονικών δεδομένων, δεν είναι εφικτή 
μέσα από τα ΣΓΠ στον επιθυμητό βαθμό. Για τον λόγο αυτόν, αναπτύχθηκε το 
«ΠΡΩΑΝΑ», αρχικά στην γλώσσα προγραμματισμού AML του W/S Arc/Info. Σην 
παρούσα του μορφή ανανεώθηκε σε περιβάλλον  ArcGIS, μέσω της γλώσσας  Python 
και με χρήση του Model Builder. Η σύνθεση χαρτών επιτυγχάνεται στον ArcMap, με 
χρήση των νέων απαιτούμενων συμβολοσειρών. Το συγκεκριμένο λογισμικό 
χαρακτηρίζεται ως «Πρωτότυπο» με την στενή έννοια του όρου, όπως ορίζεται στην 
Πληροφορική, εφόσον ικανοποιεί τις γενικές απαιτήσεις ενός «Πρωτοτύπου». Η 
ανάπτυξη του  «ΠΡΩΑΝΑ» έθεσε τις ακόλουθες προϋποθέσεις: 

 
• Πολύ καλή γνώση του ΣΓΠ και των δυνατοτήτων του για χρήση–χειρισμό 

αυτού και γνώση της φιλοσοφίας του. 
• Πολύ καλή ανάλυση του προβλήματος που ζητείται να επεξεργασθεί στην 

γενική και ειδική περίπτωση. 
• Προσαρμογή του προβλήματος, δηλαδή όλων των διαδικασιών που 

ακολουθούνται με την κλασική μεθοδολογία (χαρτί και μολύβι) σε γλώσσα 
υπολογιστή. Αυτό επιτυγχάνεται μέσα από την επιλογή και τον τύπο των 
δεδομένων, την επιλογή και την τιμή συγκεκριμένων παραμέτρων, την 
ανάπτυξη-ανάλυση-διαχείριση της βάσης δεδομένων και τα βήματα-
διαδικασίες που θα ακολουθηθούν για την διεξαγωγή αποτελεσμάτων με 
αυτοματοποιημένο τρόπο. 
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• Άμεση και δυνατή αλλαγή κλίμακας χαρτών, αλλαγή-δοκιμές παραμέτρων 
κ.λ.π. 

• Δυνατότητα αλληλεπίδρασης με τον χρήστη. 
• Δυνατότητα επισκόπησης 
• Αποδοχή-βελτίωση-απόρριψη αποτελεσμάτων. 
• Άμεση και δυνατή προσθήκη επιπλέον διεργασιών με σκοπό την παραγωγή 

επιπλέον και διαφόρων ειδών χαρτών. 
• Επέκταση του προγράμματος σε οποιαδήποτε άλλη περιοχή μελέτης, γεγονός 

που προϋποθέτει: διαφορετικά γενικά δεδομένα (τύπος, πυκνότητα κ.λ.π.), 
διαφορετικές τιμές παραμέτρων ή εισαγωγή νέων ή απαλοιφή άλλων, νέους 
συνδυασμούς δεδομένων – θεματικών επιπέδων – χαρτών κ.λ.π. 

 
Ουσιαστικά, μέσω του λογισμικού δημιουργείται ένα περιβάλλον εργασίας για 
επιστημονική διερεύνηση. Η ιδιαιτερότητα του λογισμικού έγκειται κυρίως, στο ότι δεν 
επιτυγχάνεται απλά και μόνο η ανάπτυξη-διαχείριση σχεσιακής βάσεως δεδομένων, 
ώστε να προκύψουν χάρτες–απαντήσεις σε συγκεκριμένα ερωτήματα, δηλαδή ανάπτυξη 
ενός συστήματος λήψεως αποφάσεων. Επιτυγχάνεται επίσης, η παραγωγή ιδιαιτέρων-
αντιπροσωπευτικών χαρτών με μεγάλη απαίτηση ως προς την οπτική εικόνα που 
παρουσιάζουν, ώστε μέσω αυτών να είναι δυνατή η παραγωγή νέων χαρτών, η διάκριση 
συγκεκριμένων δομών και η παραγωγή συγκεκριμένων διαγραμμάτων. Η όσο το 
δυνατόν καλύτερη απόδοση του αναγλύφου, μέσω του ΨΜΑ προαπαιτείται, εφόσον το 
ΨΜΑ αποτελεί την βάση για την δημιουργία όλων των θεματικών και συνθετικών 
επιπέδων και χαρτών αναλύσεως αναγλύφου.  
 
Στην παρούσα μορφή του περιλαμβάνει και νέες λειτουργίες σχετικές με την διαχείριση 
και απεικόνιση σε χάρτη ή σε διαγράμματα-χρονοσειρές (σε περιβάλλον ΣΓΠ) της 
εδαφικής παραμόρφωσης από διαφορικές γεωδαιτικές μετρήσεις (DGPS), καθώς και 
από σημεία προερχόμενα από την τεχνική των μόνιμων ανακλαστήρων (PSI) κ.ά.  
 
Δίδεται το διάγραμμα ροής του «ΠΡΩΑΝΑ» (Εικ.14.39), όπου ενδεικτικά φαίνονται 
αντιπροσωπευτικοί χάρτες αναλύσεως αναγλύφου και εδαφικής παραμόρφωσης που 
παράγονται. Η επεξεργασία των δεδομένων είναι πολύπλοκη και βασίζεται σε σειρά 
αλγορίθμων και εντολών του ArcGIS, που έχουν συνδυασθεί κατάλληλα και καλούνται 
αυτόματα μέσω του περιβάλλοντος εργασίας του «ΠΡΩΑΝΑ».  Το λογισμικό δύναται να 
χρησιμοποιηθεί σε κάθε είδους γεωλογική, γεωφυσική και γεωπεριβαλλοντική μελέτη 
που σχετίζεται με ανάλυση αναγλύφου: γεωδυναμική, τεκτονική, μορφοτεκτονική, 
γεωφυσική, διαχείριση γεωπεριβαλλοντικών προβλημάτων–φυσικές καταστροφές 
(αντισεισμικός σχεδιασμός, διαχείριση ηφαιστείων, διαχείριση κατολισθήσεων, κ.ά.), 
τεχνικά έργα (οδοποιία, φράγματα κ.ά), μεγάλες κατασκευές (νοσοκομεία, ξενοδοχεία 
κ.ά.), υδρογεωλογικές μελέτες, προσδιορισμό κατάλληλης θέσως για δημιουργία 
χωματερών, χρήσεις γης, κ.ά. 
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Εικόνα 14.39. Διάγραμμα ροής του ειδικού λογισμικού «ΠΡΩΑΝΑ» για την παραγωγή δεδομένων αναγλύφου και εδαφικής παραμόρφωσης από 
διαφορικές γεωδαιτικές μετρήσεις (DGPS) καθώς και χρονοσειρές από DGPS μετρήσεις και PSI σημεία.   Δίδονται αντιπροσωπευτικοί χάρτες 
αναλύσεως αναγλύφου που παράγονται, θεματικοί και συνθετικοί (συνδυασμός δύο ή περισοτέρων θεματικών επιπέδων και χαρτών). 

Μετρήσεις 
DGPS 

Χάρτης Οριζόντιας 
Εδαφικής 

Παραμόρφωσης 

Χάρτης Κατακόρυφης 
Εδαφικής 

Παραμόρφωσης 

ΔΕΔΟΜΕΝΑ 
 

• Ισοϋψείς 
• Τριγωνομετικά Σημεία 
• Υψομετρικά Σημεία 
• Υδρογραφικό Δίκτυο 
• Γεωλογικοί Σχηματισμοί 
• Τεκτονικά Δεδομένα 
• Ρήγματα 
• Τεκτονικά και Γεωλογικά Δεδομένα από 

Δορυφορικές Εικόνες 
• Μετρήσεις GPS 
• ................. 
 

ΓΕΩΛΟΓΙΚΟΣ 
ΧΑΡΤΗΣ 

ΤΕΚΤΟΝΙΚΟΣ 
ΧΑΡΤΗΣ 

ΨΜΑ 

Χάρτης 
Ισοϋψομετρικών 

Ζωνών 
 

3-D Μοντέλα 

Υδροκρίτες 

Χάρτης 
Μορφολογικών 

Ασυνεχειών 

Χάρτης Επιφανειών 
Επιπέδωσης 

Χάρτης Ανάλυσης 
Αναγλύφου 

Υδρογραφικό 
Δίκτυο 

ΔΕΔΟΜΕΝΑ ΑΝΑΓΛΥΦΟΥ 

Χάρτης Μορφολογικών 
Κλίσεων και 

Προσανατολισμού των 
Κλίσεων 

Χρονοσειρές 

PSI Σημεία 

Χρονοσειρές 
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14.4.5. Δημιουργία ΨΜΑ 
 

Μέθοδος παρεμβολής TOPOGRID του ArcGIS 
 
Η μεθοδολογία που εφαρμόζεται για την ανάπτυξη του ΨΜΑ, οπότε προκύπτει και η 
αντίστοιχη δομή (Tin ή Lattice ή  Grid), εξαρτάται από διάφορες παραμέτρους 
(Vassilopoulou, 1999; Vassilopoulou, 2001; Vassilopoulou & Hurni, 2001) και 
συγκεκριμένα: 

 
• τον τύπο των δεδομένων (ισοϋψείς, σημεία, υδρογραφικό δίκτυο κ.λ.π.) 
• την ποιότητα και πυκνότητα των δεδομένων, σε σχέση με την μορφολογία της 

περιοχής  
• την χρήση του ΨΜΑ 

 
Η ακρίβεια των μοντέλων εξαρτάται εκτός από την μεθοδολογία και από τις 
παραμέτρους που θα χρησιμοποιηθούν για την παρεμβολή. 
 
Η συγκεκριμένη περιοχή παρουσιάζει σημαντικό ενδιαφέρον από γεωλογικής και 
μορφολογικής απόψεως. Έντονες εναλλαγές διακρίνονται στην μορφολογία και αρκετές 
υποπεριοχές–μορφολογικές ενότητες χωρίζονται, ώστε να μελετηθούν μεμονωμένα η 
καθεμιά ή και συνολικά. Απαιτείται ακριβής προσέγγιση του αναγλύφου μέσω του ΨΜΑ 
και των παραγώγων αυτού χωρικών μοντέλων ή χαρτών (Σκιασμένο Ανάγλυφο – 
Χάρτης Μορφολογικών Κλίσεων – Χάρτης Προσανατολισμού των Κλίσεων κ.ά.), ώστε 
να διακριθούν και να μελετηθούν οι ιδιαιτερότητες της περιοχής τόσο ποιοτικά όσο και 
ποσοτικά. 
 
Γενικότερα,  αυτού του είδους τα μοντέλα αποκαλούνται στην γλώσσα των ΣΓΠ 
«υδρολογικά μοντέλα», εφόσον έχουν να κάνουν με την μελέτη του αναγλύφου και την 
ροή του ύδατος. Η μεθοδολογία που επιλέγη αφορά στην δημιουργία σημειακού 
μοντέλου GRID, κατάλληλη για τα απαιτούμενα αποτελέσματα αλλά και εφικτή σχετικά 
με την παρεχόμενη πληροφορία και είναι ο αλγόριθμος TOPOGRID του W/S ArcGIS. 
 
Η μέθοδος παρεμβολής TOPOGRID σχεδιάστηκε για την παραγωγή υδρολογικά 
διορθωμένων ΨΜΑ, από καλώς επιλεγμένα υψόμετρα και υδρογραφικό δίκτυο, 
χρησιμοποιώντας σημειακά, γραμμικά και πολυγωνικά θεματικά επίπεδα. Βασίζεται στο 
ANUDEM πρόγραμμα του Hutchinson (1988, 1989).  
 

• Χρησιμοποιεί μια τεχνική παρεμβολής επαναληπτικών πεπερασμένων 
διαφορών.  

• Έχει την υπολογιστική ικανότητα των «τοπικών» μεθόδων παρεμβολής (inverse 
distance weighted), χωρίς να χάνει την συνέχεια της επιφανείας των 
«καθολικών» μεθόδων (kriging και splines) 

 
Επεξεργασία Δεδομένων 
 

 
Τύπος Δεδομένων – Εισαγωγή στο Σύστημα 

Η κλίμακα παρουσίασης, η οποία θα είναι 1/50.000 αλλά και η μορφολογία της περιοχής, 
αποτελούν κριτήρια ως προς την επιλογή του τύπου των δεδομένων, την πυκνότητα 
αυτών, καθώς και τις υπόλοιπες παραμέτρους (μέγεθος κυψελίδας, παράμετροι που 
ελέγχουν την παρεμβολή κ.ά).  
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Τα δεδομένα (εικ. 14.40) ελήφθησαν από τα τοπογραφικά φύλλα «Σπέτσες» – «Ύδρα» - 
«Αν. Ύδρα» – «Μέθανα» και «Λυγουριό» κλίμακας 1/50.000 της Γ.Υ.Σ. και είναι: 
 

• Ισοϋψείς ανά 20m 
• Τριγωνομετρικά σημεία 
• Επιλεγμένα υψομετρικά σημεία σχετικά με την τοπογραφία και τις ανάγκες 

της μελέτης (π.χ. σε πεδιάδες όπου οι ισοϋψείς δεν έχουν την 
απαιτούμενη πυκνότητα αλλά και σε περιοχές όπου το ανάγλυφο είναι 
έντονο, ώστε να αποδοθεί καλύτερα κατά την μοντελοποίηση κ.ά.) 

• Υδρογραφικό δίκτυο 
• Όριο περιοχής μελέτης 

 
Εικόνα 14.40. Τα εισαγόμενα δεδομένα για την παραγωγή ΨΜΑ είναι, ισοϋψείς, 
τριγωνομετρικά και υψομετρικά σημεία, υδρογραφικό δίκτυο κ.ά. 

 
 
Κάθε κατηγορία δεδομένων εισήχθη χωριστά στο σύστημα ώστε να αποτελέσει 
ξεχωριστό θεματικό επίπεδο.  
 
Οι ισοϋψείς χρησιμοποιούνται για  δύο κυρίως λόγους στον αλγόριθμο TOPOGRID: 

• για την παραγωγή μιας γενικευμένης μορφολογίας του αναγλύφου βάσει  της 
καμπυλότητας των ισοϋψών  

• ως πηγές πληροφορίας υψομέτρου 
 
Οι ισοϋψείς χρησιμοποιούνται συνήθως σε μεγάλης κλίμακας περιοχές όπου και 
αποτελούν αξιόπιστους δείκτες για το υδρογραφικό δίκτυο και τους υδροκρίτες.  Σε 
μικρότερης κλίμακας περιοχές είναι αποτελεσματική και λιγότερο δαπανηρή, η 
ψηφιοποίηση των γωνιών–προεξοχών των ισοϋψών σε ένα σημειακό θεματικό επίπεδο 
και η χρησιμοποίηση αυτού στον αλγόριθμο. 
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Παραγωγή θεματικών επιπέδων  

Τα θεματικά επίπεδα που προέκυψαν είναι τα γραμμικά: “Spydra” και “Spydri” και τα 
πολυγωνικά: “Spydra1p”, “Spydra2p” και “Spydbound” στα οποία αντιστοιχίζονται τα 
παρακάτω δεδομένα: 

 
Spydra  Περιλαμβάνει τις ισοϋψείς 
Spydri  Περιλαμβάνει το υδρογραφικό δίκτυο 
Spydra1p  Περιλαμβάνει τα τριγωνομετρικά σημεία 
Spydra2p  Περιλαμβάνει τα επιλεγμένα υψομετρικά σημεία   
Spydbound Περιλαμβάνει το όριο της περιοχής μελέτης 

 

 
Επεξεργασία θεματικών επιπέδων 

Απαραίτητη είναι η προ-επεξεργασία ορισμένων δεδομένων, όπως: 
• Διόρθωση του προσανατολισμού-φοράς των τόξων του υδρογραφικού δικτύου: 

Όλα τα τόξα-ποτάμια είναι απαραίτητο να έχουν φορά προς τον κύριο ποταμό. 
•  Προσθήκη υψομετρικών σημείων σε ιδιαίτερες περιοχές (επιφάνειες επιπέδωσης 

κ.ά.) 
•   Δημιουργία πολυγωνικού θεματικού επιπέδου–ορίου της περιοχής μελέτης. 
 

 
Προσαρμογή σε Πραγματικές Συντεταγμένες 

Μετά την ψηφιοποίηση και την διόρθωση των λαθών ακολουθεί ο μετασχηματισμός των 
επιπέδων σε πραγματικές συντεταγμένες (UTM) οπότε προκύπτουν τα νέα θεματικά 
επίπεδα: 

“Spydraus”, “Spydric”, “Spydrau1p”, “Spydrau2p”, “Spydbounds” 
 

 
Δόμηση Τοπολογίας 

Ακολουθεί η δόμηση της τοπολογίας των παραπάνω επιπέδων και η ενημέρωση της 
βάσης δεδομένων κάθε θεματικού επιπέδου. 
 

 
Παραγωγή του ΨΜΑ - παράμετροι  

Για την παραγωγή του ΨΜΑ της Νότιας Αργολίδας, χρησιμοποιήθηκαν τα θεματικά 
επίπεδα: “Spydraus”, “Spydric”, “Spydrau1p”, “Spydrau2p”, “Spydbounds” 
 
Ορίσθηκε μέγεθος εικονοστοιχείου-κυψελίδας=20m. (όση η ισοδιάσταση των 
ψηφιοποιημένων ισοϋψών), εφόσον τα δεδομένα είναι αρκετά καλά, οπότε είναι δυνατή 
η μεγάλη ακρίβεια που απαιτείται. 
 
Ορίζονται επίσης οι παράμετροι που αφορούν στην ακρίβεια και την πυκνότητα των 
σημείων υψομέτρου αλλά και με τα δημιουργούμενα λανθασμένα υψόμετρα σε μερικά 
εικονοστοιχεία, σημαντικά χαμηλά σε σχέση με τα γειτονικά και άρα δημιουργούν 
σφάλματα κατά την παραγωγή του ΨΜΑ. Οι παράμετροι αυτοί εξαρτώνται από την 
κλίμακα και την ισοδιάσταση των ισοϋψών. Το παραγόμενο ΨΜΑ καλείται “Spyd20g”. 
 
Παράγονται επίσης αρχεία και θεματικά επίπεδα σχετικά με τις παραμέτρους που 
χρησιμοποιήθηκαν καθώς και με τα εσφαλμένα υψόμετρα αλλά και με το υδρογραφικό 
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δίκτυο και τους υδροκρίτες. Αυτά χρησιμοποιούνται από τον χρήστη για διορθώσεις του 
ΨΜΑ και νέα παραγωγή του από την αρχή. 
Επίσης, παράγεται  αρχείο που περιέχει όλες τις παραμέτρους και τα επίπεδα που 
χρησιμοποιήθηκαν. 
 

Εξομάλυνση του ΨΜΑ 
 
Προκειμένου να διορθωθούν σφάλματα που αφορούν στα παραγόμενα λανθασμένα 
υψόμετρα (είτε χαμηλά (sinks) είτε υψηλά (peaks)) επεξεργάζεται το “Spyd20g” και 
προκύπτει το “Spyd20gf”. 
 
Προκειμένου να εξομαλυνθεί το “Spyd20gf” χρησιμοποιείται φίλτρο χαμηλής διάβασης 
και προκύπτει το “Spyd20f”. 

 
Επαλήθευση – πιστοποίηση ορθότητας του ΨΜΑ 

 
Προκειμένου να ελεγχθεί η ορθότητα  του “Spyd20f”, ώστε να παραχθούν χωρικά 
μοντέλα, εξάγονται ισοϋψείς από το “Spyd20f”. Το επίπεδο των παραγόμενων ισοϋψών 
που προκύπτει καλείται “Spydcont20s”. 
 
Οι ισοϋψείς του “Spydcont20s” ταυτίζονται απόλυτα με τις ψηφιοποιημένες ισοϋψείς του 
Spydraus, γεγονός που δείχνει ότι το ΨΜΑ είναι καλής ποιότητος, δίνει δηλαδή πολύ 
καλή αναπαράσταση του αναγλύφου της περιοχής, οπότε και ξεκινούν οι διαδικασίες 
παραγωγής των απαραίτητων χωρικών μοντέλων και χαρτών. 
 
Σε περίπτωση που το αποτέλεσμα δεν ήταν το επιθυμητό, ελέγχονται τα δεδομένα, το 
είδος και η πυκνότητά τους, οι διάφορες παράμετροι, γίνονται παρεμβάσεις–διορθώσεις–
συμπληρώσεις όπου απαιτείται και επαναλαμβάνονται οι διαδικασίες ώστε να προκύψει 
νέο ΨΜΑ (Εικόνα 14.41) και το σκιασμένο ανάγλυφο (Εκόνα14.42). 
 
14.4.6. Χάρτες και Διαγράμματα Ανάλυσης Αναγλύφου 
 
Ακολουθούν μερικοί από τους αντιπροσωπευτικούς Χάρτες Αναλύσεως Αναγλύφου που 
παρήχθησαν από το «ΠΡΩΑΝΑ» καθώς και στατιστικά διαγράμματα, απαραίτητα για την 
μελέτη της περιοχής. 
 

Μορφολογικός Χάρτης Κλίσεων 
 
Στον Μορφολογικό Χάρτη Κλίσεων αποτυπώνονται οι μέσες μορφολογικές κλίσεις 
συγκεκριμένης περιοχής μελέτης, ταξινομημένες σε κατηγορίες, καθώς και ο 
προσανατολισμός των κλίσεων. Η κατασκευή του απαιτεί ιδιαίτερη προσοχή, εφόσον 
αναπαριστά την μορφολογία της περιοχής, αλλά αποτελεί και την βάση για την 
παραγωγή άλλων θεματικών χαρτών, σχετικών με ανάλυση αναγλύφου. 
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Εικόνα14.42. Σκιασμένο ανάγλυφο Ν. Αργολίδας. Η θέση του ήλιου τονίζει συγκεκριμένης 
διεύθυνσης τεκτονικές και άλλες δομές (μορφολογικές, υδρογραφικό δίκτυο κ.ά.). 
Διακρίνονται διαφορετικές γεωμορφολογικές ενότητες-υποπεριοχές, οι οποίες οφείλονται 
κυρίως στην γεωλογία και τεκτονική της περιοχής. 

 

 
 
 
Εικόνα 14.41. 
ΨΜΑ Νότιας 
Αργολίδας 
(ανάλυση 
20m*20m) 
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Υπολογισμός Μέσων Μορφολογικών Κλίσεων  

Η μέση μορφολογική κλίση (θ) μεταξύ δύο σημείων Α και Β του Γήινου Αναγλύφου, τα 
οποία έχουν «υψομετρική διαφορά b > 0», ουσιαστικά αποτελεί γεωμετρικό πρόβλημα 
και δίδεται βάσει τριγώνου ΑΒΓ (Εικόνα 14.43).   Στο τρίγωνο ΑΒΓ με πλευρές (a,b,c), 
όπου b=υψομετρική διαφορά του Α ως προς το Β και  c=η οριζόντια απόσταση του Α–Β, 
η μέση μορφολογική κλίση (θ) υπολογίζεται σε μοίρες και σε ποσοστό % βάσει της 
εφαπτομένης (tan θ):   
                 μέση μορφολογική κλίση σε μοίρες = θ 
                 tan θ = b/c    
                 μέση μορφολογική κλίση% = (tan θ) * 100                                 

  
 

Εικόνα 14.43. Η μέση μορφολογική κλίση (θ) μεταξύ δύο σημείων του Γήινου Αναγλύφου Α 
και Β, με υψομετρική διαφορά b > 0, ανάγεται σε γεωμετρικό πρόβλημα και υπολογίζεται 
βάσει τριγώνου ΑΒΓ με πλευρές (a,b,c). 

 
Προκειμένου να υπολογισθούν οι μέσες μορφολογικές κλίσεις από το σύστημα, 
απαιτείται η καλή γνώση της κλασσικής μεθοδολογίας (χαρτί και μολύβι – 
Παπανικολάου, 1978), ώστε να εκφρασθούν με μαθηματικό τρόπο τα βήματα και οι 
παράμετροι και να επιτευχθεί το επιθυμητό αποτέλεσμα. 
 
Ήδη η μελέτη της μορφολογίας της περιοχής από τους τοπογραφικούς χάρτες της Γ.Υ.Σ. 
έχει γίνει στο στάδιο δημιουργίας του ΨΜΑ, όπου επιλέχθησαν δεδομένα και αρχικές 
παράμετροι για την δημιουργία του. Και στο στάδιο αυτό λαμβάνεται υπ΄όψιν η γενική 
εικόνα μορφολογίας της περιοχής καθώς και η κλίμακα παρουσίασης των 
αποτελεσμάτων για την επιλογή των επιπλέον παραμέτρων. 
 
Κρίνεται ότι οι μέσες μορφολογικές κλίσεις για την συγκεκριμένη περιοχή, πρέπει να 
ταξινομηθούν στις εξής κατηγορίες:  
                 0-5%, 5-15%, 15-30%,  30-45%,  45-60%,  κλίσεις > 60% 
 
Λαμβάνεται υπ΄όψιν ότι οι επιφάνειες επιπέδωσης θα ταξινομηθούν στις εξής 
κατηγορίες: 

    0-1%,  1-5%,  5-10%,  10-15% 
 

Α 
 

Γ 

Β 

θ 

a 

c 

b 
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Από το ΨΜΑ και βάσει αρχείου-πίνακα με συγκεκριμένα πεδία, υπολογίζονται οι μέσες 
μορφολογικές κλίσεις της περιοχής και παράγεται το διανυσματικό θεματικό επίπεδο που 
τις εμπεριέχει  “Spydslo”. Το μέγεθος του μικρότερου πολυγώνου είναι 20*20m (όσο της 
κυψελίδας του ΨΜΑ).  
 
Ακολουθεί η διαχείριση της βάσης δεδομένων με την προσθήκη απαραίτητων πεδίων, τα 
οποία θα χρησιμοποιηθούν τόσο για την παραγωγή του χάρτη μέσων μορφολογικών 
κλίσεων όσο και για την παραγωγή των επιφανειών επιπέδωσης. Επίσης με την 
επεξεργασία επιτυγχάνεται και η οριοθέτηση των πολυγώνων των μέσων κλίσεων. 
 

Υπολογισμός Προσανατολισμού των Κλίσεων 
  

Ο προσανατολισμός της κλίσης μιας επιφάνειας είναι η κατεύθυνση του μέγιστου ρυθμού 
μείωσης της μεταβολής του υψομέτρου (z) και ουσιαστικά δείχνει την διεύθυνση της 
κλίσης. Μετράται σε μοίρες με τιμές από 00-3600

 

, κατά την φορά των δεικτών του 
ρολογιού από τον Βορρά. Αποτελεί  ξεχωριστό θεματικό επίπεδο, το οποίο παράγεται 
όπως και το επίπεδο των κλίσεων από το ΨΜΑ.  

Προκειμένου να παραχθεί επίπεδο προσανατολισμού των κλίσεων απαιτείται ο 
σχηματισμός ενός νέου πίνακα τιμών όπου κατηγοριοποιούνται οι γωνίες 
προσανατολισμού των κλίσεων. Στην συγκεκριμένη περίπτωση οι γωνίες 
κατηγοριοποιούνται ανά 450

 

. Το θεματικό επίπεδο “spydasp20” που προκύπτει 
εμπεριέχει πολύγωνα με τιμές προσανατολισμού που ανταποκρίνονται στις 
συγκεκριμένες κατηγορίες. Οι τιμές προσανατολισμού των κλίσεων δύνανται να είναι 
οποιεσδήποτε αρκεί να ορισθούν στον πίνακα. 

Τα δύο προηγούμενα θεματικά επίπεδα (μορφολογικών κλίσεων και προσανατολισμού 
κλίσεων) υπόκεινται σε μια σειρά διαδικασιών, κατά την οποία απαλείφονται μικρά 
πολύγωνα έως ένα συγκεκριμένο εμβαδόν, που κρίνεται ανάλογα με το τι είναι 
επιθυμητό κάθε φορά, με σκοπό την ευκολότερη διαχείριση της βάσης. Ουσιαστικά 
αφαιρείται περιττή πληροφορία για την καλύτερη οπτική εικόνα.  
 
Συγκεκριμένα παρήχθησαν τα επίπεδα: “spydsl20” (επίπεδο μέσων κλίσεων)  και 
“spydasp10” (επίπεδο προσανατολισμού των κλίσεων). 
 

Κατασκευή Χάρτη Μορφολογικών Κλίσεων  
 
Όπως προαναφέρθηκε, ο χάρτης μορφολογικών κλίσεων αποτυπώνει τις μέσες 
μορφολογικές κλίσεις (Εικόνα 14.44) της περιοχής μελέτης, ταξινομημένες σε 
συγκεκριμένες κατηγορίες, καθώς και τον προσανατολισμό των κλίσεων. Για τον λόγο 
αυτόν συνδυάζεται το θεματικό επίπεδο των μέσων μορφολογικών κλίσεων με το 
θεματικό επίπεδο προσανατολισμού των κλίσεων, ώστε προκύπτει το επίπεδο   
“spydslasp”. Κάθε πολύγωνο σε αυτό το επίπεδο περιέχει την πληροφορία και των δύο 
προηγουμένων δηλαδή συγκεκριμένη τιμή κλίσης και προσανατολιμού της κλίσης. 
 
Προκειμένου να αποδοθούν χρωματικά οι μέσες κλίσεις, δημιουργείται παλλέτα με 
συγκεκριμένα χρώματα από ανοικτό κίτρινο για τις μικρότερες κλίσεις έως σκούρο καφέ 
για τις μεγαλύτερες. Επίσης, κατασκευάζεται νέος πίνακας (look up table), με 
συγκεκριμένα πεδία, βάσει των οποίων αποδίδονται οι μέσες κλίσεις.  
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Προκειμένου να αποδοθεί ο προσανατολισμός των κλίσεων, δημιουργείται αρχείο, στο 
οποίο δίδονται οι επιθυμητές γωνίες βάσει πίνακα  και αποδίδεται ο προσανατολισμός 
των κλίσεων ως βέλος. 
 

Χάρτης Αναλύσεως Αναγλύφου 
 

Ο «Χάρτης Αναλύσεως Αναγλύφου Νότιας Αργολίδας» (Εικόνα 14.44) αποτελεί έναν 
συνθετικό χάρτη που περιλαμβάνει συγκεντρωμένη πληροφορία, η οποία  προέκυψε 
από την ανάλυση αναγλύφου. Συγκεκριμένα, περιλαμβάνει την πληροφορία των 
παρακάτω θεματικών επιπέδων: μέσων μορφολογικών κλίσεων και προσανατολισμού 
των κλίσεων, μορφολογικών ασυνεχειών, υδρογραφικού δίκτυου, υδροκριτών. 
 
Ο συγκεκριμένος χάρτης σε συνδυασμό με τον χάρτη των επιφανειών επιπέδωσης, τόσο 
ως εικόνα όσο και ως πληροφορία, αποτελούν βασικό στοιχείο για την ποιοτική και 
ποσοτική ανάλυση του αναγλύφου. 
 

Μορφολογικές Ασυνέχειες 
 

Οι μορφολογικές ασυνέχειες αποτελούν σημαντικά στοιχεία για την  μορφοτεκτονική 
ανάλυση του αναγλύφου γενικά, αλλά και για την συγκεκριμένη μελέτη ειδικότερα.  
Οι μορφολογικές ασυνέχειες αντιπροσωπεύουν αλλαγές στις τιμές της μέσης κλίσης που 
ξεπερνούν το 15%. Με αυτό το δεδομένο γίνεται μια προσπάθεια να παραχθεί θεματικό 
επίπεδο που να περιέχει τις μορφολογικές ασυνέχειες και η χάραξή τους να πλησιάζει 
όσο το δυνατόν καλύτερα την οπτική εικόνα που επικρατεί κατά την κλασσική 
μεθοδολογία (χαρτί και μολύβι). 
 
Το επίπεδο των μορφολογικών ασυνεχειών εξαρτάται αρχικά από το ΨΜΑ της περιοχής 
αλλά και από παράγωγα θεματικά επίπεδα αυτού. Κατόπιν δοκιμών σε επιλεκτικές 
υποπεριοχές της περιοχής μελέτης  (όπως άλλωστε έχει γίνει και για όλα τα θεματικά 
επίπεδα) ακολουθήθηκαν βήματα–διαδικασίες προκειμένου να εξαχθούν–χαραχθούν οι 
μορφολογικές ασυνέχειες.  
 
Οι μορφολογικές ασυνέχειες ουσιαστικά, αποτελούν όρια–τόξα συγκεκριμένων 
πολυγώνων του. Τα τόξα–ασυνέχειες απομονώνονται σε νέο θεματικό επίπεδο 
“spdiscont”, το οποίο επεξεργάζεται με μια σειρά διδικασιών μέσα από το «ΠΡΩΑΝΑ» 
έως οι ασυνέχειες να λάβουν την τελική  μορφή και να αποδοθούν με το σύμβολο της 
οδόντωσης. 
 
Σημειώνεται ότι το κριτήριο διάκρισης των ασυνεχειών ως προς την κλίση ορίσθηκε: 
διαφορά κλίσης >= 10% και όχι διαφορά κλίσης >= 15%, σύμφωνα με την κλασσική 
μεθοδολογία. Αυτό συμβαίνει διότι οι υπολογισμοί είναι πλέον μέσω υπολογιστή – άρα 
πιο ακριβείς, επομένως τα ποσοστά αλλάζουν. 
 
Σημαντικό ρόλο αποτελεί η σειρά των διαδικασιών και η τιμή των παραμέτρων, όπως 
ισχύει για όλες τις διαδικασίες του προγράμματος γενικότερα. 
 
Οι μορφολογικές ασυνέχειες διακρίνονται στην εικόνα 14.44, ενώ στην εικόνα 14.45 και 
14.46 δίδεται τμήμα από την βάση δεδομένων και το ροδόγραμμα διευθύνσεων του 
θεματικού επιπέδου των μορφολογικών ασυνεχειών, αντιστοίχως.  
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Εικόνα 14.44. Τμήμα του Χάρτη Αναλύσεως Αναγλύφου μέσω του ειδικού λογισμικού ΠΡΩΑΝΑ. 
Διακρίνονται οι μορφολογικές κλίσεις και ο προσανατολοσμός κλίσεων, οι μορφολογικές ασυνέχειες, 
το υδρογραφικό δίκτυο και οι υδροκρίτες. 



 188 

 
 

 
 
 
 

 
 

Εικόνα 14.45. Τμήμα της Βάσεως Δεδομένων του θεματικού επιπέδου των μορφολογικών ασυνεχειών. Διακρίνονται μεγάλος αριθμός πεδίων, 
τα οποία προέκυψαν από συνδυασμό αρκετών διαφορετικών θεματικών επιπέδων. 
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Χάρτης Επιφανειών Επιπέδωσης 
 
Ένα από τα παράγωγα θεματικά επίπεδα των μορφολογικών κλίσεων είναι το θεματικό 
επίπεδο των επιφανειών επιπέδωσης, δηλαδή των επιφανειών του αναγλύφου με 
κλίσεις: 0-1%, 1-5%, 5-10% και 10-15%. 
 
Οι επιφάνειες επιπέδωσης διακρίνονται ανάλογα με το αν είναι δημιουργικές ή 
καταστροφικές σε δύο κατηγορίες αντίστοιχα:  
 

• Επιφάνειες επιπέδωσης από απόθεση 
• Επιφάνειες επιπέδωσης από διάβρωση 

 
Οι επιφάνειες επιπέδωσης από απόθεση απαντώνται σε μεταλπικούς ολοκαινικούς 
σχηματισμούς όπως: αλλουβιακές αποθέσεις, πλευρικά κορήματα, κώνους κορημάτων, 
οι οποίοι αποτίθενται. 
 
Επιφάνειες επιπέδωσης από διάβρωση απαντώνται σε παλαιότερους μεταλπικούς 
σχηματισμούς (Πλειο–Πλειστοκαινικούς) και σε αλπικούς σχηματισμούς, οι οποίοι 
διαβρώνονται. 
 
Προκειμένου να προσδιορισθούν  οι επιφάνειες επιπέδωσης από το σύστημα απαιτείται 
μια σειρά διαδικασιών που σχετίζεται με επεξεργασία και συνδυασμό αρκετών θεματικών 
επιπέδων, διαχείριση της βάσης δεδομένων αυτών, καθώς και προσδιορισμό–
υπολογισμό αρκετών παραμέτρων. 
 
Αρχικά αποσπώνται από το θεματικό επίπεδο μορφολογικών κλίσεων (spydsl20s) οι 
κατηγορίες μορφολογικών κλίσεων που ικανοποιούν τη συνθήκη:  0 <= percent_slope 
<= 15 σε νέο επίπεδο “spydepols”. Μετά από μια σειρά διαδικασιών προκύπτει το 
θεματικό επίπεδο των επιφανειών επιπέδωσης “spydeprgas10”. Κάθε πολύγωνο του 
έχει συγκεκριμένη τιμή μορφολογικής κλίσης, προσανατολισμού κλίσης, υψομέτρου, 
πληροφορία για την γεωλογία, καθώς και διάκριση σε επιφάνειες απόθεσης και 
διάβρωσης.  
 
Στις εικ. 14.47 – 14.49 δίδεται τμήμα από τον χάρτη επιφανειών επιπέδωσης, την βάση 
δεδομένων και την στατιστική επεξεργασία αυτών. 
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Εικόνα 14.47. Τμήμα του Χάρτη Επιφανειών Επιπέδωσης της Νότιας Αργολίδας, ταξινομημένες ανάλογα με την κλίση, με διάκριση σε απόθεσης 
και διάβρωσης, μέσω του ειδικού λογισμικού ΠΡΩΑΝΑ. 
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Εικόνα 14.48. Τμήμα από την βάση δεδομένων των επιφανειών επίπέδωσης. Το πλήθος των πεδίων υποδηλώνει την σημαντική ποσότητα 
πληροφορίας, η οποία προέρχεται από τα διαφορετικά θεματικά επίπεδα που συνδυάσθηκαν για την δημιουργία των επιφανειών επιπέδωσης. 
 
 
 
 
 

Area Per im eter Spydeprga
s12#

Spydeprga
s12-id

Spydeprg5
e#

Spydeprg5
e-id

Spydeprge
5#

Spydeprge
5-id

Spydepols
#

Spydepol
s -id

Slope-
code

Code1 Code2 Spydrng
20#

Spydrn
g20-id

Range-
code

Range Medium h Area1 Cargord#

224391,7654 6108,70254 2 5 2 2 2 1 2 1 3 3 2 2 1 1 20 10 0,1661 2
113109,2752 3682,47063 3 3 4 7 3 2 3 7 4 4 2 2 1 1 20 10 0,1661 2

73600 1840 4 7 5 18 5 5 4 4 4 4 2 3 2 2 40 30 0,61676 2
67200 1360 5 25 11 32 11 14 5 67 3 3 2 4 3 3 60 50 0,22274 2

116400 2480 6 36 12 42 12 16 4 4 4 4 2 6 5 5 100 90 0,30538 2
110000 2000 7 43 15 47 15 27 5 67 3 3 2 5 4 4 80 70 0,30235 2
152800 3200 8 83 26 58 26 51 7 369 4 4 2 6 5 5 100 90 0,30538 2
72000 1920 9 92 24 56 24 46 10 696 3 3 2 8 7 7 140 130 0,28937 2

140400 3000 10 72 23 55 23 43 9 667 3 3 2 6 5 5 100 90 0,30538 2
63600 1640 11 74 24 56 24 46 10 696 3 3 2 8 7 7 140 130 0,28937 2

119200 2480 12 127 38 71 38 78 12 871 4 4 2 7 6 6 120 110 0,20201 2
99600 2160 13 100 29 61 29 63 12 871 4 4 2 6 5 5 100 90 0,30538 2
87200 1840 14 131 39 72 39 81 10 696 3 3 2 8 7 7 140 130 0,28937 2

143730,124 4793,02375 15 190 35 69 35 73 13 2515 4 4 2 2 1 1 20 10 0,1661 2
133200 2960 16 157 43 77 43 95 14 1206 4 4 2 45 44 17 340 330 0,06387 2
66800 1480 17 149 38 71 38 78 12 871 4 4 2 7 6 6 120 110 0,20201 2
85200 1440 18 164 44 79 44 97 15 2032 4 4 2 31 30 6 120 110 0,01908 2
97600 1920 19 219 53 91 53 118 18 3020 4 4 2 6 5 5 100 90 0,30538 2

141200 2920 20 224 53 91 53 118 18 3020 4 4 2 6 5 5 100 90 0,30538 2
59521,04204 1280,88274 21 225 57 103 57 130 19 4562 1 1 1 53 52 10 200 190 0,02385 3
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Στις εικόνες 14.49 - 14.50 δίδονται μερικά στατιστικά στοιχεία του αναγλύφου τα οποία 
προκύπτουν από την βάση δεδομένων συγκεκριμμένων θεματικών επιπέδων.  
 
Επιβεβαιώνεται και από την συγκεκριμένη μελέτη πόσο σημαντικά είναι τα ΣΓΠ 
και η  οργάνωση-διαχείριση της απαραίτητης πληροφορίας όχι μόνον στην 
ποιοτική αλλά και ποσοτική ανάλυση. 
 

 
 
 
 
 
 
 
 
 
 

 
Εικ. 14.49. Υψομετρική κατανομή εμβαδού  Νότιας Αργολίδας. 
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Εικόνα 14.50. Προσανατολισμός Αναγλύφου Ν. Αργολίδας 
 
 
14.4.7. Γεωλογικός Χάρτης  
 
Εφόσον συλλέχθηκε, αξιολογήθηκε και διαχωρίσθηκε η απαραίτητη για τις ανάγκες της 
μελέτης πληροφορία, ακολουθήθηκαν τα βασικά στάδια επεξεργασίας δεδομένων σε 
ΣΓΠ ώστε να συνταχθεί ο «Γεωλογικός Χάρτης της Νότιας Αργολίδας»: 
 
Κατά το πρώτο στάδιο (συλλογή δεδομένων - διαχωρισμός θεματικών επιπέδων), 
αρχικά διακρίθηκε η χωρική από την περιγραφική πληροφορία. Η χωρική πληροφορία 
ταξινομήθηκε στις παρακάτω ενότητες, ανάλογα εάν αποτελεί τόξα, πολύγωνα ή σημεία: 

• Των τοπογραφικών στοιχείων (ισοϋψείς ανά 20m και τοπικά ανά 10m ή 
5m) 

• Των τεκτονικών στοιχείων (τεκτονικές επαφές) 
• Των γεωλογικών σχηματισμών 
• Των διευθύνσεων – κλίσεων των σχηματισμών 
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Οι παραπάνω ενότητες διαχωρίζονται σε υποενότητες (θεματικές ενότητες–θεματικά 
επίπεδα), ανάλογα με τα στοιχεία που εμπεριέχουν. Τα στοιχεία κάθε υποενότητας 
εισάγονται στο σύστημα. 
 
Κατά την εισαγωγή γραμμικών και σημειακών δεδομένων προσδίδεται κωδικός (ID), 
κοινός για ομοιογενή στοιχεία, τα οποία ανά πάσα στιγμή δύνανται να διαχωρισθούν σε 
υποκατηγορίες. Στα πολύγωνα, ο κωδικός προσδίδεται σε επόμενο στάδιο μετά τις 
διορθώσεις. Όσον αφορά τα όρια των γεωλογικών σχηματισμών και τα τεκτονικά 
στοιχεία, πληροφορία προέρχεται και από την επεξεργασία των δορυφορικών εικόνων 
LANDSAT και SPOT της περιοχής. 
 
Μετά την εισαγωγή των δεδομένων, προκύπτουν τα εξής θεματικά επίπεδα-coverages: 

 
 

Spydtic Περιλαμβάνει τα σταθερά σημεία tics, κοινά για όλα τα θεματικά 
επίπεδα 

Spydra Περιλαμβάνει τις ισοϋψείς ανά 20m, 10m και 5m. Το υψόμετρο 
δίδεται στο ID. 

Spydcoast 
 

Περιλαμβάνει την ακτογραμμή της περιοχής και ορισμένων 
γειτονικών νησιών, με ID = 0. 

Tmargor1 
 

Περιλαμβάνει τα όρια των γεωλογικών σχηματισμών όπως 
προκύπτουν από την ερμηνεία των δορυφορικών εικόνων. 

Cargor1 
 

Περιλαμβάνει τα όρια των γεωλογικών σχηματισμών, στην τελική 
τους μορφή. Όλα τα απλά όρια έχουν κοινό ID, ενώ εκείνα που 
ταυτίζονται με τεκτονικές επαφές έχουν διαφορετικό ID. 

Tect_contact Περιλαμβάνει τις τεκτονικές επαφές που δεν ταυτίζονται με όρια 
σχηματισμών 

Tekton Περιλαμβάνει τις τεκτονικές επαφές 
Topogeol 
 

Περιλαμβάνει τα σημεία των πόλεων καθώς και την ονοματολογία 
αυτών, που θα εισαχθούν στον χάρτη. 

Klisi 
 

Περιλαμβάνει ως σημεία, τις θέσεις μετρήσεων για την διεύθυνση και 
κλίση των γεωλογικών σχηματισμών και φυσικά έχει αποδοθεί η 
διεύθυνση και η κλίση αυτών. 

 
Την εισαγωγή των δεδομένων και την δημιουργία των θεματικών επιπέδων ακολουθεί η 
διόρθωση των στοιχείων κάθε επιπέδου, η αναγωγή σε πραγματικές συντεταγμένες, η 
δόμηση της τοπολογίας και η ανάπτυξη της βάσης κάθε θεματικού επιπέδου. 
Αποτέλεσμα είναι ο Γεωλογικός Χάρτης της περιοχής (Εικ. 14.51). 
 
 



 195 

 
 

Εικόνα 14.51. Γεωλογικός Χάρτης Ν. Αργολίδας 
 
 
 
Σχετικά με την βάση δεδομένων του θεματικού επιπέδου των γεωλογικών σχηματισμών 
(cargor1), αυτόματα από το σύστημα έχουν υπολογισθεί συγκεκριμένα χαρακτηριστικά 
για κάθε δεδομένο, τα οποία αποδίδονται σε συγκεκριμένα πεδία εάν πρόκειται για 
γραμμικό, πολυγωνικό ή σημειακό δεδομένο, ενώ άλλα είναι κοινά για όλες τις 
κατηγορίες. Τα πεδία αυτά είναι:  

 
$recno Εσωτερική αρίθμηση κάθε εγγραφής-στοιχείου 
area Εμβαδόν πολυγώνου 
perimeter Περίμετρος πολυγώνου 
length μήκος τόξου 
fnode# και tnode# Αρίθμηση αρχικού και τελικού κόμβου για κάθε 

γραμμή– όξο 
lpoly# και rpoly# Αρίθμηση αριστερού και δεξιού πολυγώνου για 

συγκεκριμένο τόξο 
Πεδία όπως π.χ. cargor1-id και 
cargor1# 

Αντιστοιχίζεται το ID και ο εσωτερικός κωδικός 
κάθε δεδομένου, με πρόθεμα το όνομα του 
επιπέδου  

 
Στους γεωλογικούς σχηματισμούς προστίθενται τα παρακάτω πεδία, στα οποία 
αντιστοιχίζονται συγκεκριμένα χαρακτηριστικά κάθε γεωλογικού σχηματισμού: 
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Formation   Όνομα σχηματισμού. Στα αλπικά συνοδεύεται και από το όνομα 
της γεωτεκτονικής ενότητας 

Lithology   Περιγραφή λιθολογικών χαρακτηριστικών 
Age   Ηλικία σχηματισμού 
Charact1  Διάκριση αλπικών (alp) και μεταλπικών (maa για τα αλλούβια και 

τα κορήματα και mak για τα κροκαλοπαγή) 
Charact2    Απόδοση συγκεκριμένου κωδικού=1 για τους σχηματισμούς maa 

και κωδικού=2 για τους σχηματισμούς mak και alp.  
 
Τμήμα της βάσεως δεδομένων των γεωλογικών σχηματισμών δίδεται στην εικόνα 14.52. 
 
Η ανάπτυξη βάσεως δεδομένων με την απαιτούμενη πληροφορία είναι σημαντική, όχι 
μόνο για το συγκεκριμένο θεματικό επίπεδο που ανήκει, αλλά και για άλλα που πρόκειται 
να δημιουργηθούν βάσει αυτού. Ως παράδειγμα αναφέρεται, ότι από το θεματικό 
επίπεδο των γεωλογικών σχηματισμών δύναται να παραχθεί θεματικό επίπεδο με 
συγκεκριμένα πολύγωνα βάσει του πεδίου Charact2. Το συγκεκριμένο επίπεδο θα 
χρησιμοποιηθεί για την παραγωγή των επιφανειών επιπέδωσης. 
 
 

 
 
 
Εικόνα 14.52. Τμήμα της βάσεως δεδομένων των γεωλογικών σχηματισμών. 
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14.4.8. Χάρτης Ρηξιγενούς Ιστού 
 
Ο προσδιορισμός των ρηγμάτων και των τεκτονικών επαφών που απαντούν στην 
περιοχή επιτεύχθηκε με βασική εργασία πεδίου και φωτοερμηνεία μέσω δορυφορικών 
εικόνων. 
 
Τα στοιχεία του χάρτη αφού εισήχθησαν στο ΣΓΠ επεξεργάσθηκαν και περιέχονται στο 
γραμμικό θεματικό επίπεδο “fault”, το οποίο έχει αναχθεί σε πραγματικές συντεταγμένες. 

Στο “fault” περιέχονται δύο κατηγορίες δεδομένων: 
 πιθανά ρήγματα που προέκυψαν μόνο από την επεξεργασία των 

δορυφορικών εικόνων. 
 ρήγματα τα οποία έχουν επιβεβαιωθεί στην ύπαιθρο (μερικά εξ΄αυτών έχουν 

προσδιορισθεί και από την ερμηνεία των δορυφορικών εικόνων). 
 
Η πρώτη κατηγορία δεδομένων χωρίζεται στις υποκατηγορίες: 
• Ρήγματα με οδόντωση 
• Ρήγματα χωρίς οδόντωση 
• Πιθανά ρήγματα ή πιθανή προέκταση ρηγμάτων  
 

Η βάση δεδομένων του “fault” απαρτίζεται από τα παρακάτω πεδία με την αντίστοιχη 
πληροφορία: 
 
 

 
$recno  Εσωτερική αρίθμηση κάθε εγγραφής-στοιχείου 
length  Μήκος τόξου 
fnode# και tnode#  Αρίθμηση αρχικού και τελικού κόμβου για κάθε 

γραμμή–τόξο 
fault# Αντιστοιχίζεται ο εσωτερικός κωδικός κάθε 

τόξου-ρήγματος 
fault -id Αντιστοιχίζεται το ID κάθε τόξου–ρήγματος, που 

προσδιορίζεται από τον χρήστη και είναι κοινός 
για κάθε υποκατηγορία δεδομένων 

code Αριθμός που χαρακτηρίζει κάθε ρήγμα ώστε να 
αποδοθεί στον χάρτη και να επεξηγηθεί στο 
κείμενο  

orient Διεύθυνση ρηγμάτων 
 
Ο Χάρτης Ρηξιγενούς Ιστού δίδεται στην εικ. 14.53.  Τμήμα της βάσεως δεδομένων των 
ρηγμάτων δίδεται στην εικόνα 14.54.      
 
Στην εικόνα 14.55 δίδεται η στατιστική επεξεργασία των ρηγμάτων. 
 
Κατά τον ίδιο τρόπο επεξεργάζονται οι τεκτονικές επαφές (επωθήσεις-εφιππεύσεις) και 
παράγεται το θεματικό επίπεδο των τεκτονικών επαφών. Οι τεκτονικές επαφές 
διακρίνονται στον Γεωλογικό Χάρτη  (Εικόνα14.51). 
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Εικόνα 14.53.  Χάρτης Ρηξιγενούς Ιστού με υπόβαθρο δορυφορική εικόνα LANDSAT 5, TΜ, 
Ψευδέγχρωμη, 4-7-2 (RGB), Νότιας Αργολίδας. 
    

  Ρήγμα (από ερμηνεία δορυφορικών εικόνων και επιβεβαίωση στην ύπαιθρο)             
 
        Πιθανό Ρήγμα (από ερμηνεία δορυφορικών εικόνων) 
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Εικόνα 14.54. Τμήμα της βάσεως δεδομένων του θενατικού επιπέδου των ρηγμάτων Ν. 
Αργολίδας. 
 
 

 
 

Εικόνα 14.55. 
Ροδόγραμμα  διέυθυνσης  
ρηγμάτων  Ν. Αργολίδας 
(Arc/Info 7.1.2., ArcView 
3.0a., SynArc 3.0) 
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14.4.9. ΣΓΠ και Γεωδυναμική 
 
Στόχος της μελέτης ήταν η πρόσφατη  Γεωδυναμική  Εξέλιξη  της  Νότιας Αργολίδας, 
μέσω ΣΓΠ και δεδομένων Τηλεανίχνευσης. Η διαχείριση των δεδομένων σε ΣΓΠ και η 
ανάπτυξη του Ειδικού Λογισμικού «ΠΡΩΑΝΑ» έδωσε την δυνατότητα παραγωγής και 
συνδυασμού μεγάλου όγκου και διαφόρου είδους δεδομένων:  

• δεδομένα πεδίου, τα οποία προέκυψαν από κλασσική εργασία υπαίθρου, 
όσον αφορά στην γεωλογία και τεκτονική. 

• δεδομένα σχετικά με την γεωλογία και την τεκτονική, τα οποία προέκυψαν 
από συγκριτική μελέτη βιβλιογραφικών αναφορών. 

• δεδομένα τηλεανίχνευσης, τα οποία προέκυψαν από την ψηφιακή 
επεξεργασία  δύο δορυφορικών εικόνων (LANDSAT 5, TM και  SPOT 
πανχρωματική). 

• δεδομένα αναγλύφου, τα οποία παρήχθηκαν απευθείας από το «ΠΡΩΑΝΑ» 
και επαληθεύθηκαν στο ύπαιθρο. 

 
Στην εικόνα 14.56 δίδεται η βάση δεδομένων που αναπτύχθηκε  για την περιοχή 
ενδιαφέροντος.  Διακρίνονται βασικά θεματικά επίπεδα και χάρτες, σχετικοί με γεωλογία, 
τεκτονική, ανάλυση αναγλύφου. 
 
Απαραίτητο εργαλείο στην μελέτη ήταν το «ΠΡΩΑΝΑ», όπου μέσω  των  παραγώμενων  
θεματικών επιπέδων,  των  απλών  και  συνθετικών  χαρτών  με την  κατάλληλα  
δομημένη  βάση  δεδομένων, πραγματοποιήθηκε  η  ποιοτική και  ποσοτική  ανάλυση  
αναγλύφου της περιοχής.   
 
Ο στόχος της μελέτης πραγματοποιήθηκε και δόθηκε η Πρόσφατη  Γεωδυναμική  
Εξέλιξη  της  Νότιας Αργολίδας. 
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Εικόνα 14.56. Κυριότερα θεματικά επίπεδα και χάρτες που παρήχθησαν και επεξεργάσθηκαν σε ΣΓΠ, για την Γεωδυναμική Εξέλιξη της Αργολίδας.



 202 

Βιβλιογραφικές Αναφορές 
 

Αγατζά–Μπαλοδήμου,  ΑΜ, Μπαλοδήμος, Δ.Δ. (1991). Εισαγωγή στη Γεωδαισία.  
Σημειώσεις Μαθήματος, Τμ. Αγρονόμων και Τοπογράφων Μηχανικών, Τομ. 
Τοπογραφίας,  ΕΜΠ. 

Αγατζά–Μπαλοδήμου, Α.Μ. (2000). Θεωρία σφαλμάτων και 
συνορθώσεις. Σημειώσεις Μαθήματος, ΣΑΤΜ, ΕΜΠ. 

Aronoff, S. (1989). Geographic Information Systems: A management perspective. 
WDL Publications Ottawa Canada. 

Αστάρας, Θ. (1998). Φωτοερμηνεία (Τηλεπισκόπηση) στις Γεωεπιστήμες. Πανεπ. 
Σημειώσεις. ΑΠΘ, Τμ. Γεωλογίας, Τομέας Γεωλογίας και Φυσικής Γεωγραφίας. 

Astaras, Th. (1990). The contribution of Landsat Thematic Mapper Imagery to the 
Geological and Geomorphological Reconnaissance Mapping in the Mountain Area of 
Kerkini – SW Part of Rhodope Massif and the Surrounding Plains (Hellenic – Boulgarian 
Borders). Geographica Rhodopica, vol. 2, p.105-114. 

ATCOR, (2002).  ATCOR for ERDAS Imagine. User Manual – Atmospheric and 
Topographic Correction ATCOR2 and ATCOR3, ed. GEOSYSTEMS, Germany. 

An Online Tutorial in Geodesy (2001). Univ. of New Brunswick, Geodesy Group, 
Academic Press. (http://einstein.gge.unb.ca). 

Βαϊόπουλος, Δ. (2004). Εφαρμογές της Διαστημικής Επιστήμης και Τεχνολογίας και 
Στοιχεία του Πλανητικού Συστήματος, Σημειώσεις ΕΚΠΑ, σελ. 298. 

Βασιλοπούλου, Σ. (1999). Συμβολή στη Γεωδυναμική της Αργολίδας με την 
Ανάπτυξη Συστήματος Γεωγραφικών Πληροφοριών (G.I.S.) και τη Χρήση Δεδομένων 
Τηλεανίχνευσης. Διδακτορική Διατριβή, Πανεπιστήμιο Αθηνών, Τμήμα Γεωλογίας, σ.194. 

Βασιλοπούλου, Σ. (2002). Η Χρήση των Δορυφορικών Δεδομένων Τηλεανίχνευσης 
στην Γεωδυναμική Μελέτη: Επεξεργασία των Δορυφορικών Εικόνων LANDSAT 5, TM 
και SPOT/PAN της Νότιας Αργολίδας. 60

ΒΕΗΣ, Γ. (1986). Το Γεωδαιτικό σύστημα αναφοράς για το Κτηματολόγιο και την 
Χαρτογραφία, Εισηγητική Έκθεση προς τον Ο.Κ.Χ.Ε., Δελτίο ΠΑ.Σ.Δ.Α.Τ.Μ. 
(Πανελλήνιος Σύλλογος Διπλωματούχων Αγρονόμων Τοπογράφων Μηχανικών), τεύχος 
80 Φεβρ.1988, 40-41.  

 Πανελλήνιο Γεωγραφικό Συνέδριο της 
Ελληνικής Γεωγραφικής Εταιρίας, Θεσσαλονίκη, τ. ΙΙ, σελ. 102-109. 

ΒΕΗΣ, Γ. (1986). Πρόταση Διαδικασίας για την ίδρυση και καθιέρωση ενός 
Γεωδαιτικού Συστήματος Αναφοράς για την Ελλάδα, Εισηγητική Έκθεση προς Γ.Γ.Ε.Π. 
('Γεωδαιτική και Γεωφυσική Επιτροπή του Κράτους'), Δελτίο ΠΑ.Σ.Δ.Α.Τ.Μ., τεύχος 80 
Φεβρ.1988, 42-45.  

ΒΕΗΣ, Γ. (1987). Το χρησιμοποιούμενο πλέον σήμερα Ελληνικό Datum (ΕΓΣΑ87), 
Δελτίο ΠΑ.Σ.Δ.Α.Τ.Μ., τεύχος 80 Φεβρ.1988, 12-39. 

ΒΕΗΣ, Γ. (1994). Τα συστήµατα αναφοράς και η εφαρµογή του Ε.Γ.Σ.Α.’87, 
σηµειώσεις από την διάλεξη στο επιστηµονικό διήµερο του Τ.Ε.Ε. "Ψηφιακή 
Χαρτογραφία, Φωτογραµµετρία, Τηλεπισκόπηση και Τεχνολογίες Αιχµής". 

Βέης Γ, Μπιλλήρης, Χ.,  Παπαζήση, Κ. (2006). Κεφάλαια Ανώτερης Γεωδαισίας. 
Σημειώσεις Μαθήματος, ΣΑΤΜ, ΕΜΠ. 

Βλάχος Δ. (1980). Μαθήματα Τοπογραφίας. Τόμος Α. Θεσσαλονίκη. 
Βλάχου Κ. (2006). GPS Μετρήσεις στην ευρύτερη περιοχή Πατραϊκού Κόλπου. 

Μεταπτυχιακή Διατριβή Ειδίκευσης, Πανεπιστήμιο Αθηνών, Αθήνα. σελ. 158. 
Γραικούσης, Γ. & Λαγός Αιμ. (2001). Αρχές Τοπογραφίας και Γεωπληροφορικής σε 

12 Θεωρητικά και Εργαστηριακά Μαθήματα. Σύγχρονη Εκδοτική ΕΠΕ, 346. 
Colessanti, C., Ferretti, A., Prati, C. & Rocca, F. (2003). Monitoring Landslides and 

Tectonic Motion with the Permanent Scatterers Technique. Engineering Geology, 68, 3-
14. 

http://einstein.gge.unb.ca/�


 203 

Δελήμπασης, Ν. κ.ά. (2002). Μελέτη Ανίχνευσης Πρόδρομων Φαινομένων 
Ευρύτερης Περιοχής Κεφαλληνίας [Ερευνητικό Πρόγραμμα, Εκτελέστηκε από το Εθνικό 
και Καποδιστριακό Πανεπιστήμιο Αθηνών (ΕΚΠΑ), με χρηματοδότηση από τον 
Οργανισμό Αντισεισμικού Σχεδιασμού και Προστασίας (ΟΑΣΠ), 2001-2002]. 

ERDAS Imagine (2001). Field Guide version 8.5. 
ENVI (2007). User’s Guide version 4.3. 
ESRI (2000). Introduction to ArcInfoTM using ArcMapTM, ArcCatalogTM and 

ArcToolbox
ESRI (2001). ArcDoc for ArcGIS, version 8 & 9. 

TM 
http://www.esri.com/   

ESRI (2004). ArcDOC for ArcGIS, version 9.
Fundamentals of Remote Sensing (Canada Centre for Remote Sensing, Remote 

Sensing Tutorial, p. 258),  

 Help on CDROM. 

http://ccrs.nrcan.gc.ca/resource/tutor/fundam 
Ferretti, A., Novali, F., Bürgmann, R., Hilley, G. & Pratti, C. (2004). InSAR 

Permanent Scatterer analysis reveals Ups and Downs in San Francisco Bay area. EOS, 
Transactions, AGU, 85/34, 317-324. 

Geomatica OrthoEngine Basics. (2001). User’s Guide version 8.2, ed. PCI 
Geomatics 

«GEOWARN Geo-spatial warning systems: Nisyros Volcano (Greece) – An 
Emergency Case Study» (2003). [Ερευνητικό Πρόγραμμα, Εκτελέστηκε από το Εθνικό 
και Καποδιστριακό Πανεπιστήμιο Αθηνών (ΕΚΠΑ) και άλλους φορείς του εσωτερικού και 
εξωτερικού, με χρηματοδότηση από την Ευρωπαϊκή Ένωση, Project IST, 1999 – 12310, 
2000-2003].  

Gupta, P.R. (1991). – Remote Sensing in Geology. Springer-Verlag, 356. 
IRIS (2001). Temperature Correction of Thermal Imaging Software version 5.6      

http://www.infostar.de/iris   
Καρτέρης, Μ.  (1991-92). Τηλεπισκόπηση φυσικών πόρων και Γεωγραφικά 

συστήματα πληροφοριών (Πανεπιστημιακές παραδόσεις) Αριστοτέλειο Πανεπιστήμιο , 
Τόμος Ι, σελ. 247. 

Καρτέρης, Μ.,  και Μελιάδης, Ι. (1992). Τηλεπισκόπηση φυσικών πόρων και 
Γεωγραφικά συστήματα πληροφοριών (Πανεπιστημιακές παραδόσεις) Αριστοτέλειο 
Πανεπιστήμιο , Τόμος ΙΙ , σελ. 278.  

Κατσάμπαλος, Κ. (2009). HTRS07: Το Γεωδαιτικό Σύστημα Αναφοράς για το 
HEPOS. Ημερίδα ΠΣΔΑΤΜ & ΚΤ/ΑΕ, Αθήνα 24/2/2009. 

Kahmen H., Faig, W. (1988) Surveying. deGruyter, Berlin, New York 
Kavanagh, B., Glenn Bird SJ. (2000)  Surveying -  Principles and Applications. 5th 

Edt, Prentice Hall. 
Κιόκες Γ. (2004). Μελέτη Ανάπτυξης Ραντάρ Συνθετικής Απεικόνισης Μικρών 

Διαστάσεων, Διπλωματική Εργασία, ΕΜΠ, Σχολή Ηλεκτρολόγων Μηχανικών, Τομ. 
Συστημάτων Μετάδοσης Πληροφορίας και Τεχνολογίας Υλικών. 

Kratky, V. (1989). Rigorous photogrammetric processing of SPOT images at CCM 
Canada. ISPRS Journal of Photogrammetry and Remote Sensing 44 (2), 53–71.  

Κωνσταντινίδης, Α. (2002). Εισαγωγή στα Γεωγραφικά Συστήματα Πληροφοριών 
(GIS I), Σημειώσεις, TEI Σερρών, Σχ. Τεχνολογικών Εφαρμογών, Τμ. Γεωπληροφορικής 
και Τοπογραφϊας, σελ.57. 

Κωνσταντινίδης, Α. (2003). Εφαρμογές των Γεωγραφικών Συστημάτων 
Πληροφοριών (GIS II), Σημειώσεις, TEI Σερρών, Σχ. Τεχνολογικών Εφαρμογών, Τμ. 
Γεωπληροφορικής και Τοπογραφϊας, σελ. 84. 

Κωτσάκης, Χ., Κατσάμπαλος, Κ., Γιαννίου, Μ. (2008). Μοντέλο Μετασχηματισμού 
Συντεταγμένωνν μεταξύ Συστήματος Αναφοράς του HEPOS (HTRS07) και του 
Ελληνικού Γεωδαιτικού Συστήματος Αναφοράς (ΕΓΣΑ’87) - Βασική Μεθοδολογία και 
Αριθμητικά Παραδείγματα, ΤΑΤΜ ΑΠΘ & ΚΤΗΜΑΤΟΛΟΓΙΟ Α.Ε. 

http://www.esri.com/�
http://ccrs.nrcan.gc.ca/resource/tutor/fundam�
http://www.infostar.de/iris�


 204 

Λάγιος, Ε. κ.ά. (2002). Πολυκλαδική Έρευνα Ευρύτερης Περιοχής Αταλάντης. 
[Ερευνητικό Πρόγραμμα, Εκτελέστηκε από το Εθνικό και Καποδιστριακό Πανεπιστήμιο 
Αθηνών (ΕΚΠΑ), με χρηματοδότηση από τον Οργανισμό Αντισεισμικού Σχεδιασμού και 
Προστασίας (ΟΑΣΠ), 2001-2002]. 

Λάγιος, Ε. κ.ά. (2007). TERRAFIRMA: Pan-European Ground Motions Risk 
Assessment Service in Support of Policies Aimed at Protecting the Citizens against 
Natural & Anthropogenic Ground Motion Hazards. Global Monitoring for Environment & 
Security, [Ερευνητικό Πρόγραμμα, Εθνικό και Καποδιστριακό Πανεπιστήμιο Αθηνών 
(ΕΚΠΑ), με χρηματοδότηση από European Space Agency (ESA) & EU, 2004-2007]. 

Lagios, E., Dietrich, V., Stavrakakis, G., Parcharides, I., Sakkas, V., Vassilopoulou, 
Sp. (2001). Will Nisyros Volcano (GR) Become Active ? Seismic Unrest and Crustal 
Deformation. European Geologist , 12, 44-50. 

Lagios, E., Vassilopoulou, S., Sakkas, V., Dietrich, V., Damiata, B.N., & Ganas, A. 
(2007). Testing Satellite and Ground Thermal Imaging of Low-Temperature Fumarolic 
Fields: The Dormant Nisyros Volcano (Greece). ISPRS Journal of Photogrammetry and 
Remote Sensing, 62, 447–460. 

Λέκκας, E.,   (1996). Φυσικές & Τεχνολογικές Καταστροφές. Πανεπιστήμιο Αθηνών, 
Τμήμα Γεωλογίας, Τομέας Δυναμικής-Τεκτονικής-Εφαρμοσμένης Γεωλογίας, σελ. 278. 

Λέκκας, Ε. & Συνεργάτες, (1995). Αντισεισμικός Σχεδιασμός – Οργάνωση Δήμου 
Ρόδου. Εφαρμοσμένο Ερευνητικό Πρόγραμμα. Παν/μιο Αθηνών. 

Lekkas, E., Vassilopoulou, S., Xatzinakos, I. (1998). G.I.S. Aided Landslide 
Management in Ropoto (Trikala – Greece). Raster – Vector Data Treatment. 8th

Lekkas, E., Lozios, S., Papanikolaou, D. & Vassilopoulou, S. (1996). Use of 
Geographical Information Systems (G.I.S.) in Earthquake Emergency Planning at 
Rhodes City - Greece. Seismology in Europe - Proceedings of the XXV General 
Assembly of the European Seismological Commission, p.373-378, Reykjavik, Iceland. 

 
Congress of the IAEG Engineering Geology – A Global view of the Pacific Rim., Editors 
D. P. Moore, O. Hungr. Vol. III, p. 1759 - 1763, Vancouver. 

Μιγκίρος, Γ., Παυλόπουλος Α. & Παρχαρίδης Ισ. (1995). – Τηλεπισκόπηση-
Εφαρμογές στις Γεωεπιστήμες. Πανεπ. Σημειώσεις, Εργαστήριο Ορυκτολογίας-
Γεωλογίας, ΓΠΑ, Αθήνα. 

Mikhail, E.M, Gracie, G. (1981) Analysis and adjustment of survey measurements. 
Van Nostrand Reinhold Company, New York. 

Mingsheng Liao, Timo Balz, Lu Zhang, Yuanyuan Pei, Houjun Jiang (2009). 
Analyzing Terrasar-X And Cosmo-Skymed High-Resolution Sar Data Of Urban Areas (In 
Proceedings of the ISPRS Workshop on HR Earth Imaging for Geospatial Information). 

Μουτσούλας, Μ., Βαϊόπουλος, Δ. (1994). Εισαγωγή στην Πληροφορική 
Πανεπιστήμιο Αθηνών. Σελ.220. 

Μπαλοδήμος, Δ.Δ, Σταθάς, Δ. (1993) Γεωδαιτικά όργανα και μέθοδοι μέτρησης 
γωνιών και μηκών. Σημειώσεις Μαθήματος, ΣΑΤΜ, ΕΜΠ. 

Μπαλοδήμος, Δ.Δ., Σταθάς, Δ., Αραμπατζή, Ο. (2000). Γεωδαισία, Δίκτυα-
Αποτυπώσεις, Χαράξεις.  Σημειώσεις Μαθήματος, ΣΑΤΜ, ΕΜΠ. 

Μπαντέλλας, Α.Γ, Σαββαίδης, Π.Δ., Υφαντής, Ι.Μ., Δούκας, Ι.Δ. (2000). 
Αποτυπώσεις, Χαράξεις Τεχνικών έργων. Τόμοι Ι και ΙΙ. Εκδοση 2η, Αφοι Κυριακίδη 
ΑΕ.   

Μπιλλήρης, Χ. κ.ά (2007). Εισαγωγή στη Γεωδαισία. Σημειώσεις ΕΜΠ, Σχολή 
Αγρονόμων και Τοπογράφων Μηχανικών, Τομέας Τοπογραφίας, Εργαστήριο Ανώτερης 
Γεωδαισίας. 

Νάκος, Β., Φιλιππακοπούλου Β. (1992). Θεματική Χαρτογραφία. Σημειώσεις, ΕΜΠ. 
Νάκος, Β. (2000). Αναλυτική Χαρτογραφία. Σημειώσεις ΕΜΠ. 
Νάκος, Β. (2004). Μαθηματική Χαρτογραφία Σημειώσεις ΕΜΠ. 

http://www.terrafirma.eu.com/�


 205 

Νάκος B. (2004). Μαθηματική Χαρτογραφία (Διατμηματικό Πρόγραμμα 
Μεταπτυχιακών Σπουδών «Ναυτική και Θαλάσσια Τεχνολογία και Επιστήμη», Μάθημα: 
Θαλάσσιος Εντοπισμός και Πλοήγηση - Ενότητα: Χαρτογραφία).    

Ordnance Survey (2002). A Guide to Coordinate Systems in Great Britain. An 
Introduction to Mapping Coordinate Systems and the use of GPS Datasets with 
Ordnance Survey Mapping. p. 43. 

Παπανικολάου,  Δ. (1978) – Γεωλογικαί έρευναι εις την νήσον Άνδρον.  Διατριβή επί 
Διδακτορία. ΕΚΠΑ , σελ. 231. 

Παπανικολάου, Δ., Μουτσούλας, Μ., Λέκκας, Ε., Βασιλοπούλου, Σ., Παπούλια, Ι., 
Φουντούλης,  Δ., Καρβέλης,  Π., Λόγος, Ε. (1995). Χάρτης Ενεργών Ρηγμάτων του 
Ελληνικού Τόξου – Δημιουργία Βάσης Δεδομένων με τη χρήση Γεωγραφικού 
Συστήματος Πληροφοριών. 4ο

Παπανικολάου, Δ., Λέκκας, Ε., Λόζιος, Σ., Παπούλια, Ι., Βασιλοπούλου, Σ.  (1995). 
Νεοτεκτονικός Χάρτης Ανατολικής Αττικής – Χρήση και Εφαρμογή του με τη βοήθεια 
Γεωγραφικού Συστήματος Πληροφοριών. 4

 Πανελλήνο Γεωγραφικό Συνέδριο, Ελληνική Γεωγραφική 
Εταιρεία, 263-278, Αθήνα, 1998. 

ο

Παρδάλης Ν. (1983).  Μαθήματα Γεωδαισίας - Κλασσικής & Ηλεκτρονικής. Τόμοι Α 
και Β. Εκδόσεις Συμμετρία, Αθήνα.  

 Πανελλήνο Γεωγραφικό Συνέδριο, Ελληνική 
Γεωγραφική Εταιρεία, 240-262, Αθήνα, 1998. 

Παρχαρίδης, Ισ. κ.ά. (2009). Χαρτογράφηση της Εδαφικής Παραμόρφωσης στην 
περιοχή του Νομού Ηλείας με την Χρήση της Διαφορικής Συμβολομετρίας από 
Δορυφόρους Ραντάρ. Χαροκόπειο Πανεπιστήμιο, Τμήμα Γεωγραφιας, Τελική Έκθεση, 
Αθήνα 2009. 

Parcharidis I., Lagios E., Sakkas V., Raucoules D., Feurer D., Le Mouelic S., King 
C., Carnec C., Novali F., Ferretti A., Capes R. and Cooksley G. (2006). Subsidence 
monitoring within the Athens basin (Greece) using space radar interferometric 
techniques. Earth, Planets and Space Journal, 58, 505-513. 

Pettinato, S, Santi E., Paloscia, S., Pampaloni, P. and Fontanelli, G. (2013). The 
Intercomparison of X-Band SAR Images from COSMO-SkyMed and TerraSAR-X 
Satellites: Case Studies. Remote Sens. 2013, 5, 2928-2942; doi:10.3390/rs5062928. 

Richards, J. (1993). Remote Sensing Digital Image Analysis. Springer-Verlag, p. 
340. 

Robinson , A., Morrisson, J., Muehrcke, P., Kimerling, A., Guptil, S. (2002). Στοιχεία 
Χαρτογραφίας. Πανεπ. Εκδόσεις ΕΜΠ. Μετάφραση προτότυπου «Elements of 
Cartography (1995), J. Willey & Sons. Inc. (Μετάφραση: Τσιαντούλας Τ. Επιστημονική 
Επιμέλεια: Κάβουρας Μ., Νάκος Β., Τσούλος Λ., Φιλιππακοπούλου Β.), σ.  874. 

Tou, J. T. and R. C. Gonzalez. (1974). Pattern Recognition Principles, Addison-
Wesley Publishing Company, Reading, Massachusetts. 

Sabins, F.F. (1997). Remote sending: (Principles and Ιnterpretation) W.H.Freeman 
and company, N. York. p. 495. 

Sakkas V., Lagios E., Parcharidis Is., Vassilopoulou Sp. (2003). Surface 
Displacement Model of Nisyros Volcanic Field deduced from DinSAR Analysis & DGPS 
Measurements. Bulletin of the Geological Society of Greece, v. 35, 118-128. 

Smith, J. (2005).  Introduction to Geodesy. J Wiley and Sons Inc.  
Συγγρός, Ι. (2002). Coords_Gr, έκδοση 1.60, http://users.auth.gr/kvek/coords_gr.zip 
Συγγρός, Ι. (2004). Μετασχηματισμοί Συντεταγμένων των Γεωγραφικών Δεδομένων 

στον Ελληνικό Χώρο.  
(www.env.gr/myenv/meletes_iliko/yliko/SyngrosYiannisi.pdf). 

Τσούλος,  Λ. (1999). Ψηφιακή Χαρτογραφία. Σημειώσεις ΕΜΠ. 
Torge, W. (2000). Geodesy. Walter de Gruyter. 3rd Edt. Berlin, N York. 
Torge, W. (2000). Γεωδαισία (Μεταφρ). Πανεπιστημιακές Εκδόσεις ΕΜΠ, Αθήνα. 

http://users.auth.gr/kvek/coords_gr.zip�
http://www.env.gr/myenv/meletes_iliko/yliko/SyngrosYiannisi.pdf�


 206 

Tou, J.T. and Gonzalez, R. C. (1974). Pattern Recognition Principles, Addison-
Wesley Publishing Company, Reading, Massachusetts. 

Vassilopoulou, S. (2001).  “PROANA” A Useful Software for Terrain Analysis and 
Geoenvironmental Applications – Study Case on the Geodynamic Evolution of Argolis 
Peninsula, Greece. Proc. 20th 

Vassilopoulou, S. & Hurni, L. (2001). The Use of Digital Elevation Models in 
Emergency and Socio-Economic Planning: A Case Study at Kos – Yali – Nisyros - Tilos 
Islands, Greece. 20

International Cartographic Conference, Beijing, China, pp. 
3432-3440. 

th International Cartographic Conference, Beijing, China. Chinese 
Society of Geodesy, Photogrammetry and Cartography, pp. 3424-3431. 

Vassilopoulou S., Chousianitis K., Sakkas V., Damiata, B. and Lagios E. (2007). 
GIS Development for Ground Deformation Data Management. A Case Study in 
Cephallonia Island (Western Greece). Proc.11

Vassilopoulou, S., Hurni, L., Dietrich, V., Baltsavias, M., Pateraki, M., Lagios, E., 
Parcharidis, Is.  (2002). Ortho-Photo Generation using IKONOS-2 Imagery and High 
Resolution DEM: A Case Study on Volcanic Hazard Monitoring of Nisyros Island 
(Greece), ISPRS Journal of Photogrammetry and Remote Sensing, 57, 24-38 

th

Vassilopoulou S., Chousianitis K., Sarantidis, A., Oikonomou A., Sakkas V., 
Damiata, B.N. and Lagios E. (2007). Development of a GIS System to Analyze Ground 
and Satellite Data of Zakynthos Island (Πρακτικά 8

 International Geological Congress of 
Geological Society of Greece, Athens 24-26 May, 2007, pp. 2070-2081. 

ου

Vassilopoulou, S. (2009). Morphotectonic Analysis of Northern Argolis Peninsula 
based on Ground and Satellite Data using GIS Development. (Πρακτικά 12

 Πανελληνίου Γεωγραφικού 
Συνεδρίου, Αθήνα, 4-7 Οκτωβρίου 2007, τ. 2, σ. 13-23).  

ο

Vassilopoulou S., Sakkas V., Wegmüller U. & Capes R. (2012). Long term & 
Seasonal Ground Deformation Monitoring of Larissa Plain (Central Greece) by 
Persistent Scattering Interferometry. Central European Journal of Geosciences (Υπό 
εκτύπωση). 

 Διεθνούς 
Συνεδρίου της Ελληνικής Γεωλογικής Εταιρείας, 19-22 Μαϊου 2010, Πάτρα). 

Werner, C., Wegmüller, U., Strozzi, T., Wiesmann, A. (2003). Interferometric point 
target analysis for deformation mapping. Proceedings of IGARSS’03 7, 4362-4364. 

Φωτίου Ι., Πικριδάς, Χ. (2012). GPS και Γεωδαιτικές Εφαρμογές, 2η

Χατζόπουλος, Ι. (2012). Γεωχωροπληροφορική Τοπογραφία, Εκδόσεις ΤΖΙΟΛΑ, 
Θεσσαλονίκη, σ. 967. 

 έκδοση, 
Εκδόσεις ΖΗΤΗ, Θεσσαλονίκη, σ. 479. 

Χρίστουλας, Γ. (2010). Η Ανάπτυξη Συστήματος Επεξεργασίας Δεδομένων 
Τηλεπισκόπησης για Αυτόματη Ανίχνευση και Ταξινόμηση Περιοχών με Περιβαλλοντικές 
Αλλοιώσεις. Διδακτορική Διατριβή, Παν/μιιο Πατρών, σ. 82. 

Χρυσουλάκης, Ν., 2011. Αρχές και Εφαρμογές Δορυφορικής Τηλεπικόσπησης 
(http://ph338.edu.physics.uoc.gr/Remote_Sensing_Courses.pdf). 
 
 
 
Ιστότοποι 
 
asterweb.jpl.nasa.gov 
www.esa.int 
www.esa.int/SPECIALS/Eduspace_GR 
www.cartography.ch 
www.edcims.cr.usgs.gov 
www.eurimage.com 

http://www.esa.int/�
http://www.esa.int/SPECIALS/Eduspace_GR�
http://www.cartography.ch/�
http://www.eurimage.com/�


 207 

www.esri.com 
http://ccrs.nrcan.gc.ca 
http://ccrs.nrcan.gc.ca/resource/tutor/fundam/index_e.php 
http://cfis.savagexi.com/2006/04/29/geodetic-coordinate-systems 
http://www.colorado.edu/geography/gcraft/notes/coordsys/coordsys.html 
http://www.colorado.edu/geography/gcraft/notes/datum/datum_f.html 
http://www.colorado.edu/geography/gcraft/notes/mapproj/mapproj_ftoc.html 
http://www.colorado.edu/geography/gcraft/notes/gps/gif/difnav.gif 
http://erg.usgs.gov/isb/pubs/MapProjections/graphics 
www.geography.hunter.cuny.edu 
http://geogr.eduportal.gr/askhseis/geografiast/synt.htm 
www.geowarn.org 
http://grschulemz.googlepages.com/gevgrafikes_syntetagmenes.ppt 
http://www.kowoma.de/index.htm 
http://landsat.gsfc.nasa.gov/education/compositor/ 
www.oso.noaa.gov 
http://www.remsenslab.geol.uoa.gr 
www.spotimage.fr 
http://www.survey.ntua.gr/main/courses/hisatgeodesy/geoastro/lectures/astro_lect9.pdf 
http://www.survey.ntua.gr/main/courses/hisatgeodesy/geoastro/lectures/astro_lect_sum
mary.pdf 
http://www.survey.ntua.gr/main/courses/hisatgeodesy/geoastro/book/GeoAstro_chapter1
0.pdf 
http://www.survey.ntua.gr/main/labs/carto/academic/persons/bnakos_site_nafp/lecture_n
otes/math_carto.pdf 
http://www.spenvis.oma.be/spenvis/help/background/coortran/coortran.html#Introduction 
http://www.teiser.gr/geoplir/mathima501.files/atomiki06_07.pdf 

http://users.auth.gr/~tsoulis/ReferenceFrames_2005_6.ppt 
www.topa.applied-maths.gr/data/GIS/lecture3_270306.pdf 

http://users.auth.gr/~kvek/24_Fotiou_p8_FINAL.pdf 
http://el.wikipedia.org/wiki 
http://en.wikipedia.org/wiki/File:Orbits_around_earth_scale_diagram.svg 
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-
tropics-non.png. 
www.zki.caf.dlr.de 
http://light.physics.auth.gr/enc/radiation.html 
www.oso.noaa.gov 
http://landsat.gsfc.nasa.gov/education/compositor/ 
http://www.astrium-geo.com/en/147-spot-6-7-satellite-imagery). 
http://www.satimagingcorp.com/satellite-sensors/spot-7/ 

http://en.wikipedia.org/wiki/Remote_sensing#mediaviewer/File:Remote_Sensing_Illustrat
ion.jpg 

http://www.au.af.mil/au/awc/awcgate/afspc-fs/uhf.htm {{PD-USGov-Military-Air Force}} 

http://en.wikipedia.org/wiki/Electromagnetic_radiation). 
http://ldcm.nasa.gov/spacecraft_instruments.html 
http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-
spain/ 
http://www.cgg.com/default.aspx?cid=7480 
http://www.isprs.org/proceedings/xxxviii/1_4_7-w5/paper/liao-157.pdf 
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-
tropics-non.png. 

http://www.esri.com/�
http://www.colorado.edu/geography/gcraft/notes/coordsys/coordsys.html�
http://www.colorado.edu/geography/gcraft/notes/datum/datum_f.html�
http://www.colorado.edu/geography/gcraft/notes/mapproj/mapproj_ftoc.html�
http://www.colorado.edu/geography/gcraft/notes/gps/gif/difnav.gif�
http://erg.usgs.gov/isb/pubs/MapProjections/graphics/mercator.gif�
http://www.geography.hunter.cuny.edu/�
http://geogr.eduportal.gr/askhseis/geografiast/synt.htm�
http://www.geowarn.org/�
http://grschulemz.googlepages.com/gevgrafikes_syntetagmenes.ppt�
http://www.kowoma.de/index.htm�
http://landsat.gsfc.nasa.gov/education/compositor/�
http://www.remsenslab.geol.uoa.gr/�
http://www.spotimage.fr/�
http://www.survey.ntua.gr/main/courses/hisatgeodesy/geoastro/lectures/astro_lect9.pdf�
http://www.teiser.gr/geoplir/mathima501.files/atomiki06_07.pdf�
http://users.auth.gr/~kvek/24_Fotiou_p8_FINAL.pdf�
http://el.wikipedia.org/wiki�
http://en.wikipedia.org/wiki/File:Orbits_around_earth_scale_diagram.svg�
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-tropics-non.png�
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-tropics-non.png�
http://www.zki.caf.dlr.de/�
http://en.wikipedia.org/wiki/Electromagnetic_radiation�
http://ldcm.nasa.gov/spacecraft_instruments.html�
http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-spain/�
http://www.satimagingcorp.com/gallery/worldview-3/worldview-3-satellite-image-madrid-spain/�
http://www.isprs.org/proceedings/xxxviii/1_4_7-w5/paper/liao-157.pdf�
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-tropics-non.png�
http://upload.wikimedia.org/wikipedia/commons/a/ab/WorldMapLongLat-eq-circles-tropics-non.png�


 208 

http://en.wikipedia.org/wiki/Electromagnetic_radiation 
http://www.space-airbusds.com/en/programme/tandem-x-3kt.html 
http://www.crisp.nus.edu.sg/~research/tutorial/appendix.htm 

http://en.wikipedia.org/wiki/Electromagnetic_radiation�
http://www.crisp.nus.edu.sg/~research/tutorial/appendix.htm�


 
 

209 
 

 
 
 
 
 
 
 

 
ΠΑΡΑΡΤΗΜΑ 

 
 
 

 
Οι Εργαστηριακές Ασκήσεις που ακολουθούν είναι 
ομαδοποιημένες εργασίες που ως σκοπό έχουν να 

αποτελέσουν βοήθημα για την κατανόηση-εκμάθηση 
απαραίτητων βημάτων  του ArcGIS και του ENVI χρήσιμων σε  

πλήθος εφαρμογών. 
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ΕΡΓΑΣΤΗΡΙΑΚΕΣ ΑΣΚΗΣΕΙΣ 
ΣΕ ΠΕΡΙΒΑΛΛΟΝ ArcGIS  

 
 

ΑΣΚΗΣΗ 1 
Σύνθεση  Χάρτη πολλών Επιπέδων Πληροφορίας - Εφαρμογή σε  

Γεωλογικά – Τεκτονικά – Σεισμολογικά Δεδομένα: 
Δημιουργία Περιβάλλοντος Εργασίας – Απεικόνιση – Συμβολισμός Δεδομένων - 

Δημιουργία Νέων Θεματικών Επιπέδων - Δημιουργία Πεδίων στην Βάση 
Δεδομένων του Θεματικού Επιπέδου - Αλλαγή Θέσης Πεδίου 

 
 

Από:   Start  (DESKTOP των WINDOWS)   →   All Programs   → ArcGIS   
 

Εμφανίζονται  τα εργαλεία - εφαρμογές που περιλαμβάνει το  ArcGIS :  
 

 
 
Η ενεργοποίηση καθεμιάς από τις εφαρμογές του ArcGIS 
επιτυγχάνεται, εφόσον επιλεχθεί  με το ποντίκι. 

 
1. Στο ArcCatalog δημιουργείστε νέο Folder με το όνομα  GIS: 
 Από Κυρίως Μενού:       File →   New Folder 
 



 
 

211 
 

 
 
2. Α. Στο ArcMap δημιουργείστε νέο χάρτη map1.mxd   (File → New → 

Blank Map). 
 
Eν συνεχεία τον αποθηκεύετε ως ακολούθως, στον φάκελο (Folder) εργασίας 
σας, με όνομα GIS, από το κυρίως μενού του χάρτη :      File →  Save as  
→  map.mxd.  
 
Στο επίπεδο εργασίας από View  → Data View φορτώστε τα θεματικά 
επίπεδα (shapefiles) “epic.shp”, “fault.shp”, “geol.shp”, από τον φάκελο  
“askisi1”.  
Ορίστε, εάν δεν εμφανίζεται, στο View → Data Frame Properties → 
General → Display    και    Map Units → Meters. 

 
Β. Στο File → Map Document Properties   και  στο     Pathnames     
επιλέξτε   Store relative pathnames to data sources, προκειμένου  να 
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μεταφέρετε εάν θέλετε αργότερα, το αρχείο του χάρτη σε διαφορετικό Η/Υ, ή 
σε διαφορετικό φάκελο του δίσκου και να είναι εύκολη η περαιτέρω 
επεξεργασία. 
 

 
 
Γ. Ορίστε κλίμακα χάρτη 1/200000 (στο εικονίδιο της κλίμακας, στο κυρίως 
μενού δεξιά από το σύμβολο «+» που χρησιμοποιείται για την εισαγωγή 
θεματικών επιπέδων (add data).  
 
Δ. Αποδώστε σύμβολα στα θεματικά επίπεδα “epic.shp”, “fault.shp”, 
“geol.shp”, βάσει συγκεκριμένων πεδίων (codehm, ID και ID, αντίστοιχα, 
όπου ευρίσκονται στην βάση δεδομένων καθενός και τα βλέπουμε στον 
Attribute Table), ως ακολούθως:  
 
Στην περιοχή των περιεχομένων του χάρτη (Table of Contents) με δεξί κλικ 
του ποντικιού στο όνομα του συγκεκριμένου θεματικού επιπέδου-shapefile 
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→ properties → symbology → categories  →  unique values    →  
Επιλέγετε:   
value field  και δίνετε το πεδίο βάσει του οποίου θα αποδοθεί ο 
συμβολισμός (ID). 
Add all values και εμφανίζονται όλες οι κατηγορίες που περιλαμβάνει το 
επιλεγμένο πεδίο, ενώ απο-επιλέγετε το all other values. 
Τέλος δίνετε:     Apply  και   OK 
 
Ε. Επιλέγετε την μέθοδο Quantities µόνο σε αριθµητικά πεδία µε σκοπό την 
οµαδοποίηση των τιµών. Η μέθοδος Charts επίσης χρησιμοποιείται µόνο σε 
αριθµητικά πεδία και δηµιουργούνται γραφήµατα ανάλογα µε την 
περιγραφική πληροφορία των στοιχείων. Η µέθοδος Multiple Attributes 
δηµιουργεί σύνθετους θεµατικούς χάρτες. 
 
Αποδώστε χρώματα στους γεωλογικούς σχηματισμούς ανάλογα με το 
εμβαδόν τους, εφόσον τους κατηγοριοποιήσετε σε 6 κατηγορίες που 
επιθυμείτε (δεξί κλικ στο geol.shp – Properties – Symbology – Quantities 
– Graduated Colors).   

 
ΣΤ. Δημιουργείστε layer για κάθε θεματικό επίπεδο, το οποίο θα εμπεριέχει 
την χρωματική κλίμακα: Στην περιοχή των περιεχομένων του χάρτη (Table 
of Contents) με δεξί κλικ του ποντικιού στο όνομα του συγκεκριμένου 
θεματικού επιπέδου-shapefile →Save As Layer File  …….. 
 
Ζ. Στο επίπεδο εργασίας View  →  Layout View    δημιουργείστε χάρτη με 
τα ανωτέρω θεματικά επίπεδα και σε διαστάσεις σελίδας Α3.  
 
Η. Ορίστε κάνναβο συντεταγμένων (τα θεματικά επίπεδα έχουν αναφορά στο 
Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς-ΕΓΣΑ΄87 ή Greek Grid.prj - όπως 
δίδεται στο ArcGIS): 
 
 View → Data Frame Properties → Grids → New Grid. Από τον οδηγό, 
ακολουθώντας τις οδηγίες, επιλέγετε την μορφή που επιθυμείτε. 
 
Θ. Δώστε το υπόμνημα, την κλίμακα και το σύμβολο του Βορρά (από 
Κυρίως Μενού  →   Insert). 

 
3. Ετοιμάστε τον χάρτη προς εκτύπωση. Δημιουργείστε αρχείο “jpg”, “tiff”, 

“pdf” κ.ά, με ακρίβεια 300dpi   (File  →  Export Map).  
 
Σημειώνεται ό,τι στην περίπτωση που ο χάρτης εξαχθεί σε αρχείο “pdf", 
είναι δυνατόν να περιέχει και την πληροφορία της γεωαναφοράς: Στο 
“option”  του  παραθύρου “Export Map” και στην καρτέλα ¨Advance”, 
επιλέγετε “Export Map Georeference Information” και  “Export PDF 
Layers and Feature Attributes”. 
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• Το αρχείο εικόνας (raster) που δημιουργήσατε από τον ανωτέρω χάρτη (ή 
και γενικότερα ενός θεματικού επιπέδου ή συνδυασμό πολλών, με τον 
επιθυμητό συμβολισμό), είναι δυνατόν να τo φορτώσετε στο ArcMap και 
να το επεξεργαστείτε, όπως οποιοδήποτε αρχείο «raster», όπως θα δείτε 
σε επόμενη άσκηση. 

 
4. Δημιουργείστε ένα νέο και κενό σημειακό θεματικό επίπεδο τύπου shapefile 

στο ArcCatalog  με το όνομα «points.shp», από  File  →  New Shapefile:  
 

Στο παράθυρο Create New Shapefile δηλώνετε το όνομα    «points.shp» 
και την κατηγορία δεδομένων που θα περιλαμβάνει  (point).    
 
Στην επιλογή Edit ορίζετε το Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς:      
Edit → Select → Projected Coordinate Systems → National Grids → 
Europe  →  Greek Grid.prj.  
 
Προσθέστε το πεδίο (field) με όνομα «code» (ως ακέραιο short integer), ως 
ακολούθως (1ος

 
 τρόπος):  

Δεξί κλικ στο    points.shp  →   Properties →  Fields και καθοδηγείστε από 
τον οδηγό. 

 
5. Δημιουργείστε νέο γραμμικό shapefile στο ArcCatalog με το όνομα 

“line.shp” βάσει του shapefile   “fault1.shp”  (υποδηλώνεται ότι θα πάρει 
την πληροφορία του Γεωδαιτικού Συστήματος Αναφοράς από το fault1.shp):   
Edit → Import και επιλέγετε το   fault1.shp  από τον  Folder όπου 
ευρίσκεται. 

 
6. Στο ArcMap δημιουργείστε νέο χάρτη map2.mxd. Στο Data View φορτώστε 

τα θεματικά επίπεδα “point.shp” και “line.shp”. 
 
7. Στο “line.shp” προσθέστε το πεδίο (field) «code» (ως κείμενο), ως 

ακολούθως (2ος

 
 τρόπος): 

Στο Table of Contetnts, δεξί κλικ στο line.shp  →   Open Attribute Table 
και άνω αριστερά στο εικονίδιο Table Options →  Add Fields και μέσω του 
οδηγού δηλώνετε τα χαρακτηριστικά του πεδίου όπως ανωτέρω. 
 

8. Αλλαγή θέσης πεδίου: Κλικ στο όνομα του πεδίου (γίνεται όλη η στήλη 
μπλε) και το σύρετε στην επιθυμητή θέση, όπου αφήνετε το ποντίκι (η 
εμφάνιση μιας κόκκινης γραμμής δείχνει την νέα θέση που θα τοποθετηθεί το 
πεδίο). 
 
 
****  Δίνεται έτοιμος χάρτης “Map1_f.mxd” ώστε να δείτε παραμέτρους, 
χαρακτηριστικά κ.ά.  
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ΑΣΚΗΣΗ 2 
Διαχείριση & Απεικόνιση Δεδομένων -  Εφαρμογή σε Σεισμολογικά 

Δεδομένα: 
Δημιουργία Σημειακού Θεματικού Επιπέδου από Πίνακα - Συνένωση Πινάκων - 

Οργάνωση Βάσης Δεδομένων Θεματικού Επιπέδου – Αναγωγή από ένα 
Γεωδαιτικό Σύστημα Αναφοράς σε άλλο - Ταξινόμηση και Συμβολισμός 

Δεδομένων - Δημιουργία Μεταδεδομένων - Δημιουργία Γεωβάσης και “Feature 
Class” - Eισαγωγή Αρχείου «Raster» (Εικόνας) - Εισαγωγή Πληροφορίας δύο 

διαφορετικών Πεδίων σε ένα νέο Πεδίο 
 

1. Στο ArcMap δημιουργείστε νέο χάρτη Map2.mxd.  
 
Aπό το αρχείο “epic_cef.dbf” δημιουργείστε ένα σημειακό θεματικό επίπεδο 
(shape file) με το όνομα “epicenter.shp”, στο Παγκόσμιο Γεωδαιτικό 
Σύστημα Αναφοράς WGS’84: 

File → Add Data → Add X Y Data / Επιλογή συντεταγμένων και 
Γεωδαιτικού Συστήματος Αναφοράς → Δημιουργείται το στιγμιαίο αρχείο 
“epic_cef Events”.  
Εν συνεχεία δημιουργείστε το θεματικό επίπεδο (shapefile) “epicenter”:  

Δεξί κλικ στο “epic_cef Events” → Export Data  →  “epicenter.shp” 
 

2. Προσθέστε στον περιγραφικό πίνακα-βάση δεδομένων (Attribute Table) 
του επιπέδου “epicenter.shp”, τον πίνακα “epic_cef_hm.dbf”:  

Δεξί κλικ στο “epicenter.shp” →   Joins and Relates →  Join (Επιλογή 
παραμέτρων, δηλ. πίνακες που θα συνενωθούν, πεδίο με κοινό κωδικό 
βάσει του οποίου θα γίνει η συνένωση κ.ά.). 
 

Εν συνεχεία, δημιουργείστε ένα νέο θεματικό επίπεδο “epicenter1.shp” από 
το    προηγούμενο (μετά την συνένωση), ώστε να διατηρηθεί όλη η 
περιγραφική πληροφορία: 

Δεξί κλικ στο “epicenter.shp” → Export Data  →  “epicenter1.shp” 
 
3. Ανάγετε το “epicenter1.shp” στο Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς, 

δίνοντάς του το όνομα “epichgrs.shp”:  
  ArcToolbox → Data Management Tools → Projections and 
Transformations →  Feature → Project  

 
4. Στο ArcMap φορτώστε το επίπεδο “epichgrs.shp”. Προσθέστε το πεδίο 

(field) “code” (ως ακέραιο – short integer). Στο πεδίο “code” του 
“epichgrshp.s” ταξινομείστε τα επίκεντρα ανάλογα με το μέγεθος Μ και το 
βάθος Η, αναλόγως με τις ακόλουθες κατηγορίες: 

 
      Μ =< 5.5 και Η <= 10  → code = 1 
      Μ =< 5.5 και Η > 10 → code = 2 
      Μ > 5.5 και Η <= 10 → code = 3 
      Μ > 5.5 και Η > 10 → code = 4 
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Από Κυρίως Μενού  → Selection  →  Select by Attributes και από το 
παράθυρο που ανοίγει επιλέγετε παραμέτρους και συνθέτετε τις προτάσεις 
επιλογής στοιχείων μία – μία (βλ. εικόνα που ακολουθεί). 
 
Με Apply επιλέγονται τα ζητούμενα και στον χάρτη και στον Attribute Table.  
 
Στον  Attribute Table επιλέγοντας το πεδίο “code” επιλέγεται ολόκληρη η 
στήλη δεδομένων και με δεξί κλικ και επιλογή Field Calculator, στο 
παράθυρο που ανοίγει δίδεται ο αντίστοιχος κωδικός (1)  που αντιστοιχεί στην 
συγκεκριμένη κατηγορία στοιχείων. 
 
Με τον ίδιο τρόπο δημιουργούνται όλες οι επιθυμητές επιλογές και 
προσδίδονται οι αντίστοιχοι κωδικοί ανά κατηγορία.  
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5. Εμφάνιστε την καρτέλλα  μεταδεδομένων του θεματικού επιπέδου 
«epicenter.shp» και συμπληρώστε  τα απαραίτητα στοιχεία που γνωρίζετε: 
 
ArcCatalog  →   μετακίνηση στον φάκελο με τα δεδομένα «askisi2» και 
εφόσον έχετε επιλέξει την θέση contents  →   επιλογή με αριστερό κλικ του 
«epicenter.shp»  →  επιλογή με αριστερό κλικ στο Description  →  εμφάνιση 
παράθυρου μεταδεδομένων-metadata. 
 
Συμπληρώστε τα στοιχεία που επιθυμείτε εφόσον πρώτα επιλέξτε Edit από το 
παράθυρο μεταδεδομένων.  ενώ στο τέλος δώστε save. Τα στοιχεία που 
δώσατε έχουν αποθηκευθεί και εμφανίζονται στο παράθυρο των 
μεταδεδομένων. 
 
 

.  
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6. Εάν επιλέξετε να δημιουργήσετε “feature class” αντί του “shape file” θα 
πρέπει να έχετε ήδη δημιουργήσει στο ArcCatalog μια Γεωβάση:  
 

File →  New  →  File Geodatabase 
 

Εν συνεχεία, σε αυτήν θα δημιουργείσετε to “feature class”: 
 
File →  New  →  Feature Class  (με το όνομα που επιθυμείτε, δηλ. “epicenter”)  
 

*Εάν θέλετε να εισάγετε στην Γεωβάση  ένα “feature class” ή “shape file” 
από άλλη Γεωβάση, το εισάγετε με import (έχετε ανοίξει την γεωβάση - δεξί 
κλικ στην περιοχή της γεωβάσης και επιλογή import - πλοηγηθείτε στον 
φάκελλο που είναι το  θεματικό επίπεδο που επιθυμείτε και το επιλέγετε – 
ανοίγει το παράθυρο διαλόγου και δίνετε τις παραμέτρους). 

 
7. Προσθήκη πεδίου τύπου «raster» στον «attribute table» του θεματικού 

επιπέδου “epicenter” τύπου Feature Class  και εισαγωγή αρχείου «raster» 
(εικόνας): 

 
Α. Στο ArcMap φορτώστε το επίπεδο “ epicenter”.  
 
Β. Προσθέστε το πεδίο (field) “image” (ως τύπου raster) και διαμορφώστε τις 
παραμέτρους όπως επιθυμείτε (αναλόγως εάν επιθυμείτε η εικόνα να 
διαχειρισθεί ή όχι από την γεωβάση (Managed by GDB) κ.ά.) – δώστε ΟΚ.  
 
Γ. Aπό το κυρίως menu, επιλέγετε Editor και start editing. 
 
Δ. Επιλέγετε το πεδίο στον  attribute table του “ epicenter” – Εφ’οσον είσατε στο 
συγκεκριμένο record που θα φορτώσετε την εικόνα Κλικ στο  τόξο κύλισης  και 
επιλογή Load – πλοηγηθείτε στον φάκελλο που είναι η εικόνα που θα εισάγετε 
και επιλέξτε την εικόνα – Επιλογή Add.  

Εάν η εικόνα δεν έχει καθορισθεί ώστε να διαχειρισθεί από την γεωβάση, το 
παράθυρο διαλόγου μετά το ΟΚ θα κλείσει, αλλιώς, θα παραμείνει ανοικτό θα 
επιλέξετε compression method και value, κατόπιν OK. 

Στο συγκεκριμένο record (στοιχείο) του πεδίου  “image” εμφανίζεται “Raster” - 
με επιλογή του βέλους (δεξιά), εμφανίζεται η εικόνα που εισήχθη. 
 
Είναι δυνατόν σε κάθε record - στοιχείο να φορτωθεί η αντίστοιχη εικόνα. 
 

*Σε κάθε Feature Class  είναι δυνατόν μόνον ένα πεδίο τύπου «raster» να 
προστεθεί στον attribute table. 
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8. Εισαγωγή πληροφορίας δύο διαφορετικών πεδίων σε ένα νέο – Έστω 
του Κωδικού “CODEM” που σχετίζεται με το μέγεθος (Μ) και του κωδικού 
“CODEH” που σχετίζεται με το βάθος (H) στο νέο πεδίο  “CODE_all” : 
 
Α. Δημιουργία νέου πεδίου “CODE_all” τύπου text 
 
B. Στο Field Calculator δίνεται η σχέση που θα συνδυάσει την πληροφορία των 
δύο πεδίων “CODEM” και “CODEH” και θα αποδοθεί στο “CODE_all”: 
 
“M” & [CODEM] & “H” & [CODEH] 
 
Και τέλος δίνετε ΟΚ  
 
 
Εξήγηση: To “M” υποδηλώνει το μέγεθος και το “H” το βάθος. Μετά από το 
κάθε γράμμα ακολουθεί ο συγκεκριμένος κωδικός που αντιστοιχεί στο 
αντίστοιχο πεδίο “CODEM” και “CODEH”, οπότε φαίνεται ποιος κωδικός 
αντιστοιχεί σε ποιο χαρακτηριστικό. 
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ΑΣΚΗΣΗ 3 
 

Γεωαναφορά Χάρτη και Ψηφιοποίηση: 
Προσαρμογή Αρχείου Εικόνας (Τοπογραφικού Χάρτη) σε Πραγματικές Συντεταγμένες - 
Δημιουργία Θεματικού Επιπέδου και Ψηφιοποίηση Δεδομένων από το Αρχείο Εικόνας - 

Περιστροφή Αρχείου Εικόνας 
 

1.  Στο ArcMap δημιουργείστε νέο χάρτη “Ithaki.mxd” και φορτώστε το αρχείο 
εικόνας  “ithaki.tif” (τμήμα του Τοπογραφικού Χάρτη Νήσου Ιθάκης της ΓΥΣ, 
κλίμακας 1/50000), από τον φάκελο «askisi3». 

 
2.  Προσαρμόστε την εικόνα–τοπογραφικό χάρτη, σε πραγματικές συντεταγμένες    

(ΕΓΣΑ΄87): 
 

A. Ορίστε τις μονάδες μέτρησης:  
View → Data Frame Properties → General → Map Units: Meters και 
Display Units: Meters 
 
Β. Προσδιορίστε τα επίγεια σημεία ελέγχου (GCPs): 
 
Η επιλογή των σημείων ελέγχου  γίνεται από την εργαλειοθήκη 
Georeferencing / Add Control Points.  
 

• Όλες οι εργαλειοθήκες φορτώνονται από Κυρίως Μενού → 
Customize → Toolbars →  επιλογή εργαλειοθήκης Georeferencing. 

 
Τα σημεία πρέπει να εμφανίζουν ομοιόμορφη κατανομή τόσο κατά την 
οριζόντια διάσταση της εικόνας όσο και κατά την κατακόρυφη 
(υψόμετρα). 

 
Επιλέγετε κάθε σημείο ελέγχου (με αριστερό κλικ).  Προκειμένου να εισαχθούν 
οι αντίστοιχες συντεταγμένες,  με δεξί κλικ ενεργοποιείται παράθυρο όπου: 

Με Input X and Y →  Enter Coordinates, εισάγονται οι συντεταγμένες 
Με Cancel, ακυρώνεται η διαδικασία εισαγωγής συντεταγμένων  

 
Προκειμένου να προσδιορίζονται οι θέσεις των σημείων με ακρίβεια, 
ενεργοποιείτε από κυρίως εργαλειοθήκη  Window → Magnifier. Δίδεται νέο 
παράθυρο όπου περιλαμβάνει σε  μεγένθυνση την επιλεγμένη περιοχή. 
 
Οι πληροφορίες των σημείων ελέγχου που καθορίζονται με την παραπάνω 
διαδικασία εμφανίζονται από  Georeferencing → View Link Table. 
 

Ο επιτυχής καθορισμός των σημείων ελέγχου κρίνεται από το υπολειμματικό 
σφάλμα του εκάστοτε σημείου, όπως αυτό εμφανίζεται στον αντίστοιχο πίνακα 
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στη στήλη residual, όπως και από το συνολικό Μέσο Τετραγωνικό Σφάλμα 
(Total RMS Error). Οι αποδεκτές τιμές του σφάλματος προκύπτουν εμπειρικά 
μέσω του γενικού κανόνα ότι το σφάλμα δεν θα πρέπει να υπερβαίνει το ½ των 
διαστάσεων του εικονοστοιχείου της προκύπτουσας εικόνας, σε μονάδες 
μέτρησης συντεταγμένων. 
 
Οι σαρωμένες εικόνες τοπογραφικών χαρτών έχουν διαστάσεις οι οποίες 
προκύπτουν από τις επιλογές των καταλλήλων παραμέτρων κατά την διαδικασία 
της σάρωσης τους από scanner σε Η/Υ. Από την επιλογή της ανάλυσης 
σάρωσης (scanning resolution) και το αρχικό μέγεθος του τοπογραφικού χάρτη, 
προκύπτουν ο αριθμός των εικονοστοιχείων (pixels) της σαρωμένης εικόνας 
όπως και οι αντίστοιχες διαστάσεις σε αριθμό γραμμών και στηλών (rows - 
columns), τυπικά χαρακτηριστικά των ψηφιακών εικόνων που επηρεάζουν άμεσα 
την λεπτομέρεια με την οποία αποτυπώνονται οι πληροφορίες του αρχικού 
τοπογραφικού χάρτη στην τελική ψηφιακή του μορφή. Δίδεται ένα παράδειγμα: 
 
 Ανάλυση αρχικού σαρωμένου τοπογραφικού χάρτη:  100 pixels / cm 
 Κλίμακα χάρτη: 1:50.000 

 
Άρα 100 pixels / cm στον χάρτη  =  100 pixels / 500 m (στην πραγματικότητα) 
 
Άρα 500/100 = 5 m διάσταση pixel    και     άρα  5/2 = 2,5 m αποδεκτό σφάλμα 
 
Γ. Η διαδικασία της Γεωαναφοράς ολοκληρώνεται με την ενσωμάτωση των 
πληροφοριών των συντεταγμένων στο αρχείο εικόνας: Georeferencing / update 
georeferencing ή rectify.  
 

Με την επιλογή Update Georeferencing, ανανεώνεται το ήδη υπάρχον 
αρχείο εικόνας, το οποίο εκτός ArcGIS δεν έχει την πληροφορία της 
γεωαναφοράς. 
 
Με την επιλογή Rectify δημιουργείται ένα νέο αρχείο εικόνας 
γεωαναφερόμενο, το οποίο  δύναται να χρησιμοποιηθεί και εκτός 
περιβάλλοντος ArcGIS. 
 

Δ. Καθορίστε τις διαστάσεις του εικονοστοιχείου της παραγόμενης εικόνας, οι 
οποίες συνήθως πλησιάζουν τις προτεινόμενες από το λογισμικό.  Οι 
παρεμβολές που χρησιμοποιούνται είναι: 
 

Νearest neighbour: Η ταχύτερη τεχνική, κατάλληλη για τοπογραφικούς, 
θεματικούς χάρτες κλπ. Χρησιμοποιεί το πλησιέστερο εικονοστοιχείο για την 
παρεμβολή. 
Βilinear interpolation & Cubic convolution: Απαιτητικές τεχνικές σε 
υπολογιστική ισχύ. Χρησιμοποιούν σταθμισμένους μέσους όρους γειτονικών 
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ομάδων εικονοστοιχείων για την παρεμβολή. Είναι  κατάλληλες για συνεχείς 
επιφάνειες, όπως ΨΜΑ, κλπ. 
 

 Ε. Στο ArcCatalog ορίστε το ΕΓΣΑ΄87 στην γεω-αναφερόμενη εικόνα 
“rithaki.tif” που προέκυψε μετά την εφαρμογή “rectify”. 

 
ArcCatalog → Δεξί κλικ στο “rithaki.tif” → Properties → Spatial Reference / 
Edit και επιλογή το Γεωδαιτικό σύστημα Αναφοράς Greek.grd από το παράθυρο 
Spatial Reference Properties → Select → Projected Coordinate Systems → 
Europe  
 
3. Α. Δημιουργείστε στο ArcCatalog νέο γραμμικό θεματικό επίπεδο 
“contours” στο ΕΓΣΑ’87 και προσθέστε το πεδίο “elevation“, με τύπο ακέραιου 
αριθμού.  
 

Β. Στο ArcMap φορτώστε το “contours” και  την εικόνα “rithaki.tif”.  
 

Γ. Ορίστε τις παραμέτρους του snapping  
 

Editor → Snapping → Snapping Window (επιλογή παραμέτρων: vertex, 
end,….) 
Editor → Snapping → Options και δίνετε το snapping tolerance 
(απόσταση  μεγαλύτερη της οποίας να μην ενώνονται τα τόξα) για το 
“contours” 

 
Δ. Αρχίζετε την ψηφιοποίηση: 

       
Editor → Start Editing  → Ανοίγει το παράθυρο Create  
Features και επιλέγετε το θεματικό επίπεδο που θα εισαχθούν τα νέα 
στοιχεία μέσω ψηφιοποίησης.  
 
Από τα εργαλεία του  Editor επιλέγετε το κατάλληλο εργαλείο για 
ψηφιοποίηση και αρχίζετε να ψηφιοποιείτε. 

 
Εισάγετε κάθε μια ισουψή στο “contours” δίνοντας το αντίστοιχο υψόμετρο  
της  στο πεδίο “elevation“. 
 
Ε. Απαραίτητη είναι η αποθήκευση των στοιχείων, ανά τακτά χρονικά 
διαστήματα (Editor → Save Edits). Όταν θα έχει τελειώσει η ψηφιοποίηση, 
δώστε Editor → Stop Editing και Save Edits. 
 
ΣΤ. Ανά τακτά χρονικά διαστήματα και στο τέλος της εργασίας αποθηκεύετε 
τον χάρτη “Ithaki.mxd” (Save από κυρίως εργαλειοθήκη). 
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Επιλέγοντας το εργαλείο  “rotate”    και με κλικ επάνω στην εικόνα, την 
περιστρέφετε όπως επιθυμείτε. 

 
 

 
 
 
 
 

ΑΣΚΗΣΗ 4 
Αυτόματη & Ημιαυτόματη Ψηφιοποίηση από Αρχείο Καννάβου (GRID) - 
Επεξεργασία Αρχείου Καννάβου - Δημιουργία Διανυσματικού Επιπέδου 

Πληροφορίας & Ψηφιοποίηση 
 

1. Δημιουργείστε γραμμικό θεματικό επίπεδο (shapefile) στο ArcCatalog με 
το όνομα contour1 και γεωαναφορά στο ΕΓΣΑ’87, (βάσει του θεματικού 
επιπέδου μορφής καννάβου-grid contgrd). 
 
2. Εισάγετε στο ArcMap το θεματικό επίπεδο contgrd (γεωαναφορά στο 
ΕΓΣΑ’87), το οποίο περιέχει ισοϋψείς. Στην τιμή κυψελίδας «0» (backround) 
αποδώστε λευκό χρώμα (τιμή 255 στο RGB), ενώ στην τιμή «1» (ισοϋψείς) 
μαύρο χρώμα (τιμή 0 στο RGB). 
 
3. Εισάγετε το θεματικό επίπεδο contour1 στο ArcMap. Ενεργοποιείστε το 
Editing μέσω Editor. (Όταν θα έχει τελειώσει η ψηφιοποίηση, δώστε Save Edits 
και Stop Editing).  
 
4. Προκειμένου να μετατραπούν οι ισοϋψείς από το αρχείο καννάβου 
contgrd, σε διανυσματική (vector) μορφή, μέσω αυτόματης ή ημιαυτόματης 
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ψηφιοποίησης ενεργοποείστε και εισάγετε την εργαλειοθήκη ArcScan (από 
κυρίως menu:  ArcScan (από κυρίως menu:  Customize → Extensions → 
ArcScan     και  Customize → Toolbars → ArcScan ).    
 
5. Από Vectorization → Show Preview, δίδεται μια εικόνα της 
διανυσματοποίησης.  

 
6. Από Edit Raster Snapping Options, Vectorization → Options, 
Vectorization Settings, και Editor menu → Snapping, καθορίζονται 
παράμετροι διανυσματοποίησης. 

 
7. Επιλέγοντας Vectorization → Generate Features επιτυγχάνεται 
αυτόματα η διανυσματοποίηση των ισοϋψών, από το contgrd. Οι ισουψείς 
προστίθενται στο θεματικό επίπεδο contour1, το οποίο ορίζεται στον πίνακα 
Generate Features. 

 
8. Με το Generate Features Inside Area, επιτυγχάνεται αυτόματη 
διανυσματοποίηση σε επιθυμητό τμήμα του χάρτη. 
 
9. Με το Vectorization Trace επιτυγχάνεται διανυσματοποίηση τμηματικά, 
εφόσον καθορισθεί ένα αρχικό σημείο εκκίνησης και η διεύθυνση ψηφιοποίησης 
συγκεκριμένης ισοϋψούς. Όταν ολοκληρωθεί η ψηφιοποίηση της ισοϋψούς, με 
διπλό κλικ σταματά η ψηφιοποίηση. 

 
10. Με Raster Cleanup → Start Cleanup και εφόσον επιλεγούν τμήματα της 
εικόνας μέσω Select connected Cell διαγράφονται ή γεμίζουν κενά με Erase 
Selected Cells ή Fill Selected Cells, αντίστοιχα. Με Raster Cleanup →  Raster 
Painting Toolbar, εμφανίζεται το Raster Painting Toolbar. Χρησιμοποιείστε το  
Erase Tool  και το Magic Erase Tool   και καθαρίστε το αρχείο από τυχόν 
ανεπιθύμητες γραμμές κ.ά. 

 
11. Eνημερώσατε την βάση (attribute table) του contour1 με το υψόμετρο 
κάθε ισοϋψούς στο πεδίο elevation, το οποίο θα προσθέσετε προηγουμένως 
στον «attribute table» (για την διαδικασία βλ. άσκηση 1 & 2). 
 
 
 

AΣΚΗΣΗ  5  
Δημιουργία Θεματικών Επιπέδων Αναλύσεως Αναγλύφου: 

Δημιουργία ΨΜΑ (δομής ΤΙΝ και GRID) - Υπολογισμός Εμβαδού και Όγκου 
Μοντέλου - Δημιουργία Τοπογραφικής Τομής 

Δημιουργία Ισοϋψών - Μορφολογικών Κλίσεων - Προσανατολισμού των 
Κλίσεων- Υδρογραφικού Δικτύου - Σκιασμένου Αναγλύφου  

 
1. Στο ArcMap δημιουργείστε νέο χάρτη «Map5.mxd». 
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Μέσω του 3-D Analyst, δημιουργείστε ψηφιακό μοντέλο αναγλύφου (ΨΜΑ) 
δομής TIN με το όνομα “tin1” : 
 
  ArcToolbox → 3D Analyst Tools → TIN Management → Create TIN 
 
Στο παράθυρο-οδηγό που θα ανοίξει για την δημιουργία του ΨΜΑ, δώστε τα 
θεματικά επίπεδα: 
 
“contour” (ισοϋψείς - στο παράθυρο-οδηγό θα το ορίσετε ως  hard line)  
“ elevpnt ” (υψομετρικά σημεία – θα το ορίσετε ως mass point) 
“ river ” (υδρογραφικό δίκτυο – θα το ορίσετε ως soft line) 
“ boundary ” (όριο περιοχής – θα το ορίσετε ως soft clip).  
 
2. Δημιουργείστε από το “tin1” ένα ΨΜΑ δομής GRID με το όνομα  “grid1”: 
 
   ArcToolbox → 3D Analyst Tools → Conversion → From TIN → Tin to 
Raster 
 
3. Αποδώστε τα υψόμετρα “grid1” ανά 200m με χρωματική κλίμακα. 

 
4. Στο ArcMap, δημιουργείστε ψηφιακό μοντέλο αναγλύφου (ΨΜΑ) μορφής 
GRID απευθείας από αρχικά τοπογραφικά δεδομένα με το όνομα “grid2”, μέσω 
του παραθύρου-οδηγού που θα ανοίξει, από τα θεματικά επίπεδα:  

 
“contour” (ισοϋψείς - line) 
“elevpnt” (υψομετρικά σημεία - point) 
“river” (υδρογραφικό δίκτυο - line) 
“boundary” (όριο περιοχής - polygon).  
 
(Τα θεματικά επίπεδα δύνανται να είναι coverages ή feature classes ή shapefiles) 
 
Χρησιμοποιείστε την εντολή Topo to Raster, η οποία είναι εφαρμογή του 
αλγορίθμου TopoGrid του ArcInfo Workstation 7.x., όπου εξακολουθεί να 
υφίσταται. Ο αλγόριθμος έχει προσαρμοσθεί στο 3-D Analyst και στο Spatial 
Analyst. Η εφαρμογή του γίνεται στο ArcMap μέσω του ArcToolbox : 
 
ArcMap → ArcToolbox → Spatial Analyst Tools → Interpolation → Topo to 
Raster 
 
Στο παράθυρο-οδηγό που θα ανοίξει, για κάθε θεματικό επίπεδο δίνεται τον τύπο 
των δεδομένων που περιέχει (contour, elevation point, stream, boundary etc.) και 
το πεδίο, στο οποίο εμπεριέχεται το υψόμετρο, όπου αυτό υπάρχει. 
 
Ορίζετε τις απαραίτητες παραμέτρους καθοδηγούμενοι από τις επεξηγήσεις που 
δίνονται στο παράθυρο (κάνοντας κλικ στην περιοχή που θα ορίσετε την τιμή  
κάθε παραμέτρου) 
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Από το κάτω τμήμα του παραθύρου, επιλέγετε environments….. → Raster 
Storage → Cubic or Bilinear. 
 

Είναι δυνατή η εφαρμογή του αλγορίθμου με χρήση ενός αρχείου, όπως 
δίνεται παρακάτω «topotoraster.txt», στο οποίο δίδονται όλα τα θεματικά 
επίπεδα, ο τύπος τους, τα πεδία υψομέτρου και οι απαραίτητες παράμετροι : 
 

ArcMap → ArcToolbox → Spatial Analyst Tools → Raster Interpolation → 
Topo to Raster by file 
 
 

topotoraster.txt 
 
Contour C:\DATA\LECTURES \SHP_5\contour\arc  CONTOUR -ID 
Point C:\DATA\LECTURES \SHP_5\elevpnt\point  ELEVPNT-ID 
Stream C:\DATA\LECTURES \SHP_5\ river\arc 
Boundary C:\DATA\LECTURES \SHP_5\boundary\polygon  
ENFORCE ON 
DATATYPE CONTOUR 
ITERATIONS 40 
ROUGHNESS_PENALTY 0.00000000000 
DISCRETE_ERROR_FACTOR 1.00000000000 
VERTICAL_STANDARD_ERROR 0.00000000000 
TOLERANCES 2.50000000000 100.00000000000 
CELL_SIZE 40 
OUT_STREAM 
OUT_SINK 
OUT_DIAGNOSTICS C:\DATA\LECTURES \SHP_5\ttr_diag.txt 
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5. Δημιουργείστε από το “grid2” τα παρακάτω θεματικά επίπεδα: 
Contour (ισοϋψείς) 
Slope (μορφολογικές κλίσεις) 
Aspect (προσανατολισμό κλίσεων) 
Gridshd (τρισδιάστατη όψη ανάλογα με το ποιας διεύθυνσης τεκτονικές δομές και 
μορφολογικές ασυνέχειες επιθυμείτε να διακρίνονται) 
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  ArcToolbox → 3D Analyst Tools → Raster Surface ……….  
 
 
6. Υπολογίστε το εμβαδόν του μοντέλου “grid2” και τον όγκο του σε υψόμετρο 

50m και άνω: 
 
 ArcToolbox → 3D Analyst Tools → Functional Surface → Surface Volume 

 
 

7. Δημιουργείστε τοπογραφική τομή στο “grid2” συγκεκριμένης διεύθυνσης 
μέσω του 3-D Analyst : 

Main Menu → Eργαλειοθήκη 3-D Analyst →   (interpolate line) →  
 

Χάραξη τομής στον Χάρτη →  επιλογή (Create Profile Graph) →   
 
Εμφάνιση Τομής →  
 
Δεξί κλικ στο άνω γαλάζιο τμήμα της τομής (Profile Graph Title) →  
 
Εππιλογή Properties  (για ρύθμιση παραμέτρων τομής) 
 
ή  Επιλογή Export  (για επιλογή τύπου εικόνας που θα εξαχθεί) 
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ΑΣΚΗΣΗ 6 
Πράξεις μεταξύ GRID – Δημιουργία Λεκανών Απορροής – Δημιουργία 

Υδρογραφικού Δικτύου (raster και vector) – Ταξινόμηση 
Υδρογραφικού Δικτύου – Απεικόνιση Δεδομένων στο ArcScene 

 
 
1. Ανοίγετε το ArcMap και δημιουργείτε νέο χάρτη “Map6.mxd” 

 
2. Φορτώνετε τα δύο ΨΜΑ “grid2” και “grid1” (από την προηγούμενη άσκηση) 

 
3. Αφαιρέστε τα 2 grid (3D Analyst Tools →  Raster Math →  Minus). Τι 

παρατηρείτε? 
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4. Από το εργαλείο Hydrology του Spatial Analyst Tools του ArcToolbox 
επιλέξτε: 

 
Fill (Για διόρθωση σφαλμάτων sinks) 
 
Flow Direction (Για δημιουργία θεματικού επιπέδου δομής “raster” 
διεύθυνσης ροής ύδατος) 
 
Basin  / watershed (Για δημιουργία θεματικού επιπέδου δομής “raster” 
λεκανών απορροής) 
 
Flow Accumulation (Για δημιουργία θεματικού επιπέδου δομής “raster” 
συσσώρευσης ύδατος κατηφορικά σε κάθε κελί) 
 

5.  Από ArcToolbox → Spatial Analyst →  Conditional  →  Set Null ή Con 
 
Δημιουργείστε streams (υδρογραφικό δίκτυο):    
 
streamnet = setnull (flowacc < 100, 1)  :   (π.χ. επιλογή 100 σημαίνει ότι όλα τα 
κελιά που περισσότερα από 100 κελιά ρέουν σε αυτά, συνιστούν υδρογραφικό 
δίκτυο με τιμή κλάδων 1, τα υπόλοιπα δίδονται ως nodata) 
ή 
streamnet = con (flowacc > 100, 1) :  (όλα τα κελιά που περισσότερα από 100 
κελιά ρέουν σε αυτά, συνιστούν υδρογραφικό δίκτυο με τιμή κλάδων 1, τα 
υπόλοιπα δίδονται ως nodata) 
 
Δηλώνετε τις παραμέτρους 
 
input raster : δίνετε το επίπεδο που δημιουργήθηκε από το Flow Accumulation 
 
Input true or constant  :   1 
 
Output raster :  δίνετε όνομα  
 
Expression :  value > 100 
 
6. Ταξινομείστε το υδρογραφκό δίκτυο από ArcToolbox → Spatial Analyst → 

Tools Hydrology → Stream Order  
 
7.  Μετατρέψτε το υδρογραφκό δίκτυο σε διανυσματική μορφή: 
 
ArcToolbox → Spatial Analyst → Tools Hydrology → Stream to Feature 
 
8. Ανοίξτε το  ArcScene, από την κυρίως εργαλειοθήκη του ArcMap.  
 
Φορτώστε το ΨΜΑ.  
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Με δεξί κλικ → Properties → Symbology, στο όνομα του ΨΜΑ, αποδώστε στο 
ανάγλυφο την επιθυμητή χρωματική κλίμακα.   
 
Με δεξί κλικ → Properties → Base Heights, ρυθμίστε τις παραμέτρους ώστε να 
έχετε την οπτικοποίηση που επιθυμείτε.  
 
Φορτώστε ακτογραμμή, ρήγματα κ.ά. και ρυθμίστε τις παραμέτρους 
οπτικοποίησης. 
 
 
 
 

ΑΣΚΗΣΗ 7 
Δημιουργία Ζωνών Επιρροής (Buffer)  - Δημιουργία Διαγραμμάτων 

(Graphs) - Εύρεση Εμβαδού (Area) & Περιμέτρου (Perimeter) 
Πολυγωνικών Στοιχείων – Επεξεργασία & Διόρθωση Γραμμικών και 

Πολυγωνικών Στοιχείων – Μετατροπή από “shapefile” σε “coverage”  
 
 

1. Στο ArcMap δημιουργείστε χάρτη Map7a.mxd.  
 
Στο Data View φορτώστε τα θεματικά επίπεδα (shapefiles) “fault.shp” και 
“geol.shp”. Ορίστε κλίμακα χάρτη 1/100000. Αποδώστε σύμβολα στα θεματικά 
επίπεδα βάσει συγκεκριμένων πεδίων-fields (id και geolc1-id αντίστοιχα) όπου 
ευρίσκονται στην βάση δεδομένων καθενός και τα βλέπουμε στον Attribute 
Table. Δημιουργείστε layers.  
 
2. Στο “fault” προσθέστε το πεδίο (field) character (ως ακέραιο). Ενημερώστε 
το πεδίο με συγκεκριμένη τιμή ανά κοινό Ιd. Δημιουργείστε ζώνες επιρροής 
(Buffer) πλάτους 200m εκατέρωθεν των ρηγμάτων με χρήση του Buffer Wizard  
από το  Tools menu. 
 
(Προσθέστε το Buffer Wizard  στο Tools menu: Από το  Tools menu → 
Customize και επιλέγετε Commands tab. Στο Categories list  → Tools → 
Buffer Wizard από το Commands list. Τέλος, σύρετε στο Tools menu του Main 
menu του ArcMap το Buffer Wizard). 
 
3. Εισάγετε το θεματικό επίπεδο των σεισμικών επικέντρων “epic01up5.shp”. 
Δημιουργείστε γράφημα (Main Menu ArcMap → View → Graphs → Create / 
scatter plot) μεταξύ του μεγέθους (άξονας Χ) και του βάθους (άξονας Υ). Δώστε 
τίτλο γραφήματος, τίτλους αξόνων, υπόμνημα. Εξαγάγετε το γράφημα σε αρχείο 
“jpg”. 
 
4. Υπολογίστε εμβαδόν (Area) και περίμετρο (Perimeter) των γεωλογικών 
σχηματισμών.  
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Προσθέστε τα πεδία Area1 και Perimeter1 στον Attribute Table, ως διπλής 
ακρίβειας δεκαδικό (double). 
 
Προκειμένου να ενημερώσετε τον Attribute Table με το εμβαδόν των 
σχηματισμών επιλέγετε όλες τις γραμμές – record (δηλ. όλα τα στοιχεία-
δεδομενα) 
   Δεξί κλικ στο όνομα του πεδίου Area1  →  Calculate Geometry  (Δίνω 
επιλογή Area στο Property) →  Έχει υπολογισθεί το εμβαδόν 
 
Με τον ίδιο τρόπο υπολογίζετε η περίμετρος κ.ά. 
 
5. Στο Layout View δημιουργείστε χάρτη με τα ανωτέρω θεματικά επίπεδα 
και σε διαστάσεις σελίδας Α3. Ορίστε κάνναβο συντεταγμένων στο Ελληνικό 
Γεωδαιτικό Σύστημα Αναφοράς (ΕΓΣΑ΄87). Δώστε το υπόμνημα, την κλίμακα και 
το σύμβολο του Βορρά. 
 
6. Ετοιμάστε τον χάρτη προς εκτύπωση. Δημιουργείστε αρχείο “jpg”, με 
ακρίβεια 300dpi (File → Export Map). 
 
7. Δημιουργείστε γραμμικό θεματικό επίπεδο (shapefile) στο ArcCatalog με 
το όνομα contour7 και γεωαναφορά στο ΕΓΣΑ’87, (βάσει του θεματικού 
επιπέδου μορφής καννάβου-grid contgrd). Προσθέστε το πεδίο (field) “elevation”  
ως ακέραιο. 
 
Δημιουργείστε στο ArcMap νέο χάρτη (Map7b.mxd) το θεματικό επίπεδο (grid 
μορφής) contgrd (γεωαναφορά στο ΕΓΣΑ’87), το οποίο περιέχει ισοϋψείς. Στην 
τιμή κυψελίδας «0» (backround) αποδώστε λευκό χρώμα (τιμή 255 στο RGB), 
ενώ στην τιμή «1» (ισοϋψείς) μαύρο χρώμα (τιμή 0 στο RGB). 
 
Εισάγετε το θεματικό επίπεδο contour7 στο ArcMap. Ενεργοποιήστε το Editing 
μέσω Editor. Ξεκινήστε την ψηφιοποίηση ισοϋψών (Editor Menu → Task / 
Create New Feature και Target / contour7), εφόσον έχετε προσδιορίσει τις 
παραμέτρους ψηφιοποίησης (Editor menu → Snapping και Editor menu → 
Options).  
 
Για κάθε ισοϋψή δώστε στο πεδίο elevation του Attribute Table το υψόμετρο. 
 
Επιλέγοντας ένα τόξο-γραμμή, είναι δυνατή η επεξεργασία του:  

Move (μετακίνηση τόξου σε συγκεκριμένη διεύθυνση κατά χ,y) 
Split (διαίρεση τόξου σε 2 τόξα) 
Divide (δημιουργία σημείων σε ίσα διαστήματα κατά μήκος του τόξου) 
Copy Parallel (αντιγραφή επιλεγμένου τόξου σε συγκεκριμένη απόσταση) 
Eφόσον έχετε επιλέξει 2 ή περισσότερα τόξα Merge (δημιουργία ενός 
στοιχείου, δεν αλλάζει το σχήμα αλλά δημιουργείται ένα record στον Attribute 
Table). 
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Από Editor  → More Editing Tools  → Advanced Editing  → Generalize,  
Smooth κ.ά. 
 
Όταν θα έχει τελειώσει η ψηφιοποίηση, δώστε Save Edits και Stop Editing.  
 
8. Δημιουργείστε πολυγωνικό θεματικό επίπεδο (shapefile) στο ArcCatalog 
με το όνομα geol7 και γεωαναφορά στο ΕΓΣΑ’87, (βάσει του θεματικού επιπέδου 
μορφής καννάβου-grid contgrd). 
 
Εισάγετε στο ArcMap το θεματικό επίπεδο (grid μορφής) geolgrd (γεωαναφορά 
στο ΕΓΣΑ’87), το οποίο περιέχει γεωλογικούς σχηματισμούς. 
 
Εισάγετε το θεματικό επίπεδο geol7 στο ArcMap. Ενεργοποιήστε το Editing 
μέσω Editor. Ξεκινήστε την ψηφιοποίηση γεωλογικών ορίων (πολύγωνα), 
εφόσον έχετε προσδιορίσει τις παραμέτρους ψηφιοποίησης.  
 
Από Task / Auto-complete polygon και εφόσον έχετε επιλέξει το πολύγωνο στο 
οποίο θα ενωθεί ένα γειτονικό διατηρώντας το περίγραμμα του επιλεγμένου, 
ψηφιοποιείτε το δεύτερο. 
 
Επεξεργάζεστε τα όρια πολυγώνων με Editor  → More Editing Tools  → 
Advanced Editing  → Generalize, Smooth κ.ά. 
 
Από Editor δοκιμάστε τις εντολές merge, union, intersect, εφόσον έχετε 
επιλέξει 2 γειτονικά πολύγωνα. 

merge (ενσωματώνονται σε  ένα πολύγωνο και στον Atribute Table σε 1 
record),  
union (προστίθεται  1 νέο πολύγωνο στο οποίο έχουν συγχωνευθεί τα 2 και 
στον Atribute Table 1 record, ενώ διατηρούνται τα προηγούμενα),  
intersect (δημιουργείται 1 νέο πολύγωνο – η κοινή περιοχή των 2 και στον 
Atribute Table σε 1 record, ενώ διατηρούνται τα προηγούμενα), 

 
Από Task / Cut polygon feature και εφόσον έχετε επιλέξει το πολύγωνο το 
οποίο θα διαιρέσετε, ψηφιοποιείτε 1 ή 2 κ.λ.π πολύγωνα που θα το διαιρέσουν. 
 
Όταν θα έχει τελειώσει, δώστε Save Edits και Stop Editing.  
 
9. Μετατρέψατε τo θεματικό επίπεδο “geol7.shp” μορφής shapefile σε  ArcInfo 
coverage “geol7c” (Arctoolbox – Convertion Tools – To Coverage – Feature 
Class to Coverage).      
 
Μια από τις σημαντικές διαφορές του   coverage ως προς το  shapefile είναι ότι 
ορίζεται πραγματική τοπολογία (σημειακή, γραμμική ή πολυγωνική) και εάν είναι 
απαραίτητο για την μελέτη δύναται να ορισθεί και διπλή τοπολογία (π.χ. 
πολυγωνική και γραμμική, γραμμική και σημειακή κ.ά.). Η τοπολογία ορίζεται με 
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την εφαρμογή της εντολής “build” είτε στο ArcInfo Workstation είτε μέσω 
Arctoolbox ως ακολούθως: Arctoolbox – Data Management – Topology - Build. 
 
Απαραίτητο είναι να έχουν γίνει οι διορθώσεις λαθών κ.ά. στο θεματικό επίπεδο, 
προτού ορισθεί η τοπολογία. Για τα πολυγωνικά θεματικά επίπεδα προηγείται η 
εφαρμογή της εντολής “clean” για αυτόματη διόρθωση λαθών (Arctoolbox – 
Data Management – Topology - Clean). 
 
 
 

ΑΣΚΗΣΗ 8 
 

Εμφάνιση Labels - Selectable & Not Selectable Θεματικά Επίπεδα - 
Identity - Find - Measure - Bookmarks - Map Tips – Προσθήκη & 

Ενεργοποίηση – Απενεργοποίηση Data Frame 
 
1. Στο ArcMap δημιουργείστε χάρτη Map8.mxd.  
 
Στο Data View φορτώστε τα θεματικά επίπεδα (shapefiles) “fault1.shp” και 
“geol.shp”. Ορίστε κλίμακα χάρτη 1/150000. Αποδώστε σύμβολα στα θεματικά 
επίπεδα βάσει συγκεκριμένων πεδίων-fields (fault1-id και geol-id αντίστοιχα) 
όπου ευρίσκονται στην βάση δεδομένων καθενός (Attribute Table). 
Δημιουργείστε layer για το καθένα.  
 
2. Εμφανίστε στο χάρτη τις τιμές του πεδίου fault1-id των ρηγμάτων : 
                   Στον πίνακα περιεχομένων Table of Contents του ArcMap - δεξί 

κλικ στο fault1.shp – Properties – Labels :   
                                 v -  label features in this layer 
                        Method:  Label all the features by the same way 
                        Label Field: Id    
                                                           Apply – OK 
 
3. Εμφανίστε τις τιμές των πεδίων-παραμέτρους κάθε ρήγματος στην οθόνη, 
επιλέγοντας 1-1 ρήγμα (Επιλογή με identify).  
 
4. Ενεργοποίηση συγκεκριμένων θεματικών επιπέδων προκειμένου να 
επιλέγονται τα στοιχεία τους:     

 
Εφόσον στον χάρτη έχετε περισσότερα του ενός θεματικά επίπεδα, επιλέγοντας 
τα στοιχεία συγκεκριμένου θεματικού επιπέδου, επιλέγονται συνήθως στοιχεία 

διαφορετικού. Προκειμένου να αποφευχθεί αυτό, επιλέγετε την καρτέλλα  
List by Selection (στο άνω τμήμα του πίνακα περιεχομένων Table of Contents  
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του ArcMap) και εν συνεχεία πατήστε στο εικονίδιο  Click to toggle 
selectable  (δεξιά του θεματικού επιπέδου που επιθυμείτε να επιλέξετε), οπότε 
το θεματικό επίπεδο θα είναι στην περιοχή “Selectable”.  

 
Για ακύρωση πατήστε ξανά στο εικονίδιο Click to toggle selectable  οπότε το 
θεματικό επίπεδο θα είναι στην περιοχή “Not Selectable” 
 
Είναι δυνατόν να επιλέξετε όσα θεματικά επίπεδα επιθυμείτε. 
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5. Αναζητήστε μέσω του εργαλείου Find  (στο κυρίως μενου), τα 
ρήγματα με id = 3: 
                Παράθυρο Find  
                    Find: 3 
                    In:      Fault 
                    In fields: Id  
                                                 Find 
 
Εμφανίζονται στο κάτω τμήμα του παραθύρου τα ζητούμενα. Με δεξί κλικ σε ένα 
στοιχείο, εμφανίζεται ένα μενού όπου επιλέγοντας συγκεκριμένες εντολές, το εν 
λόγω στοιχείο αναβοσβήνει στιγμιαία στον χάρτη (με επιλογή Flash feature) κ.ά. 
Δοκιμάστε όλες τις επιλογές. 
 
6. Εστιάστε αυτόματα στην περιοχή συγκεκριμένων στοιχείων του 
χάρτη, έστω στην περιοχή όπου ευρίσκονται ρήγματα με id = 4, μέσω των 
Βookmarks (σελιδοδείκτες): 

a. Αρχικά επιλέγετε ρήγματα με id = 4. Με zoom in εστιάζετε στην 
περιοχή των συγκεκριμένων ρηγμάτων. 
b. Από την κυρίως εργαλειοθήκη του ArcMap επιλέγετε Bookmarks – 
Create – Bookmark Name: fault4 – OK 
c. Επανέλθετε στο Full Extent του χάρτη 
d. Μεταφερθείτε στο Bookmark “fault4”: Bookmarks – fault4 

Έχετε μεταφερθεί αυτόματα στην περιοχή των ρηγμάτων με id = 4 και με την 
συγκεκριμένη μεγένθυνση που είχατε ορίσει κατά την δημιουργία του 
συγκεκριμένου Bookmark. 
Τα Bookmarks σβήνονται κ.ά. από Bookmarks – Manage.  
Τα Bookmarks αποθηκεύονται στον χάρτη εφόσον αποθηκευθεί και ο χάρτης. 
 
7. Μετρήστε στην οθόνη 1-1 το μήκος των ρηγμάτων με id = 4 (εργαλείο 
Measure).  
 
8. Χρησιμοποιήστε την λειτουργία των Map Tips ώστε εφόσον πλοηγείστε 
στον χάρτη να εμφανίζεται η επιθυμητή περιγραφική πληροφορία των στοιχείων 
του χάρτη. Προσπαθείστε να εμφανίζετε το εμβαδόν κάθε γεωλογικού 
σχηματισμού. 

• Στον πίνακα περιεχομένων του ArcMap - δεξί κλικ στο geol.shp – 
Εμφάνιση παραθύρου Layer Properties – Επιλογή του Display - 
ενεργοποίηση με τσεκ του Show Map Tips using the display 
expression 

• Ορίζετε το πεδίο (field), του οποίου η τιμή θα εμφανίζεται στον χάρτη: 
επιλογή στο  Expression – επιλογή του πεδίου AREA στο παράθυρο που 
άνοιξε -  ΟΚ και το παράθυρο κλείνει 

• Επιλογή ΟΚ στο παράθυρο Layer Properties και κλείνει 
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Μετακινείτε τον κέρσορα στον χάρτη και αφήνοντας τον  για λίγο ακίνητο σε κάθε 
γεωλογικό σχηματισμό εμφανίζεται η τιμή του εμβαδού (AREA) καθενός.  
 
9. Στο Layout View δημιουργείστε χάρτη με τα ανωτέρω θεματικά επίπεδα 
και σε διαστάσεις σελίδας Α3. Ορίστε κάνναβο συντεταγμένων στο Ελληνικό 
Γεωδαιτικό Σύστημα Αναφοράς (ΕΓΣΑ΄87). Δώστε το υπόμνημα, την κλίμακα και 
το σύμβολο του Βορρά. 
 
10. Ετοιμάστε τον χάρτη προς εκτύπωση. Δημιουργείστε αρχείο “jpg”, με 
ακρίβεια 300dpi. 
 
11. Προσθέστε νέο Data Frame  στον χάρτη (Κυρίως εργαλειοθήκη – Insert - 
Data Frame) και προσθέστε το θεματικό επίπεδο epic.shp (δεξί κλικ στο νέο  
Data Frame  και add data το epic.shp.  
 
Κάθε φορά εμφανίζεται το επιθυμητό Data Frame  με τα στοιχεία του μέσω του 
Activate (δεξί κλικ στο  Data Frame  και Activate). Κατά αυτόν τον τρόπο, έχετε 
διαχωρίσει τον χάρτη σε ενότητες και εμφανίζονται κάθε φορά τα επιθυμητά 
επίπεδα πληροφορίας. 
 
12. Ανάγετε το θεματικό επίπεδο “fault1.shp” από το γεωδαιτικό σύστημα 
αναφοράς ΕΓΣΑ’87 στο WGS’84 και δώστε το όνομα “fault1wg.shp”. 
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Χωρική Ανάλυση 
 

Η χωρική ανάλυση–επεξεργασία δεδομένων (διανυσματικής μορφής shapefile, 
feature class, coverage, ή μορφής καννάβου) βάσει περιγραφικών 
χαρακτηριστικών επιτυγχάνεται στο ArcGIS μέσω συγκεκριμένων εντολών. Με 
την χωρική ανάλυση επιτυγχάνεται συνδυασμός θεματικών επιπέδων και 
δίδονται απαντήσεις σε συγκεκριμένα ερωτήματα, όπως: οριοθέτηση σεισμικά 
επικίνδυνων περιοχών, εύρεση περιοχής ικανής για οικοδόμηση μεγάλου 
κτηριακού συγκροτήματος, οριοθέτηση περιοχών επικίνδυνων για κατολισθήσεις, 
οριοθέτηση περιοχής κατάλληλης για ΧΥΤA,  κ.ά. Φυσικά στο όλο πρόβλημα 
υπεισέρχονται οι κατάλληλες παράμετροι. 
 
Η διαχείριση των θεματικών επιπέδων επιτυγχάνεται μέσω συγκεκριμένων 
εντολών, όπως extract (εξαγωγή-απόσπαση), proximity (εγγύτητα), overlay 
(επίθεση), generalization (γενίκευση) καθώς και υπο-εντολών αυτών, οι οποίες 
εκτελούνται στο ArcGIS/Workstation ή στο ArcGIS/Desktop. Όσον αφορά το 
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ArcGIS/Desktop, παραθέτονται μερικές από τις εντολές και καλούνται στο 
Arctoolbox, ως ακολούθως: 
 
Σε shapefiles, feature classes  και coverages εφαρμόζονται οι εντολές: 
 
Arctoolbox - Analysis Tools – Extract:        Clip / Select / Split / Table Select 
 
Arctoolbox - Analysis Tools – Proximity:    Buffer / Near / Point Distance / 
Create Thiessen Polygons / Create Near Table / Multiple Ring Buffer 
 
Arctoolbox - Analysis Tools – Overlay:      Erase / Identity / Intersect / Spatial 

Join / Symmetrical Difference / Union / Update 
 
Arctoolbox - Cartography Tools  - Generalization:    Aggregate Points / 
Aggregate Polygons / Collapse Dual Lines To Centerline / Merge Divided Roads 
/ Simplify Building / Simplify Line or Polygon / Smooth Line or Polygon / Thin 
Road Network 
 
Arctoolbox - Data Management - Generalization:    Dissolve / Eliminate / 
Eliminate Polygon Part 
 
Σε αρχεία καννάβου (raster) εφαρμόζονται εντολές όπως:  
 
Arctoolbox – Data Management Tools – Raster – Raster Processing :  Clip / 
Composite Bands / Create Ortho Corrected Raster Dataset / Create Pan-
Sharpened Raster Dataset / Extract Subdataset / Raster to DTED / Resample / 
Split Raster 
 
Ερμηνεύονται μερικές από τις εντολές που χρησιμοποιούνται συνήθως, ως 
ακολούθως: 
 
Clip:  Αποκοπή χωρικών στοιχείων από μια θεματική ενότητα και δημιουργία 
νέας, βάσει καθορισμένων ορίων (πολυγώνου) άλλης ενότητας.  
 
Select: Αποκοπή χωρικών στοιχείων από ένα θεματικό επίπεδο (βάσει λογικών 
εκφράσεων ή κριτηρίων σε ένα αρχείο) και αποθήκευση σε ένα νέο θεματικό 
επίπεδο. 
 
Split: Διαίρεση ενός θεματικού επίιπέδου σε πολλά θεματικά επίπεδα βάσει ενός 
άλλου θεματικού επιπέδου. 
 
Buffer:  Δημιουργία Ζωνών Επιρροής για σημεία – γραμμές – πολύγωνα. 
Αποτελεί εργαλείο ανάλυσης απόστασης για σημεία, γραμμές και  πολύγωνα. 
Δημιουργούνται νέα πολυγώνα σε συγκεκριμένη απόσταση από τα σημειακά, 
γραμμικά ή πολυγωνικά δεδομένα. Δίδονται απαντήσεις ερωτημάτων βάσει 
εγγύτητας. 
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Erase (Διαγραφή): Δημιουργία νέου θεματικού επιπέδου, στο οποίο έχει 
διαγραφεί συγκεκριμένη περιοχή δεδομένων η οποία αντιστοιχεί σε ένα δεύτερο 
θεματικό επίπεδο. 
 
Identity (Ταυτότητα):  Δημιουργία νέου επιπέδου από το συνδυασμό δύο 
σημειακών, γραμμικών ή πολυγωνικών επιπέδων. Η χωρική έκταση είναι ίδια με 
την έκταση του αρχικού επιπέδου (εισόδου). Συνδυασμός και των περιγραφικών 
χαρακτηριστικών των αρχικών επιπέδων. 
 
Intersect (Τομή): Δημιουργία θεματικού επιπέδου στην τομή-κοινή χωρική 
έκταση δύο αρχικών επιπέδων που συνδυάζονται και τα οποία δύνανται να είναι 
σημεία, γραμμές ή πολύγωνα. Συνδυασμός και των περιγραφικών 
χαρακτηριστικών των αρχικών επιπέδων. 
 
Union (Ένωση): Συνδυασμός 2 πολυγωνικών θεματικών επιπέδων και 
δημιουργία νέου από την συνδυασμένη γεωμετρία των αρχικών (πλήρη έκταση). 
Συνδυασμός και των περιγραφικών χαρακτηριστικών των αρχικών επιπέδων. 
 
Update (Ενημέρωση): Συνδυασμός 2 πολυγωνικών θεματικών επιπέδων και 
δημιουργία νέου. Τα περιγραφικά χαρακτηριστικά και η γεωμετρία του πρώτου 
θεματικού επιπέδου ενημερώνονται βάσει του δεύτερου και προκύπτει το νέο 
θεματικό επίπεδο. 
 
Dissolve:  Ομαδοποίηση δεδομένων (πολύγωνα, γραμμές ή περιοχές) σε μια 
θεματική ενότητα βάσει κοινών περιγραφικών χαρακτηριστικών. 
 
Eliminate: Συγχώνευση επιλεγμένων γραμμών ή πολυγώνων με γειτονικά τους 
μεγαλύτερα, σε ένα θεματικό επίπεδο. 
 
 
 

 
ΕΡΩΤΗΜΑ 

Δίδονται τα θεματικά επίπεδα των γεωλογικών σχηματισμών “geol”, των 
ρηξιγενών ζωνών “fault”, των σεισμικών επικέντρων “epic”, των μορφολογικών 
κλίσεων “slope”, του προσανατολισμού των κλίσεων “aspect”, των 
μορφολογικών ασυνεχειών “discont”, συνοδευόμενα με την απαραίτητη 
περιγραφική πληροφορία, καθώς και το ΨΜΑ “grid1” μιας περιοχής.  
 
Να καθορισθούν οι απαραίτητες παράμετροι ώστε με τον συνδυασμό των 
κατάλληλων θεματικών επιπέδων να οριοθετηθεί μια περιοχή σταθερή όσον 
αφορά το γεωλογικό υπόβαθρο και την τεκτονική, με ομαλό ανάγλυφο και μικρές 
μορφολογικές κλίσεις, προκειμένου να οικοδομηθεί ένα νοσοκομείο.  
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ΑΣΚΗΣΗ  10 
 

Model Builder 
 

Για την επίλυση ενός προβλήματος συνήθως απαιτείται η σύνθεση ενός 
προγράμματος. Αρχικά γίνεται ανάλυση του προβλήματος, διατυπώνονται τα 
ερωτήματα και θέτονται κριτήρια. Εν συνεχεία, δημιουργείται ένα διάγραμμα ροής 
και κατόπιν προσαρμόζεται το πρόβλημα σε γλώσσα υπολογιστή ώστε 
συντάσσονται οι απαραίτητες εντολές.  
 
Ένας τρόπος επίλυσης προβλημάτων μέσω της διαχείρισης των γεωγραφικών 
δεδομένων ή όπως λέγεται της γεωεπεξεργασίας, είναι η δημιουργία μοντέλων 
μέσω του Model Builder.  
 
Στο ArcCatalog, ArcMap, ArcGlobe, ή ArcScene ανοίγομε το  ArcToolbox 
window και δημιουργούμε νέο Toolbox:    
            Δεξί κλικ στην περιοχή του ArcToolbox → επιλογή New Toolbox → Δεξί 
κλικ → Νew → Model → Ανοίγει το Model window  
 
             Εάν  είναι ήδη δημιουργημένο το μοντέλο  →  Δεξί κλικ στο μοντέλο → 
Edit → Ανοίγει το Model window 
 
Τα δεδομένα εισάγονται απευθείας από ArcCatalog, ArcMap κ.ά. εφόσον τα 
επιλέξομε και τα σύρομε στο Model window.  
 
Επίσης επιλέγονται και σύρονται από ArcToolbox οι διάφορες εντολές που θα 
χρησιμοποιήσομε και στα εμφανιζόμενα αντίστοιχα αυτών εικονίδια δίδονται οι 
παράμετροι, τα δεδομένα κ.ά., όπως φαίνεται στην παρακάτω εικόνα. 
 
Εκτός από έτοιμα εργαλεία που εισάγομε είναι δυνατή η εισαγωγή νέων 
εργαλείων που θα ικανοποιούν τις επιθυμητές συνθήκες και θα επιτυγχάνονται 
νέες διαδικασίες αυτόματα. 
 
 

 
Ερώτημα 

Δημιουργείστε μοντέλο «Model_DEM.tbx» και αυτοματοποιείστε την διαδικασία 
παραγωγής ΨΜΑ, ανάλυσης 20m, στο ΕΓΣΑ’87, μέσω του αλγορίθμου topogrid 
(εντολή topotoraster).  
 
Επίσης, δημιουργείστε τα θεματικά επίπεδα των μορφολογικών κλίσεων, του 
προσανατολισμού των κλίσεων, του υδρογραφικού δικτύου, των υδροκριτών και 
το σκιασμένο ανάγλυφο, μέσω του ΨΜΑ, με αυτοματοποίηση των διαδικασιών. 
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ΑΣΚΗΣΗ  11 
 

Παρακολούθηση Εδαφικής Παραμόρφωσης μέσω GPS μετρήσεων: 
Δημιουργία Χρονοσειρών (Time Series) 

 
 
1. Στο ArcCatalog δημιουργείστε την γεωβάση «gpsa.gdb». 

 
2. Στο ArcMap δημιουργείστε χάρτη «Map11.mxd».  
 

Σας δίδετε το αρχείο «gps.xls», το οποίο περιλαμβάνει μετρήσεις GPS,  
συγκεκριμένης χρονικής περιόδου, συγκεκριμένων σταθμών GPS. 
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Στο Data View εισάγετε το αρχείο ώστε να δημιουργείσετε το σημειακό 
θεματικό επίπεδο (feature class) με το όνομα  «gpsall», στο Παγκόσμιο 
Γεωδαιτικό Σύστημα Αναφοράς WGS’84 / geographic coordinates, μέσα 
στην γεωβάση «gpsa.gdb», που ήδη έχετε δημιουργήσει: 

 
Main Menu → File → Add Data → Add X Y Data / Επιλογή 
συντεταγμένων και Γεωδαιτικού Συστήματος Αναφοράς → Δημιουργείται 
το στιγμιαίο αρχείο «gpsall Events».  
 

Εν συνεχεία δημιουργείστε το θεματικό επίπεδο (feature class) με το όνομα  
«gpsall» :  

Δεξί κλικ στο «gpsall Events» → Export Data  →  Δίνετε στο θεματικό 
επίπεδο που θα παραχθεί το όνομα «gpsall» 

 
3. Ανάγετε το θεματικό επίπεδο «gpsall» από το  WGS’84 / geographic στο 
WGS’84 / UTM, με το όνομα «gpsallutm» 
 
4. Προσθέστε στον Attribute Table του «gpsallutm» τα πεδία Easting, 

Northing, Up (Type Double), ώστε να δοθούν οι συντεταγμένες (Χ, Υ, Ζ) 
(WGS’84 / UTM, δηλ. σε μέτρα) κάθε σημείου (σταθμού GPS). 

 
Εφόσον προσθέσατε τα ανωτέρω πεδία στο «gpsallutm», ανοίγετε τον 
Attribute Table και ενημερώνετε το κάθε πεδίο με τις αντίστοιχες 
συντεταγμένες: 
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Δεξί κλικ στο όνομα του πεδίου Easting  →  Calculate Geometry  →  X 
Coordinate of Point  (Επιλέγεται από Property και αντιστοιχίζονται οι 
συντεταγμένες «Χ» στο πεδίο Easting) 

 
Κατά τον ίδιο τρόπο, προσδίδονται στα πεδία «Northing» και «Up» οι 
συντεταγμένες «Υ» και «Ζ», αντιστοίχως. 
 

 
 
5. Ανοίγετε τον Attribute Table  του «gpsallutm»  και επιλέγετε τις μετρήσεις 

(records) συγκεκριμένου σταθμού, ώστε να δημιουργήσετε ένα θεματικό 
επίπεδο (feature class) για κάθε σταθμό: 

 
6. Εφόσον έχετε επιλέξει στον Attribute Table  του «gpsallutm»  τα στοιχεία-

records συγκεκριμένου σταθμού (π.χ. του σταθμού «PONT»), μεταφερθείτε 
στο Table of Contents του ArcMap και: 

 
Δεξί κλικ στο «gpsallutm»   →  Data → Export Data → δίνετε το όνομα του 
feature class που θα δημιουργηθεί «gpspont» (περιέχει μόνον τα records-
μετρήσεις του σταθμού «PONT») 

 
7. Για κάθε σταθμό δημιουργείστε διάγραμμα – χρονoσειρά (Time Series), του 

συγκεκριμένου σταθμού για την συγκεκριμένη χρονική περίοδο που έχουν 
λάβει χώρα οι μετρήσεις: 
 

Κλικ στο εικονίδιο του Table Options του Attribute Table   → Create 
Graph → δίνετε τις παραμέτρους για το διάγραμμα:  

Graph Type: Horizontal Line 
X Field: OBJECTID 
Υ FIELD: POΙNT_X  (ή POΙNT_Υ  ή POΙNT_Ζ για να δοθεί η μετακίνηση 
– χρονοσειρά στο Χ, Υ ή στο Ζ αντιστοίχως)   
 

Next → Επιλέγετε ή αλλάζετε τις παραμέτρους που επιθυμείτε → Finish → 
Εμφάνιση του διαγράμματος → Δεξί κλικ στο άνω περιθώριο του 
διαγράμματος → Save (ως «grf» αρχείο) 
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ή 
Export (ως αρχείο «jpg», «tiff» κ.ά.) 
 

 
 

*****   Είναι δυνατόν από τον Attribute Table  του «gpsallutm»  και εφόσον 
έχετε επιλέξει τα στοιχεία-records συγκεκριμένου σταθμού (π.χ. του σταθμού 
«PONT»), να δημιουργείσετε διαγράμματα για συγκεκριμένο σταθμό και για 
συγκεκριμένη χρονική περίοδο, κάθε φορά : 

 
Κλικ στο εικονίδιο του Table Options του Attribute Table   → Create 
Graph → δίνετε τις παραμέτρους για το διάγραμμα: 
  

Graph Type: Horizontal Line 
X Field: OBJECTID (εφόσον σε καθένα αντιστοιχίζεται συγκεκριμένη 
ημερομηνία μέτρησης) 
Υ FIELD: POΙNT_X  (ή POΙNT_Υ  ή POΙNT_Ζ για να δοθεί η 
μετακίνηση – χρονοσειρά κατά  Χ, Υ ή  Ζ αντιστοίχως)   

 
→ Next → Επιλέγετε Show only selected features/records on the 
graph και αλλάζετε όποιες άλλες παραμέτρους που επιθυμείτε → Finish 
→ Εμφάνιση συγκεκριμένου διαγράμματος 

 
 
*****  Διαγράμματα δημιουργούνται επίσης και από Main Menu  του ArcMap →  
View  →  Graphs  →  Create  ....... 
 
 
8. Τι παρατηρείτε, μελετώντας τις χρονοσειρές κάθε σταθμού; 

 
9. Δημιουργείστε μοντέλο «model.tbx» σε Model Builder και αυτοματοποιείστε 

την ανωτέρω διαδικασία. 
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ΑΣΚΗΣΗ 12 

 
Διαχείριση & Απεικόνιση Γεωφυσικών Δεδομένων σε Χάρτη – Εξαγωγή 

Χάρτη με Γεωαναφορά 
 (Μαγνητοτελλουρικά Δεδομένα) 

 
Η Μαγνητοτελλουρική Μέθοδος χρησιμοποιείται προκειμένου να μελετηθεί η 
γεωηλεκτρική δομή του υπεδάφους μιας περιοχής (π.χ. η περίπτωση μελέτης του 
γεωθερμικού πεδίου της Νισύρου).  
 
Η διαχείριση των μαγνητοτελλουρικών δεδομένων δύναται να επιτευχθεί σε ένα 
ΣΓΠ, με στόχο την αξιολόγηση αυτών, την συσχέτιση με άλλα δεδομένα, 
(γεωλογικά, τεκτονικά κ.ά.) και την διεξαγωγή συμπερασμάτων. 
 
Δίδονται  

• το ΨΜΑ της περιοχής, δομής (grid) σε ΕΓΣΑ’87 («dem») 
• θεματικό επίπεδο (feature class) με τα τεκτονικά στοιχεία της περιοχής 

(«tectonic») 
• αρχείο (xls) όπου περιέχονται οι θέσεις των μαγνητοτελλουρικών 

μετρήσεων (συντεταγμένες σημείων στο WGS’84/geographic coordinates) 
• αρχείο (xls) όπου περιέχονται τα μαγνητοτελλουρικά δεδομένα, δηλ. Οι οι 

φαινόμενες ειδικές αντιστάσεις ανά συχνότητα. Διευκρινίζεται ό,τι σε κάθε 
συχνότητα αντιστοιχεί ένας συγκεκριμένος αριθμός τιμών φαινόμενης 
ειδικής αντίστασης, τόσος-όσος είναι ο αριθμός των μαγνητοτελλουρικών 
θέσεων μέτρησης, στις οποίες χρησιμοποιήθηκε η συγκεκριμένη συχνότητα. 

 
Ζητούνται: 
 
1. Να δημιουργηθεί η γεωβάση «mtgeo.gdb», η οποία θα περιέχει όλα τα 

θεματικά επίπεδα. 
 

2. Να δημιουργηθεί σημειακό θεματικό επίπεδο «mtpnt» (feature class) των 
θέσεων των μαγνητοτελλουρικών μετρήσεων στο ΕΓΣΑ’87. 
 

3. Να δημιουργηθεί χάρτης «map12.mxd» με το σκιασμένο ανάγλυφο (azimuth 
450, sun elevation 450

 

), τις θέσεις των μαγνητοτελλουρικών μετρήσεων και τα 
τεκτονικά στοιχεία της περιοχής, στο ΕΓΣΑ’87, με την απαραίτητη 
χαρτογραφική πληροφορία σχετικά με την χαρτογραφική απεικόνιση, 
υπόμνημα, σύμβολο βορρά κ.ά.  

4. Ο ανωτέρω χάρτης να εξαχθεί σε μορφή «tiff» και «pdf», ώστε να 
περιλαμβάνει και την πληροφορία της γεωαναφοράς (δηλ.  πραγματικές 
συντεταγμένες). 
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5. Ένα θεματικό επίπεδο (grid δομής) με την κατανομή της ειδικής αντίστασης, 
για κάθε τιμή συχνότητας (στο ΕΓΣΑ’87), μέσω της μεθόδου IDW. 
 

6. Να δημιουργηθεί χάρτης στο ArcScene, όπου θα φαίνεται το ΨΜΑ της 
περιοχής με τις θέσεις των μετρήσεων, οι τεκτονικές δομές και  η κατανομή της 
φαινόμενης ειδικής αντίστασης ανά συγκεκριμένη συχνότητα (όπως φαίνεται 
στην κάτωθι εικόνα). Επίσης, να δίδεται ο Βορράς και το υπόμνημα. 

 
7. Τι παρατηρείτε; Δώστε περιληπτικά τα συμπεράσματά σας. 
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ΕΡΓΑΣΤΗΡΙΑΚΕΣ ΑΣΚΗΣΕΙΣ 
Επεξεργασία Δορυφορικών Εικόνων 

Σε Περιβάλλον ENVI 
 
 

ΑΣΚΗΣΗ 1
Εισαγωγή στο ENVI  

η 

 
1. Σε περιβάλλον εργασίας Windows, το περιβάλλον εργασίας του ENVI ανοίγει με 
διπλό κλικ στο σχετικό εικονίδιο, το οποίο ευρίσκεται στην επιφάνεια εργασίας, ή δίνοντας 
Start   Programs   → RSI ENVI 4.8 -  ENVI και εμφανίζεται το κυρίως μενού του 
προγράμματος, το οποίο διαθέτει πλήθος λειτουργιών: 
 

 
 
2. Ανοίγετε την εικόνα «can_tmr.img» ( Cañon City, CO, TM Data / ENVI Header File: 
can_tmr.hdr.) από  Κυρίως Menu: File →  Open Image File και από τον Φάκελο  
IDL/IDL80/products/envi48/data  επιλέγετε την εικόνα can_tmr.img  →  Open. 
 

 
 
Για την παγχρωµατική απεικόνιση από το παράθυρο Available Bands List, με επιλεγµένο 
το Grαy Scale επιλέξτε το κανάλι Band 1 µε το αριστερό πλήκτρο του ποντικιού. Το κανάλι 
που επιλέξατε εµφανίζεται στο πεδίο Selected Band, του Available Bands List. Με Load 
Band ανοίγετε την εικόνα σε µια οθόνη Disp1. Η εικόνα εμφανίζεται σε τρεις οθόνες: 
 
Η κύρια οθόνη (main image) απεικονίζει ένα τμήμα της εικόνας σε πλήρη ανάλυση.  

Εμφανίζεται το παράθυρο «Available Bands 
List», μέσω του οποίου, είναι δυνατή η 
πρόσβαση σε αρχεία εικόνας αλλά και σε 
μεμονωμένα φασματικά κανάλια εικόνας.  
 
Το παράθυρο «Available Bands List» 
περιέχει έναν κατάλογο με όλα τα κανάλια των 
εικόνων καθώς και τις πληροφορίες του χάρτη 
(Map Info), δηλαδή το μέγεθος της κυψελίδας 
(pixel), την Χαρτογραφική Απεικόνiση 
(Προβολικό Σύστημα), το Datum και τις 
συντεταγμένες του άνω αριστερού pixel (Upper 
Left Pixel) σε γεωγραφικές και σε πραγματικές 
συντεταγμένες.  
 
Στην περίπτωση όπου δεν εμφανίζονται 
πληροφορίες χάρτη, αυτό σημαίνει πως η 
συγκεκριμένη εικόνα δεν έχει γεω-αναφορά. 
 
Υπάρχει η δυνατότητα για παγχρωµατική ή 
έγχρωµη απεικόνιση µε χρήση των 
φασµατικών καναλιών στο Κόκκινο, Πράσινο 
και Μπλε του µοντέλου RGB. 
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Η οθόνη σμίκρυνσης (scroll image) απεικονίζει ολόκληρη την εικόνα εκτελώντας μια 
δειγματοληψία και αυξάνοντας το μέγεθος του pixel, διαδικασία στην οποία δεν επεμβαίνει 
άμεσα, ο χρήστης. 
Η οθόνη εστίασης (zoom image) απεικονίζει ένα τμήμα της εικόνας που περιλαμβάνει η 
κύρια οθόνη, επιτρέποντας στον χρήστη να δώσει την επιθημητή μεγένθυνση.  
Κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού μετακινείστε το τετράγωνο της 
κύριας οθόνης σε διάφορα σημεία της εικόνας. Τι παρατηρείτε; 
 

 
 
3.        Περιγραφή των Πλήκτρων του Ποντικιού 
 
Από το Display group menu bar, επιλέγετε Window  → Mouse Button Descriptions. 
Από το  ENVI main menu bar, επιλέγετε Window  → Mouse Button Descriptions και 
μετακινείτε τον κέρσορα  στο Image window. 
 
4. Οι Τιμές των Φασματικών Καναλιών 

 
Εμφανίστε την  θέση και την τιμή pixel σε κάθε θέση του κέρσορα επάνω στην εικόνα: 

Από  ENVI main menu bar ή από το  Display group menu bar:   Window → Cursor 
Location/Value.  

    ή  Με  δεξί κλικ στο Image window και επιλογή Cursor Location/Value. 
ή  Από το μενού της εικόνας και επιλογή Tools → Cursor Location/Value.  

Εμφανίζεται το σχετικό παράθυρο. Καθώς μετακινείτε τον κέρσορα σε οποιαδήποτε από τις 
τρεις οθόνες οι τιμές μεταβάλλονται αναλόγως.  
 
Με το Cursor Location Value δίνονται πληροφορίες για: 
1. Disp#1: Εικονο-συντεταγμένες στην θέση του κέρσορα. 
2. Scrn: Τιμές μοντέλου RGB. 
3. Projection: Η χαρτογραφική απεικόνιση. 
4. Map: Πραγματικές συντεταγμένες κέρσορα. 
5. LL: Γεωγραφικό μήκος και γεωγραφικό πλάτος κέρσορα. 
6. Data: Η τιμή του pixel. Αντιπροσωπεύει DNs, Ισχύ 
ακτινοβολίας που φθάνει στον σαρωτή, ακτινοβολία στην 
επιφάνεια του εδάφους (μετά από ειδική ραδιομετρική 
διόρθωση) κ.λ.π. 
 
Με διπλό κλικ στην εικόνα εμφανίζεται και εξαφανίζεται το παράθυρο. 
Κλείνει εντελώς  από Cursor Location/Value menu bar και επιλογή File →  Cancel. 
 
5.  Πρόσθετες Ιδιότητες Πολλαπλών Οθόνων 
 
Η θέση κάθε οθόνης είναι σε επαφή με τις άλλες δύο με την ιδιότητα Auto Placement. Για 
να την απενεργοποιήσετε και να μοιράσετε τις οθόνες στην επιφάνεια εργασίας όπως 

Σταυρόνημα  
 
Μεγέθυνση 
 
Σμίκρυνση 

 

Εν συνεχεία, δοκιμάστε τις 
δυνατότητες των 3 κόκκινων 
εικονιδίων στο αριστερό τμήμα 
του Zoom Window, σε σχέση με 
τα 3 πλήκτρα του ποντικιού. 
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επιθυμείτε, δώστε δεξί κλικ στην κύρια οθόνη απεικόνισης και ζητείστε Scroll Zoom 
Position → Auto Placement off.   
 
Για να επαναφέρετε την σύνδεση μεταξύ των οθόνων, επιλέξτε Scroll Zoom Position και 
δώστε μια από τις επιλογές που εμφανίζονται. 
 
Εμφανίστε μπάρες κύλισης (scroll bars) στις οθόνες ώστε να μετακινείτε καλύτερα την 
επιφάνεια που βλέπετε. Δώστε δεξί κλικ στην κύρια οθόνη και ζητείστε Toggle → Display 
Scroll Bars. Από το ίδιο μενού ρυθμίζετε και την εμφάνιση του σταυρονήματος και του 
τετραγώνου μεγέθυνσης. 
 
6. Band Animation 

 
Ένας ταχύς τρόπος ώστε να εμφανισθεί ολόκληρο το φασματικό περιεχόμενο του αρχείου 
(εικόνας) είναι με το εργαλείο animation του ENVI: Ανοίξτε μια κύρια οθόνη (ή από μία 
υπάρχουσα) και από το μενού της επιλέξτε Tools > Animation. Εμφανίζεται το παράθυρο 
Animation Input Parameters. Επιλέξτε το πρώτο κανάλι και έχοντας πατημένο το πλήκτρο 
Shift, επεκτείνεται την επιλογή έως το κανάλι 7. Πατήστε ΟΚ. Εφόσον «φορτωθούν» τα 
επιλεγμένα κανάλια εμφανίζεται η οθόνη απεικόνισης. Στο κάτω τμήμα της οθόνης ρυθμίζετε 
με πλήκτρα πως θα γίνει η παρουσίαση των καναλιών (κατά αύξοντα αριθμό ή κατά 
φθίνοντα), η παύση και η ταχύτητα εμφάνισης. Το animation αποθηκεύεται και σε μορφή 
Video MPEG. 
 
7.       Ανοίγετε το Header File από το Κυρίως Menu: File   Edit ENVI Header. 

Κλικ στο can_tmr.img 
Κλικ στο Cancel ώστε να κλείσει το αρχείο 

      Ή δεξί κλικ στο όνομα της εικόνας (Available Bands List) επιλέγετε Edit Header - Close 
                                                                                                                       
8.       Profiles (Τομές) Εικόνας 
 
Δώστε τα Profiles (x, y, z) της εικόνας. 
 
α. Από το  Display group menu bar, επιλέγετε Tools -  Profiles -  X Profile (Αριθμός pixels, 
σε ορισμένη οριζόντια διεύθυνση (κόκκινη γραμμή σταυρονήματος), με συγκεκριμένη τιμή 
φωτεινότητας). 
β. Από το  Display group menu bar, επιλέγετε Tools -  Profiles -  Y Profile (Αριθμός pixels, 
σε ορισμένη κατακόρυφη διεύθυνση (κόκκινη γραμμή σταυρονήματος), με συγκεκριμένη τιμή 
φωτεινότητας). 
γ. Από το  Display group menu bar, επιλέγετε Tools -  Profiles - Z Profile (Ανάλυση 
φάσματος και αντίστοιχη τιμή φωτεινότητας για ένα pixel της εικόνας). Από κάθε παράθυρο 
της εικόνας με δεξί κλικ  παίρνετε επίσης το Z Profile. 
δ. Από το  Display group menu bar, επιλέγετε Window → Mouse Button Descriptions και 
δίνετε η περιγραφή των  mouse button actions στα  Profile displays. 
ε. Ένας κόκκινος σταυρός εκτείνεται από την κορυφή έως το κάτω τμήμα και τις πλευρές του 
παράθυρου της εικόνας.  Οι κόκκινες γραμμές δηλώνουν την κατακόρυφη και οριζόντια 
διεύθυνση των Profiles. Μετακινώντας τον Cursor στην εικόνα αλλάζουν τα Profiles. 
στ. Κλείνουν τα profile plots επιλέγοντας  File →  Cancel από το  menu bar κάθε profile. 
 
9. Quick Contrast Stretching 
 
1. Από το Display group menu bar, επιλέγετε Enhance και εφαρμόζονται contrast stretches 
(Linear, Linear 0-255, Linear 2%, Gaussian, Equalization, and Square Root). 
2. Συγκρίνετε τα διάφορα stretches. 
10. Φορτώστε Έγχρωμη Εικόνα (Colour Image) 
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Ανοίξετε την εικόνα χρησιμοποιώντας τρία κανάλια (3 bands) αντιστοιχιζόμενα σε RGB 
Colour. 
1. Επιλέγετε  Window  Available Bands List από το  ENVI main menu bar. 
2. Επιλέγετε TM Band 1 και κλικ στο RGB Colour radio button. Η επιλεγόμενη Band 
εμφανίζεται στο R. 
3. Επιλέγετε TM Band 2. Η επιλεγόμενη Band εμφανίζεται στο G. 
4. Επιλέγετε TM Band 5. Η επιλεγόμενη Band εμφανίζεται στο B. 
5. Κλικ στο Display #1 και επιλέξατε New Display. 
6. Κλικ στο Load RGB , ώστε φορτώνετει η εικόνα σε RGB χρωματισμό. 
 
11.   Διασύνδεση & Υπέρθεση Εικόνων – Link Displays & Dynamic Overlay 
 
Ένας πολύ χρήσιμος τρόπος για να μελετώνται οι εικόνες, είναι η δημιουργία δύο ή και 
περισσοτέρων απεικονίσεων διαφορετικών καναλιών (άρα και διαφορετικών ιδιοτήτων) και η 
εξέταση της αντανάκλασης της ηλεκτρομαγνητικής ακτινοβολίας των διαφόρων υλικών της 
επιφάνειας της γης σε διαφορετικά μήκη κύματος. 
 
Συγκρίνετε μέσω Link την έγχρωμη και την παγχρωματική εικόνα: 

 
 
Τοποθετείστε τις δύο οθόνες στην επιφάνεια εργασίας, ώστε να βλέπετε ταυτόχρονα και τις 
δύο. Στην πανχρωματική οθόνη και εντός της περιοχής της κύριας οθόνης απεικόνισης, 
πατήστε το μεσαίο πλήκτρο του ποντικιού και σύρετε το ποντίκι. Θα εμφανισθεί σε 
επικάλυψη το περιεχόμενο της δεύτερης οθόνης (της ψευδοχρωματικής). Μετακινώντας το 
ποντίκι και χωρίς να ελευθερώσετε το μεσαίο πλήκτρο του ποντικιού, ορίστε το μέγεθος του 
παράθυρου επικάλυψης. Δηλώστε ένα μέγεθος περίπου στο 1/10 της επιφάνειας που 
καταλαμβάνει η οθόνη πλήρους απεικόνισης και ελευθερώστε το πλήκτρο του ποντικιού. 
 
Το εργαλείο Dynamic Overlay του Link Display, δεν λειτουργεί για την οθόνη 
σμίκρυνσης. Σημειώστε πως είναι δυνατον να έχετε συνδεδεμένες δύο ή και περισσότερες 
οθόνες χωρίς να ενεργοποιείτε την υπέρθεση των πληροφοριών. Σε αυτήν την περίπτωση 
θα έχετε απλή σύνδεση των οθονών, και θα βλέπετε και στις δύο (ή και περισσότερες) 
οθόνες ταυτόχρονα ακριβώς την ίδια περιοχή. Για να το επιτύχετε αυτό πατήστε Tools → 
Link  → Dynamic Overlay Off.  Για να απενεργοποιήσετε το Link Display: Tools →  Link → 
Unlink Display. 
Με δεξί κλικ σε μια από τις δύο εικόνες και επιλογή geographic link εφόσον ο κέρσορας 
μετακινείται στην μια εικόνα δίνεται η αντίστοιχη θέση του στην άλλη. Η συγκεκριμένη 
επιλογή ισχύει και για διαφορετικές δορυφορικές εικόνες ή εικόνες διαφορετικής χρονικής 
περιόδου, εφόσον είναι σε πραγματικές συντεταγμένες (γεωαναφερόμενες). 
 
 
 
 

Από το μενού μιας εκ των δύο εικόνων 
δώστε Tools → Link → Link Displays και 
θα εμφανισθεί το παράθυρο: 
  Βεβαιωθείτε πως και τα δύο πεδία 
Display #1 και Display #2 είναι 
ενεργοποιημένα και πως το πεδίο 
Dynamic Overlay είναι σε θέση Yes.  
  Click OK στο Link Displays dialog να γίνει 
το link. 
  Scroll και zoom σε ένα display group and 
παρατηρείστε τις αλλαγές και στο άλλο. 
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12. Στατιστικά Στοιχεία Εικόνας 
Είναι χρήσιμη η εξαγωγή στατιστικών στοιχείων της εικόνας για περαιτέρω μελέτη και 
ανάλυση. Είναι δυνατή η μελέτη της κατανομής των DNs σε κάθε κανάλι (τα μέγιστα και 
ελάχιστα), του ιστογράμματος κάθε καναλιού.  
 
Σύντομα Στατιστικά 
 
Επιλέξετε το αρχείο εικόνας και δώστε δεξί κλικ. Από το μενού που θα εμφανισθεί επιλέξτε 
Quick Stats. Όταν ολοκληρωθεί ο υπολογισμός των στατιστικών, θα εμφανισθεί το 
παράθυρο Statistics Results, όπου δίδονται τα βασικά στατιστικά της εικόνας.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

    Με Select Plot και επιλέγοντας ένα συγκεκριμένο 
κανάλι  π.χ. Histogram Band5, το γραφικό 
περιεχόμενο μεταβάλλεται. Στον άξονα Χ 
αναφέρονται οι τιμές των pixels ενώ στον άξονα Υ 
δίνονται το πλήθος (συχνότητα) των pixels που 
λαμβάνουν τις αντίστοιχες τιμές. 
    Πατήστε Select Plot και επιλέξτε Histogram 
Band 2. Το ιστόγραμμα του καναλιού 2 θα 
σχεδιασθεί ταυτόχρονα με το ιστόγραμμα του 
καναλιού 5 με διαφορετικό χρώμα. Συνεχίστε να 
προσθέτετε ιστογράμματα για τα κανάλια. 
    Δίνεται η δυνατότητα με μία κίνηση να πάρετε όλα 
τα ιστογράμματα: Select Plot → Histogram All 
Bands. Για να επανέλθετε στα αρχικά γραφικά 
στατιστικά πατήστε Select Plot → Min/Max/Mean.  
    Στο κάτω τμήμα του παράθυρου φαίνονται τα 
στατιστικά με την μορφή κειμένου. Είναι δυνατή η 
επιογή περιοχής κειμένου με το ποντίκι και η 
αντιγραφή του επιλεγόμενου τμήματος στο 
Clipboard του υπολογιστή ώστενα επικολληθεί σε 
άλλη εφαρμογή (π.χ. ένα επεξεργαστή κειμένου).  
 
 

Το παράθυρο στατιστικών στοιχείων 
διαιρείται σε δύο τμήματα. Το γραφικό 
(Plot) και το στατιστικό (Stat). Η 
πρώτη οθόνη γραφικού αναφέρει 
μέγιστη τιμή, ελάχιστη τιμή, μέση τιμή 
και τυπική απόκλιση. Οι  τιμές 
αναφέρονται σε όλα τα κανάλια της 
εικόνας. Στον άξονα Χ δίνεται το μήκος 
κύματος (για να δίνεται το μήκος 
κύματος στον άξονα Χ θα πρέπει το 
Header File του αρχείου να περιέχει 
την πληροφορία μήκους κύματος ανά 
κανάλι), ενώ στον άξονα Υ δίνονται οι 
αντίστοιχες τιμές των pixels.  
 
Το υπόμνημα σχεδιάζεται στο άνω 
δεξί τμήμα του διαγράμματος: Δεξί κλικ 
στην περιοχή του γραφικού και από το 
αναδυόμενο μενού Plot Keys. 
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Για εξαγωγή των γραφικών ως εικόνα, δώστε δεξί κλικ στην περιοχή αυτών, στο αναδυόμενο 
παράθυρο που εμφανίζεται, πατήστε File → Save Plot As → Image File. Τροποποιήστε το 
Output File Type και την διαδρομή αποθήκευσης του αρχείου και πατήστε ΟΚ. 
 
Το εργαλείο Quick Stats δίνει την δυνατότητα για μια σύντομη στατιστική περιγραφή της 
εικόνας χωρίς να εγγραφεί καμία πληροφορία στον δίσκο, δίνει δηλαδή την δυνατότητα για 
«on the fly» υπολογισμό των στατιστικών μιας εικόνας. Δεν δίνει την δυνατότητα για 
υπολογισμό συνδιακύμανσης και συσχέτισης. 
 
Πλήρη Στατιστικά 
 
Για μια ολοκληρωμένη στατιστική ανάλυση της εικόνας, από το κύριο μενού επιλέξετε Basic 
Tools  → Statistics  → Compute Statistics. Εμφανίζεται το παράθυρο Compute 
Statistics Parameters. Ενεργοποιήστε το πεδίο Histograms.  
 
Ενεργοποιήστε το Output to a Statistics File και ορίστε την διαδρομή και το όνομα του 
αρχείου που θα περιέχει τα στατιστικά (το αρχείο που θα δημιουργηθεί θα έχει κατάληξη 
*.sta). Ενεργοποιήστε το πεδίο Output to a Text Report File και δώστε το όνομα του 
αρχείου μορφής “txt” που θα περιέχει επίσης τα στατιστικά. Πατήστε ΟΚ χωρίς να δώσετε 
άλλες τροποποιήσεις και περιμένετε να ολοκληρωθεί ο υπολογισμός και η αποθήκευση του 
αρχείου. 
 
13. Επιλογή Περιοχών Ενδιαφέροντος (Regions of Interest / ROIs) 
 
Οι περιοχές ενδιαφέροντος είναι χρήσιμες για την μελέτη μιας περιοχής, ώστε να ορισθούν 
ιδιότητες σε μια υποπεριοχή, μάσκες κ.ά. 
 
1. Από το Display group menu bar επιλέγετε Overlay → Region of Interest, ή με δεξί κλικ 
στο Image window, επιλέγετε ROI Tool. 
 
2. Ζωγραφίζετε την περιοχή ενδιαφέρονος (πολύγωνο) πατώντας στο Image window, το 
αριστερό πλήκτρο του ποντικιού για να ψηφιοποιείσετε το πρώτο σημείο αλλά και τα 
επόμενα (ή σύροντας συνεχόμενα). Κλείνετε το πολύγωνο πατώντας το δεξί πλήκτρο του 
ποντικιού.  
Το μεσαίο πλήκτρο διαγράφει το τελευταίο σημείο ή αν έχει κλείσει το πολύγωνο, ολόκληρο 
το πολύγωνο.  
Πατώντας το δεξί πλήκτρο εκτός περιοχής ROI, ζωγραφίζεται το ROI.  Τα ROIs ορίζονται 
επίσης στα Zoom και Scroll windows επιλέγοντάς τα από το ROI Tool dialog. 
Όταν έχετε τελειώσει με ένα ROI, αυτό φαίνεται στο dialog table, με το όνομα, χρώμα, 
αριθμό pixels που περιλαμβάνει και άλλες ιδιότητες. 
ROIs είναι δυνατόν να ορισθούν και σαν γραμμές (polylines) ή σαν συλλογή μεμονωμένων 
pixels επιλέγοντας τον τύπο του ROI από το ROI_Type pull-down menu στο ROI Tool. 
 
3. Πατήστε το New Region πλήκτρο, για να δημιουργήσετε νέο ROI. 
 
4. Επιλέγετε ένα  ROI πατώντας την συγκεκριμένη καταγραφή από το   ROI Tool table. 
Επιλέγετε πολλά ROIs χρησιμοποιώντας  Shift-click ή Ctrl-click.  
Επιλέγετε όλα τα ROIs πατώντας Select All στο  ROI Tool table 
 
5. Βλέπετε τα στατιστικά σε ένα ή περισσότερα ROIs επιλέγοντάς τα στον table και 
πατώντας το Stats πλήκτρο. 
 
6. Διαγράφετε  ROIs επιλέγοντάς τα στον table και πατώντας το Delete. 
Το ROI Tool table επιτρέπει να δούμε όλες τις ιδιότητες των  ROI (όνομα, χρώμα γραμμής 
και γεμίσματος). 
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Το Menu options στο επάνω τμήμα του ROI Tool Dialog δίνει αρκετές δυνατότητες 
επεξεργασίας των ROIs 
 
7. Κλείντε το ROI Tool από το menu στην κορυφή του πίνακα, επιλέγοντας File → Cancel. 
 

 

 
 
14. Δημιουργία Scatter Plots 
 
Είναι δυνατή η απεικόνιση σε διάγραμμα των τιμών λαμπρότητας δύο επιλεγμένων εικόνων 
σε ένα διάγραμμα (για σύγκριση κ.ά.).  Από Display group menu bar → Tools → 2D 
Scatter Plots. Από το εμφανιζόμενο παράθυρο επιλέγετε 2 κανάλια (ίδιας ή διαφορετικής 
εικόνας), μια εικόνα για τον Χ άξονα και μια για τον Υ άξονα. Μετά την επιλογή  οκ  
εμφανίζεται το διάγραμμα. 
 
Με ψηφιοποίηση περιοχών-πολυγώνων στην περιοχή των δεδομένων του διαγράμματος 
(μέσω του αριστερού πλήκτρου του ποντικιού) και πατώντας δεξί κλικ έξω από το 
ψηφιοποιημένο πολύγωνο επιλέγονται στο διάγραμμα τα σημεία (με κόκκινο) που 
περικλείονται στο πολύγωνο ενώ ταυτοχρόνως επιλέγονται στην εικόνα τα αντίστοιχα pixels 
που έχουν τις συγκεκριμένες τιμές λαμπρότητας (με κόκκινο χρώμα). Αντιστρόφως, 
σύροντας το ποντίκι στην εικόνα με πατημένο το αριστερό πλήκτρο  (η περιοχή επιλογής 
εκτείνεται σε  10*10 pixels γύρω από το σταυρόνημα) επιλέγονται pixels και ταυτοχρόνως τα 
αντίστοιχα σημεία στο διάγραμμα. 
 
Από Display group menu bar → Window  → Mouse Button Descriptions δίδονται οι 
ιδιότητες των πλήκτρων του ποντικιού για την συγκεκριμένη περίπτωση.  
Από Scatter Plot Menu Bar  → File  → Cancel κλείνει το διάγραμμα. 
 



258 
 

  
 
 
 

ΑΣΚΗΣΗ 2
Επεξεργασία Δορυφορικών Εικόνων 

η 

Βελτίωση – Ενίσχυση Αντίθεσης 
 
Η βελτίωση της εικόνας αποτελεί τμήμα της ψηφιακής επεξεργασίας της εικόνας και 
αποσκοπεί στην ευκολότερη διάκριση χαρακτηριστικών και δομών μέσω της φωτοερμηνείας. 
Επιτυγχάνεται µε τροποποίηση της έντασης της ακτινοβολίας, δηλαδή με τροποποίηση του 
ιστογράµµατος της εικόνας.  
 
Ανοίξτε το αρχείο bhtmref.img, επιλέγοντας File > Open Image File.  Εµφανίζεται το 
παράθυρο Available Bands List με τον κατάλογο των φασματικών καναλιών της εικόνας 
LANDSAT TM. Έχοντας επιλεγµένο το Grαy Scale επιλέξτε το κανάλι Band 1 µε το 
αριστερό πλήκτρο του ποντικιού και  με Load Band ανοίγετε την εικόνα σε µια οθόνη Disp1. 
 
Μετακινείστε το κόκκινο τετράγωνο εστίασης στην οθόνη σµίκρυνσης σε διάφορα σηµεία και 
ταυτόχρονα παρατηρείστε πως ενηµερώνεται η οθόνη πλήρους ανάλυσης – κύρια οθόνη. 
Είναι δυνατή η μετακίνηση στην κύρια οθόνη και με τις µπάρες κύλισης - Scroll Bars.  
 
Μέσω του εργαλείου Interactive Contrast Stretching δηµιουργείται το ιστόγραµµα της 
εικόνας το οποίο είναι δυνατόν να τροποποιηθεί. Αποτέλεσμα είναι η μεταβολή στην 
αντίθεση (contrast) της εικόνας.  Εφαρμόζονται διάφοροι τύποι ενισχύσεων. Το λογισµικό 
κάθε φορά που απεικονίζει µια εικόνα, εφαρµόζει µια γραµµική ενίσχυση (Linear 2%).  
 
Από το µενού της κύριας οθόνης επιλέξτε Enhance > Interactive Stretching. Από το 
εμφανιζόμενο παράθυρο δίνεται  η δυνατότητα τροποποίησης της αντίθεσης της εικόνας.  
 
Στα παρακάτω ιστογράµµατα, φαίνεται πως η αρχική εικόνα (Input Histogram) έχει 
συγκεντρωµένα τα περισσότερα pixels, στην περιοχή από 12 έως 28 και για τον λόγο αυτόν 
η εικόνα εµφανίζεται µε ιδιαίτερα χαµηλή αντίθεση. 
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Εφαρµόζοντας την προεπιλεγµένη µέθοδο γραµµικής ενίσχυσης προκύπτει η νέα κατανοµή, 
όπως φαίνεται από το ιστόγραµµα δεξιά (Output Histogram), όπου η διασπορά των τιµών 
έχει πλέον «απλωθεί» σε ολόκληρη την κλίµακα 0-255 (8-bit εικόνα). Η παραπάνω 
διαδικασία είναι η ελάχιστη βελτίωση της εικόνας που γίνεται αυτόµατα από το ENVI, ενώ 
περισσότερες τροποποιήσεις και βελτιώσεις γίνονται από τον χρήστη µε τα εργαλεία 
ενίσχυσης αντίθεσης (Interactive Contrast Stretching).  
 
Η περιοχή που χρησιµοποιεί το ENVI, για να δηµιουργήσει το ιστόγραµµα, επιλέγεται από 
Histogram_Source. Συμήθως οι εικόνες έχουν τοπικά σκοτεινές και τοπικά φωτεινές 
περιοχές. Εφόσον επιτευχθεί η βελτίωση της εικόνας βάσει συγκεκριμένων περιοχών θα 
βελτιωθεί η εικόνα τοπικά και θα μειωθεί η αντίθεση σε άλλες περιοχές. Πολλές φορές είναι 
ζητούμενο λόγω κάποιας συγκεκριμένης μελέτης να βελτιωθεί η εικόνα τοπικά. 
 
Για να ορισθεί ως πηγή ιστογράµµατος ολόκληρη η εικόνα από το µενού Histogram_source 
επιλέξτε Band, ενώ για να ορίσετε ως πηγή του ιστογράµµατος ένα τµήµα της εικόνας, 
επιλέξτε ως Histogram_Source, το Image ή Zoom, οπότε το ιστόγραµµα θα δηµιουργηθεί 
από τις τιµές των pixels που συµπεριλαµβάνονται στην οθόνη πλήρους ανάλυσης Image ή 
στην οθόνη εστίασης Zoom αντίστοιχα. Η επιλογή Histogram_Source > Scroll θα 
δηµιουργήσει ένα ιστόγραµµα από το Scroll Image Window, όπου ο αριθµός των pixels έχει 
µειωθεί (resampling), και ενδεχοµένως να οδηγήσει σε µη επιθυµητά αποτελέσµατα. 
 
Από το αναδυόμενο παράθυρο των ιστογραµµάτων, με επιλογή Stretch_Type, εµφανίζεται 
ο κατάλογος των τύπων ενισχύσεων που δύνανται να εφαρμοσθούν στην εικόνα. Επιλέξτε 
διάφορους τύπους και παρατηρείστε τα αποτελέσµατα στην κύρια οθόνη απεικόνισης 
πατώντας κάθε φορά το Apply.  
 
Κλείστε το παράθυρο Interactive Stretching πατώντας File>Cancel. Επίσης κλείστε τις 
οθόνες από το µενού της κύριας οθόνης πατώντας File>Cancel. 
 
Από το Available Bands List, φορτώστε πάλι την εικόνα bhtmref.img σε µια νέα απεικόνιση 
επιλέγοντας το κανάλι Band 1 και πατώντας Load Band έχοντας ενεργή την επιλογή Gray 
Scale. Στην κύρια οθόνη κάντε δεξί κλικ και από το αναδυόµενο µενού επιλέξτε Pixel 
Locator. 
Στο παράθυρο που θα εµφανισθεί δώστε τις παρακάτω εικονοσυντεταγµένες: Sample 
(Στήλη) = 77 και Row (Γραµµή) = 132 και πατήστε Apply. Η κύρια οθόνη (και η οθόνη 
εστίασης) θα µετακινηθούν στην περιοχή το κέντρο της οποίας ορίσθηκε. Κλείστε το Pixel 
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Locator πατώντας File>Cancel. Παρατηρείστε πως η περιοχή στην οποία µετακινήθηκε η 
κύρια οθόνη παρουσιάζει χαµηλή αντίθεση και είναι γενικά σκοτεινή.  
 
Από το µενού της κύριας οθόνης πατήστε Enchance > Interactive Stretching. Στο 
αναδυόµενο παράθυρο #1 Band: ΤΜ Band 1: bhtmref.img που εµφανίζεται επιλέξτε 
Histogram_Source > Image για να ορίσετε πως το ιστόγραµµα θα δηµιουργηθεί µόνο από 
τα pixels της κύριας οθόνης απεικόνισης. Τοποθετήστε τον κέρσορα επάνω στο αριστερό 
ιστόγραµµα και κρατήστε πατηµένο το αριστερό πλήκτρο του ποντικιού. Μετακινήστε τον 
κέρσορα κατά µήκος του ιστογράµµατος και παρατηρείστε τις τιµές που αναφέρονται στο 
κάτω µέρος του ιστογράµµατος. Παίρνετε πληροφορίες για την τιµή φωτεινότητας (DN) για 
το αριθµό των pixels που εµφανίζουν την συγκεκριµένη τιµή, για την συχνότητα εµφάνισης 
(%) της συγκεκριµένης τιµής DN και για την αθροιστική συχνότητα από την μικρότερη τιμή 
έως την συγκεκριµένη τιμή του συγκεκριμένου σημείου του ιστογράµµατος. 

 
Παρατηρείστε επίσης πως στο αριστερό ιστόγραµµα (αρχικό) εµφανίζονται στα άκρα του, 
δύο κατακόρυφες διακεκοµµένες γραµµές που ορίζουν την ελάχιστη και την µέγιστη τιµή 
λαμπρότητας που χρησιµοποιούνται στην ενίσχυση, ενώ η θέση τους δύναται να 
τροποποιηθεί. Από το µενού του παράθυρου ιστογράµµατος πατείστε Options>Auto Apply 
ώστε να βλέπετε πως επηρεάζεται η εικόνα σας από τις τροποποιήσεις του ιστογράµµατος. 
 
Είναι δυνατόν να δώσετε τις τιµές DN που επιθυμείτε από το πληκτρολόγιο, στα πεδία 
Stretch επάνω από την περιοχή των ιστογραµµάτων. Στην συγκεκριμένη εικόνα δώστε 
Stretch 12 : 21 (τιµές - DN). 
 
Σηµειώστε πως και αν ως πηγή του ιστογράµµατος ορίζεται η επιφάνεια που απεικονίζεται 
στην κύρια οθόνη, οι µεταβολές που προκύπτουν από το νέο ιστόγραµµα εφαρµόζονται σε 
ολόκληρη την εικόνα. 
 
Παρατηρείστε την εµφανή βελτίωση της εικόνας µε την εφαρµογή του νέου ιστογράµµατος. 
Η µέθοδος που χρησιµοποιήθηκε είναι η προ-επιλεγµένη µέθοδος Γραµµικής Διόρθωσης 
(Stretch_Type > Linear).  
 
Για να επαναφέρετε την εικόνα σας στην αρχική κατάσταση επιλέξτε Options > Reset 
Stretch.  
 
Εάν θελήσετε να επαναλάβετε την διαδικασία βελτίωσης θα πρέπει να ορίσετε την 
προέλευση του ιστογράµµατος από το Histogram_Source. Επαναλάβετε την άσκηση 
εφαρµόζοντας ενίσχυση ιστογράµµατος σε ολόκληρο το κανάλι επιλέγοντας 
Histogram_Source > Band και επιλέξτε διαφορετικές µεθόδους ενίσχυσης. 
 

 
 
 

ΑΣΚΗΣΗ 3
Επεξεργασία Δορυφορικών Εικόνων  

Η 

Ταξινόμηση Δορυφορικών Εκόνων  
Πράξεις μεταξύ Φασματικών Καναλιών 

 
 

Α. Ταξινόμηση Δορυφορικών Εκόνων 
 
Το ENVI, διαθέτει πολλαπλές ρουτίνες για την αυτοµατοποιηµένη ταξινόµηση εικόνας, 
δηλαδή την κατηγοριοποίηση των pixels, χρησιµοποιώντας καθοδηγούµενες ή µη µεθόδους. 
Οι µέθοδοι διαφοροποιούνται ως προς τα κριτήρια που χρησιµοποιούνται για τον 
προσδιορισµό των ορίων αποφάσεων, δηλ. εάν ένα pixel ανήκει σε κάποια κλάση ή όχι. 
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Ανεξαρτήτως της µεθόδου, αρχικά υπολογίζεται ένα πλήθος στατιστικών πληροφοριών για 
κάθε περιοχή ή κλάση. Χρησιµοποιώντας τα στατιστικά, και τα όρια εµπιστοσύνης που 
καθορίζει ο χρήστης, το λογισµικό εξάγει τις φασµατικές τιµές κάθε εικονοστοιχείου και το 
ταξινομεί. Η συγκεκριμένη διαδικασία συχνά συµπεριλαµβάνει τον υπολογισµό και την 
εκτίµηση της οµοιότητας που χρησιµοποιείται για να συµπεριληφθεί κάθε pixel σε πιθανές 
κλάσεις. Τα όρια εµπιστοσύνης χρησιµοποιούνται για να καθορίσει ο χρήστης ποια pixels 
είναι αδύνατον να ταξινοµηθούν σε κάποια κατηγορία. 
 
Οι απλούστερες µέθοδοι ταξινόµησης του ENVI, είναι οι µη καθοδηγούµενες Iso-Data και 
KMeans. Αυτές οι µέθοδοι δεν απαιτούν προηγούµενη γνώση της περιοχής που 
αποτυπώνεται στην εικόνα. Χρησιµοποιούν πληροφορίες από την ίδια την εικόνα για να 
καθορίσουν φασµατικές οµάδες, που µεταφράζονται ως κλάσεις. Η µέθοδος IsoData, 
απαιτεί από τον χρήστη να προκαθορίσει ένα εύρος κλάσεων. Εν συνεχεία χρησιµοποιεί 
διαίρεση, συγχώνευση και διαγραφή για να καθορισθεί ο τελικός αριθµός των κλάσεων. Η 
µέθοδος K-Means, απαιτεί από τον χρήστη να καθορίσει επακριβώς το πλήθος των 
κλάσεων που επιθυµεί. Και οι δύο µέθοδοι, γενικά θα ταξινοµήσουν όλα τα pixels της 
εικόνας, αλλά υπάρχει και η δυνατότητα να καθορισθούν όρια εµπιστοσύνης που θα 
χρησιµοποιηθούν για αφήσουν κάποια pixels εκτός κλάσεων, δηλαδή αταξινόμητα.  
 
Οι καθοδηγούµενες µέθοδοι ταξινόµησης του ENVI, απαιτούν την εισαγωγή πληροφοριών 
για τις προκαθορισµένες κλάσεις, πριν από την ταξινόµηση. Οι περιοχές ενδαιφέροντος– 
ROIs, χρησιµοποιούνται για να εισαχθούν αυτές οι πληροφορίες. Οι µέθοδοι 
καθοδηγούµενης ταξινόµησης συµπεριλαµβάνουν τις: Parallelepiped, Minimum Distance, 
Maximum Likelihood, Mahalanobis Distance, Binary Encoding & Neural Net. Επίσης 
για την καθοδηγούµενη ταξινόµηση χρησιµοποιούνται και τεχνικές ανάλυσης 
υπερφασµατικών δεδοµένων. 
 
Στατιστικά Στοιχεία Εικόνας 
 
Τα στατιστικά στοιχεία της εικόνας προ-υπολογίζονται προκειμένου να ακολουθήσει η 
ταξινόµηση της εικόνας. Μελετάται η κατανοµή των DNs σε κάθε κανάλι, τα µέγιστα και 
ελάχιστα, το ιστόγραµµα κάθε καναλιού και τέλος η παραλλακτικότητα των τιµών µε την 
βοήθεια της συσχέτισης και της συνδιακύµανσης.  
 
Σε αρκετές περιπτώσεις πολυ-φασµατικών εικόνων, και για γειτονικά φασµατικά κανάλια 
περιέχεται σχεδόν η ίδια πληροφορία. Αντίθετα κατά την ταξινόµηση της εικόνας 
συμπεριλαμβάνονται εκείνα τα κανάλια που θα δώσουν την µέγιστη διαχωριστική ικανότητα, 
δηλαδή εκείνα που εµφανίζουν την µικρότερη συσχέτιση. 

 
Ανοίξτε την εικόνα bhtmref.img από το File > Open Image. Πρόκειται για τµήµα εικόνας 
LANDSAT TM, ανάλυσης 30m.  
 
Στο παράθυρο Available Bands List ανοίγει το ζητούμενο αρχείο (εικόνα) και το αρχείο 
bhdemsub.img, το οποίο είναι το αντίστοιχο ψηφιακό µοντέλο αναγλύφου (DEM 
Elevation), για την περιοχή.  
 
Το αρχείο εικόνας είναι συσχετιζόμενο µε το αρχείο του ψηφιακού µοντέλου και ανοίγουν και 
τα δύο ταυτόχρονα.  
 
Πληροφορίες για την προβολή, την ανάλυση και τις συντεταγµένες της άνω αριστερής 
γωνίας της εικόνας, δίδονται επιλέγοντας το Map Info. 

 
Για µια ολοκληρωµένη στατιστική ανάλυση της εικόνας, από το κυρίως µενού επιλέγομε: 
Basic Tools > Statistics > Compute Statistics.  
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Εμφανίζεται το παράθυρο Compute Statistics Parameters. Ενεργοποιήστε τα πεδία 
Histograms και Covariance, επίσης ενεργοποιήστε το Output to a Statistics File και 
ορίστε την διαδροµή και το όνοµα του αρχείου που θα περιέχει τα στατιστικά (το αρχείο που 
θα δηµιουργηθεί θα έχει κατάληξη *.sta).  Δώστε ΟΚ και περιµένετε να ολοκληρωθεί ο 
υπολογισµός και η αποθήκευση του αρχείου. 
 
Από το Select Plots επιλέξατε Eigenvalues (ιδιοτιμές). Βλέπετε τα κανάλια που μετά από 
ανάλυση κυρίων συνιστωσών θα περιέχουν το μεγαλύτερο ποσοστό πληροφορίας από όλα 
τα αρχικά κανάλια. 
 
Δίνοντας Select Plot  →  Histogram: All Bands.  Εμφανίζονται τα ιστογράμματα όλων των 
καναλιών σε ένα γραφικό. Με Select Stat → Correlation, θα μεταβείτε στον πίνακα 
συσχέτισης των καναλιών. Εδώ αποτυπώνεται πόσο συμμεταβάλονται οι τιμές ενός 
καναλιού σε σχέση με τα άλλα κανάλια της εικόνας. Όσο η συσχέτιση μεταξύ των καναλιών 
πλησιάζει την μονάδα τόσο περισσότερο συσχετιζόμενες είναι οι τιμές τους, δηλαδή 
περιέχουν την ίδια περίπου πληροφορία.  
 
Στην διαδικασία ταξινόμησης, επιδιώκεται η συσχέτιση μεταξύ των καναλιών να είναι η 
μικρότερη δυνατή και όχι το μεγάλο πλήθος των καναλιών. Επιθυμούμε να έχουμε μικρό 
αριθμό καναλιών με μικρή συσχέτιση (μεγάλη παραλλακτικότητα) και όχι μεγάλο αριθμό 
καναλιών με περιτή πληροφορία. 

 
Μελετώντας τον πίνακα συσχέτισης, φαίνεται πως το κανάλι 1 σε σχέση με το κανάλι 2 
έχουν βαθμό συσχέτισης 0,956817, δηλαδή υψηλή συσχέτιση. Αντίθετα το κανάλι 4 σε 
σχέση με το κανάλι 1 έχει πολύ μικρό βαθμό συσχέτισης 0,012966, από τους χαμηλότερους 
στον πίνακα. 
 
Η επιλογή των καναλιών που θα χρησιμοποιηθούν για να ταξινομηθεί η εικόνα εξαρτάται 
από την μεταξύ τους συσχέτιση και από το είδος του χαρακτηριστικού που επιθυμούμε να 
ταξινομήσουμε (π.χ. έδαφος, βλάστηση κ.ά.). Μια επιλογή καναλιών είναι 1-4 > 0,012966, 1-
5 > 0,807018 και 4-5 > 0,092533, δηλαδή τα κανάλια 1,4 και 5 είναι χρήσιμα για την 
εφαρμογή μας. 
 
 
Μη Επιβλεπόµενη Ταξινόµηση 
 
Επιλέξτε την εικόνα που θα ταξινομηθεί από το κυρίως µενού: Classification > 
Unsupervised > IsoData. Στο παράθυρο Classification Input File, δηλώστε το αρχείο που 
επιθυµείτε να ταξινοµήσετε. 
 
Στο ίδιο παράθυρο Classification Input File, επιλέξτε το πεδίο Spectral Subset. Θα 
εµφανισθεί το νέο παράθυρο File Spectral Subset.  
 
Κρατώντας πατηµένο το πλήκτρο CTRL επιλέξτε µε το αριστερό πλήκτρο του ποντικιού τα 
κανάλια 1, 4, 5 και πατήστε ΟΚ. 
 
Η µέθοδος IsoData υπολογίζει οµάδες κλάσεων οµαλά κατανεµηµένες στον χώρο των 
δεδοµένων (clusters), µε µια διαδικασία που περιλαµβάνει υπολογισµό κλάσης, 
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συγκέντρωση εναποµείναντων pixels, επαναπροσδιορισµό κλάσεων κ.ο.κ. 
χρησιµοποιώντας την τεχνική των ελαχίστων αποστάσεων. 
 
Σε κάθε επανάληψη επαναϋπολογίζεται ο µέσος, και επαναταξοινοµούνται τα pixels σε 
σχέση µε τους νέους µέσους. Η επαναλαµβανόµενη διαίρεση, συγχώνευση και διαγραφή 
των κλάσεων γίνεται µε βάση τα όρια εµπιστοσύνης που θέτει ο χρήστης. Όλα τα 
εικονοστοιχεία ταξινοµούνται στην κοντινότερη προς το καθένα κλάση, εκτός και εάν έχει 
καθορισθεί μια τιµή τυπικής απόκλισης ή όριο απόστασης, οπότε κάποια εικονοστοιχεία θα 
µείνουν αταξινόµητα εάν δεν πληρούν τα προκαθορισµένα κριτήρια. Προκειμένου να μειωθεί 
ο όγκος των δεδομένων και ταυτοχρόνως τον χρόνο επεξεργασίας χρησιµοποιούµε τα 
κανάλια 1,4, και 5, όπως προαναφέρθηκε. Στο συγκεκριµμένο παράδειγµα είναι δυνατόν να 
εκτελέσουµε την ταξινόµηση χρησιµοποιώντας όλα τα κανάλια της εικόνας. Σε άλλες 
περιπτώσεις, όπου ο όγκος της εικόνας είναι εκατοντάδες Mb ή και Gb, ο περιορισµός των 
καναλιών σε εκείνα που είναι απαραίτητα, είναι µια πολύ αποδοτική πρακτική. 
 
Θα εµφανισθεί το παράθυρο του εργαλείου ταξινόµησης ISODATA Parameters. Εδώ θα 
δηλώσετε: 
 
1. Number of Classes Min Max. Ο ελάχιστος και ο µέγιστος αριθµός των κλάσεων που θα 
δηµιουργηθούν. Η µέθοδος IsoData διαιρεί και συγχωνεύει κλάσεις µέχρι να καταλήξει στην 
άριστη λύση, βάση των ορίων εµπιστοσύνης που καθορίζονται από τον χρήστη. 
2. Maximum Iterations. Ο µέγιστος αριθµός των επαναλήψεων. 
3. Change Threshold. Ο βαθµός εµπιστοσύνης για την ταξινόµηση ή µη ενός 
εικονοστοιχείου σε µια κλάση. 
4. Minimum Pixels in Classes. Ο ελάχιστος αριθµός των εικονοστοιχείων που θα 
αποτελούν µια κλάση. Όταν το πλήθος των pixels µιας κλάσης είναι µικρότερο από αυτό το 
όριο, τότε η κλάση διαγράφεται και τα pixels ταξινοµούνται στις εγγύτερες κλάσεις. 
5. Minimum Class Distance. Η ελάχιστη απόσταση µεταξύ των µέσων των κλάσεων (τιµές 
DN). Εάν η τιµή ξεπεραστεί τότε η κλάση συγχωνεύεται µε άλλη. 
6. Maximum  Merge Pairs. Ο μέγιστος αριθµός ζευγών κλάσεων που συγχωνεύονται. 
7. Maximum Stdev From Mean. Η µέγιστη τυπική απόκλιση (τιµές DN). Όταν η τυπική 
απόκλιση µιας κλάσης είναι µεγαλύτερη από αυτή την τιµή τότε η κλάση διαιρείται 
(προαιρετικό). 
8. Maximum Distance Error (προαιρετικό). 
9. Output Filename. Το παραγόµενο αρχείο – η ταξινοµηµένη εικόνα. 
 
Για την ταξινόµηση της εικόνας του παραδείγµατος, δηλώστε τα ακόλουθα: 
 
  Number of Classes Min Max 8 - 10 
  Maximum Iterations 4 
  Change Threshold 5.00 
  Minimum # Pixels in Classes 10 
  Minimum Class Distance 1.000 
Maximum # Merge Pairs. 5.000 
 

Στην επιλογή Output Result επιλέξτε Memory, καθώς θα επαναλάβετε την ταξινόµηση 
αρκετές φορές, αλλάζοντας τις παραπάνω µεταβλητές και µελετώντας τα αποτελέσµατα, 
οπότε δεν θα δεσµευθεί χώρος στον δίσκο. Δώστε ΟΚ, και όταν ολοκληρωθεί η διαδικασία 
ανοίξτε το αποτέλεσµα της ταξινόµησης σε µια νέα οθόνη. Το αποτέλεσµα περιέχεται στο 
Available Bands List, µε την ένδειξη Memory#. 
 
Χρησιµοποιώντας το εργαλείο Link Displays – Dynamic Overlay, συγκρίνετε το 
αποτέλεσµα της ταξινόµησης µε την αρχική εικόνα υπερθέτοντας την µία εικόνα επάνω στην 
άλλη. 
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Από το µενού Tools επιλέξατε Cursor Location / Value. Βλέπετε πληροφορίες που 
αφορούν και τις δύο δια-συνδεδεµένες οθόνες ταυτόχρονα, σχετικά με συντεταγμένες κ.ά. 
καθώς και την κλάση στην οποία ταξινοµήθηκε το κάθε εικονοστοιχείο. Τέλος, επειδή η 
αρχική εικόνα είναι συνδεδεµένη µε ένα ψηφιακό µοντέλο εδάφους, δίνεται και η αντίστοιχη 
πληροφορία του υψοµέτρου. 
 
Στατιστικές πληροφορίες για το αποτέλεσµα της ταξινόµησης παίρνετε από το κυρίως µενού, 
επιλέγοντας Classification > Post Classification > Class Statistics. Στο παράθυρο 
Classification Input File, δηλώστε το αρχείο µε τα αποτελέσµατα της ταξινόµησης που 
επιθυµείτε να εξετάσετε και πατήστε ΟΚ. 
 
Στο παράθυρο Statistics Input File, εφόσον δεν έχετε υπολογίσει προηγουµένως 
στατιστικά από το αρχείο ταξινόµησης, δώστε ακριβώς το ίδιο αρχείο. Στο επόµενο 
παράθυρο, το Class Selection επιλέξτε όλες τις κλάσεις δίνοντας το Select All Items και 
πατήστε ΟΚ. 
 
Το αποτέλεσµα περιέχεται στο Class Statistics Results. Στο κάτω τµήµα φαίνονται 
αναλυτικά τα αποτελέσµατα της ταξινόµησης: αριθµός pixels ανά κλάση, ποσοστό % και 
επιφάνεια σε τετραγωνικά µέτρα (m2

 

). Εάν θέλετε οι επιφάνειες κάθε κλάσης να δίδονται σε 
διαφορετική µονάδα µέτρησης, επιλέγετε Options > Class Summary Area Units. 

Εάν θέλετε να µεταφέρετε τα αποτελέσµατα σε άλλη εφαρµογή (π.χ. σε κάποιο κείμενο 
WORD) τα αντιγράφετε µε click & drag. 
 
Για να αποθηκεύσετε τα αποτελέσµατα της στατιστικής ανάλυσης, δώστε File > Save all 
Class Results to ENVI Stats File. Για να κλείσετε το παράθυρο Class Statistics Results 
δώστε File > Cancel. 
 
Επαναλάβετε την διαδικασία της µη καθοδηγούµενης ταξινόµησης έως ότου καταλήξετε σε 
ικανοποιητικό αποτέλεσµα. Για να αποθηκεύσετε το περιεχόµενο της µνήµης σε µόνιµο 
µέσον, επιλέγετε από το Available Bands List, το Memory# και με δεξί κλικ δίνετε Save 
Selected File to Disk. 
 
Επαναλάβετε την διαδικασία της µη καθοδηγούµενης ταξινόµησης με την μέθοδο K-Means. 
Δώστε τα ίδια κανάλια της αρχικής εικόνας και τις παραμέτρους που χρησιμοποιήσατε στην 
προηγούμενη μέθοδο. 
 
Kαθοδηγούµενη Tαξινόµηση με την μέθοδο Parallelepiped:  
 
Classification > Supervised > Parallelepiped. Στο παράθυρο Classification Input File, 
δηλώστε το αρχείο που επιθυµείτε να ταξινοµήσετε, επιλέγοντας τα ίδια κανάλια της αρχικής 
εικόνας 1, 4, 5 από το Spectral Subset. Για να επιτευχθεί η καθοδηγούµενη ταξινόμηση, 
δημιουργείστε αρχικά περιοχές ενδιαφέροντος ROIs, βάσει των οποίων θα γίνει η 
ταξινόμηση της εικόνας. 
 
Είναι δυνατή η συνένωση δύο ή και περισσοτέρων κλάσεων σε μία: Classification > Post 
Classification > Combine Classes.   
 
Δημιουργία Διανυσματικού Αρχείου 
 
Είναι δυνατή η εξαγωγή των κλάσεων σε διανυσματικό αρχείο (θεματικό επίπεδο 
πληροφορίας): Classification > Post Classification > Classification to Vector. 
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Β. Πράξεις μεταξύ Φασματικών Καναλιών 
 
Προκειμένου να επιτευχθεί η φωτοερμηνεία της εικόνας και να διακριθούν οι ζητούμενες 
δομές ή για την παρακολούθηση κάποιου φαινομένου διαχρονικά, αρκετές φορές είναι 
χρήσιμες οι πράξεις μεταξύ φασματικών  καναλιών της ίδιας ή διαφορετικής εικόνας (με την 
ίδια χωρική διακριτική ικανότητα). 
 
Οι πράξεις επιτυγχάνονται μέσω του Band Math, όπου αποδίδονται μέσω μαθηματικών 
εκφράσεων οι πράξεις μεταξύ των φασματικών καναλιών: 
Main Menu → Basic Tools → Band Math 
 
Επίσης οι Λόγοι των Καναλιών επιτυγχάνονται ως ακολούθως: 
 
Main Menu → Transform → Band Ratios 
 
 
 
 

ΑΣΚΗΣΗ 4
Επεξεργασία Δορυφορικών Εικόνων  

η 

 Γεω-αναφορά Δορυφορικών Εκόνων  
 

Το ENVI, διαθέτει ρουτίνες για την γεω-αναφορά δεδοµένων, χρησιµοποιώντας ως 
πληροφορία αναφοράς (reference data) μια ήδη γεω-αναφερόµενη εικόνα, ή διανυσµατικά 
γεω-αναφερόµενα δεδοµένα, καθώς και συντεταγμένες γνωστών σημείων σε αρχεία  ascii. 
Είναι επίσης δυνατόν, να αξιοποιηθούν οι ρουτίνες που αναφέρονται σε γεωµετρική 
διόρθωση (γεω-αναφορά ή ορθο-αναγωγή) συγκεκριµένων τύπων εικόνων, όπως ASTER, 
IKONOS, QUICKBIRD, LANDSAT κ.ά. Το λογισµικό αξιοποιεί µεταδεδοµένα που 
περιέχονται στα αρχεία των εικόνων (ως header) ή σε συνοδευτικά αρχεία ASCII. 
 
Σε κάθε περίπτωση, η επιτυχία της γεω-αναφοράς εξαρτάται: 
1. Από το πλήθος και την κατανοµή των εδαφικών σηµείων  ελέγχου, τα οποία είναι 
απαραίτητο να είναι ισο-κατανεμημένα τόσο κατά την οριζόντια όσο και κατά την 
κατακόρυφη διάσταση της εικόνας. 
2. Από την ποιότητα της πληροφορίας αναφοράς. 
3. Από την ευκρίνεια και την διακριτική ικανότητα της εικόνας προς γεω-αναφορά, αλλά και 
της πληροφορίας αναφοράς. 
 
Γεω-αναφορά Εικόνας βάσει Χάρτη (Raster to Vector) 
 
Η διαδικασία της γεω-αναφοράς εικόνας βάσει συντεταγµένων διανυσµατικών 
πληροφοριών, αφορά στον συσχετισμό χαρακτηριστικών σηµείων της εικόνας µε τα 
αντίστοιχα χαρακτηριστικά σηµεία του διανυσματικού επιπέδου. Θα γεω-αναφερθεί εικόνα 
Meris χρησιµοποιώντας ως βασικό χαρακτηριστικό αναγνώρισης την ακτογραµµή, η οποία 
ευρίσκεται σε διανυσματική μορφή. Φυσικά αυτό δεν είναι η σωστή διαδικασία εφόσον όπως 
έχει προαναφερθεί το πλήθος και η κατανοµή των εδαφικών σηµείων  ελέγχου πρέπει να 
εκτείνεται σε όλη την περιοχή της εικόνας, αλλά γίνεται μόνο για την άσκηση. 
 
Από το κυρίως µενού επιλέξτε: File → Open External File → ENVISAT → MERIS και 
ανοίξτε το αρχείο MER_FR__.N1.  
 
Η εικόνα φορτώνεται στο παράθυρο Available Bands List. Υπάρχουν πολλά επίπεδα 
πληροφορίας, που αφορούν στο ορατό-υπέρυθρο, βαροµετρική πίεση, υγρασία 
ατµόσφαιρας και άλλα. Επιλέξτε το πρώτο. Mε δεξί κλικ στο όνοµα του αρχείου που 
επιθυμείτε να γεω-αναφερθεί και εν συνεχεία με Load True Color θα φορτωθεί η εικόνα. 
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Από το µενού της οθόνης δώστε Tools → Cursor Location/Value. Παρατηρείστε πως 
αναφέρονται µόνο εικονο-συντεταγµένες, εφόσον η εικόνα δεν αναφέρεται σε κανένα 
γεωδαιτικό σύστηµα αναφοράς. 
 
Από το κυρίως µενού επιλέξτε File → Open Vector. Στο παράθυρο Select Vector 
Filenames ορίστε τον τύπο του αρχείου σε Shapefile, και επιλέξετε το «greece.shp». Το 
περιεχόµενο του αρχείου είναι η ακτογραμμή της Ελλάδος (προβολή UTM34, Datum 
WGS84). Tο ENVI, δεν διαχειρίζεται αυτούσια τα αρχεία διανυσµατικών δεδοµένων, αλλά τα 
µετατρέπει στην δική του µορφή (Envi Vector Format (με κατάληξη evf). Οι τύποι 
διανυσµατικών αρχείων που υποστηρίζονται από το ENVI είναι: Shapefile (shp), Arc/Info 
Interchange (e00), MapInfo (mif), AUTOCAD (dxf), Microstation (dgn) & USGS DLG. 
 
Εφόσον επιλέξετε το αρχείο δώστε ΟΚ. Θα εµφανισθεί το παράθυρο διαλόγου Import 
Vector File Parameters. Εδώ πρέπει να δηλώσετε: 
1. Layer Name. Ένα όνοµα για το διανυσµατικό επίπεδο πληροφοριών.  
2. Output Filename. Δηλώστε το όνοµα και την διαδροµή όπου θα αποθηκευθεί το αρχείο 
evf (coast.evf). 
3. Native File Projection. O διανυσµατικός τύπος Shapefile δεν φέρει την προβολική 
πληροφορία, η οποία θα πρέπει να δηλωθεί σε αυτό το στάδιο. Ορίστε την γεωγραφική 
προβολή, Geographic Projection. 
4. Datum. Παροµοίως ορίστε το Datum ως WGS84. 
5. Αφού εισάγετε τις παραπάνω πληροφορίες, πατήστε ΟΚ. 
 
Εμφανίζεται το παράθυρο Available Vectors List, παραπλήσιο του Available Bands List 
και αναφέρονται όλα τα επίπεδα διανυσµατικής πληροφορίας που έχουν εισαχθεί επιτυχώς 
στο ENVI. Επιλέξτε το επίπεδο coastline.evf και παρατηρείστε το περιεχόµενο των 
πληροφοριών στο κάτω τµήµα του παράθυρου, όπου δίνονται πληροφορίες για το µέγεθος 
και το περιεχόµενο του αρχείου, την γεωγραφική προβολή, το datum κλπ. Δώστε Load 
Selected, και θα εµφανισθεί το αναδυόµενο παράθυρο Load Vector. Δηλώνετε σε τι είδους 
οθόνη θα απεικονισθούν τα δεδοµένα. (Vector ή Image). Στην περίπτωση του 
παραδείγµατος, εφόσον η εικόνα δεν είναι γεωαναφερόµενη σε κάποιο γεωδαιτικό σύστηµα, 
η απεικόνιση των διανυσµάτων στο Display #1 θα αποτύχει αφού αυτά είναι σε γεωγραφική 
προβολή. Από το αναδυόµενο παράθυρο Load Vector, επιλέξτε New Vector Window, για 
να απεικονίσετε τα διανυσµατικά δεδοµένα σε ένα παράθυρο αποκλειστικής διανυσµατικής 
απεικόνισης. Το νέο παράθυρο ανοίγει και απεικονίζεται το σύνολο των δεδοµένων. Κάτω 
αριστερά εµφανίζονται οι γεωγραφικές συντεταγµένες.  
 
Ορίστε στον χάρτη µια περιοχή µεγένθυνσης, κρατώντας το µεσαίο πλήκτρο του ποντικιού 
πατηµένο, εγγράφετε ένα ορθογώνιο και ελευθερώνετε κατόπιν. Επιστρέψτε στην 
προηγούµενη απεικόνιση με δεξί κλικ και επιλέγοντας Previous Range, ενώ με Reset 
Range επιστρέφετε σε πλήρη απεικόνιση. Εάν επιθυμείτε να µετακινηθείτε αριστερά, δεξιά, 
πάνω ή κάτω πατήστε προς την επιθυµητή διεύθυνση µε το αριστερό πλήκτρο του 
ποντικιού. 
 
Με αριστερό κλικ επάνω σε ένα διάνυσµα ο κέρσορας «αγκυστρώνεταιι» επάνω σε αυτό, οι 
συντεταγµένες του φαίνονται στην κάτω αριστερή γωνία του παράθυρου και διατηρούνται 
έως να πατήσετε επάνω σε κάποιο άλλο σημείο. Εάν µετακινείτε τον κέρσορα οι 
συντεταγµένες παραµένουν σταθερές και καταχωρούνται στην µνήµη του Vector Window. 
 
Σε αυτό το σηµείο και εάν έχετε εκτελέσει τα παραπάνω βήµατα, πρέπει να έχετε δύο οθόνες 
ανοικτές: Μία οθόνη που απεικονίζει την αρχική εικόνα Meris (Display #1), και µια οθόνη 
που απεικονίζει την ακτογραµµή της Ελλάδος σε( long, lat) / WGS84 (Vector Window #1). 
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Από το κυρίως µενού δώστε Map → Registration → Select GCPs: Image to Map. 
Εµφανίζεται το παράθυρο Image to Map Registration. Στο Select Registration Projection 
επιλέξτε Hellenic Geodetic Reference System 87. Εμφανίζονται: Datum: EGSA87,   Units: 
Meters,   X & Y Pixel Size: 30m. Δώστε ΟΚ.   
 
Το παράθυρο Ground Control Points Selection εµφανίζεται. Το επόµενο βήµα είναι η 
επιλογή και συσχέτιση σηµείων (Ground Control Points / GSPs) µεταξύ Image Display και 
Vector Window.  
 
Εξετάστε ποιες περιοχές αναγνωρίζονται και στα δύο παράθυρα.. Μεγενθύνετε το Vector 
Window (με το μεσαίο πλήκτρο του ποντικιού), στην περιοχή της Εύβοιας, και µετακινείστε 
την οθόνη εστίασης ώστε να βλέπετε την ίδια περιοχή και να διακρίνετε τα ίδια 
χαρακτηριστικά της ακτογραµµής. Μετακινείστε τον κέρσορα της οθόνης εστίασης του 
Display #1. Για να µετακινείτε τον κέρσορα µε ακρίβεια pixel, από το µενού της κύριας 
οθόνης δώστε Tools → Pixel Locator. Το συγκεκριμένο εργαλείο σας επιτρέπει να 
µετακινείσετε κατά ένα pixel σε κάθε πάτηµα, χρησιµοποιώντας τα βέλη κατεύθυνσης στο 
κάτω τμήμα του παράθυρου και προς την διεύθυνση που αυτά υποδεικνύουν. 
 
Έχετε και στις δύο οθόνες αποτυπωµένο το ίδιο σηµείο. Δώστε αριστερό κλικ στο Vector 
Window για να επιλέξετε το σηµείο που κρίνετε πως ανταποκρίνεται καλύτερα. Οι 
συντεταγµένες του σηµείου φαίνονται στο κάτω αριστερό τμήμα της οθόνης. Εν συνεχεία 
δώστε δεξί κλικ και στο αναδυόµενο µενού πατήστε Export Map Location. Στο παράθυρο 
Ground Control Points Selection, οι συντεταγµένες κάτω από το πεδίο που αναφέρεται η 
προβολή είναι σε µέτρα (ΕΓΣΑ87). Εάν θέλετε διορθώστε το αντίστοιχο σηµείο της εικόνας 
(οι εικονοσυντεταγµένες εµφανίζονται επάνω δεξιά) µε το Pixel Locator, και όταν είστε 
ικανοποιηµένοι δώστε Add Point. Στο Vector Window και στο Display Window εµφανίζεται 
το σηµείο και η αρίθµησή του. Επίσης στο παράθυρο Ground Control Points Selection το 
πεδίο Number of selected Points από 0 αλλάζει σε 1. Με τον ίδιο τρόπο συνεχίστε να 
προσθέτετε ζεύγη σηµείων. Από 5ο

 
 σηµείο θα πάρετε το µέγεθος του RMS. 

Όταν ολοκληρώσετε πατήστε το Show List, για να πάρετε τον κατάλογο όλων των σηµείων 
που προσθέσατε (Image to Map GCP List). Μετακινήστε την µπάρα κύλισης προς τα δεξιά 
ώστε να δείτε το πεδίο RMS. Από το Options ζητήστε Order Points by Error για να 
ταξινοµήσετε την λίστα ανάλογα µε το κατά πόσο συνεισφέρει κάθε σηµείο στο συνολικό 
σφάλµα RMS. Είναι δυνατόν να επιλέξετε τα σηµεία που σας ενδιαφέρουν από τον αριθµό 
τους. Είναι δυνατόν να τα τροποποιήσετε (µε τον ίδιο τρόπο που τα εισαγάγατε) από το 
εργαλείο Ground Control Points Selection και τέλος να δώσετε Update από το Image to 
Map GCP List. Όταν επιλέγετε ένα σηµείο από τον κατάλογο, οι οθόνες ενηµερώνονται 
ώστε να απεικονίζεται το επιλεγµένο σηµείο. Επίσης, είναι δυνατόν να διατηρήσετε κάποια 
σηµεία στον κατάλογο αλλά µε την επιλογή On/Off να δηλώσετε πως δεν επιθυµείτε αυτά τα 
σηµεία να χρησιµοποιηθούν για την γεω-αναφορά (δίπλα στον αριθµό αντί του  «+»  θα 
εµφανίζεται   «-»). Τέλος, είναι δυνατόν να αποθηκεύσετε τα σηµεία είτε ως διανυσµατικά 
αρχεία (σε προβολικές ή γεωγραφικές συντεταγµένες), είτε ως αρχείο ASCII. Αυτό 
επιτυγχάνεται από το παράθυρο Ground Control Points Selection και το µενού File. 
 
Όταν ολοκληρώσετε τις ρυθµίσεις στον κατάλογο των σηµείων πατήστε Hide List. Στο 
παράθυρο Ground Control Points Selection, και εφόσον είστε ικανοποιηµένοι µε το RMS 
που υπολογίζεται, πατήστε Options → Warp File. Θα εµφανισθεί το παράθυρο Input Warp 
Image, όπου θα επιλέξετε το αρχείο που επιθυµείτε να γεωαναφέρετε.  Στο Spectral Subset 
δώστε 1. Δώστε ΟΚ. Στο παράθυρο Registration Parameters, από την οµάδα ρυθµίσεων 
Warp Parameters (δεξί τμήμα) αλλάξτε την µέθοδο επαναδηγµατοληψίας σε Cubic 
Convolution, και δηλώστε το όνοµα και την διαδροµή του αρχείου. Δώστε ΟΚ. 
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Όταν ολοκληρωθεί η διαδικασία, το νέο 
αρχείο θα εµφανισθεί στο Available 
Bans List. Σε µια νέα οθόνη 
δηµιουργείστε την έγχρωµη απεικόνιση 
της γεωαναφερόµενης εικόνας. 
Παρατηρείστε τον προσανατολισµό της 
εικόνας. Επίσης, παρατηρείστε πως στο 
Available Bans List η νέα εικόνα 
διαθέτει Map Info. Μετακινώντας το 
ποντίκι εντός της κύριας οθόνης, δώστε 
δεξί κλικ, και από το αναδυόµενο 
παράθυρο ζητείστε Cursor/Location 
Value. Είναι δυνατόν να δείτε και τις 
γεωγραφικές και πραγματικές 
συντεταγµένες που απέκτησε η εικόνα 
µετά την γεω-αναφορά. 
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ΑΣΚΗΣΗ 5
Επεξεργασία Δορυφορικών Εικόνων 

η 

Ορθο-αναγωγή Δορυφορικών Εκόνων 
 
Η ορθο-αναγωγή προσδίδει μεγάλη γεωμετρική ακρίβεια σε όλη την έκταση της εικόνας, 
καθώς η εικόνα γεωαναφέρεται και αποκτά διαστάσεις χάρτη (απαλοιφή παραμορφώσεων 
λόγω τοπογραφίας). Όπως έχει αναφερθεί, απαραίτητες παράμετροι, για την ορθο-αναγωγή 
εικόνας, είναι το ΨΜΑ της περιοχής και σημεία ελέγχου (GCPs) με συντεταγμένες (x, y, z). H 
ακρίβεια των GCPs και του ΨΜΑ που θα χρησιμοποιηθούν καθώς και το μέγεθος pixel του 
ΨΜΑ εξαρτώνται από το μέγεθος pixel της εικόνας και τις απαιτήσεις της μελέτης. 
 
Στην άσκηση θα παρουσιασθεί η διαδικασία ορθο-αναγωγής δορυφορικής εικόνας μέσω του 
ENVI, με χρήση του μοντέλου RPC (Rational Polynomial Coefficient), σχετιζομένου με 
παραμέτρους της κάμερας λήψης).  Κατά την συγκεκριμένη επεξεργασία δεν είναι 
απαραίτητα το ΨΜΑ και τα GCPs. Η χρήση τους βέβαια, προσδίδει λεπτομερέστερη 
διόρθωση. 
 
Ορθο-αναγωγή εικόνας IKONOS 
 

Άνοιγμα Δορυφορικής Εικόνας 
 

 Από το κυρίως μενού, ανοίξετε την δορυφορική εικόνα IKONOS «ikonos.tif» ως 
ακολούθως:  File →Open Image File. Από τον φάκελο ENVI/DATA/ORTHO επιλέγετε την 
εικόνα «ikonos.tif» και δίνετε open. Από το παράθυρο «Available Bands List» επιλέγετε 
Gray scale και Band 1. Εν συνεχεία, δίνετε Load Band και η εικόνα εμφανίζεται στην 
οθόνη. 
 
 
 

Άνοιγμα ΨΜΑ 
 

Από το κυρίως   μενού και από τον φάκελο ENVI/DATA/ORTHO, ανοίγετε το ΨΜΑ (μορφής 
USGS) «dem1.dem»:  File →Open External File →Digital Elevation →USGS DEM. 
Μετατρέπετε το ΨΜΑ σε μορφή «dat», ώστε να χρησιμοποιηθεί στον αλγόριθμο για την 
ορθο-αναγωγή. Στο παράθυρο «USGS DEM Input Parameters» δίνετε το όνομα του 
παραγόμενου ΨΜΑ  «dem.dat». Από το παράθυρο «Available Bands List» επιλέγετε Gray 
scale και επιλέγετε το Select DEM. Από το παράθυρο «Available Bands List» επιλέγετε 
Display #1 και New Display. Επιλέγετε Load Band και το ΨΜΑ εμφανίζεται στην οθόνη. 
 
Σημείωση:

 

 Το υψόμετρο της περιοχής κυμαίνεται από 0-250m. Οι αλλαγές υψομέτρου 
(τοπογραφική μεταβολή) στην περιοχή, δημιουργεί σφάλματα στην γεωμετρία της IKONOS. 
Το ΨΜΑ και η IKONOS έχουν διαφορετική προβολή και μέγεθος pixel. Δεν είναι απαραίτητο 
να πραγματοποιηθεί προσαρμογή σε κοινό προβολικό σύστημα και αναδόμηση του ΨΜΑ ή 
της IKONOS (παραγωγή ΨΜΑ ή εικόνας με νέο μέγεθος κυψελίδας-pixel), πριν την ορθο-
αναγωγή. 

Διαδικασία Ορθο-αναγωγής 
 
Από το κυρίως μενού επιλέξετε Map → Orthorectification →  IKONOS →  Orthorectify 
IKONOS. Από το παράθυρο με την λίστα των αρχείων επιλέξετε την εικόνα «ikonos.tif». 
Στο παράθυρο «Orthorectification Parameters» δώστε τιμές στις ακόλουθες παραμέτρους: 
 

Image Resampling (Αναδόμηση εικόνας): Δώστε  Bilinear, όπου είναι και η 
προκαθορισμένη για τον αλγόριθμο επιλογή (δίνει σχετικά ομαλά αποτελέσματα). Η 
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επιλογή Cubic Convolution δίνει περισσότερο ομαλά αποτελέσματα, ενώ η Nearest 
Neighbor δεν αλλάζει τις αρχικές τιμές των pixels και δίνει μια σχετικά τραχεία υφή. 
 
Background (αναφέρεται στις τιμές των pixels στα περιθώρια της τελικής ορθο-
αναγώμενης εικόνας): Δώστε την προκαθορισμένη τιμή «0». 
 
Input Height (προσδιορίζει το ΨΜΑ ή μια μέση τιμή υψομέτρου για την περιοχή): 
Επιλέξετε DEM και στην επιλογή Select DEM δώστε το «ortho_dem.dat». 
 
DEM Resampling (Αναδόμηση του ΨΜΑ σε σχέση με την IKONOS): Δώστε  Bilinear. 
Geoid Offset:  Δώστε «-35». Είναι το ύψος του γεωειδούς ως προς την μέση στάθμη της 
θάλασσας στην περιοχή της εικόνας (μια σταθερή τιμή, η οποία προστίθεται σε κάθε 
υψομετρική τιμή του ΨΜΑ, ώστε να υπολογισθεί το ελλειψοειδές υψόμετρο). Τα ΨΜΑ 
συνήθως, προσδίδουν πληροφορία υψομέτρου ως προς την μέση στάθμη της θάλασσας 
για κάθε pixel. Για την ορθο-αναγωγή απαιτείται πληροφορία ελλειψοειδούς υψομέτρου 
για κάθε pixel. Τα «RPC» έχουν δημιουργηθεί σε σχέση με το γεωειδές υψόμετρο και η 
συγκεκριμένη παράμετρος χρησιμοποιείται για ακριβέστερη ορθο-αναγωγή. Για 
παράδειγμα, εάν το γεωειδές είναι 10m κάτω από την μέση στάθμη της θάλασσας τότε 
πρέπει να δοθεί στην παράμετρο η τιμή «-10». 
Η σχέση μεταξύ Ελλειψοειδούς υψομέτρου H και γεωειδούς υψομέτρου h με το μοντέλο 
γεωειούς-ελλειψοειδούς διαχωρισμού N, είναι:  H = h + N 

 
Save Computed DEM: Επιλέξετε No. Δηλώνετε εάν επιθυμείτε να αποθηκευτεί το 
αναδομημένο ΨΜΑ, το οποίο δημιουργείται κατά την διαδικασία ορθο-αναγωγής.  

 
Στο δεξί τμήμα του παράθυρου-διαλόγου δίδονται οι παράμετροι (μέγεθος pixel και όρια 
εικόνας) της παραγόμενης (ορθο-αναγόμενης) εικόνας. Οι παράμετροι υπολογίζονται από 
την αρχική εικόνα IKONOS. Είναι δυνατή η αποδοχή των προκαθορισμένων παραμέτρων 
ή η αλλαγή αυτών. 
 
Orthorectified Image Filename: Δίνετε το όνομα της παραγόμενης εικόνας 
«ikonos_ortho.dat». 

 
Μετά την εισαγωγή όλων των παραμέτρων, επιλέγετε ΟΚ, για να αρχίσει η διαδικασία ορθο-
αναγωγής. Με το πέρας της διαδικασίας η ορθο-αναγώμενη εικόνα εμφανίζεται στο 
παράθυρο «Available Bands List». 
 
Εμφανίσετε την εικόνα στο Display #2. Επιλέξτε και συγκρίνετε κοινά σημεία της αρχικής 
εικόνας IKONOS και της ορθο-αναγώμενης, επιλέγοντας Tools  → Link Displays  → Link 
από το μενού. Με το αριστερό πλήκτρο του ποντικιού ενεργοποιείτε ένα «display». 
Παρατηρείστε τις συντεταγμένες αντιστοίχων σημείων. 
 
Με File →Exit από το κυρίως μενού,  κλείνετε το ENVI. 
 
 
 
 

ΑΣΚΗΣΗ 6
Εφαρμογή Μεθόδων Βελτίωσης Εικόνας - Φωτοερμηνεία 

η 

 
Ανόιξτε την ορθο-εικόνα ΙΚΟΝΟΣ-2 της Νισύρου:  “orthonis.tif” 
 
Εφόσον την έχετε βελτιώσει οπτικά χρησιμοποιώντας ίσως διαφορετικές τεχνικές για 
διαφορετική κατηγορία δομών που θα προσπαθήσετε να διακρίνετε, ψηφιοποιήσετε τα 
κάτωθι θεματικά επίπεδα και δημιουργείστε 1 shapefile για κάθε κατηγορία. 
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• Οδικό δίκτυο (ταξινομημένο σε κυρίως και δευτερεύων) 
 
• Κτήρια   
 
• Τεκτονικές δομές  
 
• Χρήσεις Γης  (ταξινομημένες σε καλλιεργημένη γη, δασική περιοχή, θαμνώδης έκταση, 

κατοικημένη περιοχή, κρημνός, κρημνώδης ακτή) 
 
 
 
 

ΑΣΚΗΣΗ 7
Παραγωγή ΨΜΑ από Δορυφορικές Εικόνες  

η 

μέσω ENVI  
 
 
Η  δημιουργία ΨΜΑ από δορυφορικά στρεο-ζεύγη ASTER, IKONOS, OrbView-3, SPOΤ και 
Α/Φ επιτυγχάνεται μέσω του ENVI. 
 
Ο οδηγός του εργαλείου (DEM Extraction Wizard) καθοδηγεί βήμα - βήμα στην διαδικασία 
δημιουργίας ΨΜΑ από στρεοζεύγη με Rational Polynomial Coefficients (RPCs - 
περιλαμβάνουν τις απαραίτητες πληροφορίες για τον αισθητήρα-sensor).  
 
Τα βήματα για την παραγωγή ΨΜΑ είναι: 
 

 
 
 
Α. To ΨΜΑ δημιουργείται με βήματα μεμονωμένα ή μέσω οδηγού – wizard: 
 
Main Menu →Topographic → DEM Extraction Wizard → New 
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Στο παράθυρο που ανοίγει γίνεται η επιλογή στερεοζεύγους (που περιέχει RPCs) από 
λήψεις που έγιναν παράλληλα ή κάθετα στην τροχιά της πλατφόρμας.  
 
Β. Στο επόμενο βήμα επιλέγετε να προσδιορίσετε ή να φορτώσετε έτοιμα σημεία ελέγχου - 
GCPs και θα ανοίξει το παράθυρο διαλόγου εισαγωγής - επεξεργασίας GCP. 
 
Γ. Εφόσον ολοκληρώσετε την διαδικασία με τα GCPs προχωράτε στην επιλογή σημείων 
αγκίστρωσης: 

• Το ENVI δημιουργεί αυτόματα σημεία αγκύστρωσης (Τie) ή επιλέγετε τα επιθυμητά 
μεταξύ των δύο εικόνων (στερεο-ζεύγος). 

• Ελέγχετε και διορθώνετε τα σημεία αγκύστρωσης που εξάγονται αυτόματα για να 
επιτευχθεί υψηλότερη ακρίβεια και μείωση του σφάλματος της παράλλαξης. 

 
 
Όπως έχει προαναφερθεί, τα GCPs αλλά και τα σημεία αγκίστρωσης πρέπει να είναι 
ισοκατανεμημένα τόσο κατά την οριζόντια όσο και κατά την κατακόρυφη διάσταση της 
εικόνας. 
 
Δ. Επόμενο βήμα είναι η δημιουργία στερεοσκοπικών εικόνων (Left & Right Epipolar 
Images) 
 
Ε. Στο ανοιγόμενο παράθυρο δίνετε τις παραμέτρους σχετικές με τα Datum, Map Projection 
κ.ά.  
  
ΣΤ. Σε νέο παράθυρο δίνετε χαρακτηριστικά του ΨΜΑ που θα παραχθεί. 
 
Ζ. Όταν ολοκληρωθεί το ΨΜΑ, το απεικονίζετε στον οθόνη. Η επεξεργασία του (διόρθωση 
σφαλμάτων, πρόσθεση υψομέτρων όπου δεν αποδόθηκαν κ.ά.) επιτυγχάνεται μέσω του 
DEM Editing Tool. 
 
Η. Μέσω του εργαλείου Stereo 3D  επιτυγχάνεται ο υπολογισμός υψομέτρου από ένα 
στερεοζεύγος με ένα μόνο σημείο αγκύστρωσης.  
 
Θ. Μέσω του Epipolar 3D cursor είναι δυνατόν να δείτε στρερεοσκοπικά χρησιμοποιώντας 
τα κατάλληλα γυαλιά. 
 
Ι. Με τα εργαλεία Epipolar 3D cursor και 3D Stereo measurement επιτυγχάνεται η 
συλλογή υψομέτρων και η αποθήκευσή τους ως 3D shapefiles, τα οποία χρησιμοποιούνται 
σε απεικονίσεις 3D. 
 
 
ΖΗΤΕΙΤΑΙ 
 
Να παραχθεί ΨΜΑ με το στερεοζεύγος εικόνων που σας δίδεται μέσω των ανωτέρω 
βημάτων. 
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